


Common KelJ.board Shortcuts: 
Use these shortcuts to avoid spending time 
going to the menu bar with the mouse. Simply 
hold down the 3€ key and press the letter listed 
below. 

Desktop C/arisWorks 

new folder 3€-N new 3&-N 
open 3€-0 open 3&-0 
get info 3€-1 close 3&-W 
put away 3€-Y save 3&-S 
undo 3€-Z print 3€-P 
cut 3€-X quit 3€-Q 
copy 3€-C undo 3€-Z 
paste 3€-X cut 3€-X 
select all 3€-A copy 3€-C 
eject disk 3€-E paste 3€-V 

select all 3€-A 
plain text 3€-T 
bold text 3€-B 
italic text 3€-1 
underline 3€-U 

Your Mac's model name is printed on the front. For the 
System and memory info. choose About This Macintosh 
from the tl menu. 

Your Mac model: -----------

Your System version: _________ _ 

How much memory it's got: _______ _ 

Always Do This 

Read the screen! If you're not sure what to do 
next, read the screen and follow directions! We 
teachers are constantly telling students to read 
and find out-let's follow our own directions. 
More often than not, the screen in front of you 
holds the answer to your question. 

Purchase (or have your 
school purchase) 

... For Dummies: # 1 Computer Book Series for 8e9inners 
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Workin9 with Windows 
Opening or closing a window 

A window is simply your view into something that's 
normally closed. When a window is closed, it's not a 
window at all - it's represented by an icon (of a disk, 
a folder, or a file). 

1. Double-click any icon to open its window. 

2. To get rid of a window, click the close box in the 
upper-left corner. 
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Moving a window 
Point to its striped title bar (where the name of the 
window appears). Hold the mouse button down, and 
drag the window into a new position. 

Bringing concealed icons into view 
Sometimes a window is too small to show you all the 
icons within it. If that's the case, you'll see gray scroll 
bars along the bottom and right side. 
1. Point to one of the small arrows on the scroll bar, as 

shown, and press the mouse button continuously. 
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Your view of the window will slide in the direction of 
the arrow, showing you what's hidden beyond the 
edges. 

2. To make the window as large as necessary to view 
all the icons (limited by screen size), click the zoom 
box, as shown. 
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Making a dimmed window active 
Click in it. 

Finding a file 
Each file you create is represented by an icon and is usually 
stored inside an electronic folder, which looks like a file· 
folder on your screen. Beginners and pros alike occasion· 
ally lose files or forget where they fi led a certain file. 

1. Choose Find from the File menu. 

2. Type a few letters of the missing file's name. 
You don't have to type the whole name .. . only enough 
to distinguish it; type Wonk to find the file called Willy 
Wonka Quarterly Earnings. Capitalization doesn't matter. 

3. Press the Return key, or click the Find button. 

The Mac roots through your files. It either displays the 
first icon it finds that matches your request, or shows 
you a list of all icons that match. 

4. If the Mac finds the wrong file, choose Find Again from 
the File menu. 

Keep choosing Find Again until you find what you're 
looking for, or until the Mac beeps, telling you that it's 
done searching. 

1. Point to an icon's name, and click the mouse button. 
The icon's name is now highlighted (selected). 

2. Type a new name. 

A file's name can be up to 31 letters long. If you make a 
mistake, backspace over it by pressing the Delete key. 

Note to IBM types: A Mac file name can have any kind of 
letters you want (uppercase, lowercase, symbols- any· 
thing but a colon) and doesn't have to have a period in it. 

3. Press Return when you finish typing. 

To insert a floppy disk 
1. The metal part goes in first. 

2. The label side should be up. 

3. Push it into the Mac's disk slot until it makes a chunk 
sound. 

Copying a file onto a disk 
Drag the icon onto the disk's icon, and let go. 

Alternatively, you can drag the file into the disk's window, 
instead of on top of the disk's icon. 
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What People Are SalJint~ about 
Michelle Robinette and Macs For Teachers 

"A great resource guide ... I wish I'd had it two years ago when I first 
got my Mac." 

-Susan Narduzzi, Carmel, NY 

"Michelle Robinette has an excellent writing style. She is interesting and 
amusing to read. I would buy any of this series if she wrote it . .. I love 
her books!" 

-Richard Hicks, Minneapolis, MN 

"The best book- made my new Mac much less intimidating- your 
style was like calling a girlfriend for help. Two thumbs up." 

- Shellie Brunsman, Springfield, IL 

"Wittily written- just what teachers need- covered content 
simply and beautifully. Every teacher using Macs should have a 
copy available." 

- Mary E. Sanders, Homer, AK 

"This book is very helpful, specific to teacher's needs, very easy and 
enjoyable to read. I'm so glad someone is recognizing the education 
profession." 

-Jeanette Stinebaugh, Quenemo, KS 

"Michelle's book is a must for all teachers!" 
-Sue Delaney, Lawrenceville, GA 

"I can understand it! But best of all, Michelle has the key to how teach­
ers survive. It's not self-sacrifice, it's humor! I love this book; I even put 
aside my new sci-fi book. Reading this book is fun ." 

- Lois R. Ayers, Bedford, PA 

"Has Michelle Robinette written other computer books for the Mac? If 
so, I'd like to know about them ... she is a great teacher." 

- Katy Worcester, Butte, MT 

"I've been doing my reports on the computer for a year, but nothing 
else. This book gave me the confidence to try other things." 

- J. Beer, White Rock, BC, Canada 
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Are you intimidated and confused by computers? Do you find 
that traditional manuals are overloaded with technical details 
you'll never' use? Do your friends and family always call you to 

· fix simple .Probh~ms on their PCs? Then the •. . For Dummiesrs 
computer book series from.IDG Books·Worldwide·is for you • 

• • . For Dummies books are written for those frustrated computer users who know they 
aren't really dumb but find that PC hardware, software, and indeed the unique vocabulary of 
computing make them feel helpless .•. • ForDummies books use a lighthearted approach, 
a down-to-earth style, and even cartoons and humorous icons to diffuse computer novices' 
fears and build their confidence. Ughthearted but not lightweight, these books are a perfect 
survival guide for anyone forced to use a compt,rter. · 

"/like my copy so much I told 
friends; now they bought copies." 

Irene C., Orwell, Ohio ''Quick, concise, nontechnical, 
and humorous.,, 

'Thanks, I needed this book. Now I 
can sleep at night, 

Robin F., British Columbia, Canada 

Already •. millions of satisfied readers ~;~gree. lbey have 
made .••• For Dummies books the #I introducb,ny level 
computer book series and have wrif,tQn jlski~g for more. 
So, H you're .looking for the mosftun 811d easy way to 
learn about computers, look to ••• FOr Dummies books to 
give you a helping hand. 

Jay A., Elburn, Illinois 
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Foreword 
oeooooeeeooeeooeeoooeoooeooeoooeoooeoeoooeoooooo 

S:nce the first time I was asked what I wanted to be in life, my answer has 
always been "an engineer like my father and an elementary school 

teacher like Miss Skrak (my 4th and 5th grade teacher)." I started Apple 
Computer largely by accident. The initial intent was to build a machine for a 
technical person (myself). But the usefulness of such modestly priced 
computers for average people has caused great changes in homes and in 
business - as well as in education. For the last several years I have spent 
almost full time supporting the local public schools while contributing 
equipment and technical support. I have, with a small staff, taught year-long 
courses for 5th through 8th graders, as well as for teachers. 

Computers were simple machines in 1977, but they can be incredibly 
complicated to use and understand nowadays. To many students, the 
computer is as interesting and fun as a video game. Provide a computer and 
some software and, presto, the students will line up to use it. But today's 
students should be taught how to use the computer: to vary the look of text, 
to use fonts correctly, to align paragraphs and columns automatically, to 
include graphics, to emphasize items by various methods. And not to go 
crazy with all these capabilities. 

The students learn much of this if motivated. But they lapse into sloppiness 
creating works no better than those created with a typewriter if they don't 
feel that computer quality has value. The big obstacle here is the teacher. 

Teachers with normal (or minimal) computer experience don't assign tasks 
in a way applicable to computer solutions. For example, having the students 
create a computer timeline to demonstrate a unit on Egyptian history 
doesn't always come to mind for teachers. Also, most teachers cannot 
evaluate student work in terms of whether or not proper computer tech­
niques were used. It is not uncommon to find teachers admiring a font stew 
or a rainbow decoration of colors -amazed that it's even possible. With 
just a little experience, teachers discover that such techniques are often a 
very simple way to add effect to a paper. 

You can never learn enough about using your computer- which changes 
every time a new operating system is introduced. And I find it Intimidating 
to newcomers (teachers included) to have tons of software that they don't 
yet know how to use dumped on them. 
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Miss Skrak always made me feel proud about my scientific and mathematics 
knowledge. I credit her for strengthening my education values. My parents 
told me that adults had done a pretty poor job with the world in a lot of 
ways - and that we students attend school to learn from mistakes and 
make a better world. They told me how elementary school teachers earn less 
money than many other types of workers. I felt my teacher was worth more 
than that. I grew up caring about and helping others, like teachers and 
childhood heroes do. I particularly cared about young people and their 
world. 

Allocation of funds for computers is tight where I live. My district is lucky to 
have me. California ranks 47th in per capita spending on schools, and it's 
getting worse due to legislation of the past. I occasionally see cases where 
the schools get equipment - but not the staff training or funding to keep it 
maintained. Because the importance of the computer in education from 
elementary school through college is obvious, it may be time for school 
boards to reprioritize expenditures and requirements. But the ultimate 
question is how schools can obtain more funding, since computer costs are 
on top of funds required to teach every bit of material being taught when I 
was in school. 

The materials covered by this book are very appropriate, and I am honored 
to write this foreword. The programs discussed represent the most com­
monly used ones in our schools - and are exactly the ones I use and teach. 

Steve Wozniak 
Co-founder of Apple Computer, Inc. 



Introduction 
GGOGOOOOO~eooGOOOGOOOOOOOOOQO~OOOOOOOOOOOOOGOOOO 

Jam one of you. 

I've spent eight years in the classroom- I know how important your job is, 
I know that you are a well-educated individual, I know how hard you work, 
and I know how difficult it is to fit one more thing into your daily schedule. 
I'm also aware of how underappreciated you sometimes feel. (And there is 
very little incentive these days to spend time learning something new.) 

It seems to me that every time a school system jumps on a new bandwagon, 
trains staff members, and gives them time to master a new concept, the 
system turns around and decides to go in another direction. Remember the 
phonics-versus-sight-reading debate? Remember open classrooms? 

A wonderful veteran teacher I had the pleasure of working with once said, 
"It's all a big circle; every ten years or so ideas resurface, and they just put 
new names on them." I really believe that she is right - in most cases. 
However, that's just not going to happen with technology. It is here to stay, and 
if you don't decide to join in this movement, you may eventually be left behind! 

Three years ago, I left the classroom to become the technology coordinator 
for the elementary school in my neighborhood. I thought I'd landed the 
perfect job. The description called for me to preview software and hard­
ware, train teachers, oversee our three computer labs, and come up with 
plans to make relevant ties between curriculum and technology. The school 
was only a mile from my home. And the best part of all - I had an office and 
a phone. 

If you're not a teacher, you couldn't possibly appreciate that final tidbit of 
information. 

College graduate that I am, I decided to research and pool all my resources. 
Guess what? Every piece of published work out there was aimed at the 
business executives who sometimes have those one-hour-or-more lunch 
breaks and an assistant to screen out interruptions so that they can sit and 
read about their new computer and all the wonderful things they can spend 
their money on to make it really work for them. 
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Let me stop for a moment and examine this last sentence in teacher terms: 

Business World 

Real lunch break 

Eat with colleagues in restaurant 

Ever-present assistant 

Expense account 

Teacher's World 

25 minutes max 

Eat in cafeteria with 100 or more 
students 

Maybe an aide once a week for 30 
minutes 

A what? 

And here is the age-old answer we're always given if we complain about our 
jobs: "But you have summers off!" 

Don't you just love that response? Let's see. After taking a graduate course 
or two in order to maintain my credentials, participating in the staff develop­
ment that wasn't required (but was strongly suggested by the administra­
tion), and spending two weeks before school starts getting my room ready 
because pre-planning week was filled with everything but planning time, I 
probably only have about two weeks off in the summer. 

And now they've put a computer in your room. Or maybe a beautiful new 
computer lab that cost thousands of dollars has been installed in your 
school. What are you going to do? 

Mu Rationale 
That, my fellow educators, is why I decided to write this book. 

I want to tell you what you need to know, not what civilians need to know, 
about computers. I want to spare you weeding through those lofty computer 
manuals with vocabulary that could have been invented either by my 4-year­
old (words like mouse pad, screensaver, icon, floppy disk) or a rocket 
scientist (megabyte, partition, disk cache, PRAM). 

These manuals accompany every piece of software you purchase. And then 
you have the five or six manuals Apple included with your computer. Of 
course, we all have time to read these tomes that were probably written by 
someone who has never even stepped foot in the classroom as anything 
other than a student! In all honesty, less than half of each of these master­
pieces is necessary reading. 
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When I first became interested in computers, I had no one to tell me the 
shortcuts or walk me through even the simplest procedures. Now I get a real 
thrill out of showing teachers ways to make their lives easier. I've noticed 
that most people in education who know a little about computers tend to 
treat the topic as some big secret that only a select few are allowed to know. 

Above all, I want you to walk away from this book feeling comfortable with 
technology and its uses in the world of education. I want you to spread the 
word about technology, the Mac, and how it has helped you become a much 
better teacher. 

What~ New about This Reflised Edition? 
Believe it or not, I read every reader response card sent in by readers of my 
books (unlike school board members who ask for teacher comments and 
then tend to ignore the response and do the opposite). I took those com­
ments and incorporated the requested information into this new edition. I 
would never profess to know all that you need, and I appreciate your 
comments and concerns. 

I took those reader requests, updated the information in the second edition, 
inserted new information that wasn't around a year ago, and rearranged 
things a little to make the text easier to follow. 

Along with updating information already within the book (including major 
additions to the recommended software lists), I include extended Internet 
and World Wide Web explainations, expanded ClarisWorks coverage (includ­
ing a 5.0 update and a ClarisWorks for Kids sneak preview), all new class­
room activities, more troubleshooting pointers, and a CD whose contents 
directly correlate with the book's content. In order to make room for all this 
new information, I had to cut some of the information found in the second 
edition of Macs For Teachers. Well, I felt that everything I'd originally written 
was important, so instead of cutting large amounts of information, I moved 
the information to the CD. Yes, on the CD you find some chapters that were 
original to the second edition and readable (and printable) files. 

The Lesson Plan 
In Chapter 1, I assume that you have a Mac and printer (or access to these 
in your school) and that the Mac is installed (put together and plugged in). 
Don't worry; you can complete this first task on your own. The Mac is very 
easy to put together, and I know that you are an educated individual who is 
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capable of reading and following simple directions. Macs even have symbols 
to help you match cables with the proper ports. In this first chapter, I 
explain how to turn your Mac on and how to use the mouse. I also describe 
the menu bar, go over some basic Macintosh syntax, and tell you how to 
turn your Mac off. 

Chapter 2 covers some of the computer terminology that techno-nerds throw 
out to make the rest of us feel inferior: memory, hard disks, floppies, and so 
on. I also give you a list of words that are often overheard in computer 
circles and have no relevance to the world of education. 

In Chapter 3, you're on your way. It's like the first day of school! I teach you 
all about folders, control panels, your computer's desktop, the apple menu 
items, icons, and keyboard shortcuts. I almost guarantee that you can keep 
working and fly right through this chapter. In this new edition, I use this 
chapter to give you an overview of Mac OS 8, the latest version of Apple's 
operating system. 

After all the work you've done, in Chapter 4 you finally find out how to put it 
on paper. I tell you all you need to know about the different types of printers 
and how to make them work. 

Chapter 5 examines the major software categories: skill-and-drill, productiv­
ity, multimedia, and simulation. This chapter also explains the technology 
behind CO-ROMs. 

I'm sure you'll keep working on into Chapter 6 and Chapter 7, where you are 
introduced to ClarisWorks and the wonders of word processing. I help you 
create a personalized letterhead along with my all-time great time-saver, a 
lesson-plan template that enables you to throw away your lesson-plan book. 

Chapter 8 teaches you how to use the spreadsheet function in ClarisWorks. 
Spreadsheet knowledge lets you create customized checklists. 

In Chapter 9, you learn to create a database for your class. I also explain the 
mail-merge capabilities that enable you to send the same letter (with a 
personalized greeting) to each parent in your class. 

In Chapters 10, II, and 12, I help you fake your way through the three most 
popular educational software programs: Kid Pix Studio, The Student Writing 
Center, and The Print Shop Deluxe. 

In Chapters 13 and 14, I explain the mysteries of the information superhigh­
way. You learn how to get online and what you can do when you're there. In 
addition, you take a quick tour of the World Wide Web. 

In Chapter 15, I give hints on using one Macintosh in a classroom full of 
students. At first, I thought this task was an impossibility. However, we 
teachers can be very creative when it comes to time and space. 
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Chapter 16 deals with the computer-lab situation and is worth reading even 
if your school doesn't have a lab. Who knows? You may become the cru­
sader who persuades the PTA to make the investment! 

Chapter 17 holds some ideas on getting your local community and board of 
education excited and involved in your technology pursuits. 

Scanners, touch screens, and QuickTake cameras are just a few of the cool 
additions that any school's technology inventory would welcome. Chapter 
18 covers the neat things that you may like to add as you become more 
techno-literate. 

Appendix A holds a whole set of new lessons from every curriculum area, 
for use in either the classroom or lab. These lessons can be adapted for any 
grade level. Sharing these lessons is my way of creating a springboard. 
Teachers are smart; just plant a seed of information and watch it grow. r d 
love to hear back from any of you who really take off with these lesson plans 
and go in all kinds of directions. The lessons that appeared in the first and 
second editions of Macs For Teachers can be found on the CD located in the 
back of the book. 

Make a copy of Appendix B for your technology coordinator or principal. 
This list of software titles is super! (I had to weed through tons of trash 
software to get to the treasures.) It is possible to get a lot for a little money. 
This list is also on the CD. Feel free to print a copy before you go on a 
shopping spree! 

Appendix C, "Troubleshooting by David Pogue," was written by my buddy, 
David Pogue. He's the author of Macs For Dummies, 5th Edition (lOG Books 
Worldwide, Inc., 1996) and can answer just about any question you may 
have concerning your Mac or software. 

In Appendix D, you find down-to-earth, easy-to-understand definitions for all 
those overused techno-terms. 

Appendix E tells you all about the great CD you find in the back of this book. 

Wh1J. Mac} 
Personally, I use the Mac for economic reasons. Macs are in my school 
system, and, therefore, I have easy access to hardware and software. Apple 
computers are number one in educational circles and probably will continue 
to be for many years to come. And a Mac is very easy to learn and use on a 
daily basis - even for adults. 
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Macintosh is tops in education for many reasons. Above all, it is the easiest 
computer to operate. Children seem to pick things up much more quickly 
than adults - including colds, frogs, and other unmentionable objects. After 
reading this book and learning the basics, you'll find your students pushing 
you toward new heights in computers and technology. 

You are a teacher because you love children, you love imparting knowledge, 
and you want to have a stake in our future. Computers and technology are 
going to be a large part of this future. 

The Final Bell 
I appreciate the fact that you lead a busy life and have very little time for 
business or pleasure reading. Keeping that in mind, I am committed to 
making this book succinct, informative, and enjoyable. And who knows? 
Maybe those classrooms of the future we keep reading about will really exist 
one day. And you, my friend, will be a few steps ahead of the game. 

Con"entions Used in This Book 
This icon highlights items or activities that I highly approve of and feel 
would be worthwhile additions to your classroom environment. 

This icon brings your attention to information that's crucial to basic com­
puter operation - but I give it to you in easy-to-understand language. 

Wake up and pay attention! This is critical information for teachers. No 
sleeping or daydreaming allowed during the lesson. 

This icon points out great ways to integrate curriculum and technology. 

This one points out some real hands-on learning activities. You know, the 
kind of stuff we do everyday in our classrooms. 
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This icon flags references to the great stuff you find on The Macs for 
Teachers CD, found in the back of this book. 

This icon calls your attention to information that's specific to Apple's latest 
operating system. 

Web Disclaimer 
Because Web sites change so often, sites mentioned in this text may not be 
available by the time you read this book. If you have difficulty finding a site 
I've listed, try one of the great Web search tools or try working backward 
from the end of the address. 

For instance, the following web address should take you straight to Apple's 
eMate page: 

. bttp::t (www. newton. a:pp 1 e.:.cPII_l! eMate3.()0. html. 

But, if you have trouble, you can just enter 

ht~P: //www •. newton. app 1~. ~om 

and go to Apple's Newton home page - from where you can probably get 
where you want to go. 

Keep in Touch! 
I love hearing from fellow teachers. I want the ... For Teachers series to 
continue to meet the needs of educators. Let me know what you want to see 
in upcoming books or revised editions of this text. 

IDG Books Worldwide, Inc., Attn: Michelle Robinette, 7260 Shadeland 
Station, Suite 100, Indianapolis, IN 46256. E-mail: feedback@idgbooks.com 
Web site: http: I /www. i dgbooks. com 

Or, for a faster response, write me online at mnette@aol. com 

Also, please remember to fill out and mail in the reader response card in the 
back of this book. 
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Ode to Po9ue 
David Pogue is an incredible man. 

I realized this while reading Macs For Dummies. He took an intimidating 
subject and turned it into an enjoyable learning experience. His wit and 
humor kept me going and eventually turned me into a computer addict. 

After reading his book, I decided to give the genius a call - that's right, I 
just picked up the phone, dialed New York City information, and asked for 
the number. He not only accepted my phone call but was very warm and 
polite as well. Our discussion soon led to the need for more computer 
information for teachers. And thus a book was born - this book! 

David agreed to be my accomplice in crime. We devised a plan to create a 
book that had the Dummies style and delivery, without calling it a Dummies 
book. (I explained that teachers wouldn't think very highly of that label.) 
And without hesitation he agreed to give whatever assistance was needed to 
create this literary masterpiece. 

You see, David is a MacGod. In the kingdom of Mac, he knows all and sees 
all. It is rare to find someone with his high level of knowledge who Is still 
willing and patient enough to share it with others. In that sense, David is a 
teacher. In fact, he's been one of the best teachers I've ever encountered. 

I had supreme confidence in my own abilities in the field of education and 
using the Mac to enhance curriculum. What I needed was David to hold my 
hand (and allow a wee bit o' plagiarism) through the technical aspects of 
Mac use, care, and feeding. I hope some of his wit and wisdom have rubbed 
off on me over the past few months of our relationship - and if you enjoy 
this book, you have him to thank for the initial inspiration. 

Some excerpts that appear are taken directly from Macs For Dummies, 5th 
Edition (IDG Books Worldwide, Inc., 1997). Appendixes C and D, and large 
portions of Part I, are paraphrased from this same supreme work. 
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In this part ... 
~ere are at least four ways to become "one of those J ~~achers who knows about computers." (We all have 

a few of these technically-literate individuals in our 
school, and our feelings for them usually range from 
contempt to sheer admiration.) You could wait for your 
school to provide some type of training that would be 
taught after school when you're busy grading papers, 
picking up your kids, or taking the dog to the vet. You 
could read the manuals that came with the Mac, which 
are almost as exciting as a PTA meeting. You could even 
enroll in a class taught at a local computer center and 
pay big bucks for information that addresses the needs of 
the business Mac user. The final way (and, in my opinion, 
the ideal way) to learn about using the Mac is to read 
this book! 

Have you made a decision? 

In this part, you're given the respect you deserve. I don't 
bother you with information you don't need. Instead, I 
give you the basics - the bare bones required to help 
you get up and running on the Mac- and nothing else. 

Well, I may throw in a little teacher humor every now and 
then. 

One last thought .... 

You can do this. Think about what you are expected to be 
on a daily basis in your personal and professional life: 
mother/father, cook, chauffeur, accountant, custodian, 
wardrobe expert, laundry specialist, counselor, planner, 
curriculum creator, entertainer, artist, decorator. The list 
is endless. 

This computer stuff is a piece of cake compared to those 
responsibilities! 



Chapter 1 

Mac Basics 
ooooooooooooooeooooooeoooooooooooooooooooeeoooeo 

In This Chapter 
l> Turning the Mac on and watching what happens 

8> Using the mouse 

~ Making the most of Menu bars 

~ Meeting the desktop: icons, windows, and Macintosh syntax 

lir;a> Using multiple windows and multiple views 

~ Shutting down 

~ Top Ten differences between your Mac and your students 

ooooooooooooooooooooooooooooooooooooooooooeeeooo 

l know how frustrating it can be to have a new student, a new set of text­
books, or a new piece of classroom equipment thrust upon you. It's not 

that you don't welcome the new addition; it's just that things had been going 
so smoothly. The thought of accommodating the newcomer is both frustrat­
ing and overwhelming. 

The student will be fine. Just pair him up with your most sociable child. By 
the end of the day, they'll be fast friends. The textbook may look brand new, 
but you 'II probably find very few changes after you get past the glossy, 
graphically inviting cover- which allowed the publisher to call it a new 
edition and charge your school system double the original cost. Finally, my 
friend, trust me when I tell you that the computer is just as easy to conquer. 
And you can have fun at the same time! 

It's sitting there waiting to meet you. So think happy thoughts, roll up your 
sleeves (or put on your reading glasses), and do it! 

SUiitchintJ the Mac On 
In this first lesson, you're asked to locate the On button. To keep life inter­
esting, Apple has decreed that This Switch Shall Be in a Different Place on 
Every Different Mac Model. Fortunately, after you know where yours is, it 
pretty much stays in that spot for as long as you own your Mac. 
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You find the power switch in one of five possible places. Here goes: 

A keyboard button 

Back-panel switch 

Round front-panel button 

Back-panel push button 

Keyboard push button 

Every Mac keyboard has this key in the upper­
right or upper-left corner. It has a left-pointing 
triangle on it: On many of the world's Macs, this 
key turns the machine on. If yours doesn't, you 
must have one of the other on-switch locations. 

Feel around on the ends of your Mac's back panel. 
On many Macs, especially smallish or inexpensive 
ones, there's a plastic rocker switch back there. If 
you look at it, the On position is marked by a 
straight line, and the Off position is marked by a 
circle. Nobody can ever remember which is 
which. You may want to think of it this way: the 0 
stands for Off. (Of course, it also stands for On ... 
and they wonder why people are intimidated by 
computers?) 

A couple of models (61 0, 6100, 6115) have a round 
nub of an On/Off button on the front panel, on the 
right side. 

Only PowerBook laptops have this button. If your 
model number begins with a 1, you have to flip 
open the back panel, which is a pain. You then see 
the round, concave power button. (If your 
PowerBook model number begins with a 5 or 
higher, you turn it on with the triangle-labeled key 
on your keyboard.) 

On PowerBook Duos only, a rubber capsule­
shaped button on the keyboard is your On switch. 
(An identical button is on the back.) 

Was your hunt for the elusive On Switch successful? Then turn the Mac on! 
You should hear a ding or a chord, and after a few seconds, an image 
appears on the screen. 

What You Hope to See 
After a few seconds, you should see this cute little smiling computer: m 
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A few seconds after that, you are given a pleasant "Welcome to Macintosh" 
message. If you have a newer Mac, you also get a quick view of the Mac OS 
(operating system) logo. 

Finally, you see a stream of little icons (the techno-term for little pictures) 
that appears across the bottom of your computer screen. Each of these 
icons represents a "little extra" you or Apple has added to an already 
extensive list of special capabilities that came with your Mac. 

Your desktop should appear. Or, if your school has already installed a 
protection program (At Ease), you see something that looks like a file folder. 
If you see this file folder, ask someone in your school for the password that 
gets you to the desktop -and have this person disable At Ease for you. 

Great job! You are ready to go. 

The First DaiJ of School 
Well, you did it! The machine is on. It wasn't that hard, was it? Now, take 
some time for you and your Mac to get better acquainted. 

UsiniJ the mouse 
The mouse is the gray, soap-sized plastic box on the desk beside your 
keyboard. Having trouble visualizing it as a rodent? Think of the cord as its 
tail, and (if it helps you) draw little eyeballs on the sloping side facing you. 

Now then, roll the mouse across the desk (or mouse pad), keeping the cord 
pointed away from you. See how the arrow pointer moves across the 
screen? For the rest of your life, you'll hear that pointer called the cursor. 
(And now you know that those technically literate teachers are not referring 
to the kid with the advanced vocabulary when they use this computer 
term.) 
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Try lifting the mouse off the desk and waving it around in midair like a 
remote control. Nothing happens, right? The mouse only controls the cursor 
when it's on a flat surface. (A ball on the bottom of it detects movement and 
moves the cursor accordingly.) That's a useful feature because it means that 
you can pick the mouse up when your run out of desk or mouse pad space, 
but the cursor stays in place on the screen. Only when you set the mouse 
down and begin to roll it again does the cursor continue moving. 

One day, while working with a group of first graders in the lab, I came upon a 
sweet little girl who was slowly rolling the mouse up her leg. When I asked 
why she had the mouse on her leg, she replied, "I needed to get to the 
bottom part of my picture and I ran out of room. My leg's longer than that 
mouse pad - and it still works!" 

People who use a mouse for the first time sometimes think that they are 
stuck when they get to the edge of their mouse pad. Simply pick that baby 
up and move it over. 

What's on the menu? 
Let's do some real computing here. 

I. Move the cursor up to the white strip at the top of the screen and 
touch the arrow on the word Special. 

This white strip is called the menu bar. Pointing to something on the 
screen in this way has a very technical term: pointing. (I told you this 
would be a piece of cake!) 

2. Now put your index finger on the button on the mouse and press the 
button down. Hold it down. Don't let go. 

If all goes well, you should see a list of commands drop down from the 
word Special, as shown in the following figure. Keep holding down the 
button. 

Clean Up Desktop 
Empty Trash ... 

Eject Disk XE 
Erase Disk ••• 

Restart 
Shut Down 



Congratulations -you just learned how to click the mouse (which is 
yet another term you can now use in front of those computer-nerd 
colleagues). You also learned how to pull down a menu (the list of 
commands). 

3. Try letting go of the mouse button: The menu disappears. 

You have only one more mouse skill to master -drag. The act of moving the 
mouse with the button down is called dragging. This movement is useful in 
the menu bars when you want to make a selection from the menu. 

Let's try the act of dragging. 

I. Point your mouse at the word Special on the menu bar. 

2. Now here comes the tricky part: Click and hold down the mouse 
button. While you are holding down the mouse button, roll the 
mouse so that the cursor slides down the menu. 

As you slide down the menu, your options are highlighted. 

The only commands that don't get highlighted are the ones that are 
dimmed, or "grayed out." They're dimmed because they don't make any 
sense at the moment. For example, if there's no disk in the floppy-disk 
drive, choosing Eject Disk wouldn't make any sense, so the Mac makes 
it gray, which means it's unavailable to you. 

3. Roll the mouse all the way down to the words Shut Down so that 
they're highlighted, as shown here. 

Clean Up Desktop 
Empty Trash ... 

Eject Disk 38E 
Erase Disk ••• 

Restart 
Shut Oown 

4. If you've had enough for one session, release the mouse button - the 
Mac turns itself off. 

If you are ready for more, and you want to slog ahead with this lesson, don't 
let go of the button yet. Instead, slide the cursor off the menu in any direc­
tion and then let go of the mouse button. The menu snaps back up like a 
window shade, and nothing happens. (You invoke a menu command only 
when you release the mouse while the cursor is on a command.) 
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PowerB.ook mouse buttons 
If your Mac is a laptop Mac, you're probably 
halfway to the bookstore to return this book. 
Yes, it's true; your computer doesn't have a 
mouse. Instead, it has a trackball (which is 
essentially an upsidet-d.oWI1 mous.e) or a 
trackpad~ The,principle is the same: Roll the 
ball away from .you, and th~ cursor moves up 
the screen. Instead of a mouse button, you 
have one or two crescent~shaped buttons 

nestled against the ball or pad. The newer 
Powerbooks · have just one button. {If you've 
gottwo.buttons, they're identical in function.) 

I won't mention this distinction again, because 
if you're.' smart enough to have bought a 
PowerBook, you're smart enough to translate 
future references to the mouse into trackball 
terms. 

The Desktop - aka the Finder! 
I don't know about your desk, but I certainly couldn't interchange the word 
Finder with my desktop. It's impossible to find anything on top of that piece 
of furniture. As a matter of fact, I'm not sure if I should call it a desk at all -
I never sit behind it and work, because I never have the time! 

Other than the fact that a Trash can comes with the territory, nobody's 
really sure why this "home base" screen is called the desktop- or the 
Finder. Move the mouse to the File menu and hold the button down. See the 
word Find? (If not, read the sidebar "All systems are go.") This command 
instantly roots through all your stuff and locates any file you ask for. Thus 
the name: the Finder. Used in a sentence, you may hear it like this: "Well, no 
wonder you don't see the Trash can. You're not in the Finder!" 

What's an icon] 
So now you've mastered the mouse! Take a look around the Mac screen. 
(Once again, if you see what looks like two file folders, ask someone in your 
school to disable At Ease.) You've already encountered menus (those words 
File, Edit, View, and so on, at the top of the screen). An icon is a small 
symbolic picture. Icons represent everything in the Mac world, and they all 
look different: One represents a letter you wrote, another represents the 
Trash can, another represents a floppy disk you've inserted. Here are some 
examples: 



You can move an icon by dragging it. 

I. Point to the Trash icon. 

2. Drag it to a new position. (Move the mouse while the button is down.) 

Hey, this isn't so technical after all! 

Macintosh windows and SIJ.ntax 
Point to the hard-disk icon (a rectangular box) in the upper-right corner of 
the screen. A hard disk is like a massive floppy disk. It's the filing cabinet 
that contains all your work, all your files, and all your software. 

So how do you see what's in it? Where do you get to see its table of con­
tents? 

It turns out that any disk icon can be opened into a window, where you see 
every item inside listed individually. The window has the same name as the 
icon you opened. (It may already be open. If a window is open on your 
screen, choose Close from the File menu. Choose Close again and again until 
no windows are open on your screen.) 

Before we proceed, though, it's time for a lesson in Macintosh syntax. No, 
don't moan; it's nothing like English syntax. In fact, everything you do on the 
Macintosh has this format: noun-verb. Not much poetic nuance, but it's sure 
easy to remember. 

Let's try a noun-verb command, shall we? 

I. CHck the hard-disk icon in the upper-right corner of the screen. 

It should turn black, indicating that it's selected. Good job-you've just 
identified the noun. 
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Figure 1-1: 

2. Move to the File menu and choose Open. 

You guessed it! Open is the verb. And sure enough, your hard disk opens into 
a window, where you can see its contents . 

Did any of that make sense? In the world of Macintosh, you always specify 
what you want to change (using the mouse), and then you use a menu 
command to specify how you want it changed. You'll see this pattern over 
and over again: Select something on the screen and then apply a menu 
command to it. 

Look over the contents of your hard-drive window. Check out Figure 1-1. 
( Everybody's got different stuff, so what you see on your screen won' t 
exactly match these illustrations.) You can do all kinds of neat things to a 
window. They're worth learning because you're going to run into windows 
everywhere after you start working. 

CLOSE BOX- Click here to close 
the window. It's the same as 
choosing Close from the File menu. 

TITLE BAR- Drag anywhere 
in this striped area to move 
the entire window. 

~~5~~~~~M~ec~ln~t~os~h~o~~~~~~~~-ZOOM BOX- Click here to make 
64 Items 550.9 MB In dlslc 476.3 MB nuellnble the window large enough to 

~ 
Hyper.itudlo for HD 

D 
Kid PIH Studio 

D 
Rmerlcn Online u2.7 

(Q] 
System Folder 

• show all its contents . 

t-VERTICAL SCROLL BAR - It's 
gray, indicating that you can 
click the arrows or use the 
sliding square to adjust your 
view (top to bottom). Your hard­

drive 
window. 

~;j· V SIZE BOX- Drag in any 
i direction to make the 

---- ltlilliiii:ii~iiiiii!~ili!Yi~iiillliiiiiiiiiliir!Eif window bigger or smaller. 
I 

LJ 
ClnrlsWorlcs 4.0 Folder 

D 
Student Writing Center'" 

HORIZONTAL SCROLL BAR - It's gray, indicating that there is something 
off to either side. Click the arrows to adjust your view or use the 
sliding square. If you're seeing everything in the window (left to right), 
the bar would be white. 



Go ahead and try some of the little boxes and scroll bars. Click them. Tug on 
them. Open the window and close it again. No matter what you do, you can 
never hurt the machine by doing "the wrong thing. " That's the wonderful thing 
about the Macintosh: It's the Nerf appliance. 

Now try this. Make sure that your hard drive window is open. See the 
System folder? Even if you don't, here's a quick way to find it: Quickly type 
SY on your keyboard. 

Presto! The Mac finds the System folder (which happens to be the first thing 
that begins with those letters) and highlights it, in effect dropping it in front 
of you with its tail wagging. 

Try pressing the arrow keys on your keyboard: right, left, up, down. The Mac 
highlights neighboring icons as you do so. 

Take a look at what's in the System folder. Of course, using your newfound 
noun-verb method, you can (1) click the System folder to select it and then 
(2) choose Open from the File menu. 

But that's the sissy way. Try this power shortcut: Point to the System folder 
icon so that the tip of the arrow cursor is squarely inside the picture of the 
folder. Keeping the mouse still, click twice in rapid succession. 

If all goes well, your double-click succeeded in opening a new window, 
showing you the contents of the System folder. (If it didn't work, you 
probably need to keep the mouse still or double-click faster.) 

Remember this juicy golden rule: Double-clicking an icon is the same as 
opening it. The precious moments and treasured calories you save by using 
this shortcut will add up rapidly. 

UsiniJ Multiple Windows 
and Multiple VieWs 

Multiple windows and a great view add value to any home. The same is true 
with your Mac. However, unlike your beautiful new home, the Mac allows 
you to alter your view to best suit your needs. (If only I could alter the view 
of my neighbors' garage and unkempt yard as easily!) 



20 Part 1: For the First-Time Mac User ______________ _ 

Multiple windows 
Right now, you should have two windows open on the screen: the hard-drive 
window and the System-folder window. (The System-folder window may be 
covering the first one up; they're like overlapping pieces of paper on a 
desk.) 

If your computer is running Mac OS 8, you can simply drag an open window 
down to the bottom of the screen, and the window will turn into a tab. You 
can then click on the tab to access the window's contents at any time. This 
feature leaves your desktop uncluttered while at the same time allowing you 
to have easy access to items you frequently use. 

I. Click the title bar of the System-folder window and drag it downward 
until you see the bard-drive window behind it. 

Macintosh liD 
18 ittm:S 70.1 118 ~disk 6 .7 1'-S ~nmblt 

p-, ~ ("'-, I 
System folder 

17itHM 70 .1 118 ~ dille 6.7f""E IVIfllblt 

~ ~ (Q] i. Applo Monu lttmS Control P.n.ls Exttns!ons 

~ C1J ~ Lm ~ D .... 
r~ ... fonts Scr opbook F!lo Sojsttm At Eu t c t ... Is 

i .... '-•' ~:-:i.ii:>~·,:t.:~, .:.,~,_,.., "'" .>; cr-·lill 

2. Take a stress-free moment to experiment with these two windows: 
Click the back one to bring it forward and then click the one that 
was in front to bring it to the front again. 

If you need any more help fooling around with these windows, the 
Macintosh manual has a complete tutorial. 



-------------------Chapter 1: Mac Basics 27 

A look at what's coming with Mac OS 8 
With Mac OS 8, Apple has managed to incor­
porate just about every feature Mac users 
have been begging for over the past few years. 
Yes, they've taken the best and made it even 
better! I highlight and discuss in-depth each of 
the new features as they come up within the 
text For now, here's a brief rundown of what 
you can expect if you upgrade: 

Y* Speed: Everything happens faster- from 
opening files to emptying the trash to 
searching for files. 

Y* Multitasking: like children, your computer 
can now talk and chew gum at the same 
time. So go ahead, launch a program, make 
copies of a file, and empty the trash all at 
the same time. 

Y* OpenDoc: This is now part of the OS archi­
tecture or basic curriculum for Macintosh. 
OpenDoc is something like an instructional 
framework- it breaks applications down 
into smaller building blocks that are all in­
terchangeable. OpenDoc allows you to 
drag and drop between applications that 
have Open Doc standards. This means that 
you can drag a document from your 
spreadsheet program and drop it in your 
presentation program completely intact. 

Y* Refined Menus: My personal favorite new 
feature is the ability of the Menus to stay 
open after you click on them (a feature 
common to Windows users). You no longer 
have to hold the mouse button down to 
keep your menu in plain sight! In addition, 
Mac OS 8 now uses more pop-up windows 

within the menus that make it easier to 
access frequently used files, folders, and 
applications. All of this makes for a less 
cluttered desktop. 

Another cool new trick that Mac OS 8 makes 
available for education is called Open Trans­
port This feature allows you or your class to 
share (yes, you both see it on the screen at the 
same time) and collaborate on a document or 
other project with another class, professional, 
or individual via the Internet, a Local Area Net­
work, or Wide Area Network. With the proper 
equipment (a digital video camera) you can 
even video conference, seeing the other per­
son and discussing the changes you make on 
the shared document you both have on the 
screen simultaneously. 

Y* Advanced Help Features: The Mac OS 8 
has some neat advanced help features 
that include tips customized to help you in 
a variety of different computing situations, 
as well as a neat Experts guide that takes 
you step by step through the actions in­
volved in maintaining your computer and 
setting up your Internet access. 

Y* Creative Freedom: Rnally, for those power 
users out there, Mac OS 8 offers almost 
unlimited creative freedom. From en­
hanced 3-D modeling to Virtual Reality and 
everything in between, the Mac continues 
to maintain its place as the best computer 
for creative professionals. 

Note: The upgrade is only available for 
PowerMac and 040 microprocessors. 
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What system? 
If you bought a used Mac; orifyou:.boughtit _ This'informativewindow indicates whlch·ver­
some time ago and you're iu.~ nQW learnh1g ~ion ofthe System software your computer: 
·how to ma.ke it work, then·youmayhayeone.of. b~s._Th.is version number is- important when 
the earlier versions of system· software. you'nt purchasing software or additional pe-

,ripherals·(add-ons) for your computer. 
Finding out which versiorrofthe system soft: 
ware you have is easy. Remember the Apple hi general, I'm going to assume that you're 
log()(ttlintheupper-leftcornetofthescreen? using System 7 (or 7.1 or 7.5 or 7-point­
As you may recall, it's no ordinarvJogo-that anytljing). 
apple is actually a menu; like_ the .ones you For now, if you don't see the Find command in 
already know about Point your arrow cursor the File menu, you should see its System 6 
tip on the apple, hold the button down, and equivalent ~ Find .File _ under the Apple 
watch whathappens. mern.i,. Which: is marked by the: Apple togo· at 
As with any menu, a list ~raps: down. f:ligblight the' left side: of the menu bar; Find .. File serves 
AboutThi~ Macintosh(slideyourpointer.down -the~ sam' :P.urpose as the .System 7 find 
until About This Macintosh>turns black) and ·commafid. · 
then ·release the moose button~ A ;window 
appears. 

All syste~ns aJe go 
You know how your reading series comes OIJt 
with a new version every few years? Wen_,. 
Apple does the same thing: It keeps making 
minor changes to its computers, trying to make 
them better (and providing more incentive to 
buy them). 

You've already encountered the System folder; 
which holds software the Mac needs for 

itself ~the ··'system software" or "OS" (for 
operating system). System 7.6 is Apple's latest 
OS software~ (Mac OS 8 debuts in the fall 

-of 1997, andit has lots of terrific. features­
see the sidebar later ·in this chapter.) Every 
Mac sold since mid-1996 is equipped with 
System 7.6. 



Multiple fliews 
One other aspect of windows will probably make all of you with type A 
personalities squirm with delight. Up until now you've viewed the contents 
of your disk as a bunch of icons. Nice, but wouldn't it be neat to see things 
in alphabetical order? Okay, it's a little obsessive, but it could make life 
easier. 

I. Make sure the System folder is the active window (the one in front). 

You're going to use the System folder because it's got a lot of stuff in it. 
Remember how to choose a command from the menu? 

2. Locate the View menu at the top of the screen. From it, choose by 
Name. (fhat's by, with a lowercase b.) 

Suddenly, the big icons are replaced by a neat alphabetical list of the 
window's contents. 

The Final Bell of the Da1J. 
Yep, the bell just rang and the last bus has pulled out of the parking lot! You 
need to turn off your Mac and hit the road. Promise me here and now that 
you will never simply flip the switch on the back of your computer! Instead, I 
want you to drag your cursor (the little arrow that moves when you move 
your mouse) to the Special menu, choose Shut Down (notice how the 
inaccessible choices are gray instead of black), and let go of the mouse 
button. Your Mac (if it's a newer model) should automatically shut itself off. 
If you have an older Mac, you get a message telling you that it's okay to tum 
off your Mac, and you can then turn it off manually. 

Another, better option for those of you running System 7.5 or higher is to 
choose Shut Down from the Apple Menu (as shown in Figure 1-2). My friend, 
David Pogue (the Mac god), tells me that you have fewer problems with your 
Mac if you use this method for shutting down your Mac. 
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Figure 1-2: 
Here is the 

best way to 
shut down 
your Mac. 

Rbout This Macintosh ..• 

fiEj) RppleCD Rudio Player 
6 Calculator 
~Chooser 
1m ClarisWorks 
@a Control Panels • 
.Find File 
.. Graphing Calculator 
~ Jigsaw Puzzle 
JiJ Key Cops 
[]Note Pad 
fa Scrapbook 
~Stickles 

Rhap-so-dy. n: an exc~~iv_e,~i,play of.enthusi&$01 
Thafs Webster's definition, and it's an ·acc.urat¢ description of how Apple feels about its 
upcoming $y$tem software upgrade. Rha~sody is the ri,ode name for the new system ·softWare, 
and· U.P until oow it's been a mystery -leaving many Mac users wondering 'What's going on?" 
So,jn an effort t.o clear things up, here'$ the officiartowdown straightfrorn Apple: 

Rhapsody is the code name ofthe first system softwa~:e effort. planned from the prospective 
unionof Apple and Next Its intent is to extend the. existing strengths of both companies to 
provide·a. computing environment that is both stronger and. more flexible.:-- and, .. ultimately, 
better able to meet the ne.eds of our custorners,-·than currently available offerings. More 
specifically, Rhapsodytargetsthe following goals: 

Ill' High performance and stability 

Rhapsody will be an "industrial-strength" operating system (OS) - a stable, modern, fully 
preempted and memory-protected multitasking environment, with built-in capabilities for 
'symmetric· multiprocessing. 

Ill' Superior lnternef/intranet support 

Already, the Mac OS offers leading advantages in all three major Internet usage areas: 
access, creation, and delivery. These advantages, when backed by NeXT's extensively 
tested and deployed network-optimized technology - as well as full, built.;.in support for 
Java- should make Rhapsody an unparalleled Internet/intra net environment 

Ill' Ease of use 

Rhapsody· will. build on the ease-of-use tradition long established by the Mac OS. It will 
preserve the familiar "look and feel" otto day's Mac OS user interface, while incorporating 
improvements from both Apple Labs and NeXT technologies - providing features that 
complement Rhapsody's superior power by making the user experience even simpler and 
more engaging. 



,- Compatibility 

A key part ofthe Rhapsody architecture-is aJ~"ow~rPC-native compatibility environment for 
the Mac OS, designed to ensure that botH existing· Mac OS applications and current 
Macintosh peripherals can work withoqt mgd,iticati<in~ Rhapsody will especially appeal to 
customers who require the highest syste~iTfperf(fnnance and ·throughput, in fields such as 
print publishing, lnternetcontentdevelop~ife~:tta~d:publication, in-house application devel­
opment, and video editing. However, be~au~e. R~apsody is based on coupling Apple's 
exceptional ease of use with superior performance and stability, we expect that the new 
operating system will ultimately tneefthe _needs of-all ·customers; our intent is to offer an 
initial devei<Jper .release pf, Rhapsoa.y d~r~no·l~~?~; This, will allow third parties t~ begin 
developing th~ next generation ofappJicat~~Jl~ fqr POwerPC processor-based systems in a 
timely manner •. Our goal is to ensure ttlat.;w."et'l:}~hapsody is ready for general customer 
release (slated for mid.;1998), users will be~.~bl~"to choose from among numerous software 
solutions that allow them to take advant~ge, pfthe greatly increased stability and perfor-
mance this environment offers. · ·· · · · · 

Q: Does this mean that Apple is abandoning tb~':Mac~ OS? 

A: No. Our plans caUfor continueds'opport o( : ~nd enhancements to-the existing Mac OS 
through semiannual releases. Thus~ concur{eiltwi~ ~mr ~evelopment plans for Rhapso~y, 
we will continue to integrate the latest Apple technolqgies into the Mac OS, delivering 
updates every six months. · 

Q: What about the Mac OS "look and feel"? 

A: Apple understands the value of a· ~onsi~ent user interface across operating systems- in 
terms of both ease of use and training arid osupport efficiency. So Apple's plan is th~:~t 
Rhapsody's user interface will continuethe tradition .of unparalleled ease of use established 
by the Mac OS, while incorporating elemems:ofNeXT user interface technology that can 
augment the familiar intuitive Macintosh interface. 

Q: Which_ Macintosh models will Rhapsody support? 

A: Initially, Rhapsody should support all currently ·Shipping PowerPC processor-based 
Macintosh systems, from Performa compl.ltersthrijugh PowerBook and Power Macintosh 
models. 

Q: What about existing· applications - will1hi!Y .run on Rhapsody? And what about existing 
peripherals? ·· · 

A: Apple is committed to enabling Rhapsodyto'run existing applications written for the current 
Mac OS, delivering performance that meets or e·xceeds current performance levels. This 
support will be achieved by hosting a native version ofthe Mac OS on a modern microkernel, 
enabling the Mac OS to run under RhapsQdy in native. mode, as opposed to emulation -
thus providing outstanding speed and responsiveness.Jn addition, most existing networking 
setups, printers, monitors, and cards will b_e supported. 
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Top Ten Differences between Your Mac 
and Your Students 

1. Your Mac never plays in the bathroom. 

2. Your Mac always remembers what you told it the day before. 

3. Your Mac doesn't have parents to make your life interesting. 

4. Your Mac doesn't ask about recess every five minutes. 

5. Your Mac never has excuses; it always finishes its work on time. 

6. Your Mac gets along well with others. 

7. Your Mac never loses its work. 

8. Your Mac has never heard of Rug Rats or Goosebumps. 

9. Your Mac follows directions. 

10. Your Mac always speaks to you politely. 



Chapter 2 

High Tech in Teacher Terms 
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 

In This Chapter 
~ How disks and memory work 

~ A look at a floppy disk 

b> The difference between memory and hard disks 

11>- Why you should always SAVE, SAVE, SAVE 

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 

II {rning: The text you are about to read is not a reflection of me or my W ~ersonality. I refuse to be labeled a computer nerd - my editor 
made me include this information. I had to do it! 

Feel Free to Skip This Chapter 
When was the last time someone told you that? I look at this chapter in the 
same way I face the endless stream of memos that are sent from the district 
office - worth scanning now, but certainly not crucial in your development 
as a computer aficionado. Later, you may want to come back and read the 
chapter on a more detailed level. By then it will all make more sense. 

I must also apologize ahead of time because I promised you that I would 
only include the essential stuff. This information isn't essential, but it is 
worth knowing at some point. And it will allow you to converse at a much 
higher level with the other techno-wizards at your school. 

StorintJ ThintJs With FlopplJ. Disks 
Human beings, for the most part, store information in one of two places. 
Either we retain something in our memory, or, if it's too much to remember, 
we write it down on a scrap of paper that gets lost between school and home. 
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Computers work pretty much the same way as humans (except they don't 
have scraps of paper). They can either store what they know in their 
relatively pea-brained memories, which I cover in a moment, or they can 
write it down. A computer writes stuff down on disks. 

The most common kind of disk is the 
floppy disk. Don't ask me why the 
computer world still refers to these 
as "floppy." In truth, these disks are 
quite rigid. Those of you who were 
around during Apple's He days know 
all about the large 51/4-inch floppies 
that truly were "floppy" and easy to 
bend or damage. The disks I'm 
referring to here are only 31/2 inches 
and made of hard plastic. 

Inside the protective hard shell is a 
circle of the same shiny brown stuff 
that videocassette tapes are made of. 
Instead of recording a Public Televi­
sion special to share with your class 
at a later date, the computer records 
your documents: a letter to the 
superintendent, your class grades, or 
your first novel. 

Floppy disks come in several capaci­
ties, but even the largest one holds 
only about 1,000 pages' worth of 
data. That may seem like a lot, but 
that's just text. Pictures, for instance, 
take up much more space; that same 
floppy disk can probably only hold 
one or two color pictures. You can 
see that floppies aren't very handy 
for storing lots of information. 

The Hard Disk 

.......... ........ . 

Nearly every Mac has an even better storage device built inside it: a hard 
disk. The concept of a hard disk confuses people because it's hidden inside 
the Mac's case. Because you can't see it or touch it, it's sort of conceptual­
like teacher retirement accounts, I guess. But it's there, and a hefty chunk of 
your Mac's purchase price pays for it. 
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Hard disks differ from floppy disks in a few critical ways. A hard disk deliv­
ers information to the computer's brain about ten times faster than a floppy 
and costs about 500 times as much as a floppy. (Floppies are dirt cheap.) 

Why all this talk of disks? Because this is where your life's work is going to 
reside when the computer is shut off. 

Don't be confused if you hear (or see) the words hard drive and hard disk 
used interchangeably - they're the same beast. 

Memoru 
Those of you who don't have children probably have better memories than 
the rest of us. Enjoy the ability you now possess to complete a task or a 
thought without interruption. Being able to recall where you last laid your 
keys or remember the last paragraph you read is a privilege that seems to 
disappear when you enter the world of parenting. 

Students have remarkable memories. However, their memories seem to be 
more selective. For instance, how is it that they remember to put snack 
money in their pockets each morning yet forget their homework? 

The Mac's memory is powerful, but when it is turned off at night, it forgets 
everything. It becomes a dumb, metal-and-plastic doorstop. That's because 
a computer's memory, just like yours, is kept alive by electrical impulses. 
When you turn off a Mac, the electricity stops. (Fortunately, few things can 
turn off a person, except possibly nose-picking - a common classroom 
occurrence -which fortunately has no long-term effect on our memories.) 

Therefore, each time you turn on a Mac, it has to re-learn everything it ever 
knew, including the fact that it's a computer, what kind of computer it is, 
how to display text, and so on. It's like the first day of school when the kids 
seem to have forgotten everything over the summer. 

When you turn on the Mac, there's a whirring and blinking; the hard disk 
inside begins spinning. When it hits about 3,600 rpm, the Mac starts reading 
the hard disk (or, if the analogy helps you, it "plays" the disk like a record 
player). It finds out: "Hey, I'm a Mac! And this is how I display text!" and so 
on. It's reading the hard-disk and copying everything it reads into memory. 
(If only students could re-learn their information as quickly as the Mac!) 
Without the hard disk, the Mac is like someone with a completely hollow 
skull- and we've all met that type. 
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Your Mac's memory doesn't hold as much as your hard disk: The hard-disk 
is used for long-term permanent storage of lots of things (like the name of 
every student you've ever taught), and memory is used for temporary 
storage while you work on one thing at a time (like who hasn't turned in 
homework today). 

You often hear computer-literate teachers discussing megs. Trust me­
they're almost certainly not talking about a new student in their class. Meg 
is short for megabyte. 

What is highly confusing for most beginners - and it took me forever to 
keep straight - is that memory (fast, expensive, temporary) and hard-disk 
space (permanent, slower) are measured in the same units: megabytes. A 
typical Mac has between 16 and 64 megs of memory (silicon chips), but 
between 1 and 4 gigabytes of hard-disk space (spinning platters). (See the 
sidebar "Sinking in the sea o' terminology" for an explaination of megabyte 
and gigabyte.) 

What is RAM? 
I'll make this very simple: RAM is a type of memory. RAM (pronounced like 
the male sheep) stands for Random Access Memory. It's a term you hear a 
lot, and I feel compelled to give you an explanation. 

The term RAM can be interchanged with the term memory. When someone 
asks, "How many megs of RAM do you have?," they want to know about your 
computer's memory capacity. 

If you're dying to know how much RAM or memory your computer has, 
choose About This Macintosh (or About This Computer) from the ti menu. 
A window appears. 

The number circled in Figure 2-1 shows how much RAM your Mac has. If you 
lop off everything after the comma, you're left with the number of megs of 
RAM.lt's probably 4, 8, 16, or 32 megs. Older Macs may have less; high­
powered expensive ones may have more. 
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Sinking in the sea o' terminology 
OK, here's your life preserver. Hold on and 
read. If you're like me, you'll end up coming 
back to this passage a number oftimes before 
it's all completely straight in your head. 

One meg equals 1,024 kilobytes, or K; a K is 
about the equivalent of one page from that oh­
so-exciting history textbook. 

Gigabyte: A unit of memory or storage capac­
ity, nicknamed gig or abbreviated GB. One gig 
equals 1,024 megabytes. 

Megabyte: A unit of memory or storage ca­
pacity, nicknamed meg or abbreviated MB. 

Figure 2-1: 
You can 

check how 
much RAM 

you have. 

This Mac has 8MB of RAM. 

Rbou This Macintosh 

eCI Sgste-t~~ S.ftw.,.• 7 .:5 
'\""!!> - i) l.pplo~t ... , lno. 1983·1994 .... 

T ob 1 tt.mory : ~ Lw-~st U.used Bleok : 4 ,0:581< 

£1 &Jst.m Softw.arr 4,0901( ~ 

to 
Iii 

PuttintJ It All To9ether 
All right. Now that you know where a computer's information lives, let me 
take you on a tour of the computer's guts. If we were going on a school field 
trip, you'd be getting on the comfortable yellow bus at this point, and I'd be 
telling you to keep your hands inside the window at all times. 

When you turn on the Mac, the hard disk spins, and the Mac copies certain 
critical information into its memory. So far, the Mac only knows that it's a 
computer. It doesn't know anything else that's stored on your hard disk; it 
doesn't know about the grades from your second-period English class or the 
children's book you've been writing- yet. 

To get to any of this work, you need to transfer this information from your 
hard disk into memory. In simple terms, you have to open the file. ( Remem­
ber double-clicking from Chapter 1 ?) Once opened, the file is in memory and 
ready for you to manipulate to your heart 's content. 
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You can enter grades and average them, delete sentences from your daily 
journal, or type a letter to a worried parent. Remember, you're making all 
these changes while the document is in memory. If your three-year-old 
daughter comes in demanding attention and accidentally pulls the plug on 
your computer, the screen goes blank and the changes you've made disappear 
forever. You are left with only the original copy that was on your hard disk. 

The message here is SAVE, SAVE, SAVEl 

Saving is a very simple process that every Mac program comes equipped to 
offer. Most people use this command every five or ten minutes so that their 
work is always up-to-date and preserved on the disk. You can save your 
work to your hard disk or floppy disk. It is also important to make backups 
(on floppies) of everything on your hard disk in the event that you someday 
experience the inevitable hard-drive crash. (You learn how to use this save 
command in Chapter 7.) 

Differences between Memoru 
and a Hard Disk 

1. You usually buy memory 8 or 16 megabytes at a time. Hard disks 
usually come in 1GB, 1.5GB and 2GB sizes (and so on). 

2. Memory comes on chips - little brown mini-circuit boards. A hard disk 
is a big box made of metal (and sometimes housed in plastic). 

3. You can only install memory inside the computer (something you can 
pay someone else to do or, with proper directions, you can accomplish 
yourself). A hard disk may be either inside the Mac (an internal hard 
drive) or a separate box you just plug into the back (an external hard 
drive). 

4. Memory delivers information to the Mac's brain almost instantly. The 
hard disk sometimes seems to take forever. 

5. Memory is sometimes referred to as RAM. A hard disk has no 
abbreviation. 

6. Not every Mac has a hard disk (some people still use very old models 
with nothing but floppy disks). But every Mac has memory. 

7. When the Mac is reading some information off the hard disk, a little 
light flickers on and off (usually on the front of your Mac or on the case 
of an external hard disk). You can't tell when the Mac is getting informa­
tion from RAM. 
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8. As a very general rule, RAM costs about $12 per megabyte, and hard­
drive space averages about 35 cents per meg. 

9. Memory's contents disappear when you turn off the computer. A disk's 
contents stay there until you deliberately throw them away. 

Readu for Action 
Enough chalk talk. Let's take ourselves out of the classroom and have some fun! 

Hop on the bus, boys and girls. We're going on an interactive field trip of 
sorts. In the next chapter, you're going to put your fingers to the keyboard, 
move your mouse, and actually manipulate your computer environment. 
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Chapter 3 

What's on Your Desktop? 
•••••••••••••••••••••••••••••••••••••••••••••••• 
In This Chapter 
~ Learning all about folders , windows, and icons 

~ Discovering keyboard shortcuts 

~ Taking out the trash 

~ Working with floppy disks 

~ Top Ten disk and window tips 

•••••••••••••••••••••••••••••••••••••••••••••••• 

Figure 3-1: 
A typical 

Mac 
desktop. 

My desktop is usually impossible to see. I'm a pile-maker. The pile in 
the center is for the new teacher down the hall, the pile on the corner 

is for Justin (he's been out with strep throat), the box of fat-free crackers is 
for me (I'm always on a diet), and the papers spread all over the desk are for 
next week's lesson plans. 

In this chapter, I tell you about your Mac's desktop. Your Mac's desktop is 
what you see on your screen before you open a program (well, it's there 
while you're running a program, too, if you ever need it). Its menus contain 
accessories that help you use your computer and organize information more 
efficiently. I give you a few lessons on manipulating the items on your 
desktop. Take a look at Figure 3-1 and then read the rest of the chapter to 
find out all about desktop manipulation. 



36 Part 1: For the First-Time Mac User ______________ _ 

Foldermania 
It's been said that your hard disk is like the world's largest filing cabinet. 
Consider it a place to store all your stuff. But a filing cabinet without filing 
folders would be about as convenient to handle as a kindergartner without a 
potty pass. 

The folders on the Mac screen don't occupy any space on your hard drive. 
They're electronic icons whose sole purpose is to help you organize your 
stuff. The Mac provides an infinite supply of them. Want a folder? Do this: 
From the File menu, choose New Folder. 

Ooh, tricky, this machine, eh? A new folder appears. Note that the Mac 
gracefully proposes untitled folder as its name. ( Kinda like when you get a 
new student in your class and for weeks you say things such as, "My new 
student is really doing well.") 

Notice something else, though? The name is highlighted in black. Remember 
our earlier lesson? Highlighted = selected = ready for you to do something. 
When text is highlighted, the Mac is ready for you to replace it with anything 
that you type. In other words, you don't even have to backspace over it. Just 
type away. 

I. Type Third Grade. Press the Return key. 

The Return key tells the Mac that your naming-spurt is over. 

Now, to see how folders work, create another one. 

2. Choose New Folder from the File menu again. 

Another new folder appears, this one, too, waiting for a title. 

3. Type Class List. Press Return. 

Thk;L. & 
You're going to create one more empty folder. But by this time, your wrist is 
probably weary from the trek back and forth to the File menu. Don't you 
wish there were a faster way to make a folder? 

There is. 
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Keuhoard Shortcuts 

Figure 3-2: 
Some 

commands 
have pre-
assigned 

shortcuts. 

Pull down the File menu, but don't select any of the commands in it yet. See 
the weird notations to the right of some of the commands in Figure 3-2? 

New Folder 88N 
Open 880 
Print sgp 
Close Window 3gW 

Get Info XI You can use a shortcut 
Sharing ••• instead of the mouse. 
Ouplic:ote XD 
Make Rlios 
Put Rwoy XY 

Find ••• XF 
Find Rgaln XG 

Get used to them. They're keyboard shortcuts, and they appear in almost 
every menu you ever see. You're by no means obligated to use them, but 
you should understand that they let you select certain menu items without 
using the mouse. 

Unimportant info reg,ardittg other ·menu symbols 
Writing Tools ~ 
Find/Change ~ 
Publishing ~ 

Monaco 
/'Ju.. £a.a- ;H.CZ. 
New York 
@Jb ~g!ll'lJ ~tXI ~ 
Palatino 

~ ... 

" :Jlf~d~~ ~Q little:~eyboard-shortcut symbols 
·:, ·r:~t,t.fi,e:r:ioh,t$ide of a rn~nu, you occasionally 
· ·.tt!ri'lnto.a.little ~ow.nward.;pointing arrow or a 

--. : ~~fde~ays-polnting arrow, like these: . 

· What ~h~se arrows .are telling you is that the 
·= :ro~nu is. so long; it doesn't even fit on the 
'~ct~en .. Th~ arrow is implying that there are 
·sti'itmore commands in the memf.that you're 
'Jtot·seeing. Jo getto them, carefully roll the 
·~c;iot~r along the menu all the way to that 

· ·.d.oWilward- or sideways-pointing arrow. Don't 
~ UJl'it scare you: The menu .commands ju·mp 

.. ~:~::.liiiV..,~rd, bringing tbQ hidden onesJnto view . 
. <;:·:·:·;~~~.~~:.;;. ,~· ' . t • • •• • • 
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When you type, you press the Shift key to make a capital letter, right? They 
call the Shift key a modifier key because it turns ordinary, well-behaved 
citizen keys like 3 and 4 into wild symbols like # and $. Welcome to the 
world of computers, where everything is much more complicated. Instead of 
having only one modifier key, the Mac has three of them! 

Look down next to your spacebar. There they are: In addition to the Shift 
key, one says Option, one says Control, and another either says Command 
or has a little 38 symbol on it. It's that little cloverleaf symbol that appears in 
the File menu. Next to the New Folder command, it's 38-N. That means: 

I. While pressing the 3G key down, press the N key. 

Bam! You've got yourself another folder. 

2. Type 2nd Quarter Grades and press Return. 

You just named your third folder. So why have you been wasting a 
perfectly good afternoon (or whatever part of the day it is in your time 
zone) making empty folders? So that you can pretend you're getting 
organized. 

3. Drag the Class Ust folder on top of the Third Grade Folder. 

~& 
A1LJ 

2nd Qtn~rter Grades 

Make sure that the tip of the arrow actually hits the center of the Third 
Grade folder so that the folder becomes highlighted. When it turns 
black, let go of the Class List folder - and watch it disappear into the 
Third Grade folder. (If your aim wasn't good, you now see the Class List 
folder sitting next to the Third Grade folder; try the last step again.) 

4. Put the 2nd Quarter Grades folder into the Third Grade folder in the 
same way - by dragging it on top of the Third Grade folder. 

5. Double-click the Third Grade Folder. 

Yep. Opens right up into a window, and there are your two darling 
folders nestled sweetly where they belong. If you were to double-click 
one of them, you'd open another window. 

Okay, so how do you get them out again? Do you have to drag them 
individually? That would certainly be a bummer if you had 50 folders in 
the Third Grade Folder. 

It turns out that there are several ways to select more than one icon at 
a time. 
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6. Click above and to the left of the Class Ust folder. Without releasing 
the mouse button, drag down and to the right so that you enclose 
both folders with a dotted rectangle. 

If you're using System 7 or higher, each icon turns black as the dotted 
rectangle encloses it. (Otherwise, nothing turns black until you release 
the mouse button.) In any case, release the mouse button when both 
icons are enclosed. 

Now that you have several folders selected, you can move them en 
masse to another location. 

This was a somewhat unproductive exercise, of course, because we were 
working with empty folders. It becomes much more exciting when you start 
working with your own documents. All these techniques work equally well 
with folders and with documents. 

Takin9 Out the Trash 
There's one more icon-manipulation trick you might find valuable. 

1. Close the Third Grade folder by clicking its close box. 

The close box is that little box in the upper-left corner of the window, 
by the way. (You could also go to the File menu and choose Close 
Window, but why make it harder?) 

2. Drag the folder on top of the Trash can in the lower-right corner of 
the screen. 

Don't let go until the Trash can actually turns black (when the tip of the 
arrow cursor is upon it). When you do let go, notice how the Trash can 
bulges, a subtle reinforcement of how important it thinks it is. (I've 
experienced students with this same posture just before they utter 
answers that are completely off-base.) Anyway, this is how you throw 
things out on the Mac: Just drag them on top of the Trash can. 
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Gone,c:but n·ot. forgotten 
Manyteachers are_ pleasantly surprisedwhen available to: be ·used by other information (the 
I ·tell them that emptying the trash doesn!t ·new information.Witr just be written ovarthe 
mean· your files are gone forever. Tlia!s right; • top·ofthe files you "trashed"). That means the 
:if Johnny just "accidentally" trashed Susie~s lJE!x.tthing:you save may take the place.ofthe 
term; p~)ler, ifyp_u a~t quickly,: thf!re.is a. gg(l~d- · . fi\~~:YQ.!Jtr~shed •.• unlessyo,uuse a·recgvery 
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that the :~Pace once used by yo.ur filesis f1()\N . ,error$ .ar;td repair most problems found. 
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If you need to rescue something, just double-click the Trash to open its 
window; drag whatever-it-was right back onto the screen. 

So if putting something into the Trash doesn't really delete it, how do you 
delete it? Choose Empty Trash from the Special menu. 

The Menu Items 
Several menus appear across the top of the screen. As you get to know the 
Mac, you discover that menu wording changes from program to program. 
Right now, they say File, Edit, View, Label, and Special; in a word processor, 
they might say File, Edit, Font, Size, and Format. The menu names (and 
commands listed in those menus) are tailored to the function of the software. 

One menu is always on your screen, though: the Apple menu, which is the ti 
at the left edge of the menu bar (see Figure 3-3). Among other things, this 
menu provides immediate access to some useful miniprograms known as 
desk accessories. Desk accessories are surefire, nonthreatening, and fun -
perfect for your first baby steps into the world of using software. 
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Figure 3-3: 
Just a 

sample of 
what you 
can find 

under the 
Apple 
menu. 

About This Macintosh .•• 

@S AppleCD Audio Player 
~ Calculator 
~Chooser 
l1l] ClarisWorks 
~ Control Panels • 
~Find File 
• Graphing Calculator 
~ Jigsaw Puzzle 
liJ Key Caps 
rim Note Pad 
1!1 Scrapbook 
~Stickles 
~~ • Shut Oown ';.. 

Under the Apple Rainbow 
The chances of your Apple menu exactly matching the following list are 
pretty small. Unless the Macintosh is brand-new, you or somebody you love 
has probably changed what's in the Apple menu. And you should feel free to 
do so, too. If you use ClarisWorks a lot, then, for goodness' sake, put 
ClarisWorks into your Apple menu for easy access. If you haven't the least 
bit of interest in a time-waster like the Jigsaw Puzzle, then get it out of your 
Apple menu this minute. 

Addin9 items to the Apple menu - and 
remoflin9 them 
To add something to the Apple menu (or remove something), do the following: 

1. Open your hard drive icon. 

2. Open your System folder. 

3. Open the folder called Apple Menu Items. 

Inside is an icon for everything your Apple menu contains. 

4. To add something to the Apple menu, drag it into this special folder. 

5. To remove something listed in the Apple menu, drag its leon out of 
this special Apple Menu Items folder. 

Most people actually select the item and then choose Make an Alias from the 
File menu. Your Mac then puts a copy of that icon beside the original. Now, 
click on the alias icon and drag it into the Apple Menu Items folder instead 
of the actual icon. 
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Here, then, is the Basic Apple Menu Starter Kit- what's listed in your Apple 
menu the day you first turn on your Macintosh. 

Apple CD Audio l'laiJer 
If your Macintosh has a CD-ROM player attached, you may be surprised to 
learn that it can be used to play regular music compact discs, too, the kind 
sold in record stores. It's perfectly possible to type your lesson plan into 
ClarisWorks while the soothing strains of Brahms or Carly Simon play from 
your Mac's speaker. 

The Apple CD Audio Player is simply a front panel for your music CD player, 
with buttons for play, stop, fast-forward, and so on. If you poke around a 
little, you discover that you can (a) change its color scheme, (b) type in the 
names of the songs on your favorite COs - which will automatically show 
up if you ever insert those COs into your CD-ROM drive again, or even (c) 
rearrange the tracks on your music discs, assembling them into "play lists" 
that feature multiple plays of your favorite songs and eliminating your least 
favorite ones entirely. 

Automated Tasks 
This little menu item contains several AppleScripts - little software robots, 
each programmed to execute one time-saving task. For example, the one 
called Add Alias to Apple Menu is a useful shortcut for adding something to 
the very Apple menu you're reading about. For example, to add ClarisWorks 
to your Apple menu, highlight the ClarisWorks icon. Then choose Add Alias 
to Apple Menu from your Apple menu; instantly, ClarisWorks is listed in said 
Apple menu. 

Calculator 
Guess what? It's a calculator. You can click the tiny buttons with your 
mouse, but tapping the keys on your keyboard's number pad is far simpler. 
You can also copy equations from your word processor and paste them in. 

Chooser 
This venerated little window lets you tell the Mac what kind of printer you're 
attached to. The Chooser occasionally serves other purposes, having to do 
with networks and fax-sending, too, but printing is its primary purpose in life. 

Control Panels 
This isn't a desk accessory at all; it's just a handy shortcut that makes the 
window full of control panels appear. 
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Find File 
Find File is, for many, the single most useful program on the Mac. It enables 
you to find files you've lost on your hard drive somewhere. Find File can 
search for a file by name, when you created it, and so on. 

]itJSaUI Puzzle 
Hours of rainy-day fun await! Choose Start New Puzzle from the Options 
menu, specify how large you like your jigsaw-puzzle pieces to be, and solve 
away (by dragging pieces into place). If you or your students are feeling 
particularly creative, you can paste any graphic into the Jigsaw Puzzle 
window- even a class photo - and make putting it together a whole new 
ball game. If you teach at the primary level, using the Jigsaw Puzzle is a 
great way to practice fine motor skills. 

KeiJ Caps 
The primary function of Key Caps is to help you figure out what keys to press 
to apply the oddball symbols not found on the typical typewriter keyboard: 
©, ™, ¥, and other exotic markings. After you open this little program, hold 
down the Option key on your keyboard; you see the "keys" in the Key Caps 
display change to show their hidden characters. From there, you can either 
(a) memorize the fact that, say, Option+Shift+C produces the c; symbol, or 
(b) click the on-screen key to produce the desired symbol in the typing 
strip, which you can then copy and paste into your word processor. 

Note Pad 
Ah, yes, the Note Pad: the word processor of the impoverished. It's ideal for 
notes, ideas, grocery lists, and other typed blurbs that fit into a tall, narrow 
window. 

RecentAppUcauons 
This handy menu command automatically lists, at all times, the five or ten 
programs you used most recently. (If, that is, you have the standard control 
panel called Apple Menu Options.) Use it this morning to launch, say, 
whatever program you were using at the end of yesterday. 

Recent Documents 
See the preceding - but this menu command lists the recent documents you 
worked on. 

Recent Serllers 
This command only works if you're connected to a big network. If so, it lists 
the last bunch of computers (servers) you've logged on to. If not, it's useless. 
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Scrapbook 
This grizzled Apple-menu veteran isn't profoundly useful today. Still, it's a 
handy place to paste graphics or text blobs you intend to use again some­
day: a logo, the body of a resignation letter, and so on. When the window is 
open, you can paste something you just copied from another program by 
using the Edit menu. And to retrieve some material later, just use the Edit 
menu's Copy command. 

SimpteSounJ 
Apple's latest crop of Power Macs (such as the 7500, 7600, and 8500) come 
with a system-software oddity: The familiar Sound and Monitors control 
panels have been merged into a single, unified Monitors & Sound control 
panel. It duplicates the functions of its predecessors in every respect but 
one: You can no longer record new error beeps when you're looking at the 
Sound portion of the new control panel. 

Nobody understands why this peculiar state of affairs came to be. However, 
at least the record-your-own-sounds feature isn't missing- it's just been 
moved to the SimpleSound desk accessory. 

Stickies 
For years, the good looks of Macs have been marred by dozens of yellow 
stick-on notes, slapped by their hasty owners on monitors, corners, and disk 
drives! At last you can jot down your phone numbers, memos, and brain­
storms on the screen instead of taping them to the screen. Stickles is the 
glorious electronic equivalent of stick-on notes. Make a new note by choos­
ing New Note from the File menu. Change the color by using the Color menu. 
Change the type style using the Note menu. And to make sure that you never 
forget to check your Stickles, choose Preferences from the Edit menu - and 
click "Launch at system startup." 

Shut Down 
This command does just what you'd guess it does- after politely inviting 
you to save your work in whatever programs you're running. 

The Application menu 
Do you see the tiny Note Pad icon at the right end of your menu bar? It's 
next to that question mark thing. 

Do you see the tiny computer icon (or possibly some other icon) in the 
upper-right corner of your screen? That's called the Application menu. The 
icon that's showing indicates the current program that's running. If you see 
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the small computer, that means you're in the Finder or Desktop. Click on the 
icon and a list of currently open programs will appear. Highlight the name of 
the program you want to work with and let go of the mouse. That's how easy 
it is to switch between programs when you're using a machine as wonderful 
as the Mac. 

the Application menu 

I 

Note: If you're constantly getting uNot enough memory" messages, check 
your Application menu. More likely than not, the last person using your 
computer simply closed a window and never actually quit a program. Quit 
the programs that still remain open and your problem will more than likely 
be solved. 

Extras~ Extras~ Read All about 'Em 
On every Macintosh, inside the System Folder, is a strange little unexplained 
folder called Apple Extras. (If your Mac came with a CD-ROM, a copy of 
Apple Extras is probably sitting there, too.) This folder comes with assorted 
niche-market goodies: Some will astonish and delight you; others will baffle 
and annoy you. Because not a word of explanation is provided by Apple, 
here's a rundown of the Apple Extras. 

Apple Video l'laiJer 
If your Mac has a jack on the back marked uVideo In," you're a lucky teacher 
indeed. You have a Performa, Power Mac, or LC model that's equipped with 
video digitizing circuitry - such as the Apple Video System card - meaning 
that you can plug a VCR or camcorder into that Video In jack. The Mac can 
convert your footage into digital movies (QuickTime movies). QuickTime 
movies are great fun to play with: You can cut, copy, or paste scenes, 
rearrange events, add credits, and otherwise pretend that you're a big-time 
Hollywood mogul. 

As with any useful hardware, however, your video-capturing circuitry requires 
software. Tag, Apple Video Player, is it. 
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AppleScript 
AppleScript is a programming language. 

If you're stil1 reading, then I'm surprised. Anyway, AppleScript can be used 
to write little robot programs that do certain Mac tasks for you: launching a 
program, making a printout, emptying the trash, and shutting down. Macs 
for teachers? Sure- CompSci teachers, maybe. 

CDU 
This little goody, included with many Performa machines, is a set of utility 
programs. Utility programs these days mean "unnecessary doodads that dress 
up the way your Mac works." In this case, CDU has features that (a) make 
your menus drop down without having to be held down with the mouse; (b) 
shut your Mac down (or dim the monitor) half an hour after you stop using 
it; (c) let you operate your menus completely from the keyboard; (d) add a 
clock to your menu bar; (e) require a password to get at your stuff; and so on. 

HIJperCard PlaiJer 
HyperCard is a $200 "software construction kit" sold by Claris that enables 
savvy beginning programmers to construct their own address books, 
calendars, and so on. 

HyperCard Player, on the other hand, is this free program that lets other people 
play the HyperCard "programs" that a HyperCard programmer has created. 

Graphin9 Calculator 
This enchanting little program was originally designed as a demonstration of 
the Power Mac's number-crunching speed: It was left running continuously 
in computer stores, impressive-looking graphs flashing across the screen. 

However, Graphing Calculator is actually a fairly sophisticated, impressive 
math tool. You literally type any equation into the top blank, and this pro­
gram will graph it, no matter how complex the equation. You may start with 
boring, static graphs like y = x + I, and move on to 3-D displays like z = xy. 

A couple pointers: Every equation must begin withy = or z =. Copious help 
screens are hidden in your ? menu. And remember that you can capture any 
graph by dragging it directly into any "drag-and-droppable" program (such 
as the Scrapbook) - or you can simply use the Copy command to paste a 
graph into almost any program on earth. 
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LaserWriter Uti lit' (or Apple Printer 
Utilit1J) 
These little programs are exclusively for use with networked laser printers. 
They perform all sorts of interesting power-user functions (such as pre­
downloading [sending] fonts to the printer), but by far their most important 
real-world application is to tum off the annoying and wasteful startup page 
that spews forth from a laser printer whenever you first turn it on. 

Special Needs 
This folder traditionally contains two control panels that don't normally 
come installed in your Mac: CloseView and Easy Access. The former is for 
the visually impaired (it enlarges the screen image); the latter is for people 
who can't use the mouse. Easy Access lets you operate the Mac entirely 
from the keyboard. 

Speech RecotJnition 
Any Mac with a four-digit model number (except Power Books) can also 
follow your spoken orders! Install this software, known as PlainTalk Speech 
Recognition, and a $19 PlainTalk microphone, and you can give your Mac 
such commands as "Open ClarisWorks," "What time is it?," and even "Tell 
me a joke," and your Mac responds intelligently. 

We're not talking taking dictation here, however, all your Mac can really do is 
open things (programs, the Trash, control panels, and so on). Still, it's a 
computer responding to a human voice, which is nothing to sneeze at, and 
it's good for at least a half hour of classroom entertainment. 

Text-to-Speech 
By far the most kid-friendly of the Apple Extras bunch, this installer puts 
speech software into your Mac's software. After the installer is finished, 
launch SimpleText; type up something funny for your Mac to say; and 
choose Speak All from the Sound menu. You even get a choice of different 
voices! 

Techie note: If you dig around in the options of your software, you'll dis­
cover that America Online, ClarisWorks, WordPerfect, and even FileMaker 
can also read stuff back to you, after you install this Text-to-Speech software. 
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What's on Your Hard Dritlel 

Figure 3-4: 
Here is 

what is on 
my hard 

drive. 

Up until this point, we've pretty much ignored that little hard drive icon in 
the upper-right corner of your screen. Aren't you just a little bit curious? In 
the last chapter, I told you all about the hard drive and its purpose- that's 
where all your programs are stored and where you may end up saving some 
of your prized works. 

Let's take a look at what's on your computer's hard drive. Double-click the 
Macintosh HD icon. 

The window that opens up has a list of folders, files, and applications. Yours 
won't look exactly like mine (shown in Figure 3-4), but a few things are 
common to all Macs. 

~Iii Macintosh HO l!l! 
62 Items 551.2 MB In disk 476 MB ouoiloble 

~ .. ,,n, _____ ,_, ___ , ,_ ,, __ ,,, __ , _ _ ,,,_,,,,.,, __ ,,.,_~.-·•--••••••••-M•••••-•••-•-•••••••·---·--••••""""''"'-'''"""''''''"-"'-

~ Size Kind 

I> 0 Print Shop OeluHe 11,352K folder ! 
I> 0 ProPhone folder 1,469K folder .. _ 

I> 0 QulckCam 875K folder 

~ ResEdlt 
1-

644K opplicotio 

I> 0 Scrabble OeluHe 1,304K folder !' 
I> 0 Sierra 27,572K folder 

~ I> 0 Sim City 2000 3,861K folder 

I> 0 Student Writing Cen~ 10,032K folder ~ 
.IIlii . .;:_.l•',.' fj;[> ,~, -:'! <"' '__;.~·· 15 

A list of the Mac's hard drive contents 

HatlinfJ Fun with Floppies 
For our next trick, you're going to need a floppy disk. If you didn't buy a box 
of blank disks with your Mac, you're going to need some eventually. If you 
don't have a blank disk handy, you can use one of the white System disks 
that came with your Mac. 

1. Put the disk into the disk-drive slot. 

The Mac gulps it in with a satisfying kachunk. If it's a brand-new disk, 
you're asked if you want to initialize it. 

Go ahead. Click Initialize. You're then asked to name the disk: Type a 
name, click OK, and then wait about 45 seconds while the Mac prepares 
the disk for its new life as your data receptacle. 
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c=J 
Moclntooh HD 

• 
If it's not a new disk- for example, if you're using one of the disks that 
came with your Mac -the floppy-disk icon shows up on the right side, 
just beneath your hard-disk icon. 

To see what's on the disk, double-dick the icon. As you no doubt are 
tired of hearing repeated, a double-click on a disk icon opens its 
contents window. 

This is important stuff: In your lifetime, you'll do a lot of copying from 
floppy disks to your hard drive (such as when you buy a program and 
want to put a copy of it on your hard drive). If you're smart, you'll also 
do a lot of copying onto floppies from your hard drive (such as when 
you make a backup copy of all your work, in preparation for the inevi­
table day when something goes wrong with your hard disk). 

2. Double-click your hard-disk icon. 

If its window was closed, it now opens. If the window was open but 
hidden behind the floppy-disk window, the hard-disk window comes to 
the front. 

3. Drag the Class List folder on top of the floppy-disk icon. 

Macintosh HD 
131tems 58.9MB In disk 17.9MB ovolloble 

~ (lJ • ; 
teach-text Bailey's Book House 

(GJ CJ CJ li System Folder ClorlsWorks 3.0 Folder Kid Pix 

118clntooh HD 

( • 
~--. ,., , .. 

If you already trashed your Class List folder, no big deal. Choose New 
Folder from the File menu (or press 3€-N) to create a new folder. Drag 
that instead. 

The point is that, on a Macintosh, making a copy of something is as easy as 
dragging it to the disk you want it copied onto. You can also drag it into the 
disk's window (if it's open) instead of onto its icon. 

Copying something from floppy to your hard disk is equally easy. Open the 
floppy-disk window (by double-clicking the floppy-disk icon). Then drag 
whatever icons you want onto the hard-disk icon (or onto the hard-disk 
window). For example, in Figure 3-5, two files are being copied from a floppy 
disk- not just into the hard-disk window, but into a specific folder on the 
hard disk: 

Okay. So you made a copy of your third-quarter math grades, or you just 
copied this week's lesson plans onto your hard d isk. Now what? How do you 
get the disk out? 
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Figure 3-5: 
The Math 

and 
Science 

folders are f---------l 

being 
copied to 
the Class 

List folder. 

Well, you wouldn't be alone if you guessed that you use the Eject Disk 
command in the Special menu. But you'd be sort of wrong. The Eject Disk 
command does spit out the disk- but it leaves the disk's icon on the screen 
so that the Mac thinks it's still available. The minute you try to go on with 
your work, the Mac starts displaying messages demanding that you give the 
disk back to it. 

A much better way to get rid of the disk is to select it and choose Put Away 
from the File menu. That makes the disk pop out, and its image disappears 
from the screen. 

Desktop Protection 
No, I'm not about to offer you some sleazy insurance policy. I'm going to tell 
you about two programs that may just save your life one day. . .. Okay, they 
just save your work and possibly keep your Mac in proper working order! 

Desktop programs are also referred to as security systems. The two most 
popular protection systems in schools are At Ease (Apple Computer 800-
800-APPL, ext. 2775) and FoolProof (SmartStuff Software 503-231-4300). 

At Ease places a set of folders over the top of the desktop. Through an easy 
setup procedure, you decide what programs students are allowed to access. 
Those accessible programs are then given a button on the folders. Students 
simply click a button to open a program instead of accessing the program 
from the computer's hard drive. You can also set up At Ease so that files can 
be saved only to floppy disks. 
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FoolProof (my personal preference) allows the students to see the actual 
desktop (as does newer versions of At Ease). You simply decide, through a 
very easy set-up procedure, which files, accessories, and menus the stu­
dents are allowed to access. I like this type of protection because it lets the 
student see the actual working environment ... you know, that "real world" 
kinda thing we're supposed to be preparing them to be a part of! 

Top Ten Windo"" Disk, and Trash Tips 
"I don't do windows," you say? After reading the following tips, you'll find 
windows so easy to do that you may even consider cleaning the Venetian 
blinds. 

1. To rename an icon or disk, click carefully on its name. Wait for a second 
or so, until a rectangle appears around the name. That's your cue to 
type away, giving it a new name. Press Return when you're done. 

It works a little differently in System 6. Just click an icon and start 
typing. No rectangle, no waiting. 

2. If you're looking at a windowful of file icons, you can select one by 
typing the first couple of letters of its name. 

3. Don't forget that you can look at a window's contents in a neat list 
(choose "by Name" from the View menu). Once in a list view, when a 
folder is highlighted, you can press 3€-~ to expand it (as though you 
clicked the triangle to view its contents) and 3€+- to collapse it again. 

4. In System 7, every time you choose Empty Trash from the Special 
menu, the Mac asks you if you're absolutely sure. If you prefer your 
computer to simply vaporize the Trash contents without asking, select 
the Trash icon. Choose Get Info from the File menu and click the "Warn 
before emptying" check box so that the X disappears. 

" Trash Info 

Iii Trosh 

Yhoro : On tho dosklop 

Cont•nts: Tht Tru h ts .mpty. 

Hodlfiod : Tt.l Oot20, 1~,8:1 6 PH 

(1--[j v~rn boforo omptgtn0 
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5. If you're trying to make a copy of a floppy disk, and you have only one 
floppy-disk drive, you find that the Mac can only copy a little bit at a 
time. It winds up asking you to insert one disk, then the other; on~ disk, 
then the other ... until your wrists are swollen and bleeding. 

A better, faster idea: Copy the entire disk to your hard disk, eject the 
floppy, insert the blank floppy, and then copy the stuff from the hard 
disk to the new floppy. Using the hard disk as an intermediate holding 
tank in this way eliminates the disk-swapping. (Just trash the superflu­
ous copy from your hard disk when it's all over.) 

6. If you have a very important document, you can prevent it from getting 
thrown away by accident. Click its icon. Choose Get Info from the File 
menu. Select the Locked check box. Now, even if you put it in the Trash 
and try to empty the Trash, the Mac simply tells you that there's a 
locked item in the Trash, which it won't get rid of. 

7. You already know how to copy a file from one disk to another. You can 
copy it on the same disk, too. Click the icon and choose Duplicate from 
the File menu. 

Or, while pressing the Option key, drag the icon onto a new window or 
folder. 

8. Isn't it frustrating to open a window that's too small to show you all of 
its contents? 

··- Control P11nels 
26tttms 11 2.2 MB 1n disk 

~ ~ . 
Brlohtne" Color - ~ 

- lg 
7.8MB l VII 

~ 
Lebe13 

II 
It's hard to see the entire 
contents of this window. 

Of course, you could spend a weekend fussing with the scroll bars, 
trying to crank the other icons into view. Or, using error-and-trial, you 
could drag the lower-right handle (the resize box) to make the window 
bigger. 

There's a much quicker solution. Click the zoom box in the upper-right 
corner of the window. The Mac automatically makes the window exactly 
large enough to show all the icons. 

9. You don't have to be content to leave the Trash stranded way down 
there at the bottom of your screen. You can move it anywhere you 
want, just by dragging it. That's especially handy if you're lucky enough 
to have one of those screens that looks like it was taken from the movie 
theater and don't feel like packing a week's worth of supplies every 
time you want to make a journey to the Trash corner. 
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10. You don't have to eject disks and clean up your windows before you 
shut down the computer. The disks pop out automatically, and the 
windows are right where you left them the next time you turn on the Mac. 

-:o Control Ponels 0sl} Zoom box 
26 iteJM 112.2 MB In di~k 7.8 MB aveilab e 

~ ~ ~ ~ ~ 
0 . 

Brightnes~ Color lebe1s Dele & Time Screen 

-~= ~ ~ General Controls Keyboard launcher PC Exchange <> 
¢fl 1¢'21 
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Chapter 4 

A Printing Primer 
oooooeooeoeoooooooooooooooooooooeooooooooeoooooo 

In This Chapter 
~What the different types of printers are and how much they cost 

.,.. What fonts are and how to load them 

~ How to print 

ooeoooooooooooooooooooooooooooooooooooooeooooooo 

I lou did all this work, and now it's time to print. I must first tell you that X ~his subject could become very deep. If, after reading this chapter, you 
feel the need for more knowledge on printers and fonts, please get Macs 

For Dummies, 5th Edition. David Pogue goes into much more detail on the 
subject. I will try to give you the information you need right now, however. 
The extra stuff is worth learning about later on, if you're the curious sort. 

A Primer on Printers 
Printers come in all kinds of configurations and prices. You can spend next 
to nothing and get a printer whose printouts are so jagged that they look 
like something scribbled by an angry middle-schooler. Or you can spend a 
thousand clams or so and get a printer whose printouts resemble profes­
sional typesetting. 

The three types of printers I discuss are: 

I 
~dot-matrix 

~ inkjet 

~laser 
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Dot-matrix low-cost1 louJ-t(ualitlJ 
I'm talking about the Apple Image Writer II. If you were a teacher during the 
'80s, your school was probably full of these babies (mine still is). It's called a 
dot-matrix printer because it prints by firing little pins against a ribbon that 
strikes the paper. The resulting collection of dots forms the letters. 

These printers are in many of our schools because they're cheap and they 
were the first ones available to work with those wonderful Apple lie and 
Apple He computers - computers that were often our first introduction to 
the world of computing. If your school has just begun to purchase 
Macintosh computers, those same printers that are connected to your lie or 
lie machines will work with your new Macs. They will serve you well until 
your budget has room for upgrades. 

The Image Writer is slowish and so noisy that people regularly buy mufflers 
for them. The print quality isn't anything to write home about- yet it is a 
good machine for the school setting. The lmageWriter uses ribbons that are 
considerably cheaper than ink cartridges (and you can also purchase color 
ribbons). The Image Writer uses pin-fed paper (attached sheets of paper with 
little holes running along each side) that you can load and then have fed out 
of the box. Pin-fed paper keeps you from constantly having to reload paper. 

Inkjet low-cost1 hit}.h-t(ualit1J1 low-speed 
Inkjet printers create a printed image by spraying a mist of ink on the paper. 

The two most popular ink-jet printers are the Apple Style Writer and the 
Hewlett-Packard DeskWriter. Their quality almost matches that of a laser 
printer. The Style Writer is very small, very lightweight, and almost silent 
(that's more than I can say for some students), whereas the DeskWriter takes 
up more desk space and makes a little more noise. You can feed all kinds of 
nonliving things into both printers: labels, envelopes, tagboard, whatever. And 
they cost less than $300. Both the Apple StyleWriter and the Hewlett-Packard 
DeskWriter also come in color versions - for a slightly higher price. 

So what's the catch? Well, both the StyleWriter and the DeskWriter create an 
image by spraying ink on a page. Therefore, the printing isn't laser-crisp if 
your stationery is even slightly absorbent. Note, too, that inkjet-printed 
pages smear if they ever get the least bit damp. 
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Laser hitJh-cost, hitJh-qualitlJ 
If you can afford to pay something like $1,200 for a printer, though, some real 
magic awaits you: PostScript laser printers. Don't worry about the word 
PostScript for now. Just look for the word PostScript in the printer's descrip­
tion, as if it were some kind of seal of approval. 

A PostScript laser printer can print any text, in any style, at any size, at any 
angle - and everything looks terrific. PostScript laser printers can also 
print phenomenal-looking graphics, like all the diagrams in Macintosh 
magazines. They're quick, quiet, and hassle-free. Most can print envelopes, 
mailing labels, and paper up to legal-size (but not tag board). 

Oh1 Houl I Lotle Those 11FanciJ." Letters 

Figure 4-1: 
The basic 

fonts of 
System 7. 

If you have a computer-friendly coworker who's produced some incredible­
looking parent letters or student handouts, you probably noticed some 
pretty "fancy" lettering on those documents. To computer nerds, those 
"fancy" letters are better known as fonts. Your computer comes loaded with 
some basic fonts. System 7 fonts are shown in Figure 4-1. 

Chicago Courier Geneva 

Helvetica Monaco New York 

Palatino l:'lfJlPoA Times 

Fonts are fun 
The basic set of fonts that came with your Mac let you accomplish some 
amazing stuff because you not only can change the size of your letters, but 
you can also change the style and color. 

We get to the how-to portion later in Chapter 7. Right now I just want you to 
be aware of the possibilities that await you. 
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Figure 4-2: 
Making 

changes in 
font style. 

Every word-processing program in use today allows the user the flexibility 
of choosing a font style and making changes within that style. Notice the 
different ways I altered the fonts in Figure 4-2. 

Chicago Chicago (C[hlu~@)~® 

~<e)~vce~~©lal Helvetica Helvetica 

Palatino JlD mllm ftllrru<ID Palatino 

You can also purchase additional fonts from any software vendor. Literally 
thousands of different fonts are out there - and they are very cheap. 

Fonts enable you, the teacher, to make what your students or their parents 
need to read fun, exciting, and eye-catching. How many of us look twice at 
those boring memos that are written in standard print? However, a nice 
memo is easy to create and makes someone want to read it simply because 
of the way it looks. 

Knowing a little about fonts inspires you to look at a page in a magazine or 
an ad in the newspaper in a new way. You start to notice the creativity 
behind the advertising game and how fonts express different feelings. 

School fantl:! 
Many software companies. ani· beginning. t9· · fo~t$::,o.~ the ~Dthat came with this book. If 
see the light ahd create fonts specifically yQu:.c~~y-;:moret che~koutthese companies: 
aimed at the school market You know, left8r,s ·School' Font'.·Collection: Mountain Lake 
that l.ook like. the manuscriptor .. cursivt:we:~rv. .;S~#W~te::('apo•GB9~as74). 
to tea~h our students I There att:t evan·Jon~' , .. ·. .) .. 
thatlook like a kid's h~ndwr~lng~ I've ~fr~ol18.q>. ;,$~#p~lhe~s~. F.o11ts:. · Sig,na:~!Jre. S of~wa re 
to give you a couple of free· ~school-typ·e~ . ·. ~·{$J,1j38~-~3221) · 
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LoadiniJ a new font 
So you decide to go out and buy some of the nice fonts you hear so much 
about. How do you get them onto your machine? 

It's easy. If you are using System 7 (which I hope most of you are by now!), 
quit all your programs. 

I. Insert your new disk into the computer. Double-click the icon of the 
disk to open it. 

You should see a number of little suitcases, each one labeled with the 
name of a font that you purchased. 

2. Now open up your hard drive (double-click the hard-drive icon in the 
upper-right corner of your screen) and find your System folder. 

You don't have to open this folder. 

3. Decide which fonts you'd like to install, highlight them, and drag 
them over to the System folder. 

4. When the System folder is highlighted, let go of the mouse. 

Remember, do not open the System folder. Simply drag the suitcase on 
top of the folder until it is highlighted and release the mouse. (I'm really 
a teacher. See how I repeat the information I want you to remember?) 

You see a message alerting you that the Mac is going to install the font 
for you. Just smile, wave, and click OK. Wasn't that easy? 

Houl to Print 
Bet you haven't had a lesson with that title since about first grade. (Unless, 
of course, you teach first grade.) 

The hardest part of printing on a Mac comes at the very beginning- an 
unfortunate fact for the novice who simply wants to get going. 

When you first plug a printer into the Mac, it's like a kid on the first day of 
school - not smart enough to notice that it has a new friend. You have to 
tell the Mac explicitly. We get to that stuff in a moment. 
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Imagine that you work in a big school with lots of technology money; you 
have three different kinds of printers and a few dozen Macs, and they're all 
wired together into a giant network. You want to print something. You have 
to be able to tell the Mac the following stuff: 

I 
Y' What kind of printer you want to use (laser, StyleWriter, whatever) 

Y' If there's more than one of each printer connected to the network 

Y' Which printer(s) you have connected 

That long-winded explanation is supposed to help you understand why 
there's a desk accessory in your Apple menu called the Chooser. Using this 
gadget, you can specify what kind of printer- and which one - you want 
to use. 

If you're a one-person operation, of course, this stuff is utterly superfluous. 
But you have to go through it, anyway. What the heck- maybe your school 
will get that multimillion dollar technology grant, and you'll know exactly 
what to do! 

The Chooser 
After the Mac is connected to the printer, turn both machines on and follow 
these steps: 

I. Choose Chooser from the t1 menu. You should see something 
like this: 

• Chooser 

~ I) Q 

lm19t W'rtttr Lu t rVrittr 

~ ~ 
LO lm•90'tt'rit ... St~lt't"rlttr 

~ AppleTelk 
®Acti ve 
0 lnecl1ve 7 .1 
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Your screen may look different, of course. The icons that appear in the 
left half of the window depend upon which printer drivers have been 
placed in your System folder. A printer driver is a little piece of soft­
ware that teaches the Mac how to communicate with a specific printer. 
Its name and its icon match the printer itself, as you can sort of tell 
from the preceding figure. 

2. If you see a printer driver icon in the Chooser window that matches 
your printer, you're in luck! Click it. 

If you selected a laser printer, you should see its name show up in the 
right side of the Chooser window, as shown here: 

Chooser 
select e Leserwnter: 

l1 ~ · · tl' "f ~ 

II 

~ 
LO fN9t'w'riter r 

Good going! Everything's coming up roses. If the names of several 
printers show up on the right, then you're either part of a school 
network with several printers or you're an unexpectedly wealthy 
individual. Congratulations! 

If you don't see any icons in the left half of the Chooser window, some­
body has probably taken them out. No matter - reinstall all these 
icons by running the Installer on your original white System-software 
disks (or the start-up compact disc) and performing a custom install for 
the printer drivers. (Don't reinstall the whole system!) Now you can 
repeat this Chooser business, and everything should go fine. 

If things still aren't going well- for example, if you click the driver 
icon but your printer's name doesn't show up in the right side of the 
window - see Appendix C of this book, "Troubleshooting." 

Anyway, after you click a printer driver icon, a couple of things happen. 
If you're selecting a laser printer, you're told to turn on AppleTalk. 
AppleTalk is related to LocalTalk, the networking system described 
previously; remember that if you have a laser printer, you're suppos­
edly part of a network even if just one Mac is attached to it. So make 
sure that the little AppleTalk setting (in the lower-right corner of the 
dialog box) is active if you have a laser printer. Conversely, make sure 
that Apple Talk is inactive if you have a Style Writer. 

Note: Some of the newer Inkjet printers, from both Apple and Hewlett­
Packard, are networkable. Therefore, turning off Apple Talk would not 
be the right thing to do. 
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3. Close the Chooser. 

But when you close the Chooser, you get a soon-to-be-annoying alert 
message: 

You houe changed your current 
printer. Please choose "Page 
Setup •.. " In all of the open 
applications. 

I[OKJ] 

It tells you (as if you didn't know) that you just changed to a new 
printer. Its advice, though, is sound. 

4. Choose Page Setup from your Flle menu after you select a printer 
driver. A dialog box appears. 

5. Don't do anything in this box; just click OK. 

You just introduced the Mac to its new printer. All of this is a one-time 
operation, by the way. Unless you have to switch printers or something, you 
never have to touch the Chooser again. 

BacktJ.round printing 
In the Dark Ages of the 1980s, when you printed something, the printer's 
soul took over your Mac's body. You couldn't type, you couldn't work, you 
couldn't do anything but stare at the screen that said "Now printing." It was 
a dark and stormy era, a time of wild children waiting for their stories to 
print. Only when the paper came out of the printer were you allowed to use 
your computer again. 

Since then, some clever Apple engineer figured out how to allow background 
printing. When you use this handy feature, the Mac sends all the printing 
information at a million miles an hour into a file on your hard disk and 
immediately returns its attention to you and your personal needs. 
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Then quietly, behind the scenes, the Mac shoots a little bit of that file at a 
time to your printer. It all happens during the microseconds between your 
keystrokes and mouse clicks, making it seem as though the Mac is printing 
in the background. In time, the printer receives all the information it needs 
to print, the paper comes gliding out, and you've been able to keep working 
the whole time. 

In practice, you have to consider a few background-printing realities. First of 
all, a document takes much longer to print in the background than it would 
if the Mac devoted all its brainpower to printing. Similarly, making your Mac 
concentrate on two things at once also bogs down what you're doing: While 
something's being printed in the background, the word processor slows 
down (letters don't appear immediately after you press the keys), windows 
seem to take longer to open, and so on. Finally, background printing isn't 
available for Image Writers (unless you buy a program called a spooler, 
especially designed for the ImageWriter). 

Turning the Background Printing feature on and off is easy. Select Chooser 
from the ti menu. In the lower-right side of the box, you see the On/Off 
buttons. Go for it. 

If it's 2:00 on a Friday afternoon, and you need to print your five-page parent 
letter as quickly as possible, turn off background printing. 

After all that ... how IJOU actuaii1J print 
Okay. Suppose you followed all the directions and the printer is plugged in 
(and via the Chooser, the printer has been introduced to the Mac). You 
created a beautiful document using some really cool fonts. The moment has 
arrived. You actually would like to print the thing. 

1. Choose Print from the File menu. 

This dialog box appears; it looks different depending on your printer, 
but the one pictured here is what you see if you have a 'Writer. 

=oe=s=kW==n=te=r========~================~3.1 I[ OK j 
Quality: Pages: 

® Best 0 lUI ( Cancel ) 
QNormal ®From:~ To:~ (Preuiew) 
QDraft 

Copies: Page Order: Help D D Pnnt Bac:k to Front 
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You can specify how many copies you want by clicking and typing in 
the Copies box. 

The main thing you do in this dialog box is tell the Mac which pages of 
your document you want it to print. If you just want page 1, type a 1 in 
both the From and To boxes. If you want page 2 to the end, type 2 into 
the From box and leave the To box empty. 

Some printers (Lasers and 'Writers) give you the option of printing 
"back to front." This means that when you pick up your pile of printed 
papers, the first page of text is on top. 

Note: Instead of using the mouse to click between the blanks in a dialog 
box, use the Tab key to jump from box to box. 

2. Click OK. 

You did it, my friend! 

CancelintJ printintJ 
If you want to interrupt the printing process, 8€-. (period) does the trick­
that is, while pressing the X key, type a period. Several times, actually. Even 
then, your printer takes a moment (or page) to respond to you. 

Note: This procedure doesn't work when you are printing in the back­
ground. 
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A Guided Tour through the 
Software Jungle 
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In This Chapter 
tp. Skill·and-drill software 

b> Productivity software 

~ Multimedia software 

~ Edutainment software 

1> Simulation software 

~ A look at the ideal world and the day·to-day reality 

ooooooooeoooooooooooooooooooooooooooooooeooooooo 

S:hool administrators don't always agree on the intended outcome of 
their technology pursuits. Some will tell you that their main goal is to 

raise test scores; they display class scores on overhead projectors, compare 
scores with rival counties, and basically make you feel like you haven't been 
teaching anything significant for the past year. Often, these schools are 
looking for a quick fix and hope that technology can cure what we teachers 
just can't seem to get right. Other administrators take a more global ap­
proach and feel that if we use technology in teaching children to be better 
thinkers and problem-solvers, we will produce confident and successful 
individuals - who, in return, may produce higher test scores. 

The software jungle can be very confusing. It's filled with numerous prod­
ucts to meet the goals of a diverse group of users; and whether you're 
spending your own money or the limited funds provided in your school's 
technology budget, you anticipate a tight squeeze on available cash. You 
simply don't have room for a costly purchasing mistake. In this chapter, I 
examine the four major types of software intended for student use. I give 
you the straight facts (and, of course, a few of my opinions on each cat­
egory), while providing you with some valuable ideas for incorporating each 
type of software into your school setting. 
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Ch·eck .out my extenai.Ve-li$tit)f:q,uality software:! 
In Appendix· B you'll find ·my- .t~oro,uph ~nsi :qt- --~th~~to f9clude_d-with this bopk. Yes,'l'had thos, 
high-quality educational software. Believe-Jt :c:uafty cp-d~velqpers add the li~ to tfle.-discl , 
or riot,_this Jist took-lono,er to write,thf!n- a~y- :It11Fprit1t;~utexactly as it appears in the 'bQQk.· 
other .chapter in the bookLRead.througb. the ; YQ.Li ;carr ·then. offer :the information to· your 
coU_ection, take a few. rtot$·s, ~n_d sh~teJhe li~ tec~nol~gy comm~ee, take. it with yotf on 
wJth friends. If .you fE!.ellike you need_:a prii:lt~cf -~boppJqg· 'P~~es, _qr· k.eQp it on hi,ind fpr ·yout 
~opy, don'~ spend vour time waiting f~r a turo _cl_a~~-r~·~m:vvrsti 'list .-
at the copier; instead simply· printthe Ustfrom , -

' • • ' l I , ~ 

Skill-and-Drill Software 
In the simplest of terms, skill-and-drill software is a form of electronic flash 
card. (The difference is you don't have to hold this software with your 
thumb, artfully covering the upper-right corner, so that the students can't 
see through to the answer on the back.) Don't misunderstand me. Today's 
skill-and-drill software is beautifully crafted, and some good programs out 
there do a super job of reviewing skills. Most of the programs concentrate 
on a single skill (multiplication facts, addition, and so on) or a single subject 
area (math, science, or reading, for example). 

The granddaddy of all skill-and-drill software is MECC (Minnesota Education 
Consulting Consortium). How's that for a name? But MECC has produced 
some incredible programs over the years, and many of you may be familiar 
with what MECC created for those wonderful - and now very lonely­
Apple lie and lie computers. 

Skill-and-drill software has its place within the school. Some things, such as 
multiplication facts, need to be continually reviewed - and there's no magic 
way to get children to memorize these facts without practice. The best 
forms of skill-and-drill software give immediate feedback and helpful correc­
tions: Here's what you did wrong, here's how to fix it. 
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Skill-and-drill and me! 
Without skill-and-drill software, I might have 
missed out on acceptance to graduate school. 
You see, I don't test well - I never have. 
When I found out that I needed to take either 
the GRE or the GMAT to enter grad school, I 
became quite the nervous teacher. (Unlike the 
Mac God, I cfid not graduate summa cum laude 
from Yale.) Anyway, I opted for the GMATwhen 
I found out that it lasted an hour and dealt only 
with analogies. I was told that the computer 
lab at the education school had a program to 
help you study for this hour-long brain burner 
of a test. Guess what? It was pure skill-and-

drill: It not only told me the correct answer, but 
it also analyzed my response and told me how 
I should have addressed the problem. I used 
this program for two days in a row and then 
went to take the test. I scored so well that the 
evaluator had to look at my answer sheet 
again. And I owe it all to our friend, Mr. Skill­
and-Drill. (I'm sorry to report that the univer­
sity couldn't tell me the name of the 
program - this was in 1984. But there are 
many great test-preparation programs on the 
market covering all the major entrance exams.) 

The kids love drills that come in the form of a game, which most of today's 
programs include. But not all skill-and-drill software needs to be a game. 
Some of the programs I enjoyed the most in those early days of MECC and 
the Apple lie were just like flash cards: They flashed up a multiplication 
problem, gave you so many seconds to respond, and then took away the 
problem. At the end of the game you were given an accuracy score. It was 
pure learning without the distraction of animated characters and soaring 
rocket ships -and it worked because kids enjoy a challenge and love to be 
given another chance to improve their scores! This type of skill-and-drill 
software works especially well in the one-computer classroom where a 
teacher wants to give everyone a fair amount of computer time each day 
and is interested in monitoring progress. 

But skill-and-drill software has its drawbacks. I already mentioned that most 
programs focus on a single skill or subject area. This restriction can prove 
troubling when budgets are limited and you want to purchase programs that 
please the masses. The prescribed age range for each program can also be a 
disadvantage. Most programs are grouped by preschool, early elementary, 
elementary, middle, or high school -with the majority of the software 
being aimed at kindergarten through grade 6. Thus, the restricted number of 
kids who will benefit from the purchase is once again a problem. Finally, 
skill-and-drill software does very little to encourage creative thinking and 
problem-solving (unless you count searching for the spaceship that contains 
the ugliest monster in the creative-thinking category). I feel that such skills 
must be encouraged in this rapidly changing world. 
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How~often have these words·come out of your 
mouth? ·f:''know that I should want student$·tO 
be ilitere$ted inJhe computer:and begging for, a 
turn -bUt notduring ·a 'lesson that t~:.-ok. me 
days :to:·prepare.lefs face it In a. onewqomputet 
classroom~ the whole cl.ass is intrigued by the 
noises•coming out ofthe machine that you've 
tried to place out of their line of vision. And 
some. -ofthe best skiJI .. and-drill software is 

panels: Where you can· switch off thQ•·SOl!rtd,;. 
·vary ~the number of problems presented;.' and: 
set the-Jevel. of difficulty. Altjlough.;hearhig rthe· 
rQcket'blast off or the alien capture youiis~:half 
the fun. (Oh, 1 forgot, learning i$nf~,supposed. 
,o.b.e aboutfunlll.cured this noise ,pr~bl~nr 
·without· ruining ~he .fun by .purchasin(Lfi~aa­
phones for my classroom. ·The cheap .ones­
workJ~st fin·e; I picked up a seUor- each.~c.om"" 
putar in: our lab at a lo.cal arugstore for $1 
each~ ·· · · 

. u:su;illy: very noisy. (The sound effects in these 
programs:are-cool and very realistic). But have. 
no fear.:Afmost ail these programs have oo~:~trol 

l'roductiflitiJ. SoftWare 

~~D"t'.:.~. ~ ,_ . 
' ' 

As the name implies, productivity software lets you walk away with a product 
of some sort. And, in answer to your next question -yes, a printer attached 
to your computer would be great when you're using most productivity 
software. However, it's not a necessity. Remember the art of saving? You can 
have each child save work to a disk; then, at a more convenient time, take 
the "product" to a computer with a printer. (I know, there is no convenient 
time, unless you can squeeze it in during your 30-minute "break" somewhere 
between using the rest room, checking out resources from the library, 
calling the concerned parent, and preparing for your next class.) 

In my job as a technology coordinator, I'm required to integrate the class­
room curriculum with technology. It's unrealistic to think that a school 
could purchase software on each individual area of the curriculum. Don't get 
me wrong: Some great programs are very specific and usually skill-and-drill. 
Yet I can't justify spending taxpayer dollars on a piece of software that may 
be used by one grade level to highlight a topic being taught for a single 
semester. By using productivity software, you can create activities for all 
levels and all subjects with just a single program. (I love productivity 
software, as you can probably tell.) 

Another great benefit of productivity software is the power you give stu­
dents. You are not giving them a predesigned format where they are simply 
participants. You are giving them the tools they need to solve their prob­
lems or interpret a topic. Look at some examples using ClarisWorks: 
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That's edutainment! 
Isn't that a great name? Edutainment software 
is a hybrid of sorts, combining aspects of skill­
and-drill software with the simulation software 
titles. Kids learn while "playing" on the com­
puter. Pretty sly, I know, but it works! Many of 
the titles in this area involve students in an 
adventure of some type or in a mystery. Along 
the way to solving the mystery or experienc­
ing the adventure, students pick up a few fun 
facts or delve deeper and deeper into a sub­
ject area. 

Parents especially love this type of software 
because it usually doesn't require a lot of prior 
knowledge on their parts - they sometimes 
enjoy the adventures as much as their kidsl 
Teachers enjoy the titles for the same reason; 
in a one-computer classroom, a student or 
group of students can work alone with little 
teacher supervision. 

Y' Second-grade students can write five sentences and then choose a way 
to show that they know the subject in each sentence. The opportunities 
are endless. They can change the font of the subject, underline the 
subject, type the subject in a different size, type the subject in a 
different color, or do any combination of these things. 

Y' Fifth-graders can survey other students each week and compile the 
survey results on a spreadsheet. Then, using the Make a Chart com­
mand, they can turn their results into a visual image to share in a 
school newspaper - kinda like the graphs you see each week in USA 
today. 

Y' Middle or high school students can use the database to enter information 
on a variety of environmental or social issues; later, the students can 
call upon this database to help find information to aid in the creation of 
call-to-action letters for specific causes. They can even use the data­
base to create address labels for mailing envelopes. 

In other words, most productivity programs are like those knives sold on 
late-night TV: They slice, dice, chop, and even julienne! 

Other forms of productivity software help students create published prod­
ucts. These products can be based on any areas of the curriculum. Book­
publishing software that lets the student write, illustrate, print (front to 
back, no less), fold, and staple is easy for any age group to use. This type of 
creative involvement between the student and the computer helps make the 
learning more meaningful and personal. 
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$CJ-;m~'RlJIJ@,:: 
~~m~mbering .·~h.~~.· softw~r~:. is :a ~~9-Pvti9fit~P~ :· : :pfg~~~rri·~itH~"t~:frJeQP.~t.J~~~. it ~p· y.ttur · pwn-. 
ite~~-~~ v.e_ry.imPor.t~r~t·.wij·e.Q'~Y:~Y:J:fMt~ni~-,~f ";9!,¢~r%~~h-~rtJ~. _; :-~h~t's:.UI~g.~:h:$q:f1W~~I!_pin~~v­
soft\Nare:progralll,,You aret~ll~w,~.d~~:~s~~~:s~ ;•· 'i$ ·:a, ,:n~~-~ .~r;o~l~,~?t<?d~y. Regj~~f'-Y.Ql)n~Pft:: 

. soft\Nare ononfy one.·cpmpu~~r(~r'a,~p_ectfi~(l·:-;wa~~;p~r~~~se.s,·and'hon_or-~heJerms of'yoqr 
num~·~r pf J~Qmp~tets;.~Jo~l p,urc~~~-e~t~\·t~~~ . ~: _r~g~~~r~~hii,t~~re~.mept: . . --
pack or site lic.ense). Yoy :t~n':t~shate:o:y~Ufi .· ;r :: ; ... / ::· . ,,'. · ·" . · .. 

, . . . - _· .· ;: . . 'r . _· ,' . ,. . ; . :· ·}..' , .. -. ~ ·,; ·• -~ . , ~l: . -. 

Multimedia Software 
Now we come to the kids' favorite type of productivity programs: the 
drawing, painting, and multimedia programs. I consider these programs to 
be a form of productivity software because a product is created. If used 
correctly, the product can be integrated into any area of the curriculum. Yet, 
to some parents and even some educators, these programs are pure fluff 
that should never be included in the education environment - kids 
shouldn't spend school time drawing and coloring. 

I beg to differ. Multimedia software can be a great asset to any technology 
curriculum. 

Multimedia programs allow for the purest form of assessment: authentic 
assessment. We need to allow students more chances to "show what they 
know," instead of prescribing a test to tell us how bright they are. Here are a 
few examples showing how students can use one of the Kid Pix programs: 

Ill" Why not have kindergartners practice letter recognition and handwrit­
ing skills by using each of the paint tools in Kid Pix to create different 
versions of the same letter? Then, if they are ready to extend the 
learning a little further, they can use Kid Pix stamps of images that start 
with that letter - or even better, they can use the text tools to type 
words starting with that letter. 

"" Fifth-graders can create an advertisement for a product that might have 
been sold during the period of westward expansion. Using the text tool, 
they can add descriptive words and phrases to justify the purchase of 
the item. Wouldn't this activity tell a teacher whether the student 
understood the hardships facing the travelers? 
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~~~~~~~~~~~~~~~~~~ 
Everything is frozen on my screen! 

What a bummer! Today's computer programs 
have more Quicklime movies, more interac­
tive elements, and an overabundance of cool 
sounds. All this improvement is great. How­
ever, I sometimes think software developers 
have forgotten those of us who are still work­
ing in schools that have a few PowerPCs and 
tons of old LCIIs with a mere 4MB of RAM -
slow processors. Our trusty old LCIIs (and 
many ofthe new higher-end machines) have a 
hard time when it comes to running these 
flashy new programs, and inevitably the 
screen will freeze at the most inopportune 
moment! 

If your computer screen freezes, you have a 
couple of options: 

V' Force quit the program by pressing the 
following key combination: all-Option-Esc. 

Hopefully, a dialog box will appear, asking if 
you wantto force quitthe program. Click Force 
Quit, cross your fingers, and say please three 
times. If your computer is still frozen after this, 
try the next option. 

V' Restart the computer by pressing the re­
set switch (it's the button with the arrow 
that points to the left). This button does the 
same thing as turning the Mac off and on 
again. 

I 
V' Middle school students can create a slide show that could be aired later 

via closed circuit television to the entire school. Topics for the show 
can be based on any topics in their curriculum - or the topics can be 
chosen to arouse social awareness. 

Simulation Software 
This final type of software is relatively new to the market. Many of the 
programs have been labeled edutainment - a new word in the software 
industry. Yet, as contrived as it sounds, this hybrid term describes well the 
programs in this area. 

Simulation so ftware is often labeled as interactive because the student 
becomes part of the software. Simulation software is incredibly fun, of 
course, and most of the quality programs involve a high level of thinking and 
reasoning. The only drawbacks involve the time necessary to complete an 
activity and the limits of your computer's memory. 

Getting caught up in the activities is easy: crossing the plains in the 1800s on 
the Oregon Trail, finding Carmen as she travels through history (Where in 
Time is Carmen Sandiego?), or building a new town that will prosper and 
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A little,conversationiha computing·cl~sstoom 
is all right. Y~s, st>rnetimes ~ids can e)(pl~)n 
thingsbetterthan a teacher.;Tobe quite hQIJ~ 
est,the kids usually solve a problem quicker than 
I can.·So,~my rule in,a whole-class computing 

situ~tio~ i§ ''Ask 3, then me.''· Thi$, :simply 
m~~nstJ.iatstudents mu~Jtskthree,fri.el.ld$for 
help b~f.()re they come to inEI• 'Try It, and tb~t 
you~nn~ver ·;:tgain_be bombardedyvit.h-a room~ 
fufofjmpatienihands . .waving in the a)r. . .. 

grow in SimCity. But, before you know it, it's time to leave the lab or take the 
class to PE. It borders on cruelty when you ask a child to leave an adventure 
unsolved or incomplete, and that situation often occurs when you use 
simulation software in the school setting. 

Most of the programs are now available on disk or CD-ROM, and either way, 
they usually require a large amount of memory. Always check the package or 
ad to be sure that you have the proper requirements to run the software. If 
your school is like most in the country, you're probably working on ma­
chines that have 4MB of RAM and a limited amount of hard-drive space, 
which makes it difficult to run some of the programs. (Some of the promo­
tional material may say that a program will run with a minimum of 4MB, but 
it won't be nearly as smooth as you'd like- and it will be very slow.) 

Are there really·fewer Nlac programs: 
than Windows pr9grams? 

No, no, no, and·no. This common misconcep• btrt'~hat~wouldhav~ .been too eas~: P~cause: · 
tion is .conStantly fueled by the. way in which cos'.can hold more than 600MB of information, 
computer .stores stock ;their; $helves;· Givjng .moS!: ~f.th~. n.ew software releases have·b.een 
Windov,vs P[()gre~ms · tbrl!t:J tiJTies mor~ sa.le~ .COIJliQg·: .outJn .. c:ross-platform. v~rsions· · (botll 
~pac.e than their Ma.c cou~terparts does tend . · Mac 9ndWindows on the same CD). 
to painta bleak picture for the Mac software If you still ne.ed 8 Jittle reassura:nte;: 
scene. 

Take a $hart walk down thos~r "WindoWs 
Aisles": Notice that just a~out every box con .. 
taihiilg ·a· CD • reads· "Windows 95 and Mac~n­
Th~(s right, that same box could have just·as • 
easily berm placed. on the lonely Mac aiste ~ 

c,all MacWijrehouse .· (800•25·5 ... 62:2.71, 
Ma.~C(jn·n~ction (800-B.OO~P019); Qr .MacZone 
(800~248.-:0800)fora comple~e'UstiJ1g .. Yo~••can 
find over 200 pages of Mac ~stutf'r; in each of 
their ;catalogsl · · 
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A RAM Refresher 

Figure 5-1: 
Your Mac·s 

RAM is 
important 
when you 

want to add 
software. 

In Chapter 2, I talk about memory and I tell you that RAM stands for Random­
Access Memory. You pronounce this acronym the way it reads, like the 
sheep: ram. And you will hear this word quite frequently. RAM is memory; it 
delivers information to your Mac's brain almost instantly. 

Remember the tl menu? Pull down that menu and highlight About This 
Macintosh. Then release the mouse button. A window appears (as shown in 
Figure 5-1). 

Look here for your RAM. 

§1- Rbou This Mac:intosh 

System Soflvare7.1 
Cl::al Hacmtosb LC II IS> App~ Comput•r, Inc. 1983-1992 

if 
Built-in Hemorg : & ~ LargHt UAUSed Block: 6,6681< 
Total t1emorg: 1921< 

1m At~• 140K • Q 
£J St,jstem Sofuot.ar• 1,3761< 

~ 
l!i 

M.edia: c.ente-lralternatives 
- . . -- .... • : • .. ' : '. ~ . •1· • . • ~ 

Tbe·mediacent~dnyourschool·oft~ncanbe ln'1he media center at my school, we also 
~-viable aftemative for a complete lab sitUs• :have·onecomputerthat's conne~edto a laser 
tion. Sim~latlon programs w~rk as a .great -printer ~nd a_ mod.em-.- an (I is reserved solely 

- addition.,to ·a media center in the fQrrn of a Jorteache(s.Teachers use this computer tQ 
miriUab. With a center used this way, stud_ eo~ ~ _ .c;reaw their . newsletters, enter grades on 
can come on their own, possibly after finish~ gradebook ·programs, or send and. receive 
ing required classroom work. and stay for a e-mail c.orrespondence. (I often ask teachers 
while. to preview software on this computer as weiJ.) 

The media center could also have·a few com;. 
pJJters setasidefor skill-and;..drill software that. 
tea.chers:could:request-from a media special-
. ist: This strategy, could be a way to customize , 
learning to meet the needs of- all students. · · 

TheyJike knowing 1hat they have tlleir :own 
"space" to complet~ computing a-cliiities. ·. 
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The number shown in Figure 5-1 would be the amount of RAM your Mac has. 
If you lop off everything after the comma, you're left with the number of 
megs of RAM. It's probably 4, 5, 8, 16, or 32MB. Older Macs have less. Higher­
priced Macs have more. Take this opportunity to write the figure on the 
cheat sheet in the front of this book. This number comes in handy when 
you're shopping for software. 

Let's Be Realistic 
In an ideal world, I'd have one lab for each type of software: skill-and-drill, 
productivity, multimedia, and simulation. I'd also like to have minilabs 
within each classroom to allow small groups of students access - and 
possibly allow each student a fair amount of time on the computer each day. 
However, that's not possible within most of our schools, and time con­
straints often control what can be done within the labs. So, if I had to make 
decisions: 

1. I'd first choose to have a productivity/multimedia lab where teachers 
could sign up for at least an hour at a time with the freedom to come 
back on consecutive days to complete a project. 

2. My second choice would be to have a multimedia lab like the productiv­
ity lab, where teachers could sign up for large blocks of time on succes­
sive days to complete involved multimedia projects. I'd make sure that 
the lab was equipped with Macs with major amounts of memory (32MB 
of RAM or more and 2GB or more of hard-disk space), a scanner, a 
QuickTake Camera, and a video camera. 

3. Then I'd choose to have a skill-and-drill lab that worked on a rotation 
schedule in order to give everyone in the school a chance to use the 
lab. Time slots for this lab could be 30-45 minutes each. 

4. And last, I'd choose to have a simulation lab where the students could 
sign up individually for large blocks of time (which would allow for 
really experiencing the simulation). 

CD-ROM &plaineJ 

<I) CD stands for compact disc. ROM stands for read-only memory. Read-only 
memory means that you can only read, see, or hear what's on the CD. You 
can't make any changes to the contents of the CD. 

So what do I need to take advantage of this acronym? 

The requirements are minimal, and so is the cost when compared with other 
add-ons in the computer universe. 
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Wbat do all those nbnibers beside 
a software title mean? 

That's a good question, my friend I The num­
bers.nextto a ·software title indicate the ver­
. sion of the software (for example, ClarisWorks 
5.0). lfs important. to know which version of 
:the software you're working· with when you 

·want to- share files between computers or 
send a fihHo a friend (who may have another 

. versionofthe·same software). 

·vo.u $ee, mostver,ions of a software program 
can uread" (open and allow you to work with) 
.anything-earlier (thafs to say~ "lower") thf!ln · 
itSelt ClarisWorks 5.0 can read ClarisWorks 
4 • .0 or 3~0. However, an earlier software ver­
·sion can't read a version newer than itself: 

· _Cia(isWor.ks 2.0 can't. read ClarisWo~ks' 4.0 · 

Vouneeda CD 

files. Are you totally confused? Let me throw 
in another factor. You can purchase convert­
ers that allow earlier versions. of a software 
program to read the most recentversionl _ 

And tha.t's where the upgrade issue comes 
·into play. For a little more than yo.u'd pay for a 
file converter (and sometimes for free), you 
c·an upgrade to the newest version of a soft­
~are program. If you· or your school regis­
tered the software when you made the origi­
nal purc~ase (as any go()d citizen would), you 
are sent notices when the software manufac-

. tbrer re1eases an upgraded version. 

You probably know what a music CD looks like. I'm embarrassed to say this, 
but I just recently purchased a CD player for my stereo system. (I'll always 
call new releases albums, and I'll never get rid of my turntable.) 

Anyway, a CD is a flat, thin, shiny disc that has a diameter of about five 
inches. The ones that play music look exactly the same as the ones you use 
in a computer. The information is formatted on the plain side (the side 
without the graphics or title). However, a computer CD does much more 
than play music. The technology behind this wondrous creation is truly 
amazing. You see, a CD can hold a bizillion times more information than a 
regular computer disk, therefore allowing it to contain animation, incredible 
sound, and bedazzling graphics - all of which would consume hundreds of 
floppy disks. 
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You Need a CD--ROM Drifle 
The other part of this equation is the CD-ROM drive (the $200 to $400 thing 
you use to play the CD). I told you in the beginning of this book that I'm not 
a techno-nerd, so I won't even begin to try and explain how this baby works. 
I will tell you that all new Macs come with CD-ROM drives built in (internal). 
Or, if your school is like mine and full of lower-end Macs, you can purchase 
an external CD-ROM drive and plug it into the back of the Mac. (I've done it. 
It's tres easy!) 

CD-ROM drives come in an array of speeds. Most newer Macs are equipped 
with at least an eight-speed (8x) CD-ROM drive. Anyway, the speed refers to 
how fast the CD spins, which determines how fast information on a CD-ROM 
can be accessed or "read." This speed becomes a critical component when 
you use a lot of reference discs that are chock-full of data spread throughout 
the CO's available 600MB! Buy the fastest CD-ROM drive you can afford. 

If you purchase an external CD-ROM drive, you find some software inside the 
box. This software tells the Mac that it has a new neighbor sitting beside it 
on the desk. Don't fret; installing software is an easy task and takes less than 
five minutes. Simply pop the floppy disk in your disk drive and follow the 
instructions for installation. 

Note: Installing a CD-ROM drive is easy. Running a sometimes-memory­
hungry CD-ROM on a Mac with only 4MB of RAM, however, may be less than 
appealing. Check into purchasing additional RAM for your Mac if you decide 
to add a CD-ROM drive. 

The Internet connection 
The newest and coolest feature found in refer­
ence COs is a connection to the information 
superhighway. It's a natural! Now you can 
have the printed information, and, with the 
click of a button, your CD can access your 

Internet account and make up-to-the-minute 
information available to you whenever you 
want it. Reference information will always be 
current (Now, if we could only teach the kids 
how to cite their references!) 
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Where's the Card CatalofJ.} 
As I mention earlier in the book, kids today have it easy. (I never imagined 
I'd hear myself utter those words.) They don't even have to leave their 
computers to look up a term, get a good quote for an article, or find out the 
state flower for Georgia. It's all available on CD. 

Because CDs can hold so much information, they are the perfect medium for 
reference software. Over the past few years, reference software has ex­
ploded onto the scene. As a matter of fact, most of what you consider 
mainstream reference materials are now available on CD. 

Reference CDs can be divided into two categories: general learning and 
specific learning. In the general-learning CD category, you find the basics: 
dictionaries, thesauruses, encyclopedias, and an atlas or two. Specific­
learning COs target one area of learning, such as the ocean, and contain a 
vast array of information on that individual subject. The specific-learning 
tools often include fun activities that actually take the learner into the 
subject and involve lots of interaction in the research process. The student 
learns from experience. (With general-reference COs, the student is given 
information in more of a textual format.) There are some exceptions to this 
rule, as you'll see in the next chapter. 

Good reference COs are easier to use than their hardcover counterparts. 
When you venture into specific-learning software, the ease of use is immedi­
ately evident - the software manufacturer has taken information from a 
variety of sources and compiled it onto one CD. This task would take a child 
forever to accomplish. 

A good reference CD should also be easy to use and - when it comes to 
dated material - should offer yearly updates at a nominal cost. 

The CD that·doesn:tact like a CD 
R@.eeot trend~ have shown that many soft­
W:ctrij:companie~. are putting .. traditional .. pro .. 
dOctivitY· sot:tware. on COs, instead Qfjust on 

1
, . floppy di~ks. M~ov of th~. programs .. · aren't 

1 jnte.ridedt~.bEfrun from CO.eachtime·th.ey~re· 
~~~d~ Pla~ipg.~ program on a CO simply makes 
itea~ier:to install.·onto your hard drive;Y~L.f 
don'thaveto~~itch .back and. forth ftomfour 

! 

or five disks during installation. The COs are 
also easi~r to store than a pile of disks, and 

··they take up less space. 

Note: It you don't have a machine with a CO­
.RO.M drive,. you can ·usually contact the soft- ·· 

·ware company for floppy disk versions of the 
softWare~ 
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Part II 
ClarisWorks The 

Loaded Spud 



In this part ... 
J::erything in education is centered around the 
I;, ~hildren - and justifiably so! However, it sure would 
be nice if a few perks were thrown in every once in a 
while for those of us down in the trenches. 

For example, I'll never forget the day my school cafeteria 
added baked potatoes to the teachers' lunch bar. We were 
all so excited! Looking back, it seems ridiculous, but it 
also proves how deprived we poor teachers sometimes 
are. Something as simple as a baked potato provided us 
with happiness and conversation for weeks. (And we 
became oh-so-creative with our toppings.) 

Imagine what would happen if teachers were always 
allowed to leave the school for lunch! 

ClarisWorks is much like that baked potato I so artfully 
loaded on my lunch tray last year. It will cause you to 
chatter excitedly for days as you show colleagues your 
incredible creations and brag about how much easier day­
to-day tasks have become. And like the potato, 
ClarisWorks has everything you need in one neat package. 
How's that for stretching an analogy? 

Later in this book, we discuss the wonderful things your 
students can do with this spud of a program. But right 
now, I want to give you a well-deserved perk. 

In this part, I show you a variety of ways in which 
ClarisWorks can make your professional (and maybe 
personal) life easier. You learn about the world of word 
processing, templates, and databases -and I take you 
step-by-painless-step through the creation of each 
document. 



Chapter 6 

An Overview of ClarisWorks 
ooooooooooooooooooooooooooooooooo~oooeoooooooooo 

In This Chapter 
i>- What is ClarisWorks? 

~The ClarisWorks components 

111>- ClarisWorks basic training 

!Ia> Assistant, please 

~ Check your spelling 

oooooooooooooooooooooooooooooooooooooooooooooooo 

l:n Chapters 1-5, I show you all the Macintosh basics. Now it's time to 
get busy. 

There are two major 'Works programs: ClarisWorks and Microsoft Works. 
They're very similar. I admit that all the activities in the next three chapters 
can be completed on either program. Use the program that you prefer. Then 
make the necessary adjustments. (I just prefer ClarisWorks.) 

What is ClarisWorksl 
ClarisWorks is Swiss-army-knife software. Just look at all you get, even if you 
don't know what they are yet: a word processor, a database, and a spread­
sheet. Now how much would you pay? But wait. You also get a graphics 
program that can even serve as a basic page-layout system. And if you call 
now, they even throw in a little communications program (to use if you own 
a modem- a phone hookup for your Mac). 

All these modules are neatly bundled into a single program. You can write a 
letter and put a graphic in it, or you can design a flyer that has a little 
spreadsheet in it, and so on. This section will be worth reading, even if you 
don't own ClarisWorks yet, because ClarisWorks works exactly like most 
other Mac programs. 



82 Part II: ClarisWorks- The Loaded Spud------------

Mar(le/ous Modules 
As I mentioned earlier, ClarisWorks has it all. Here's a brief description of 
each module: 

Word Processing: You know that a word-processing document is something 
you type: a memo, lesson plans, and newsletters. 

Drawing: This is the ClarisWorks version of MacDraw. In this kind of docu­
ment, you toy around with lines, shapes, and colors to produce logos, maps, 
classroom layouts, diagrams, and other important visuals. You can move 
and manipulate in various ways the shapes that you can create. 

Painting: This is the ClarisWorks version of MacPaint or Photoshop. Paint­
ing is another way of making graphics. Unlike the Drawing mode, where you 
can create only distinct circles, lines, and squares, the Painting tools enable 
you to create shading, freeform spatters, and much more textured artwork. 

Database: An electronic index-card file, much like FileMaker. You type in 
your lists - household expenditures, record collections, classroom books­
and the program sorts them, prints them, finds certain pieces of info 
instantly, and so on. 

Spreadsheet: A computerized ledger sheet, almost exactly like Excel. It 
crunches numbers, for example, and it calculates your car's mileage per 
gallon, your bank account, how much of the phone bill your teenage daugh­
ter owes - that kind of thing. 

Communications: You need this kind of program if you want to use your 
modem for dialing up local "electronic bulletin boards," pay-by-the-hour 
online services like CompuServe, or your local school's computer system. 
You can't use a program like this to dial up an online service (such as 
America Online). Instead, you have to use a special program provided by 
that company. 

To make ClarisWorks strut its stuff, I'll show you in the following chapters 
how to create a class-list database, personalized stationery, customized 
checklists, lesson-plan templates (templates are stationery documents that 
remain constant and let you add changes to them each time you pull them 
up), and much more! But first, let's continue with our overview. 
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A shameless plug 
As you can prqbably teU ·from this chapter'" 
ClarisWorks is·an amazing~r()gram. Believe it 
or· not, this portion oftbe,boo~only ~cratcbes 
the :surfa¢·e when it corrie.s· 'to what 
ClarisWorks can actually dol· So, if you find 
yourself awake ~t llight~ondering other uses 
for Clari$Work$ in the clas~room, you might 
want to check out another book I've written: 
The ClarisWorks Reference For Teachers 
(from I"DG Books Worldwide, Inc., ISBN 
# 1-56884-853-6). 

In The C/arisWorks ReferenceFor Teachers, I 
. give you tons of great ClarisWorks tips; intro­
ductryouto basic layout ~nd design principles:· 
include an expansive Cla.tisWorks trouble~ 
. shooting ·chapter; give you instructio(_ls for 
creating a ClarisWorks slide show; tell you all 
about labels, letters and lists;·: explore the 
ClarisWorks Drawing arid Painting modules; 
and include tons of great fonts iJnd templates 
on the CD that comes packaged with tht! book. 
But hey'" don'ttake my word for it .•. go out and 
see for yourself! 

What~ New With Version !,.OJ 
Claris did some great things with the introduction of Version 4.0. I give you a 
brief rundown here and introduce you to a few of my favorite new enhance­
ments in the chapters that follow. 

Otlerall Enhancements 
The best overall enhancement is the addition of drag-and-drop clip art 
libraries. The capability to drag and drop means the end of cut and paste. 
The libraries of clip art are grouped by category (education, holidays, flags, 
and so on). After you open a library, adding an image is as quick as clicking 
on the image of your choice, dragging it to the "ideal spot," and then drop­
ping it (letting go of the mouse button) in place. (See Figure 6-1.) 

The addition of the Mailing Label Assistant and Certificate Assistant is a big 
plus to those of us in the education biz. ClarisWorks walks you step-by-step 
through the creation of mailing labels (complete with the Avery label style 
numbers) and makes creating custom certificates a breeze! 
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Figure 6-1: 
Now you 
can just 

drag and 
drop 

clip art. 

Click on image. Keep mouse button 
down and drag image to document. 

Jumping on the Internet bandwagon, ClarisWorks 4.0 also features HTML 
( Hypertext Markup Language) translators . This addition allows a user to 
create and read World Wide Web documents. 

New word-processiniJ features 
Now it's easy to integrate outlines, numbered lists, and bulleted lists into 
your text. Just select the text you want to format and choose the style from 
the style pop-up ruler. If you insert a new item in the middle of your outline 
or list, the numbering or other annotations adjust themselves. 

Endnotes are now an option. I was honestly shocked when a friend told me 
that footnotes were "old-fashioned." In Version 4.0, Claris has made 
endnotes an easy addition. 

There are also a few new enhancements in the area of formatting. In Version 
4.0, you can insert multiple headers, sections, headers, and footers. All the 
new formatting options are found under the Format menu. 

New database features 
I'm most impressed with the new features in this area. List view lets you 
view, manipulate, and organize your data quickly and easily. In addition, 
there are also new field types in Version 4.0: 

Names: This field type allows you to enter a name in the typical order (first 
name and then last name) and when you sort alphabetically, ClarisWorks 
will look at the first letter of the last name. 
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Figura 6-2: 
Check 

boxes and 
radio 

buttons 
make your 
database 

even better. 

Radio Buttons: Radio buttons are great for speedy data entry. A simple click 
in the radio button records your data. 

Pop-Up Menus: These menus work like the radio buttons, only instead of 
clicking inside a button, you highlight an item in a menu that pops up when 
you click on the field's area. 

Check Boxes: This field inserts a check box in front of the field name -
kinda like those forms you fill out at the doctor's office. (See Figure 6-2.) 

Serial Numbers: Choosing a serial field will automatically insert a number 
each time a new record is added. You tell the computer what number to 
start with, so this would be a great feature for those of you who assign 
numbers to each of your students. 

Record Info: This field can be programmed to automatically enter one of the 
following: the date or time the record was created or modified, or the name 
of the person who created or modified the record. 

Volunteers Please 
(g] Read to Class 

[g] Provide snacks 

(g] Organize Field Trips 

~Room Mother/Father 

; z~ioooo 
( 030001 

New spreadsheet features 
In Version 4.0, you can shade cells with a color or pattern. You can shade 
individual cells or a range of selected cells. In addition, the new Fill Special 
feature allows you to increment data automatically by month, year, quarter, 
and more. 

New drawiniJ features 
In the Drawing environment, you can now free rotate (a full360°). This is 
a great feature when you're using the Draw environment for page layout 
and design. 
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ClarisWorks Boot Camp 

Figure 6-3: 
The New 

Document 
dialog box 

is where 
you start in 

I want to take this time to review a few ClarisWorks basics with you. The 
information listed here is common to all areas of ClarlsWorks. Becoming 
familiar with this information will help you in all your ClarisWorks endeavors. 

The New Document dialotJ box · 
This dialog box appears each time you open ClarisWorks. Your two choices 
are shown in Figure 6-3: Create a new word processing document and Use 
Assistant or Stationery. 

New Document 

A UIOI d PI Oli'SSIOg ~ 
4iJ Dntwlng 

_A Pointing 

II Spreodsheet 

~ Dotobose 

;:j Communlc11tions 

ClarisWorks. 0 Use Asslst11nt or St11t1onery ( Concel ) ( OK D 

"Create a new word processing document" means what it says. You're 
starting from scratch with nothing to guide you. 

"Use Assistant or Stationery" gives you assistance in creating a variety of 
predesigned ClarisWorks documents or lets you go right to a stationery item 
you've already created (maybe your weekly lesson-plan form). 

So what is stationery? When you create a document that you know you will 
be using again and again ( like your lesson-plan form), ClarisWorks gives you 
the option of saving this document as stationery: Each time you open your 
lesson-plan form, a copy of the original appears, ready for you to fill in. The 
original is never altered, and you don't spend unnecessary time reentering 
items that recur every week. Saving a document as stationery is an option 
each time you save something in ClarisWorks. 
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The latest offering from·th·e folks,at,Ciatis-
crarisworks for Kids is the·· first complete . Teacher$ Will 'like :·the· fact that the dialog 
cross-platform productivitY.sPftwan~:$OI~tiqn . b~o~~s,m~IJIJ~~ :an.~Jwen .CI ,~d~flt'$·work can 
designed. specificaUyJor gr8,des K..:s. ·(q~e~k · be. ··ria'd·-out lo.ud~ the s(factivijies that are 
outthe·demo:on the CD.)Yes,lt's CtarisWorks . includ.ed.:are &; gooa way for te~:chers:to.'.Qet 
for the junior setl Gone are the: complicated . started usinig ithe 'program. Teachers ~an de­
menus, and in their place you find greaticons, · :sign templ~tes using ClarisWoi'ks 4.0 anci'open 
kid-style fonts, more: clip.·art,,toos·oftemp-lates, ·them fQr use in CIJirisWorks for Kids. My-favor~ 
and if you have Internet acc6,ss, there's one . · ·mrfeature is the kid~fr:iendly filing system.~it · 
button access to -th_e Web.. Allthis along with a yo"'v~ .ever trie~ to teach kids how to save a 
huge supply of sounds and:-movies makes it .document, you to_o Will ~ppreclate Clarb~WorkS 
easy for the younger setfo write, paint, graph, ·for Kids'· e~sy filin_g system., -
or create a great list 

The word.-processiniJ rulers 
We go into each of these controls in Chapter 7. For this overview, I want you 
to be aware of the incredible amount of control ClarisWorks gives you. Isn't 
this great? My typewriter sure didn't make writing this easy! 

Controls indent Text alignment Paragraph formatting 

Tab controls Une spacing Column settings 

The Open dialoiJ box 
This dialog box appears when you choose Open from the File menu (see 
Figure 6-4). You use the Open dialog box when you want to retrieve saved 
work. If your work is saved on a floppy disk, simply put the disk in the 
computer after this box appears. The computer reads the disk, and the 
disk's contents appear in the scrollable window. 

If your work is saved on your hard drive, you may have to do some digging 
to find out exactly where it is saved. 
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Figure 6-4: 
The Open 
dialog box 

lets you find 
and open 

your saved 
work. 

If you saved your work in a ClarisWorks folder, it should appear when you 
choose Open from the File menu. Simply highlight the name and click Open 
(or double-click the name). 

Creat e 

A document document 

a 11rlsWorks 
Ql Cl11ss list Spre11dsheet 
a Clip Rrt 
D Couer templ11te 
D 011t11b11se S11mple 
D H perstudlo check list 

181 Show Preutew 

File Type 

~HRRD DRIUE 

Eject 

Desktop 

I Open , 
C11nce1 

jRII Ruallable ,.I 

If you saved your work on the hard drive, pull down the drop-down menu 
(also called a pop-up menu!) at the top of the dialog box. Then choose Hard 
Drive. The hard-drive contents appear in your scrollable window. Just find 
your work! You practice this procedure in Chapter 7. 

The flieul buttons 
In the lower-left corner of the ClarisWorks screen, you see an odd-looking 
array of controls: 

As you can tell, ClarisWorks makes it extremely easy to blow up your work. 
(Obviously, I mean magnify it; destroying it is up to you.) A quick click on 
either of those little mountain buttons makes your work appear smaller or 
larger. Or jump directly to a more convenient degree of magnification by 
using the percentage pop-up menu. Click and hold where it says 100. A list of 
percentages appears for you to choose from. You won't be changing the size 
of the actual printed work- only how it's displayed on the screen. 

The final control (to the right of the mountains) enables you to view or hide 
the tool palette. These tools are used primarily in the drawing and painting 
modules of ClarisWorks. 
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Figure 6-5: 
The Save 

dialog box 
will soon be 

familiar 
to you. 

The Saf/e dialotJ box 
Saving a document is a very important skill. Let me take this opportunity to 
introduce you to the Save dialog box (as shown in Figure 6-5). 

After you type something wonderful (and you choose Save from the File 
menu), your demanding computer requires that you give your masterpiece a 
title. In its manipulative way, the computer also asks that you store that 
document someplace. 

ell ClartsWorks 3.0 rot ... ,. 

CJ chapter - dota base .Q 
D Cheat Sheet for school ... 
D Cheot Sheet Macs forT ... 
CJ ClartsWorks 
(<I ClorlsWorks 3.0 
lj Clo~~ ll~ t Spreadsheet 
CJ Clip Art 
D Couer t emplate 0 

Saue As: 
ltlarlsWorks •I 
Untitled 2 

Sa(liniJ to a disk 

= HARD DRIUE 

[ Eject 1 
[ Desktop 1 

I Saue 

( Cancel 1 

®!Hff 0~ 
~I 51~ 

Use this drop-down menu to find the folder 
you want to save your work in. 

After deciding where to save your work and 
giving your work a name, click here. 

Name your work here. 

In schools, many computers are set up to require you to save your work to a 
disk. If that's the case , simply insert the disk when this dialog box appears. 
The disk's contents (if any) appear in the scrollable box. Then type in the 
name of your file and click Save. 

Sa(linlJ to a folder 
Other schools set up a folder on the hard drive for each teacher. If that's the 
case, you may have to do a little digging to find your folder. 

If your folder is inside ClarisWorks, it should show up in the dialog window 
immediately after you choose Save from the File menu. 

If the folders are kept on the desktop, click the Desktop button (or choose 
Desktop from the drop-down menu at the top of the box). You should see 
your folder as one of the choices in the scrollable window. 

If the folders are kept on the hard drive, pull down the drop-down menu at 
the top of the box and choose Hard Drive. Find your folder and open it 
(double-dick it, or highlight it and click the Open button). Now you're ready 
to save to your folder. 
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So, let's get busy! Jump into Chapters 7, 8, and 9 where we put all this 
information into practice. 

~·~~~~~~~~~~~~~~~~~ 
An easy way to avoid learning this stuff 

This business about the "Save Where?" dia­
log box is, as anybody will tell you, the most 
confusing thing about the Mac. After years of 
experience, a few professional beginners (in­
cluding myself) have adopted the following 
cheat- and we never lose another file. 

Whenever you save a file, you are faced with 
the Save dialog box. Name your file, and then 
click the Desktop button. Only then should you 
click the Save button. 

Go ahead and ask - UWhat's the point?" 

Easy. When you're done working for the day 
and you return to the desktop, you won't have 
to wonder what folder your document's icon 
fell into. Your new file will be sitting right there, 
on the desktop - in plain sight. 

lei! ClllrisWorks 3 o Fol • I ... 
D ch11pter ·d11t11 b11se j,! 
D Cheat Sheel for school ... 
D Cheat Sheet M11rs forT ... ~; 
D Cl llrisWorks l.,-
,.,_ ClarlsWorks J.O ~-t 
OJ CIIISi list Spreadsheet 
D Clip Art 
D C:ouer t emolate 

S11ue As: 

= HARD ORIUE 

( Eject ] 

l S11ue D 
C11nce1 

I Cl llrlsWorks •I 
:=., ======----__,, ® ~ 0 ~ 
~essie . ~ 1!7!1 

Oooumont s t.ttonorv 

At this point, it's child's play to drag the icon 
into the folder where you want it. 

Atloid Embarrassment- Check Your 
Spellin9 

You have to get the information out quickly, so you whip up a handout to 
send home in the afternoon, Later that evening, you pull the handout from 
your book bag, and staring you right in the face is a misspelled word! We've 
all made this mistake at some point in our teaching career; it's one of the 
most embarrassing things a teacher can do- teachers are supposed to 
know how to spell (or type). 

Here's how to avoid this embarrassing situation: 

After you enter all your text, choose Writing Tools from the Edit menu. A 
submenu should pop into view with Check Document Spelling as a choice. 
The Spelling dialog box comes up on your screen. 



_____________ Chapter 6: An Overview of ClarisWorks 91 

Cheating! 
Just as you eventually had to memorize those 
multiplication tables and throw away the cheat 
sheet, I feel that learning to create a slide 
show on your own is important However, if 
you're short on time (and what teacher isn't?) 
and you're using either Version 3.0 or Version 
4.0 (or after September of 1997, 5.0) of 
ClarisWorks, a cheat sheet that doesn't in­
volve writing on your palm with a messy 
ballpoint is waiting for you. 

To find the handy cheat sheet, follow these 
steps: 

1. Choose the Assistant or Stationery box 
when you open ClarisWorks. 

A list of available assistants appears. 

2. Scroll down until you see Presentations 
and then double-click Presentations to 
open this file. 

What appears is a hand-holding lesson 
that allows you to create a really neat 
presentation. 

The catch is that ClarisWorks has done it all 
for you- this lesson isn't a tutorial by which 
you can learn each step involved in the pro­
cess. This assistant is more of a fill-in-the­
blank worksheet; and like any good teacher, I 
frown upon cheating. I won't call your mother 
this time, but I expect you to learn how to do 
this task on your own, eventually. 

Now just sit back and relax while ClarisWorks does all the hard work. As the 
computer scans your work, any words that may seem questionable are 
pulled up. When a word appears to be questionable, Claris tries to give you 
a list of possible words you may have been trying to spell. In the example 
shown in Figure 6-6, I might have been trying to type "the" when I entered 
"teh." Isn't the computer smart? 

Each time ClarisWorks comes up with a questionable entry, you have five 
choices: 

Y' Replace- You can replace the word with the word ClarisWorks has 
highlighted in its list of choices, a word you highlight from the list, or a 
word you retype where the original word was displayed ( just delete the 
word and type in your correction). 

Y' Check- This button is a good one to use if you don't see the word you 
intended to use in the list ClarisWorks gives you, and you decide to try 
to spell it again yourself. Delete the original word, type in your own, 
and then click Check. If you spelled the word correctly this time, you 
see Status : Correct Spell i ng at the bottom of the dialog box. Then 
all you have to do is press Replace, and your problem is fixed. 
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Figure 6-6: 
ClarisWorks 
checks your 
spelling and 

makes 
suggestions. 

Y' Skip - Allows you to skip the word if you know the spelling is correct, 
but the word is not in the computer's dictionary. This problem often 
comes up when I type in strange computer program names like 
HyperStudio. Clicking Skip leaves the word untouched. 

v Learn -This key is important. You should click Learn the first time the 
computer pulls up your last name, city, or child's name as a misspelled 
word. Doing so adds the word to the ClarisWorks dictionary, and from 
that point on the word will not be pulled up as a misspelled word. 

Y' Cancel- Clicking Cancel takes you back to your document and stops 
the computer from completing the spelling check. 

Word: ( Rep111ce ~ 
XI 
X2 

Check 

X3 Skip 

X4 
X5 

leorn 

X6 Cancel 

St•tus: : Oues tion•ble SpeUint 3 Words Choekod 
4 2 Outslion.tllt 'IIO<'ds 

When the entire document has been checked, the word Done flashes up and 
the Status message reads Finished checki ng spe l ling. Click Done, and 
you're ready to print your handout without the worry of embarrassment. 

Note: If you need to check only a single word or small passage, highlight the 
word or passage and choose Check Selection Spelling from the Writing Tools 
menu. ClarisWorks takes you through the same spell-checking process 
discussed earlier, only this time the text you highlighted is all that is 
checked. 



Chapter 7 

The Wonderful World of Word 
Processing 

oooooeoeeoooooeoooooooooooooooeooeoeoooooooooooo 

In This Chapter 
~ Your very first word-processing lesson 

l)- Saving your work for posterity 

~ Retrieving a document 

.,.. Creating templates for a letterhead 

~Creating a lesson plan template 

ooeeooooooeooooeoooeoooooooooooooooooooooooeeooo 

II ~ll, here it is, folks, the reason most people use the computer: word 
W~rocessing. Don't let the name fool you. You aren't actually process­
ing the words into anything ... you're typing. Not only that, you are typing 
without a little bottle of white-out at your side. Word processing is typing 
made easy. So go ahead and have some fun. 

SuppiiJ. List for Word Processin9 10 1 
As your instructor, I expect you to come to class prepared. Don't worry­
you're not going to need to take a trip to the local mall or computer store. 

This supply list is short and simple. You need two folders. (Not folders you 
can hold in your hands - electronic folders.) These folders can be found 
free, right now, at your local menu bar. 

1. Choose New Folder from the me menu. (Make sure that you have no 
programs or windows open.) 

2. When the folder appears, it's ready to have a name typed in. Name 
this first folder School Stuff. 
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3. Now, repeat the whole process - but this time name the folder 
Funny Anecdotes. 

4. Finally, drag the Funny Anecdotes folder into the School Stuff folder . 

... t. · ~ ; f r • , ~ · ~ 

Word Processin9 10 1 

Figure 7-1: 
A brand­

new 
document 

can be 
opened 

from this 
menu bar. 

Find the ClarisWorks icon on your hard drive. It may be inside a folder, which 
you can open by douole-clicking. In any case, when you find the program icon, 
double-click it. You are presented, after a moment, with a menu screen that 
looks like the one shown in Figure 7-1 (if you have Version 4.0): 

ftj! New Document 

A wm d "' m PS\mg 00 
4;1 Drawing 

.AI Painting 

IBl Spreadsheet 

!;! Database 

~ Communications 

Crute a ntw word proctssin9 docurMn1. 

D Use Assistant or Stationery X R [concel 118.) C£J 

Choose word processing. You then see a blank screen and some changes on 
your menu bar. 
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Figure 7-2: 
A blank 

slate awaits 
your words 
of wisdom. 

Rules of word processiniJ 
The first rules of typing on a computer are going to be tough to Jearn, 
especially if, like me, you've been typing since high school. But they're 
super-crucial. Here they are: 

v Don't press the Return key at the end of each line. 

I'm dead serious here. When you type your way to the end of a line, the 
next word automatically jumps down to the next line. If you press 
Return in the middle of a sentence, you mess everything up. 

v Put only ONE space after a period. 

This was a hard one for me to swallow, too. But it's true! 

If that last statement gives you uncontrollable muscular facial spasms, I don't 
blame you. After all, I'm telling you to do something that you were explicitly 
taught not to do by your sharp-tongued high school typing teacher. 

Nonetheless, don't put two spaces after a period. Typewriters print letters 
onto paper by slapping tiny metal blocks against a ribbon, and every block 
(every letter) is the same width- including the space. But on a Mac, every 
letter has a different width. Look how much wider this W is than this I, for 
example. On the Mac, a space is already extra wide, thus saving you that 
precious calorie you would have exerted to press the spacebar a second time. 

Why aren't you supposed to press Return at the end of each line? 

For the first time in print (in case you missed the other editions of this 
book), here's an actual example of the kind of mess you can get into by 
pressing Return after each line of text. Start with the original passage. 
Suppose you decide to remove Mr. Robinette's title, "the principal," because 
everybody already knows what kind of guy he is. 
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You want to get rid of this text. 

1:8 E ~ Note Pad 

I At empttng to stop the rtght, 
JmBil!lliii~Mr. Robinette, 

'

lost hts rooting end fell tnto the 
bleechers. 

But suppose you'd been foolish enough to press Return after each line of 
text. If you remove those highlighted words, the words "Mr. Robinette" flop 
back to the left side of the line, but the rest of the sentence stays where it is, 
looking dumb. 

l ook what happens if you press Return after each line. 

Note Pad 

Attempting t o stop the fight, 
Mr. Robtnette,-------i-' 
~ ost hts rooting end rell Into the 
bleechers. 

On the other hand, if you hadn't put Returns into your text, you'd get this 
figure, where everything looks peachy. 

Note Pad 

Attempting to st op the f ight, 
Mr. Robinette lost his rooting 
end fell Into the bleecher~ 

Typing on a computer has a few other rules, too, but breaking them isn't 
serious enough to get you investigated by the school board. So dig in. 
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You should see a short, blinking vertical line at the beginning of the typing 
area: the insertion point. It's called the insertion point because it shows you 
where the letters appear when you start to type. 

Type the passage below. If you make a typo, press the Delete key, just like 
Backspace on a typewriter. Don't press Return when you get to the edge of the 
window. Just keep typing, and the Mac creates a second line for you. Believe. 

The teacher's screams could be heard throughout the school as the student 
attempted to recapture his snake and return it to the aquarium. 

See how the words automatically wrap around to the second line? This 
feature is called, with no small measure of originality, word wrap. 

But suppose, as your novel is going to press, you decide that this sleepy 
passage really needs some spicing up. You decide to insert the word terrified 
before the word screams. 

Remember the blinking cursor- the insertion point? It's on the screen even 
now, blinking calmly at the end of the sentence. If you want to insert text, 
you have to move the insertion point. 

There are two ways to move the insertion point. First, try pressing the arrow 
keys on your keyboard. You can see that the up- and down-arrow keys move 
the insertion point from line to line, and the right- and left-arrow keys 
move the insertion point across the line. Practice moving the insertion 
point by pressing the arrow keys. 

If the passage you want to edit is far away (on another page, for example), 
using the arrow keys to move the cursor is inefficient. Your fingers would be 
bloody stumps by the time you finished. Instead, grab that mouse: 

1. Using the mouse, move the cursor (which, when it's near text, looks 
Uke this I ) just before the word screams. Cllck the mouse. 

The tea<:her's~reams <:ould be h&ard ttroughoutthe 
school as ttl& student attempted to recapture his snake and 
return it to ttl& aquarttm. 

This is as confusing as word processing ever gets - there are two little 
cursors, right? There's the blinking insertion point, and there's this I, 
which is called anI-beam cursor (it looks like an oversized capital letter I). 
In fact, they're quite different. The blinking insertion point is only a 
marker, not a pointer. It always shows you where the text typing will 
appear. The 1-beam, on the other hand, is how you move the insertion 
point to a different location; when you click with the I-beam, you set 
down the insertion point. 
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2. Type the word terrified. 

The insertion point does its deed, and the Mac makes room on the line 
for the new word. A word or two probably got pushed onto the next 
line. Isn't word wrap wonderful? 

So much for inserting text: You click the mouse (to show the Mac where you 
want to start) and then type away. But what if you need to delete a bunch of 
text? What if you decide to edit out the first half of our sample text? 

Well, unless you typed the challenging excerpt with no errors, you already 
know one way to erase text- by pressing the Delete key (which is called 
Backspace on some keyboards). Delete (or Backspace) takes out one letter 
at a time, just to the left of the insertion point. 

That's not much help in this situation, though. Suppose you decide to take 
out the first part of the sentence. It wouldn't be horribly efficient to back­
space over the entire passage deleting the correct information just so that 
you could work on the beginning. 

Instead, you need a way to edit any part of your work, at any time, without 
disturbing the stuff you want to leave. Once again, the Macintosh method 
saves the day: 

I. Using the mouse, position the 1-beam cursor at the beginning of the 
sentence. 

This takes a steady hand. Stay calm. 

2. Click just to the left of the first word and keep the mouse button 
pressed down. Drag the 1-beam cursor to the end of the word as. 

As you drag, the text gets highlighted, or selected. 

the student 
ettempted to recapture hl s sneke end retum It to the aquarium. 

If you're especially clever and forward-thinking, you have selected the 
blank space after the word as, as well. 

All right. In typical Mac syntax, you've just specified what you want to 
edit by selecting it (and making it turn black to show that it's selected). 

3. Press the Delete key. 

Bam! The selected text is gone. The sentence looks pretty odd, though, 
because it doesn't begin with a capital letter. 
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4. Using the mouse, position the cursor just before (or after) the letter t 
that now begins the sentence. Drag the cursor sideways across the 
letter so that it's highlighted. 

lhQ stu<k>ntaltQmptQd to rQ¢apt<.rQ hlg &nakQ and rotum tto 
the aquarium. 

Here comes another ground rule of word processing. See how you just 
selected, or highlighted, the letter t? The idea here is to capitalize it. Of 
course, using the methods for wiping out (and inserting) text that you 
learned earlier, you could simply remove the t and type a T. But because 
you selected the t by dragging through it, replacing it is much easier. 

5. Type a capital T. 

The selected text gets replaced by the new stuff you type. That, in fact, is 
another ground rule: Selected text gets replaced by the new stuff you type. As 
your Macintosh proficiency builds, keep that handy fact in mind; it can save 
you a lot of backspacing. In fact, you can select 400 pages of text and then 
press one single key to replace all of it. Or you can select only one letter, but 
replace it with 40 pages of typing. 

Hint: If you make a change that you didn't mean to make, go to the Edit 
menu and choose Undo. This step will undo your last action. 

Take a moment now for some unsupervised free-play. Try clicking anywhere 
in the text (to plant the insertion point). Try dragging through some text. If 
you drag perfectly horizontally, you select text just on one line. 

Breathklssly, he ran lrto the worl<room only to find a line or 
Jar:chine. His eye 

began to twtch uncontrollably as he ~ alized the parent 
letter would notoogolng ~that afternoon. 

If you drag diagonally, you get everything between your cursor and the 
original click. 
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You de-select (or, equally poetically, an-highlight) text by clicking the mouse. 
Anywhere at all. 

Try pointing to a word and then double-clicking the mouse: You easily select 
exactly that word, without having to do any dragging. 

Please Salle Me! 
No, I can't save you from that conference with the parent who "used to be a 
teacher" and seems to think she can handle things better than you. But I can 
save you from the severe bouts of depression suffered by those who simply 
create and print ... only later to find small, yet crucial, errors - such as 
incorrect spelling. Teachers never make spelling mistakes. And if they do, 
there's always a parent ready to circle this gross error and bring it to their 
attention. 

It may terrify you- and it probably should- to find out that you've been 
working on an imaginary document. It's being preserved only by a thin 
current of streaming electricity. It doesn't exist yet, to be perfectly accurate, 
except in your Mac's memory. 

You may recall- if you happened to wade through Chapter 2 -that 
memory is fleeting. (Specifically, I mean computer memory. Yet, isn't it 
amazing how so much of this terminology applies to students?) In fact, the 
memory is wiped away when you turn the Mac off- or when your curious 
toddler thinks the little red light on the surge protector switch needs to be 
pushed. At that moment, anything that exists on the screen is gone forever. 

Therefore, it is very important to save, save, save. When you save your 
work, the Mac transfers it from transient, fleeting, electronic memory onto 
the good, solid, permanent disk (either your computer's hard drive, a floppy 
disk or if you choose, an external hard drive). There your work remains, 
safely saved. It will still be there tomorrow. It will still be there next week. It 
will still be there ten years from now, when you're ready to retire and write 
your memoirs. 

In ClarisWorks, the save command is located in the File menu. Try to save 
the wonderful sentence you typed about the teacher and the snake. 

1. From the f11e menu, choose Save. 

You are now presented with the Save File dialog box, because the 
computer needs to have a little chat with you before proceeding. 
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le ClarlsWorlcs 4.0 Folder.., I c:::::~ Macintosh HD 

if1j c larisWorks I 
B ClarisWorks 4.0 Read Me 
~ ClarlsWorlcs Assistants :. '~ 
~ ClarlsWorlcs Libraries ;;,1 
CJ ClarlsWorlcs Scripts ., ~ 
QJ ClarisWorlcs Stationery ~.~ 
LJ ClarlsWorlcs Styles 

Eject 

Desktop ) 

New CJ ) 

Cancel ) 

n Saue lJ 

oogoiiJj 
Documtnt St~ttontr\1 

What the Mac wants to know is "Under what name would you like me to 
file this precious document?'' 

And how do you know this? Because in the blank where it says Save As, 
there's a proposed title that's highlighted (selected already). And what 
do you know about highlighted text? Anything you start typing will 
instantly replace it. The Mac, in its cute but limited dialogy way, is trying 
to say that it needs you to type a title. 

Make a promise to me now that you will always name your work before 
clicking the Save button. There's nothing worse than a file, a floppy 
disk, or a folder that doesn't have a name! 

2. Go ahead, do it. Type Snake Episode. 

At this point, you could just click the Save button. The Mac would take 
everything in perilous, fleeting memory and transfer it to the staid, safe hard 
drive, where it would remain until you're ready to work on it some more. 

However, there's a bunch of other stuff in this dialog box. Because the Save 
File box can be a major source of confusion to beginners, I think a tour is in 
order. 

Nafli1J.atin9 the Safle File 
(and Open File) box 
Refresher course: Your computer helps you organize files by providing 
electronic folders and folders within folders. 
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Well, the point of all that complicated-looking stuff in the Save File dialog 
box is a miniature version of that filing system. 

I. Go to the File menu and choose Save (if you haven't already done so). 

lei! ClarlsWorks 4.D folder •I =Macintosh HO 

D ClarlsWorks Assistants 
(J ClarlsWorks Libraries 
(J ClarlsWorlcs Scripts 
GJ ClarlsWorks Stationery 
D ClarlsWorks Styles 

~ HlML Primer II! 

Eject 

Desktop J 

New LJ J 

Cancel ~ Introduction to Clo1isWorlcs ~ 

Saue As: [ Saue B 
jclarlsWorks •I 
._I s_na_k_e_E.:....pt_so_d_e _____ _.l <!l ~o fiiJ 

DoCUMnt Sbtion9rl,l 

You may decide that none of the files shown in the window suits you. 
But on your desktop (your computer screen) sits the great little School 
Stuff folder that (I hope) you created in the beginning of this chapter 
(see "Supply List for Word Processing 101"). 

To use that folder to hold your Snake Episode, you need to go to the 
desktop. 

2. Click the Desktop button. 

You see all the items currently on your desktop, including your School 
Stuff folder. 

I iii Desktop •I 
liD Daddy 
EZ1 for Bill 

I!EJJessle & John- Mich8el 
(jg Mommy 
~My Lob Schedu le 

Trash 

You open this folder by either double-clicking the name or highlighting 
the name and then clicking the Open button. Voilii. Your School Stuff 
folder is open. 
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Now we see that there is a folder inside the School Stuff folder that's 
titled Funny Anecdotes. I think the Snake Episode is pretty darn funny, 
so file it there. 

3. Highlight the Funny Anecdotes folder and click Open (or simply 
double-click Funny Anecdotes). 

If you haven't already done so, type in the name for your story, Snake 
Episode. 

4. Now click the Save button. 

I e School Stuff •I G::J Madntosh HD 
JECJ::::::. =:=Fu=n::::\:n~y ~Rn~e~cd$o~te~s~;;;;;;;;;b=r.::Q:il I Eject 

( Desktop ) 

New LJ ) 

I Cancel ) 

Saue As: (I Saue J 
ltlarlsWorlcs •I 
L...ls_nu_k_e_E;;_pl_so_d_e _____ ~l ® ~0 (y 

Documtnt St~tion.ry 

You're done! Your document has found a home. It's been snugly tucked 
away in the Funny Anecdotes folder, which is inside the School Stuff 
folder. 

I know, it's scary to put your trust in a machine; you probably feel like 
printing your work and running to the nearest copy machine to make five or 
six extra copies- but don't. Let's prove that you really did save this 
document. 

Look for the Application menu on the upper-right side of the screen. It lists 
all the programs that are running at once. Choose Finder from the Applica­
tion menu. When you choose Finder, the folders, window, and Trash can pop 
up. And there we see our School Stuff folder. Go ahead. Open it up (double­
click). You see the Funny Anecdotes folder. Open that one, too. And, if 
everything went well, you should now see your Snake Episode document (as 
shown in Figure 7-3). 

You did it! Technology can be trusted. 
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Figure 7-3: 
Your Snake 

Episode 
document is 

nestled 
inside a 

folder 
within a 

folder. 

School Stuff 
I ttem 119.2 MB in disk 91 8K available -' 

Funny Anecdotes 

51 Funny Anecdotes -
litem 119.2 MB in disk 918K avana 

g ~ 
- r-----1-

Snake Episode 
'V 

¢1 I~ '2l 

Closin9 a file1 with a sitjh 
You created your lesson plans, it's 5:15, and everyone's out of the building. 
You save the work in the Lesson Plans folder you proudly created at the 
beginning of the school year and are ready to hit the road. It'll be there 
tomorrow, ready to print. 

~~ Click the close box in the upper-left corner of the window. 

In the Mac's universal language of love, clicking the small square up there 
means "close the window," as you may recall. If all went well, the window 
disappears. 

How to find out what I/.OU
1re doin9 

No, I'm not going to help you rethink your career decision - although there 
are days when we all wonder about that mysterious force pulling us back 
each September. 

Just because you closed your document doesn't mean you left the program. 
In fact, if you pull down the Application menu on the top-right side of the 
screen, you see that ClarisWorks is, in fact, still running. (It's the one with a 
check mark beside it.) 

Hide ClalisWorts 3.0 
Hide Others 
Show All 

[l At Ease 
""im ClartsWorks 3.0 

[J Finder 
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But they told me NEVER to save to the hard drive 
This warning isn't uncommom Many schools 
request that teachers and· students tefrain 
from saving their work on the computer's hard 
drive. Imagine how quickly _the computer's 
hard drive spa·ce would fill with clutter in a 
school with more than l,OOO·students and an· 
other .50 or so teachers I 

It's very wise for teachers to purchase a. box 
.of disks (either preformattedfor the Mac .or 
those you can format yourself) on which to 
save work. 

The procedure for saving to disk is similar to 
what you just learned. This time, after you 

~ .choose Save, slide your disk into the computer. 
When you see the contents of the disk open, 
olickthe bottom box undetSave As. Type in the 
name of your document Click Save. The com­
puter saves the information to your disk. 

Now you are free to carrythis disk to any com­
puter (provided it has ClarisWorks loaded) and 
do your work. This-practice comes in handy in 
schools with limited numbers of computers 
scattered throughout the building. (Be sure you 
stick a label on the outside ofyour disk.) 

You can bring the Finder to the front by choosing its name from the Applica­
tion menu -without exiting the word processor. They both can be running 
at the same time, but only one can be in front. If you're asking yourself, 
"What in the world is she talking about," turn back to Chapter 1 for a 
refresher course. 

In fact, that's the amazing thing about the Mac (using System 7 or higher). 
You can have a bunch of programs all running at once. The more memory 
your Mac has, the more programs you can run simultaneously. 

If you want to completely quit ClarisWorks, make sure that it's still the active 
program. Go to the File menu and choose Quit. 

How to retriefle er document 
Pretend it's tomorrow. You're at school and the principal asks to have a look 
at your plans for next week. You are in complete control. 

You turn to your Mac. Double-click your hard drive icon (usually in the top 
right hand corner of your screen) and double-click ClarisWorks. Here's 
where it gets tricky, but you can handle it. If you saved your work to a disk: 

1. Click the Cancel button when the dialog box appears asking you to 
select a type of document. 
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,•,-···:,._:· .. : ·.:', . ·' 

From the way ·I describe the· terrifyingly,~eU;~, ;>:C.Iick,¥ss if:you ,do wantto<save yolirvvork. Click. · 
cate- condition . of. a docume.nt: :that's :ort th~: c }~o if yo11 were only goofing around or. showing 
screen (thatyou haven't s;nled~yet) ~.that is,·. · .iffft YQUt: Mac to. somebody and "~onrt want to 
precariously .. close to oblivion, keptalive.·()lily _;presr:tr.Ve your lab~rs. Click -Cancf!l if you 
by electric current-you· may think that clos.:. -' · -·chang~ ypur.inind completely:a bqUt clo~dng th-EJ 
ing a window is a dangerous act. Aft~.i" all, . ·~ocyment and wantto keep Working on it 
what if· y.ot1 forgot to save. some ·work?· 
Wouldn't ¢losing the window mean ·tosingthat 
criticarmemo? . ' 

N,ot re_alty.lf-yQu_try:to ·c.t.()s~: a do.cumE!ntr.;tl)e 
Mac)i!t~n~t/e.t.YtlY~,proc~~~:unt11.ita~kS,.ifYP4~t~·-···· 
sure~yQuwanttQ'I()se alhhe vvorkY,oJa!ve(~c)m~~· · 
It will say:som~ttiing~Uke: . 

Saue changes to "Snake 
Episode" before closing? 

n Yes II 
( No ) ( cancel ) 

2. The dialog box disappears, and you just see your Menu bar. From the 
File menu, choose Open. 

3. Insert your disk. The Mac automatically reads the disk and shows its 
contents. Click the document you want to work on. When it's high­
lighted, click Open. 

(Or simply double-click the document name- double-clicking accom­
plishes the same thing as highlighting something and then clicking 
Open.) 

If you saved your work to the computer's hard drive: 

I. Go to File and choose Open. 

The ClarisWorks 4.0 folder appears with a list of choices. 

2. Locate the folder titled Weekly Lesson Plans and highlight it. 
Click Open. 

3. The folder's contents are listed. Find the plans you want to work on, 
highlight your choice, and click Open. 

Your plans are there, just the way you left them (ready to be printed and 
handed to your principal). Hey, why does the principal want to see your 
plans, anyway? 
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Salle Me AIJ.ain! 
Now, how about making some changes to a document that you already saved? 

Prepare to test your retrieval skills. Find the Snake Episode document and 
make some changes. 

Now, if that toddler plays with the little button again (or you forget to pay 
the electric bill and the electricity is shut off), you lose all the work you 
added to this priceless document. 

Therefore, you have to use that trusty Save command each time you make 
changes that are worth keeping. The Save dialog box does not appear on the 
screen each time you use the Save command (like it did the first time). Only 
the very first time you save a document does the Mac ask for a title (and 
folder location). 

You probably know horror stories about people who lost hours of work 
when some glitch made their computers crash. Well, usually it's their own 
darned fault for ignoring the two most important rules of computing: 

Rule I: Save your work often. 

Rule 2: Never forget Rule I. 

"Often" may mean every five minutes. It may mean after every paragraph. 
The point is to do it a lot. Some word-processing programs have auto-save 
features that complete this task for you every few minutes. 

Trust me on this one. The day- no, the minute -you forget to save 
something you typed, you'll experience what's called a system crash. Result: 
loss of your entire document to the technology wasteland. 

StationerlJ 
The Mac has a neat feature that allows you to save a document as Statio­
nery. Stationery is a special type of document that retains your original 
saved piece and gives you a copy of that document to add to - or alter­
and then save with a different name. 
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® ~ Here's how it works. When you click the Stationery button in the Save box, 
~ that document is saved as it is and can't be altered and saved under the 

Stition•rv • 
same name agam. 

Let's talk lesson plans again. Say you wrote the times and activities that take 
place week after week. Before you filled in the specifics, you save this 
"skeleton" of your plans as a Stationery document. The next time you pull 
up the document, make changes (fill it in with specifics), and go to Save­
ClarisWorks won't let you save it under the same name as the template. 
That's good news: Your template or stationery is always there, ready for you 
to fill in. 

What 1/.0U are real/11 doin9: Satle As 
In reality, you are using the Save As command. Save As means that you are 
saving a document previously saved under another name with a different 
name this time. That sounds very confusing. Read it again slowly and raise 
your hand if you have questions. 

We get into this stuff later in this chapter when you create your own statio­
nery. You'll get it- I promise. 

AIUialJ.S Hafle a Backup 
You know all about this rule. At my school, we call it CYA (Cover Your You­
Know-What). We apply this rule to notes sent by parents, memos from the 
county, proof of in-service credit, and so on. You have to look out for 
yourself in the education jungle, and I always want to have proof when a 
dispute arises. 

The same is true in the world of computing. Only here, your protection 
comes in the form of backup disks. If it's important enough to spend time 
working on, it's important enough to back up. This means making a copy of 
the things you saved on your hard drive. Yes, even your trusty hard drive 
can fail. Therefore, make backups of its contents as often as possible -
once a week is a good schedule. 
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The idiot-proof gqicte to backing up_-
Put a blank floppy disk in the disk drive. (If it's a 
brand new disk, you are asked to initialize it; 
do so~) 

Now, selectthe icons of the documents you 
want to back up. Drag them, together or one 
by one, onto the floppy disk icon. If the floppy 
fills up, insert another one and continue. label 
the floppy disks "backup" (and note the date). 
Keep them away from magnets and tele-.. 
phones~ 

~ If you're a businessperson, you may'even\/Vant 
to invest in a backup program, which essen­
tially does the work for you automaticall,y. 
DiskFJt, Redux, and Retrospect are some popu­
lar backup programs. If you have a Performs, 

_ you already own a backup program, you luckY 
dog, called Apple Backup. · 

Now Let's Do a Little CustomiziniJ 
After you understand all the word-processing basics, and start to feel comfort­
able with this new version of typing, you can try out a few tricks and tips! 

Select 
The first thing you must do before making any type of modification is select 
the text you want to change. You know that you made a selection success­
fully when your text is highlighted. You can select in a number of ways: 

Y' To select an entire document, choose Select All from the Edit menu. 

Y' You can select text by placing the insertion point to the immediate right 
of the last word or letter you want to delete and then clicking and 
dragging to the left. (Or start at the left and drag right - it doesn't 
matter.) 

Y' One of my favorite ways to choose a word, a line, or an entire para­
graph is by double-, triple-, or quad-clicking. 

Go ahead and try multiple clicking. Click once to place your cursor in 
the middle of a word. Click again and you select the whole word; click a 
third time and you get the whole line, and a final click selects the entire 
paragraph. 

If multiple clicking doesn't work the first time you try it, you probably 
allowed too much time between your clicks. Try again, but this time 
don't pause between your clicks. 
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Cut/Delete 
If you want to cut the selected text, do one of the following actions: 

I 
"" Start typing what you want to replace the highlighted text with. 

"" Press your delete key and watch the text disappear. 

""Use the keyboard shortcut, H-X, to cut the text when it's highlighted. 

CopiJ & Paste 
I use the copy command quite often when I'm preparing how-to handouts for 
the teachers at my school. If a teacher wants directions for creating columns 
in a word-processing document, I open a chapter or article I've already 
written on the subject, select the text that answers her questions, and 
choose Copy (88-V) from the Edit menu. I can then close that document with 
everything still intact- I didn't cut anything out, I simply made a copy. 
Next, I open a new word-processing document, place my insertion point 
where I want the new text to appear, and choose Paste from the Edit menu 
(38-V). You can copy and paste between different documents or within one 
document. Learning to use the copy command saves you a great deal of 
extra typing. 

Undo 
The Undo command reverses your last action and only your last action. If 
you make a mistake and realize it immediately, go to the Edit menu and 
choose Undo. The suffix attached to this command depends on what you 
just did (and expect to undo): Undo Typing, Undo Placement, and so on. 

Form and format 
One of the important differences between a typewriter and its replacement­
the personal computer- is the sequence of events. When you use a type­
writer, you set up all the formatting characteristics before you type: the 
margins, the tab stops, and (for typewriters with interchangeable type 
heads) the type style. 

But the whole point of a word processor is that you can change anything at 
any time. Many people type the text of an entire letter (or proposal or memo) 
into the Mac and then format it. When you use a typewriter, you may discover, 
after typing the entire first page, that it's slightly too long to fit, and your 
signature has to sit awkwardly on a page by itself. With a Mac, you see the 
problem and nudge the text a little bit higher on the page to compensate. 
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Figure 7-4: 
The Return 
character 

moves text 
down on 

the page. 

Word processing has other great advantages: 

v No cross-outs 

v Easy corrections that involve no white-out and no retyping 

v A permanent record of your correspondence that's electronic, not 
paper 

v A selection of striking typefaces (fonts) in a wide range of sizes 

v Paste-in graphics 

I think it's safe to say that once you try it, you'll never look back. 

The return of Return 
With all the subtlety of a Mack truck, I remind you that you're forbidden to 
use the Return key at the end of a line. Still, that rectangular Return key on 
your keyboard is important. You press Return at the end of a paragraph, and 
only there. 

To the computer, the Return key works like a letter key- it inserts a return 
character into the text. It's just like rolling the paper in a typewriter forward 
by one notch. Press Return twice, and you leave a blank line. 

The point of Return, then, is to move text higher or lower on the page. 
Check Figure 7-4 for an example. 

Drag through this area and press Delete to move the rest of the text up. 

;J 
.I 
.I 
~ 
Dear M'"S.-Becker,.l 
.I 
t.am.Vtfitlng.to.fntonn.you.that.Jessie-has.qual!f~.for.the. 
gilte<l.and.talente<l.program .. Never.have.we~xperlenced. 
such-lntellect-ln.a.chlld-so.young .. Jessl&-w!ll-be.a.wonderful· 
asset-to-our-program .and-1-look.forward.to.fnc ludlng. her-ln. 
our.group . .l 
.I 
Please.complete.and.return.the~nclosed.forms.by.next. 
Friday .. l.would.llke.Jessie.to-joln.our .group.as-soon.as. 
possibte . .l 
.I 
1-look .forward.to.meeting.you.soon . .l 
~ 
Thanks !+I 
Mrs.-Robinette 
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So, if you want to move text up on the page, drag through the blank space so 
that ifs highlighted. Then press Delete. Of course, you just selected the 
usually invisible Return characters. If you delete them, the text slides up the 
page. (See the sidebar, "Seeing the unseen," if you need to satisfy your 
curiosity right now.) 

Combine this knowledge with your advanced degree in Inserting Text. 
(Remember? You click to place the blinking insertion point and then type 
away.) You can see how you make more space between paragraphs or push 
all the text of a letter down on the page. 

Come back and play with the other preferences when you find some time. 

Appealing characters 
Another big-time difference between word processing and typing is all the 
great character formatting you can do. You can make any piece of text bold, 
italic, underlined, all of the above, and more. You also get a selection of 
great-looking typefaces (fonts)- only a few of which look like typewriter 
stuff. 

Here's the scheme for changing some text to one of those character formats. 
Go for it. 

1. Select some text by dragging through it. 

Remember, you can select a single word by double-clicking it. To select 
a bunch of text, drag the cursor through it so that it turns black. The 
highlight-effect identifies what you want to change. 

ClarisWorks keeps its Bold, Italic, and Underline commands in the 
Style menu. 

Seeing the un$een 
l said that returns are usually invisible .. How­
ever, every time you press the Return.key, the 
Mac actually does plop down a symbol onto 
your screen. Same thing with the ·spacebar. 
Same with the Tab key. 

In ClarisWorks, the command to see these 
neat symbols falls under the Edit met1u in the 
Preferences category. Choose Preferences 

from the Edit menu and .vou see ano~her 
screen with lots of choices - some neat 
options, but none truly crucial. Notice· the 
box that reads Show lnvisibles. Click this 
box to see all those clever characters. Other­
wise, leave it blank- and only the computer 
sees them. 
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Font-crazed kids 
Be warned, kids go crazY ,Jviihthese options.] 
guesswe don~t.give~them enough choices.or 
creative.Qutlet•thes.e ~.avs.JA'hPtknoyY$?Any-. 
way~ att~r.intro.~u~ing'the_.concfept"of chatac~ 
te.dorrr,atting,.IIJ~uaUylef.them ij~ve. an.entire 
period to get ~~mm.ar w~.theiroptions~ Then, 

when it's time to put what they learned into 
practice, I find it best to set a few limitations. 

).Ot~el'\l,lli~e, they spend the entire work period 
i:11ay1ng-wltti character formatting, instead of 
. generating a product 

2. From the Style menu, choose Bold. 

You can apply several of these formats to the same text, too, although 
you won't win any awards for typographical excellence. Try changing 
the typeface (font) also. The various fonts are called things like New 
York, Chicago, Times, and Geneva. To change the font, go to the Font 
menu and take a look at your choices. The final trick involves changing 
the size of your text. You can do this by going to the Size menu. Your 
font looks its best if you choose only from the sizes that are written in 
an outline or hollow-style format - not those written in solid. Trust me 
on this one; it will print, yes, but it won't look as good as it could. 

New York 12 point plain 
New York 14 point bold Jt6Uc 

lin !mlk nm IP®Hm111J)Hflllm Gtlhmc{l~ 
Ncmw l'mt ~4 n»«»rum1t, n»ftt~Uiml <O>lillillml® 

By applying a variety of styles and adjusting the size, a single font can 
appear in many different ways. Before you know it, those parents are 
going to be waiting eagerly for the next school notice, just to see your 
font creativity. 

FormattiniJ paratJraphs 
Whereas type styles and sizes can be applied to any amount of text, even a 
single letter, paragraph formatting affects a whole paragraph at once. In 
ClarisWorks, these styles are easy to apply. Clicking four times within a 
paragraph highlights the entire passage. Then, by choosing any of the four 
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justification options located just below the menu bar, you can have your text 
become left-justified, right-justified, centered, or fully justified. You can also 
determine the amount of space between each line. Take some time now to 
play with your options before going on to the next exciting lesson. 

SettintJ tabslusintJ the ruler 
ClarisWorks takes the agony out of setting tabs and using rulers. Take a look 
at the ruler in Figure 7-5. 

The solid black triangles on the left and right control the indents. Simply 
click and slide the triangles to the desired position. Don't worry, changing 
your indentation will not affect your margin settings . 

Left margin control 

11 indents 

Centered 
Decimal 

Left justified 

Tabs Line spacing 

Right margin control 

Full 
justification 

Right 
justified 

Centered 

Tabs are nearly as easy. Choose the type of tab marker you desire (left, 
centered, right, or decimal) and click the triangle that represents that type 
of tab. As you click, drag the triangle to the desired pos ition. You can set as 
many tabs as you need; the little triangles s imply reappear after you drag 
one off - you have an unlimited supply. 

You can hide this ruler by choosing Hide Rulers from the View menu. 
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1]t)~~~~~~~~~~~~~~~~ 
Guide to power typing 

Because you can format text after you've 
typed it doesn't mean you have to. Most users 
get used to the keyboard shortcuts for the 
common style changes, like bold and italic. 
They're pretty easy to remember: In 
ClarisWorks, you get italic by pressing :IC-1, 
and bold with 00-B. 

You can press either key combo just before 
you type the word. For example, without ever 
taking your hands off the keyboard, you could 
type 00-8 once to turn bold on for the next 
burst of typing and 00-B again to turn it off­
all without ever having to use a menu. Handy, 
huh? 

Top Ten Word Processin9 Tips 
1. Select a word by double-clicking. Then, if you hold down on the second 

click and drag sideways, you select more text in complete one-word 
increments. 

2. Never, never, never line up text using the spacebar. It may have worked 
in the typewriter days, but not anymore. (And it may look fine 
onscreen, but it won't line up correctly when you print.) So instead of 
using spaces to line up columns, rely on tab stops to get the job done. 
Practice setting tabs and use them! 

3. You can select all the text in your document at once by using the Select 
All command (to change the font for the whole thing, for example). Its 
keyboard equivalent is 00-A. 

4. Aesthetics Rule of Thumb: Don't use more than two fonts within a 
document. (Bold, italic, and normal versions of a font only count 
as one.) 

5. Don't use underlining for emphasis. You're a typesetter now. You have 
italics! Underlining is a cop-out for typewriter people. 

6. The gray box in the scroll bar at the right side of the window tells you, 
at a glance, where you are in your document: 

The position of the o 
box in the scroll bar 
tells you whether 
you are at the 
beginning ... 

... in the middle ... 

. .. orthe end of 
your document 
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By dragging this box, you can jump anywhere in the document. 

You have two other ways to move around: 

Click in the gray part to jump 
one screenfulup or down. Click (or hold down) 

the arrows to scroll 
one line at a time. 

Click in the gray area above or below the scroll box to jump one 
screenful up or down. 

Click or hold down the button with the up- or down-arrow to move up 
or down your document one line at a time. 

7. You already learned how to copy some text to the Clipboard, where it 
rests until time to paste it somewhere else. Another useful technique is 
to cut text to the Clipboard. Cut works just like Copy except it snips the 
selected text out of the original document. (Cut-and-paste is how you 
move text from one place to another and is not to be confused with the 
skills required to go from kindergarten to first grade.) 

8. It's considered uncouth to use "straight quotes" and 'straight apostro­
phes.' They harken back to the bygone days of typewriters and mimeo­
graph machines. Instead, use "curly double quotes" and 'curly single 
quotes.' See the difference? In ClarisWorks, you can make this switch 
easily. Choose Preferences from the Edit menu. In the dialog box that 
appears, choose Smart Quotes. 

9. If there's an element that you want to appear at the top of every page, 
like the page number or the date, don't try to type it onto each page. 
Not only is that a waste of effort, but the minute you add or delete text 
from somewhere else, this top-of-the-page information becomes middle­
of-the-page information. 

Instead, use the Insert Header or Insert Footer (for the bottom of the 
page) command found in the Format menu. 

10. Be painfully aware that what you see on the screen isn't always what 
prints out. The number one source of rude surprises happens when you 
write with a Mac connected to one printer (like a StyleWriter) but print 
on a different one (like a laser printer). Because the typefaces are 
handled differently for each printer, you discover that sentences, lines, 
and page endings in printout form don't necessarily match what you 
see on the screen. This is another problem that I experience when 
creating documents at home and waiting to print them at school on the 
laser printer. 
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The solution is simple. Before you print, trick the Mac into thinking it 
has that laser printer already attached, so you can see what it's about 
to do to you. From the Apple menu (tl), select Chooser. You should see 
the name of several printers there, like StyleWriter or LaserWriter 
(which is used for all brands of laser printers). Click the one you plan 
to print on, even if it's not currently connected. 

If you don't see more than one printer icon in the Chooser, you have to 
reinstall them from your System or printer disks. 

Get Busu! 
Feel like a word-processing expert? If you're tired of reading and practicing, 
how about getting busy? 

Note: The Macs For Teachers CD contains a sample letterhead that you can 
use by simply changing my name- if you're not ready to learn a new skill 
right now. 

CreatiniJ a letterhead 
Every year, I like to create my own stationery for those times when my 
messages need to have a more personal tone provided by (dare I say) 
handwritten notes. Yes, even I still send home handwritten notes. They let a 
parent know that, in this age of technology, there's still a warm, loving 
individual behind the teacher's desk. 

1. Open a new word-processing document. 

You remember: Double-click ClarisWorks to open the program. When 
the New Document dialog box appears, choose Word Processing. 

2. From the ruler, choose the alignment setting of center justification. 

Untitled 4 (WPl 
14 I I I I~ I 

3. From the Font menu choose Times. Then choose 24 points as your 
Size and bold and italic as your Style. 

4. Type your name and then press Return. Type the name of your 
school and then press Return again. 
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Mrs. Robi.aeue 
Norco.a Eleme.acary 

5. Now let's add another skill to your repertoire. First, click the small 
picture of a page that sits in the bottom-left corner of the screen oust 
to the left of the page number). 

After you click this button, a tool box appears to the left of your work 
area. See the arrow in the top-left corner of this tool box? Click it. (It 
should become highlighted.) 

6. If you are using ClarisWorks 4.0, go to the File menu and choose 
Library. 

A pop-up menu appears with a list of available clip art libraries. Select 
the library that you want to view and scroll through your clip art 
choices. When you find the graphic that you want, click on it (a hand 
appears), and with the mouse button still pressed down, drag the 
picture onto your page. 

Or-Cop 
~~tit> lor 
l tllllb 

~-
. . 
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7. If you are using ClarlsWorks 3.0, go to the File menu and choose 

Insert. When the dialog box appears, double-click the Clip Art folder. 

Take a look at the list of clip art that Claris so thoughtfully installed for 
you! Scroll through your choices. If you see one that makes you curi­
ous, don't choose it. Instead, highlight the choice and then click the 
Create button in the lower-left corner of the dialog box. This action 
creates a preview of the artwork that allows you to make a choice 
without going back and forth between your document and the Clip Art 
folder. Yeah, the choices aren't that incredible- but they are free. (You 
can purchase clip art for very reasonable prices and easily add the 
images to your files.) 

8. Highlight your Clip Art choice and click the Insert button. (I choose 
the Macintosh - big surprise.) The image appears on your stationery. 

9. Now, class, we should all be in the same spot at this time, looking at 
our document with some type of picture somewhere on the screen. 

Do you see the little squares at the corners of your picture? (If you 
don't see four black squares- the graphic's "handles"- you need to 
click in the graphic and start all over again. Make sure you choose the 
arrow in the tool box before you choose your picture.) These squares 
help you adjust the size of your picture. Point to one of the squares; 
click and drag the corner. You can do some pretty strange things to 
your graphic. 

... 
·· . 

. Can't,ind.·Ctip Art? 
If yo_u• are, ~sing an ·e·,.d.ier=_.v.e·r,ioo ot 
ClarisWorks (e~riJe.r:·:thafn.~Q)};yolJ;,\IIIQO~find a · 
Clip Art file ·alre~tdy. inSt@ll.tdf_ ,l~$fead, _aft~~ 
highlightitfo ttte.·jrr.QW'ir(th~ to(ll:box, gg_t<Jithe 
~ppl_a MenuJi) a~-~ open'~«!)Scra~boo~ 

. . -

J,·know; thf!re;:are_n~t.many'~to"c~·oo~e!from,·.bui 
you:,e:an ~dd.,;to.the,C:csllep;tiPil~lat't•--:~orinQw~ 

-iirtd :~s~m,tt1iq_g;: you can li\(e w1th .. Wher:1 the · 
' ; -~, .; 

:'Pi~te~'you have,·cbosen.is .. on the screen, go 
tcHhe Edit menu~and cfio9s~,Col)y. Remember 
t~{! -~Upb.qarcl _ w~_le.llr.ned about in Chapter 4? 
·W~II, .your picture is onthafbaby,.right nowl 

. . . 

. t;:lo-~·e:the:Scrapbook.(click.the 'ittfe. boxin the 
~top~l.att·corner ofth~ Window)~Yqu·sho~ld s~te 
~yo(j_r~a~io?e.rv ~gain •. G~·~olhe Editroenu and 
~::h.OO$~··P~ste~ You~ve addedGr.aphtcs. 



120 Part II: ClarisWorks- The Loaded Spud ___________ _ 

10. Now, whenever the squares are visible, you can also move that 
graphic anywhere on the document. Simply click in the center of 
your graphic and drag to the to~right comer of your stationery. 

(Click off the graphic to make the squares go away. Click on the graphic 
to make them appear again.) 

•• • 

~ 
11. Symmetry is everything, so let's put another Mac in the to~left 

corner. Who can remember bow we accomplish this amazing feat? 
That's right: Copy and Paste. 

If the four corners are showing around your graphic, simply go to the 
Edit menu, choose Copy, go back to your stationery, and choose Paste. 
Follow Step 10 (mentioned previously) to maneuver that baby into 
place. Looking good! 

Mrs. Robinerre 
Norron Ele.menrary 

12. Now we are ready to save this as a Stationery me that you can pull 
up quickly and easily. Go to the File menu and choose Save. 

When the dialog box comes up, notice the choices in the bottom-right 
corner: Document and Stationery. You want this to be saved as Statio­
nery, so click the button. Now the Save As box is highlighted and ready 
for you to name your creation. Let's call it Personal Stationery. ( Remem­
ber, just start typing over the highlighted area; your words automati­
cally replace Untitled 1.) 

QJ Cerlificate.Two 
Qj Class Seating Chart 

Classroom I cons 

Saue Hs: 
lclarisWorlcs ..,I 
I Personal StationerY 

H Saue l 
( Cancel I 
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13. Click Save. 

14. A Document Summary appears for you to make a few notes about this 
supreme piece of work. Type Personal Stationery for the title, put 
your name as the author, and create a name for the category. 

Document Summary 

Title: I Personal Stationery 

Author: I Michelle Robinette 

Uerslon: 
~==========================~ Keywords: 
F=========================~ 

Category: I School 
~==========================~ 

Descrlptlon:l..._ ---------------' 

(Cancel ] ([OK]) 

The rest you can fill in later if you need more detail. For now, this 
will do. 

15. Click OK. You did it! 

If you want to prove that you really have created a Stationery file, go to 
File and choose New. When the screen appears, click Use Assistant or 
Stationery. Then, beside the word Category, you see the title General 
with a black arrow pointing downward. Click General and look at the 
list. Personal Stationery comes up in the scroll box. I'm proud of you. 

The beauty of saving something as Stationery is that when you open the 
document, ClarisWorks creates a copy and names it Untitled, thus leaving 
your original stationery document intact. You can rename your new docu­
ment when you save it. 

Turn down the corner of this page; the Stationery file function is useful 
when you create a lesson plan and checklists. Think how much time you can 
save by not having to set things up each time you get ready to create those 
required weekly communications. 
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$J,Ving,as .. i,ne~jJI·~ar.ll•r 
. ·- .; :-vers.ions; :,_,4i·Cia~ieWork•, 

; ·, ;tt'~.QQ,;.~te,u~Jog ·~ ;~~~~ign;ptClf!"isW:itt~~~-:~~~ .· , :,rmm4~:T\r,p$:-,.·?@~~.for ypur :dooument.:S~fgr;e 
·"{lit$ :~~Q~~·i&Yi.i\O,'!~$. -~~"9"-~·tY:: ~is .. J'·iUffl~:·i\fJ:Q.t! :: : . .~, '!~li~~ing!· $.a'i,t~; \P~_Ij .down, tfi·~. !Save. ··As· :drop· 
-~ltivc;»lved~ :FitSt; :~hqost .S,av,:-A~Jfroill·thi,.ftlij:~ , .. ~own .:menuC'CW.~ose :elarisWorks,stationery. 

Creating a personalized lesson-plan 
template 
Creating a personalized lesson-plan template is one of those 1-should-have­
done-this-a-long-time-ago things. You know what I mean - things like 
putting up a multipurpose bulletin board that lasts the whole year instead of 
coming up with a new masterpiece every month. 

Lesson-plan templates can be used in different ways. First, you can create a 
standard template with all the "little details" filled in- you know, those 
things that you write in your plan book day after day and week after week: 
lunch times, recess duty, Special Ed times, bus call, and so on. This template 
can then be run off on your trusty copy machine, and you can fill in the 
remaining blanks by hand. This option is a good option, and it's the one that 
I used when I didn't have access to a computer in my classroom. A standard 
template saved me tons of time that I usually spent with a ruler and pencil, 
getting the plan book set up just the way I wanted it. 

Option number two is great if you have access to a computer on a regular 
basis. You create your template, save it as a stationery document, and then fill 
in your blanks (the actual lessons) on the computer each week. This process 
requires you to create text blocks so that you don't lose all your formatting 
each time you press Return. When you finish filling in all the information on 
your template, you simply print up as many copies as you need. 

Either way you choose, you can save major amounts of time, and your 
lesson plans look oh-so-professional. 

I've also included a lesson-plan template on the CD at the back of this book. 

Here's how to create a personalized lesson-plan template: 

1. Open a new word-processing document. 

A blank page appears, ready for you to do a little work. 
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2. Choose Insert Header from the Format menu. 

Your header appears on the screen. 

3. Design a header that suits your individual needs. 

I like to include a space for the day of the week, as well as the date, 
because my classroom isn't always the same from day to day. 

4. Click below the bottom line of your header and create the perfect 
plan sheet. 

Don't leave out anything. (I put details on here that any substitute 
teacher could understand, and my plans are usually so complete that I 
don't have to write extensive notes when I'm going to be out!) 

Leave space between each of your headings so that you can fill in your 
blanks later on. Pressing Return gives you lines of white space. If you 
run out of room, don't worry about going on to a second page. (I always 
make front-to-hack copies on the school's copy machine.) 

Remember: Don't fill in the plans yet; this is just a template. 

IH...~~e 
~~~-~ . 

18:00 - 8:30- Attendance, Lunch Count, and Morning Work 
! 

,8:30 - 9:1 5 - Language Arts 

' 

5. After you enter all your information, check your plan's spelling and 
then choose Save from the File menu. 

6. When the Save dialog box comes up, choose Stationery from the 
lower-right corner before typing in a name for your lesson-plan 
template. 

7. Click Save, and your wonderful template now has a permanent spot 
in the Stationery folder. 

To open your template later, just click the Assistant or Stationery box 
on the opening screen. Your template is listed with all the other Statio­
nery files. 

8. If you don't have easy access to a computer, you can just pull this 
template up, print it once, use your school's copy machine to make 
enough copies to last you for a few weeks, and then fill in the specif­
ics for each lesson. 

123 



12!, Part II: ClarisWorks- The Loaded Spud __________ _ 

9. If you do have access to a computer (you lucky soul), I suggest that 
you type in your information while you have the template on the 
screen. 

Normally, entering new information in front of all those Returns you 
entered in Step 4 would shift your formatting, but if you enter your text 
in a text frame, the text exists on its own and won't alter your other 
formatting. 

If you left the appropriate amount of space for adding text, creating text 
frames is a breeze. 

10. Click to place your cursor where you want your frame to begin and 
bold down Option/ Alt as you drag a text frame the width of the space 
that you need. (Don't worry about the depth of the frame, because 
the box expands downward as you type.) 

That's all there is to creating a text frame. 

11. Type in your information and create your next text frame. Continue 
until you complete entry of all your lesson-plan information . 

..!)$UP .4l!flJ 
~~ Remember: Because you saved your plan as Stationery, you can make as 

. . 

v ·. many changes to your text as you like without ever harming your original 
· template (shown in Figure 7-6). 

fi.. b 

Figure 7-6: 
See how 
you can 

create 
different 

documents 
from one 

template? 

:8:00- 8:30- Attendance. Lunch count. and Morning Wort 
Vrtite spelling words 3x each. 

8:30 - 9:1 5 - Language Arts 
: ¥eibs ... ······ - · ---------·--- - ·· ·-
i 11. Read a passage from today•s pap&r and have the students clap their 
: 1 hands when they hear a verb. 
! 

1
2. Give each student a page from the paper and have them highlight at 
· least 1 0 verbs. , 
/ :3. Have the studet1s use five ot the ~erbs they round In sentences. 1_ _ _; 
I 



Chapter 8 

I May Spread a Few Sheets, but I 
Don't Do Windows 
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In This Chapter 
b> Getting to know spreadsheets 

~ Using spreadsheets in business and education 

~ Creating customized checklists 

t1>- A potpourri of ideas for spreadsheet use 

0 0 0 0 0 0 0 0 0 0 • 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 

1/ fhat I'm about to tell you is completely true. I once had a student W Clefs call him Johnny) whose mother was obsessed with his aca­
demic performance in first grade. Johnny was a bright child who was 
already reading chapter books when he entered my class. At our first 
conference in November, his mother brought in a scrapbook filled with 
every piece of work I'd sent home since the beginning of the school year. 
Now, I don't believe in giving letter grades in first grade, so most of the 
papers I'd sent home had positive images like smiley faces or check marks. 
This parent had converted these images into her own 4.0 grading scale and 
was concerned about her child's grades. I assured her that Johnny was doing 
fine and jokingly added that his scores in first grade would not affect his 
Harvard admission. She then looked at me very seriously and said, "Are you 
sure?" 

Parents like that make us all realize how important good record-keeping can 
be. Most districts now require months of information-tracking on a student 
before they even discuss special-area placement. I find that good checklists 
can help me keep track of the important stuff (like grades and homework) 
and the not-so-important stuff (like ice cream money). I'm just not the 
anecdotal-record kind of gal - but hey, you can even create a spreadsheet 
to help you keep track of anecdotal information. 
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What Is a Spreadsheet? 

~ \IV 
Spreadsheets have nothing to do with the actions you go through when 
making your bed. A spreadsheet is simply an electronic form of the old­
fashioned ledger, and spreadsheets are generally used in the business arena. 

Business 
Our friendly businessperson uses spreadsheets to crunch numbers. You 
know, they take some numerical information, enter some formulas, and let 
the computer do the math for them. They end up with information that they 
put in publications called profit and loss statements, quarterly reports, or a 
number of other venues - all of which are foreign to most teachers. 

Education 
When I first encountered spreadsheets, I didn't look at all the numbers. 
I only saw this wonderful layout and thought, "With a little manipulation, 
I can turn this into a wonderful customized checklist." 

I admit that you can take a basic spreadsheet, enter student names and 
grades, and then create formulas that average grades for you. However, it's 
much easier (and relatively cheap) to purchase your own gradebook pro­
gram that does your math for you and even prints out a report for those 
documentation-crazed parents like Johnny's mom. 

Let's Make a Spreadsheet! 
I'm going to give you step-by-step instructions so that you can create your 
own checklist. Then I show you some other neat ways to use spreadsheets 
to keep track of classroom activities. And guess what? You can even save 
spreadsheets as Stationery and recustomize them for other classroom needs 
(see Chapter 7 for details on Stationery). 

And, you get a few spreadsheet samples on the Macs For Teachers CD. 

1. Open up ClarlsWorks. 

You remember: Go to your hard-drive icon, find ClarisWorks, and 
double-click. 
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2. When you see this screen, choose Spreadsheet (big surprise, right?). 
Then press Return (or click OK). 

A Word Processing 

4J Drawing 

.J Painting 
ii I o I ' 

~Database 
~ Communications 

New Document 

0 Use nsslstont or Stotlonery oon [concel 81:.) n OK D 

You are then presented with a confusing-looking page full of lines, 
letters, and numbers. The menu-bar choices look a little different, too. 
Don't worry. 

3. Now spread that sheet! First go to the View menu and choose Page 
View. 

This action keeps your document the size of the page you' ll be printing 
it on. Otherwise, this sheet scrolls endlessly down the hall all the way 
to your principal's office. 

4. Next, click in the cell (that's what boxes are called in spreadsheets) 
located at AI. The cell should become highlighted. Go to the Format 
menu and choose Column Width. 

A box pops up with a space for you to type in a column width. The 
default is 72 pixels or screen dots. Type in 150 and press Return. The 
column automatically extends to a width large enough to accommodate 
even the longest name. 

Column width ,_11_5~...:...._---' 
0 Use default 

( concel ] H OK ]J 
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5. Cell number AI should still be highlighted. Type the word Name. 

What? You don't see it in the cell? That's because what you enter first 
appears in the box at the top of the lettered columns, called the editing 
strip. The box to the left of this space tells you what cell you are 
working on. 

10 Untitled 1 (SS) 0 1 
f-..;.A.;.;.I_~I x..!.' I "...&'I .;.;.N;.;;AM.;.;1El~o.... _____________ -.-the editing strip 

~ ~ 
LJ 11 e c o >; 

~--······-----·--------·--------~-----·-·····-----..1.·--------·----J·--··-------·-J. 

6. Press Return. Your typing appears in the cell. Notice that the next 
cell down is now highlighted. 

10 Untitled 1 (SS) 0 1 
A2 I•H 

Q 

II B c D 

I HAl-E I I -- ~-2 I 
3 ! 

7. Now enter the names of every darling in your class. After typing each 
name, press Return. 

Set up the student names in a way that best suits your style (alphabet­
ized, first name, and so on). You can save this checklist as Stationery. 
When you pull it up each time, all you have to enter is headings for 
your columns - not names. 

10 Untitle d 1 (SS) I 

II B c D 

I NAI"'E ------------i-----t- -----+---+-- ~ + at-ich .. l =--==:! -==~---+: ---+----- Ji 
5 Mitch ! ---
6 
7 Comi11o 
8 l .at.r.n 
9 ....... 
10 Ort'tf 

II 
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I like to enter the names in clusters according to the group they sit 
with, because that's usually how I travel around the classroom and 
keep track of work. 

Now that you've entered your names, clean this baby up and save it as 
Stationery before putting in any specific information. 

8. Go to the Options menu and choose Display. 

The display dialog box pops up. 

Display 

181 Cell grid 
181 Solid lines 
0 Formulas 

0 Column headings 
0 Row headings 
0 Mark circular refs 

[ Cancel ) c:::E;J 

I'm not going to explain each of the choices that now greet you - just 
do what I say. Choose Cell grid and Solid lines, and make sure the other 
boxes are empty. You just eliminated any extra lines and made your 
work much easier to read. Click OK. 

Wow! Doesn't that look a little better? 

9. Before going any further, choose Save from the File menu and name 
the spreadsheet Blank Class List. Be sure you click the Stationery 
icon in the lower-right corner of the dialog box that appears. Follow 
all the instructions as they appear on the screen. 

les1 ClarlsWorks Statio ... ..,.I 
Qj ABOUT St ationery 0 
Qj Business Cards 
Qj Business Stationery 
Qj Calendar/ To Oo list 
Qj Certirlcate.One 
Qj Certlflca te.Two 
Qj Class Seating Chart 
Dl Cloisroom I rons 

Saue As: 
ICiarlsWorks ..,.I 
I Blank Class list 

=HAAO OAIUE 

[ Eject 1 
(Desktop 1 

n Saue I 
Cancel 

Your document should still be on the screen. Now you can adapt this 
spreadsheet for a specific use. Ready? 
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10. Go to the Format menu and choose Insert Header. A header appears 
at the top of your spreadsheet and cannot be altered by any informa­
tion you put in the spreadsheet itself. 

You should now see a flashing cursor in the upper-left corner of your 
document. The next part is easy. 

11. Name your checklist Homework. Just like in your word-processing 
activities, you can choose your foots, their size, and their style. 

~ 

no-ework r~ 

NI.ME 

Jtssit 
.John-MichHI 
Emilit 
Mitch 

Camtllt 
Laurtn 

AM• 
Onw 

12. Now, click back on the actual spreadsheet in the cell just to the right 
of the word Name. 

We need to work across this row and put in dates or assignment num­
bers. I'm making this a checklist for homework assignments, so at the top 
of each of the columns I'm putting a homework due date. Go ahead -
just click in the block, type a date, and press Return. Enter all your dates. 

When you press Return to enter your date, the next cell down becomes 
highlighted. You have two ways to navigate between the cells: Either 
click in the next cell you want to work in, or use the arrow keys. 

13. Now you can go back and highlight and format to your heart's 
content. Look in the Format menu for Foot, Size, Color, and Align­
ment choices. 

At this point, you're ready to print the checklist. You don't necessarily 
have to save this creation if it will be used only for this singular pur­
pose- you have a personal stationery template waiting for you to 
customize for other needs. 

14. So now choose Print from the File menu. 
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Don't waste your time! 
Yes, you can format as you go - making 
things bold, italic, underlined - but why 
bother? This is definitely one of those times 
where formatting should take place after you 
complete all your entries. Then simply go back 
and highlight everything you want to format. 
Remember to click where you want to start 
and then drag. (The first cell you click in is a 
hollowed outline; don't worry, it's selected.) 
When choosing cells, you need to start in a 
corner and drag to the opposite corner. 

Click here. 

After you highlight the area you want to for­
mat, you see all your choices in the Format 
menu. You can even use different colors for 
your headings (if you have a color monitor). 

Don't go crazy. Choosing funky fonts or outra­
geous styles may make your document diffi­
cult to read - or the lettering may become 
too large for your column size. You want your 
work to be easy to read, and you don't want to 
reformat in order to accommodate your off­
beat style choices. 

>---++-+-Drag diagonally to here. 
~r------~--~---1----~· 
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4.0 Fill Special 
It you're fortunate enough to have ClarisWorks 
Version 4.0, you can till cells in a special way. 
The Fill Special command allows you to till a 
selected row or column of cells with sequen­
tial information like days of the week, 
numbers, times, or months. Is this great or 

what? All you have to do is select the row or 
column you want to insert the cells in, choose 
Fill Special from the Calculate menu, and 
decide which type of fill you want to use. 
What will they come up with next? 

So You Want to Use Spreadsheets to Do a 
Little Number Crunchin9 ... 

I could write a whole chapter on formulas and functions or take pages to tell 
you how to set up your own gradebook program in ClarisWorks ... but I 
won't. You see, I think you can save time and peace of mind if you purchase 
a good gradebook program. A gradebook program won't just average your 
grades; it'll print custom reports, create seating charts, and keep your 
attendance for you. My favorite is EasyGrade Pro by Orbis Software. 

I'm taking this space to tell you about a cool little feature called AutoSum. 
ClarisWorks has provided this neat little shortcut key called AutoSum that 
adds up a row or column of numbers with a quick press of a button -no 
special functions or formulas . Here's how: 

I. Choose Show Shortcuts from the File menu to bring your Shortcuts 
palette into view. 

2. Select the cells you want to add. 

Include an empty cell at the end of your selection -your total appears 
here. 

3. Click the AutoSum button on the shortcut palette and watch as the 
answer appears in the empty cell. 

Select cells to add. Click AutoSum shortcut. 
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MakiniJ a Few Minor Adjustments 
You enter all your information and suddenly realize that you left out a 
student's name or forgot to enter an important step. Don't fret; read on and 
discover how easy it is to make adjustments to your spreadsheet. 

lnsertiniJ rows or columns 
You always have times when you need to add a row or column- you know, 
a new student joins your class or you add a few dates to a project. 

II' If you want to insert a new row, select the row below where you want 
the new row to appear. To insert a new column, select the column that's 
directly to the right of where you want the new one. After you make 
your selection, choose Insert Cells from the Calculate menu, and a new 
row or column appears to the left of the cell you highlighted. 

II' If you don't select a complete row or column before you choose the 
Insert Cells command, the following dialog box appears: 

~ Insert Cells ~ 

® Shift Cells Down 380 

0 Shift Cells Right 388 

(cancel 38.) n OK ~ 

The computer is assuming that you want to insert a new row and has 
chosen Shift Cells Down by default. If you want to insert a column, choose 
Shift Cells Right. Click OK, and the computer does the rest of the work 
for you. 

Note: This command is sometimes confusing to the beginner. If you 
mess up and get a row or column where you dido 't intend for one to be, 
immediately choose Undo from the Edit menu and your last action is 
reversed. 

DeletiniJ rows or columns 
Deleting the information in an entire row or column is easy. Just click on the 
row header (the 123s) or the column header (the ABCs) of the row or column 
you want to delete. When the cells are highlighted, press the Delete key. 
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Resizin9 rows or columns 
There are two ways to accomplish this feat: 

/II"' The quick and surefire way to get your row or column to the desired 
size is to use the mouse to click and drag your row's or column's 
border. Just move the standard plus-sign spreadsheet pointer over the 
row or column headers (the 123s and ABCs) until you see the pointer 
turn into a thick line with arrows. When you see the arrows, click and 
drag until you like the way things look. 

/II"' Another option is to select a cell within the row or column you want to 
change. Then choose Column Width or Row Height from the Format 
menu and type in the desired size before clicking OK. This is great for 
times when you need a group of rows or columns to be exactly the 
same size. 

Now That You'tle Done It 
One wonderful thing about writing a book for educators is that I know how 
incredibly bright my readers are. Therefore, I'm not going to explain the steps 
involved in using spreadsheets in other ways; I'm simply going to throw 
some ideas out there. You resourceful sponges can soak it up and go from 
that point. Spreadsheets are fun to play with and really easy to customize. 

/II"' Is there a child you're trying to get placed in a Special Education 
program, and the psychologist wants you to track specific behaviors 
for a time period before placement will be considered? (Gosh, is that 
ever frustrating -you know the kid needs help, and you have to jump 
through hoops to get it!) Instead of trying to keep handwritten records 
on scraps of paper, create a checklist with the behaviors, along with a 
space in which to write stuff. Then blow Mr. or Ms. Psychologist's mind 
when you come back with specific dates, types of incidents, and 
comments! 

A.D.D. CIDCKUST 

8ehav1or Tally Dates Notes I Detatls 

D8QdrcominQ 

Out of seat 

Destructive 

Harms others 
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""' The same type format could be used for a child with behavior problems 

that you are trying to correct. Make a form that the child could take 
home every day - a form detailing the behavior during specific 
periods of time. I like to leave these forms on the child's desk as a 
visual reminder throughout the day. 

, ""' Projects and papers are sometimes hard for kids to conceptualize. Why 
not create a checklist containing each step in the process and include 
due dates? This form also helps parents keep track of progress and 
avoid those day-before-the-assignment's-due trips to the library. 

J,lll How often are you asked for a list of the students in your class? Having 
this list saved on the computer makes it easy for you to whip that baby 
out at a moment's notice. 

J,lll When we were sharing one Mac among all the teachers in one grade 
level, I would create a checklist for each subject area and use those 
sheets to record grades. Then, when it was my turn for the computer, 
I'd enter the grades in my gradebook program for easy averaging at 
report card time. 
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Chapter9 

An Introduction to Databases 
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 • 0 0 0 

In This Chapter 
Ll> Getting to know databases 

1> Creating your own class-list database 

1> Navigating your database 

~ Developing columnar lists with your info 

~ Using databases and Mail Merge 

ooooooooooooooooooooooeooooooooooooooooooooooooo 

H:ow many of you expect parents to fill out those horrible, 5 x 7-inch, 
white index cards on registration day? Parents hate them and you 

hate them, but you know they're necessary for record-keeping. Well, a 
database takes the place of all those awful little cards. A database is an 
electronic list of information that you can customize to meet your own 
needs. 

A database is also why you get all that lovely junk mail. You see, companies 
sell database lists to other companies who in turn sell to two others who 
sell to two others, and so on, and so on. Anyway, probably tons of compa­
nies have the equivalent of a little index card with your vital information. 

Your Class--List Database 
It takes only a short time to set up the format for your database: After that, 
you're on your way to total (or close to total) organization. Unfortunately, 
the exercise won't do anything for that drawer in your desk where you dump 
everything. 

Note: If you're shy on time and want to learn this skill later, try using the 
database included on the Macs For Teachers CD. 
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Figure 9-1: 
The 

ClarisWorks 
selection 

screen. 

Figure 9-2: 
The first 

screen 
of the 

database 
program 

may 
intimidate 

the weak at 
heart! 

You decide what information is important to you and how it will be displayed. 
Before starting, you need to find the ClarisWorks icon on your hard drive 
and open that program up. When you see the selection screen, double-click 
Database (or just click Database and then click OK), as shown in Figure 9-1. 
Don't freak when you see the first screen (Figure 9-2)! 

A Word Processing 
.4)1 Drawing 

.A Painting 

Ill Spreadsheet 

~ Communications 

New Document 

0 Use Rssistlmt or Stationery XR (cancel 8C.] ILJL~tJ 

Define Fields 

N11me Type 

Name ( 
~--------------~ 

Typa -------------------, 
@ TeHt 8CI 0 Time X4 
0 Number ae2 0 Celculotlon 3eS 

0 Date X3 0 Summery X6 

t:n~ntl' J ( Otltlons ... J 

OL•h~tl• J ( Mudii!J J 

n Done B 

SettintJ up lJOUr fields 
The screen that confronts you may look confusing, but this is where you 
assert control. The computer is waiting for you to tell it what blanks (fields) 
you want to fill in for each child in your class: name, address, phone, 
parents, and so on. 

You're about to type the names for these blanks. As always, if you make a 
typo, just press the Delete key to backspace over it. Here we go. 
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Figure 9-3: 
You are 

defining the 
fields of 

your 
database. 

1. Type First Name. Press the Return key. 

2. Type Last Name and press Return. 

3. Type Parents Formal and press Return. 

"Mr. & Mrs. Robinette," for example. 

4. Type Parents Casual and press Return. 

"John & Michelle," for example. 

5. Type Address. Return. 

See how each field name appears in the list above? 

6. Type Phone (H). Return. 

7. Type Phone (W). Return. 

8. Type Special Info. Return. 

9. Type First & Last. Press Return. 

You filled in all your fields, and your screen should look something like 
Figure 9-3. 

Field N11111e Field Type 

Field N11111e Field TYPe ITeHt "'I 
[ Creo l e SllR ] [ Modify lSM ) [ Delele ll€E ] ['-op-:-1:-lon- s-•.• -:-ll€:-::-,;o) 

10. Click the Done button in the lower-right corner. 

The dialog box goes away. 

When you see what you created, things should begin to make a bit 
more sense- you now have the blanks (fields) to be filled in for each 
person on your list. (Don't worry if the field names are too long to 
show up in their entirety; you still know what they are.) 

Note: In The Claris Works Reference For Teachers, I show you some cool ways 
to enhance your database. Learn how to increase the size of your fields , 
change the font, insert clip art, add a colorful background, and much more! 
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Fillin9 in the blanks 
Computer nerds would call this next step data entry. Put simply, you are 
going to fill in the blanks you just created. To advance from one blank to 
another, press the Tab key or click inside the blank you want to work on. Are 
you ready? 

I. Make sure that you can see the dotted rectangle for each field -like 
the ones here. If not, press the Tab key. 

FntNamo 

Last Name 

Parents 
Formltl 

Parents 
Cuultl 

Address 

The little blinking cursor should be in the "First Name" blank. (If it's 
not, click there.) 

I'll set this first one up using my daughter's info. 

2. Type Jessie and press the Tab key. 

The cursor should jump to the "Last Name" box. 

3. Type Robinette and press the Tab key. 

4. Now enter Mr. & Mrs. Robinette in the "Parents Formal" box and 
press Tab. 

You should now be in the "Parents Casual" box. 

5. Type John & Michelle and press Tab. 

6. You are going to enter the address in the "Address" box, so type 4 705 
Somewhere Drive and press Return. 

The cursor didn't jump to the next box. Instead, you expanded this box 
by pressing Return. 

7. Now type Anywhere, GA 30202 before pressing the Tab key. 

The box collapses back to its original size. Don't worry, your informa­
tion is still there. 

Continue now with the "Home Phone" blank. 

8. Type 963-7139 and press Tab. 

Next, in the "Work Phone" section, you can enter two phone numbers 
(one for each parent or guardian). 
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9. Type M- 963-1953 and D- 963-2159. And yes, once again, press that 

Tab key. 

Of course, that Mom and Dad designation won't work for all your 
students. You can work out your own system for labeling the two phone 
numbers in this field. 

For the next step, you should be in the "Special Info" box. 

10. Type this word for word: Precious child- very bright for her age. 

Don't question it, just type. (Remember, she's a teacher's kid. Aren't 
they all extremely bright?) Press the Tab key, of course. 

11. Type Jessie Robinette in the "First & Last" box. 

You did it! You just filled in your first card! 

Now, if you have all the information in front of you, pull up another 
blank card by going to the Edit menu and choosing New Record. Voila! 
A new blank card appears ready for you to fill in. 

Keep filling in cards until you have entered your entire class (or all the 
names for your Christmas-card mailing list). Then don't forget to SAVE! 

12. Choose Save from the File menu. 

13. When the dialog box appears, type in a name for your database (how 
about Class List Database) and click Save. 

You know what to do if you want to print a couple of copies of your class 
info (maybe one for home and one for your plan notebook): Go to the File 
menu, choose Print, and follow directions! 

You may want to wait, however, and read the activities that are coming up. I 
show you a variety of ways to customize this information. 

UsiniJ Your Database 
You created the ultimate database, entered all the information, and even 
found time to use the restroom and get a cup of coffee. So now what can you 
do with the last ten minutes of your planning period? Why not give that 
database of yours a good workout? 

You can utilize all the information you entered in a number of ways: 

I 
Jtl' Search for specific information (Which mothers can volunteer for field 

day?) 

Jtl' Sort the list (day-care buses, car riders, bus riders) 
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m Jt' Create lists (phone numbers, bus numbers, birthdays) 

m Jt' Create Mail Merge letters 

]umpin9 from record to record 
When your database contains many records, you may want to move through 
your database at a faster pace than that provided by your scroll bar. Here 
are a few options for quicker movement: 

Click to move forward or backward one card. 

ar-~r-Siide bar up or down to view records quickly. 

Type the number of the record you would like to view. 

I 
Jt' Use the Bookmark slider to move from record to record. 

Jt' Click the top of the flip book to move back one record at a time. 

Jt' Click the bottom of the flip book to move forward one record at a time. 

Jt' Type in the number of the record you want to view. 

Findin9 
Sure, you could spend your valuable 40-minute planning period flipping 
through records to find the information that you need, but a quicker way to 
get your eyes on the information you need is to use the Find command . 

... \)SUP~ 
~(f).. .' -v If you've done prior searches, all the records for your database may not 

• \ currently be in view on your screen. Choose Show All Records from the 
. · . , ! Organize menu before you begin the Find process. 

I. From the Layout menu, choose Find. 

Don't freak when you see a new blank record pop up in front of you. In 
reality, this isn't a blank record, it's a Find Request form. 

2. Type the information that you want to find In the space provided In 
the Find Request form. 

In my example, I want to locate all the students living in Oakdale. The 
more information you enter on this request form, the more focused 
your search becomes. 
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When you chose the Find command, you probably noticed that the 
following extra choices appeared on the left side of your screen: 

You can use these choices to narrow your search. 

• Visible: Clicking this button instructs the program to search only 
the records currently visible. 

• All: Clicking All instructs the program to search all the records in 
the currently opened database. 

• Omit: Placing an X in this box inverts the Find operation so that 
ClarisWorks selects the records that don't match the requests 
you've created. 

3. Click the Find button to begin your search. 

After the search is complete, the records that match your search are 
the only records visible; all other records are hidden. 

Sortin9 
The ability to sort records quickly is one great reason for using a 
database. 

If you've done prior searches, all the records for your database may not be 
showing. If you want to sort all your records (and not just the ones that are 
showing), choose Show All Records from the Organize menu before you 
begin a sort. 

To sort records, follow these steps: 

1. Choose Sort Records from the Organize menu or choose New Sort 
from the Tool panel on the left side of your screen. 

When the Sort Records dialog box appears (as shown in Figure 9-4), you 
see a list of all your fields on the left side of the box. 
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Figure 9-4: 
The Sort 
Records 

dialog box. 

The sorting order The field to be sorted 

I 
.. - - Sort Records 

Field List Sort Order 
First Name g ( Clear ) 
Last Name ~ 
Parents Formal I («Moue«) 
Parents Casual [ I Address OK 
Phone (H) f:~ 
Phone (W) 

~ ( Cancel ) tQ ~ 

.d ® Ascending order 
IL 0 Descending order 

2. Choose the field that you want to use as the basis for your sort. 

In most cases, I sort by name in order to create alphabetized lists. 

3. When your field is chosen (it should be highlighted), click the Move 
button. 

When you click Move, the field you selected shifts to the Sort Order 
side of the dialog box. 

The next step requires that you decide upon the order in which you 
want to sort: Ascending order means that you sort from A to Z or 
numbers that increase in value 1, 2, 3, and so on; Descending order 
means that you sort from Z to A or numbers that decrease in value 10, 
9, 8, and so on. 

4. Choose either Ascending order or Descending order. 

5. Click OK and let the sort begin! 

MaltiniJ a columnar list 
Just the facts, ma'am. I know you just entered lots of information that you 
certainly don't need on a daily basis. The beauty of the ClarisWorks data­
base is that you're never locked into one particular way to view your 
information. You can create a list that contains only the information you 
need from the database. So why print the entire list? Let's create a list of 
student names with the parent names and home phone numbers. 

1. If it's not already open, open your database. 

You remember: Double-click ClarisWorks. Click Cancel, go to the File 
menu, choose Open, and find your database. 
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2. Now go to the Layout menu and choose New Layout. 

A layout is simply a way to view the information in your database. 
A dialog box appears. 

N11me 

Type----------, 

0 Stllnderd 
0 Duplicate 
O Bienlc 

® Column11r r epor t 
0 L11bels 

lc us1orn .... , 

3. Choose Columnar report and click OK. 

I know it sounds strange - but this is the one we need. Yes, another 
dialog box appears. This time we're going to tell it what information 
(from the database) we want to include on our customized list. 

Set Field Order 

Field list Field Order 
First N11me {} ( Clear J Q 
lest Name 
P11rents Form111 ( MDUl\ l 
Perents Casual 

n JJ Rddress OK 
Phone (H) 
Phone (W) -o ( Cancel ) 0 

The list on the left shows the fields in your database (Field List). The 
empty list on the right is waiting for your information (Field Order) . It 
is important to enter the information in the order that you want it to 
appear on your list. 

4. Scroll down and begin with the last field on your database: "first & 
Last." Highlight this field. 

5. Click Move (which is no longer grayed-out, thanks to your selection). 

The field should move over to the Field Order list. 

1!,5 



14 6 Part II: ClarisWorks - The Loaded Spud------------

6. Continue by adding the "Parents Casual" field and the "Special Info" 
field. 

Your screen should look like this: 

Set Field Order 

Field List Field Order 
First & Last ~ [ Clear ) First & Last ~ 
Porents Cosuol Porents Casual 
Special Info (« Moue «) Sl!ec:lallnfo 

I OK J 
~ ( cancel ) {) 

7. Click OK. 

The customized list should appear on your screen. Save your Jist and 
print a few copies! 

Creatin9 a Mail Mer9e document 
Mail Merge doesn't accurately describe what we are about to do - it sounds 
as if we are about to mix your mail with someone else's. In reality, Mail Merge 
allows you to merge or replace general information in your letter with specific 
information from your database. Mail Merge doesn't have to be used for your 
classroom. Why not create a customized Christmas Jetter and have person­
alized greetings for each of the lucky people on your Christmas card Jist? 

Let's start out with an easy project: a letter home to the wonderful parents 
of those sweet darlings you see Monday through Friday. Pretend that you 
just finished a unit on Egypt and the kids have created a museum of Egyp­
tian artifacts within your classroom. I'm going to show you how to create a 
customized invitation note that you could send home with each student. 

Ready? 

I. With your class-list database open, choose New from the File menu 
and open a blank word-processing document. 

2. Type the following standard invitation: 

Pretty boring? Wait and see what we're going to do to this plain Jane. 
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~1 0-14-91 

rear Parents, 

!I'm so proud of everyone's worlc on our Egyptian Studies unit. We 
]have had a wonderful tlmel 1 hope that you can come and visit 
~he Egyptian Museum the class created. Your child Is a wonderful 
asset to my class. 

:Thanlcsl 

~rs. Robinette 
I 

3. Go to the File menu and choose Mall Merge. 

You see a dialog box that offers the line Class List Database. 

4. Choose your database by double-clicking it (or by selecting it and 
clicking OK). 

Another (even smaller) dialog box appears. It's tiny, and it would be 
easier if you moved it to a corner of your screen. (Click in the title bar 
and drag!) 

Now this next part is fun. 

5. Look at your invitation. Highlight Parents (but don't highlight the 
comma). 

Go to that tiny box and make a decision: Do you want this letter to be 
casual (calling the parents by first name) or formal? 

In the box under field name, you see all the fields you set up. 

6. Choose the way you want to address the parents (Parents Formal or 
Parents Casual) and highlight it, and then click the Insert Field 
button. 

Field Nome 

'

First Nome 1Q 
Lost Nome 
Parents Forma ~ 

<(). 

Insert Field 

Merge Ootabase: 

Class List 

Select Data ••• 

Print Merge ••• 

Look at your document! A place holder has taken the place of Parents -
and in each letter you print, a different set of names will appear. (One 
set for each child in your database. Are you getting it?) 
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Figure 9-5: 
Mail Merge 

can make 
your life 
easier! 

lto--=-r4=-97___ - ----~-------

1oear «Parents casual•, 

'1•m so proud of«Child's Name Possessive• wort 

7. Now go to the word everyone's. Highlight everyone, but leave the's. 
Go to the little Mail Merge box and choose "Flrst Name." Click Insert 
Field. 

Once again, a place holder takes the place of the highlighted words, and 
each letter you print will have a different child's name in the possessive 
form in that spot! 

We'll do one more bit of customizing. 

8. Highlight the words your child and go to the Mall Merge box. Choose 
First Name and click Insert Field. 

You know what happens next. Magic time! 

9. Look at that Mail Merge box. See the Print Merge button? Click it. 

Field Name Merge Detebese: 
Class List 

( Select Data ... 

1 MHI4i!AI(I 

The normal print screen comes up for you to make the standard 
printing decisions. Go for It! As you probably figured out, the possibili­
ties are endless (as shown in Figure 9-5). 

You can address the parents ... 

... and speak to them about their child . 

. llFf4-97 ·- --------------------------------------------] 

\oear John & Michelle. ! 

trn so proud of Jes~le•s wort on our Egyptian studies unn. We 
1 pave had a wonderful tlmel I hope that you can come and visit 

~he Egyptian Museum the class created. Jes
1
sle Is a wonderful 

asset to my class. 
I 

iThanlcsl 
I 
JMrs. Robinette 



Part Ill 
Acting Like You Know 

What You're Doing 



In this part ... 

K:. ds do it every day in the classroom. You know what 
I mean: They mouth the answer to that multiplica­

tion problem as the other 85 percent of the class screams 
out the answer. 

I'm going to help you fake it through three of the more 
widely used programs in educational circles: Kid Pix 
Studio, The Student Writing Center, and The Print Shop 
Deluxe. I try to include programs that would be appropri­
ate for a variety of grade levels and uses. 

Take your time and see what you think. 

I'm only scratching the surface on each of these programs. 
You can dig deeper when you have time (hal). Or you can 
even do the unmentionable and read the manuals! 



Chapter 10 

Faking Your Way through Any 
Kid PixProgra~n 

OOQGOOOOOOOOOOOOOOOGOOOOOOOOOOOOOOOOOOOOOOOOOOOO 

In This Chapter 
DJ>- Zipping through a brief history of Kid Pix 

~ Using the toolbox 

f)a- Creating a slide show from saved work 

ooooeooooooooooooooooooooooooooooooooooooooooooo 

Jl';d Pix is the grand pappy of all drawing programs. It's been around the 
f\i~ngest and still ranks as the most popular program in its class. This 
gem appeals to a wide range of ages as well, which makes it a valuable 
addition to most schools' software libraries. And the sound effects are 
awesome! 

A Bit o' Confusion 
Listen carefully as I explain this next bit of software rationale. Br0derbund, 
the company behind Kid Pix and many other successful software programs, 
first released Kid Pix as a stand-alone program. It was wonderfully fabulous, 
and everyone had to have it - but still there was a thirst for more! So 
Bn-,derbund soon came out with Kid Pix Companion, which added some 
neat features to your original Kid Pix purchase. A few years back, 
Br0derbund wised up and packaged both of these programs together under 
one title, Kid Pix 2. Does all that make sense? 

Well, now that you understand the straight scoop on Kid Pix history, let me 
throw you a curve. Br0derbund has a new CD that they confusingly titled 
Kid Pix Studio - a CD version that blows all the others out of the water 
when it comes to special features. (See the sidebar for more information.) 

If you or your school owns any of the programs or combination of programs 
mentioned in these last very confusing paragraphs, you may pass GO, 
collect $200, and participate in all the upcoming activities. 
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What's so great about Kid Pix Studio? 
Kid Pix Studio comes on a CD and has three totally new components: Moopies, Stampimator, 
and Digital Puppets. Because I don't have room to give details on how to maneuver through 
each of these new components, I give you a brief breakdown of each: 

Moo pies: The paintbrush tools take on lives of their own in this mode. 

Stampimator: In this mode, you can create animation paths for up to four stamps of your choice. 
Create a background picture (maybe a beautiful garden scene) with the regular Kid Pix tools and 
then add your animation (say, a few birds and bees flying from flower to flower) to make your 
picture come to life. 

Digital Puppets: Choose one of ten different puppets and move the puppet by typing on the 
keyboard. When you come up with a combination of movements you like, simply press the 
record button at the bottom of the screen to record your puppet show. Inserting a cool sound 
track from any number of the Kid Pix provided sound files is a great way to add excitement to 
your show. 

In addition to the three activity components, the smart folks at Brederbund have also added tons 
of colors (click the arrows at the bottom of the color bar to see all the shades), a large 
assortment of stamps, hundreds of pictures you can use as backgrounds, and a newfangled 
sound library that contains a vast array of cool sounds (Boogie Woogie is my personal favorite). 
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Openin9 Kid Pix Studio, Kid Pix ~ 
or Kid Pix 

Go to your hard drive, find the appropriate icon, and double-click. (If your 
school has installed At Ease, it's even easier! Look at the screen, point to the 
Kid Pix 2 icon, and click.) If you're using Kid Pix Studio, click the Kid Pix 
button in the center of your screen. 

Tools of the Trade 

Figure 10-1: 
The Kid Pix 

screen. 

The first screen that greets you has a blank sheet of paper and a row of 
interesting-looking icons down the left side (the toolbox) and across the 
bottom (as shown in Figure 10-1). What's neat about these icons is that, if 
you learn to use each of the tools represented by the icons, you can master 
most of the more advanced "adult" drawing programs 
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This little guy is a lifesaverify~u rememberoto make a, mistake, go straightto him. D()rt'ttryto 
use him right aw~y. Wheri you click on hhra,:~J· fi~ itin ~notlj~r. way; he can correct onfv. the 
und.o.es y~ur last acti~,. Thatmea.ns;i !t:~~qu; , la~~.$,t.a~~ion,·. 

Let's Create a Masterpiece! 
The best way to learn this program is to actually do it as it's being 
described - step by fun step. I want you to create and save three pic­
tures using Kid Pix. Don't worry - I'm going to hold your hand along the 
way. After you create and save the pictures, I'm going to show you how to 
use them in a really super slide show. 

Picture 1 
You opened up your version of Kid Pix and now you have a blank paper (on 
screen) in front of you. 

I. CHck the pencil icon (in the top-left comer) and let go of the button. 

2. Choose the color green from the color palette on the row of tools. 

3. Now draw a line across the bottom of the page where you want some 
grass. 

Your mouse controls your pencil strokes - holding the mouse button 
down and moving creates a line. When you lift your finger off the mouse 
button, you stop drawing. 

Be sure that the line touches both sides of the page. 

4. Now click the paint bucket and leave the color as green. 

5. Move the cursor, which now looks like a paint bucket, to the area you 
drew in for grass and click. 

That whole area should turn green. If the whole page turns green, that 
means you left an open area when you drew your first line. The paint 
"spilled" into the rest of the picture. If this happened, click the "Oh no!" 
man. That last action is undone. 
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6. Let's use the paint bucket again and choose sky blue as our color. 
Dump it above your grass. 

I know, I'm not the artsy type. Be more creative if you'd like. 

~ 7. Now go to the stamp icon and click. 

You see a row of small stamps appear at the bottom of the screen. Find 
one that you like. If you don't like any of these, click the arrow at the 
end of the row, and you see more. 

8. When you see a stamp you like, click it. The image becomes your 
cursor. 

9. Move the stamp to the desired location and try this: 

a. Push the option key (the stamp gets big). 

b. Push the shift key (the stamp gets bigger). 

c. Push the option and shift keys together (the stamp gets the biggest!). 

10. Choose the location and size you want and then click the mouse. 

11. Enough for this picture. Go to the File menu and choose Save a 
Picture. Name this work of art Picture 1. 

New X N 

rJ Open o Picture ... XO 

~ save a P1ctute ... J>, S 

g,rrlnt XP 

~ Retum to Studio XQ 
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Don't. spill the paint! 
Noti~e the very tip of the spilling paip~ Th~ location of this tip of spilling paint[s Where the paint 

:-'i~#.d1J01Ped,"·Maoychjldrengetfrust~atedwhenthe:Y caQ'tQetthe paint to gqwherethey·:want 
it •. When drawing figures that will later be.fille~ with paintfrom the buc·k.et.r:b~Tsure aU the lines·· 
are closed~ If nof,the p_aint spills out of the shape and ·fill_s the entire p~ge. 

• . raa~ra9:s.s where the tip of spilling paint "Even a small op9Ring will cause 

.. · · paintto spill. · · · 

-Aoother good tip is to have students stay away from the fine-line width when-drawing. lfs too 
·~i.fflcult to be sure l.ioes are clos~d 111fhen using su~h a fin~; point 

Using thin·U(lesto ~rawma~eslt _ 

mored~Cutt~~, 

Picture 2 
I. Go to the File menu and choose New. 

A nice clean sheet of paper pops up in front of you. 

2. Choose the circle tool and the color black. 

Across the bottom of the screen you see some new choices on how 
your shape can be filled (or not filled). Play around. Click and drag. As 
you drag, you pull a circle. The same premise works with the square 
tool. Fill your page with shapes. 

3. Choose the paint bucket and a bright color, such as red. Dump it for 
your background. 

Pretty visual, huh (see Figure 10-2)? 

4. Go to the File menu and Save this masterpiece as Picture 2. 
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Figure 10-2: 
Does your 

masterpiece 
look this 

good? 

Picture 3 
1. Go to File and choose New. 

2. This time we're going to pretend that we are Andrew Pollock. (Isn't 
he a modern artist?) Click the paintbrush and choose a color. 

Across the bottom of the page you see a variety of choices for your 
brushstrokes. Try each one of them. Alternate colors between your 
tries. Go ahead - fill the page! (Check out my effort in Figure 10-3.) 

3. Let's say that you aren't comfortable with this wildly modern image 
in front of you. Go to the eraser icon and click. 

At the bottom of the screen some new choices appear. The first four are 
eraser s izes and shapes. Choose one and erase part of your master­
piece by clicking and dragging over what you want to get rid of. 

As you erase, a hidden image appears. 

Eraser sizes Erases entire page 
Blows up your picture 
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figure 10-3: 
Did you fill 

the page 
like this? 

The dynamite explodes, or erases, the whole picture. The other icons, 
with the exception of the question mark, also clear your entire page. 
The question mark allows you to erase your picture while uncovering a 
hidden Kid Pix 2 image. 

4. Choose the dynamite, move it to the center of your picture, and click. 

Now go back and use all your newfound talents to create another 
masterpiece. This time you're going to add some words to your work of 
art before saving it. 

5. If you are using Kid Pix Studio, click the TypeWriter icon. 

Choose a letter style you like from the bottom of the screen (you can 
choose colors, too), click where you want your text to begin, and start 
typing. 

6. If you are using Kid Pix or Kid Pix 2, go to the letter A icon and click. 

You see some letters across the bottom of the screen. You can click and 
drag letters where you want them to appear on the screen or hold 
down the Option key and click the letter A icon again. The previously 
mentioned letters are replaced with letter styles. In this view, you can 
choose the style of letter you prefer and then click where you want to 
begin typing on the screen. (Don't forget, you have a choice in color as 
well!) 
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Figure 10-4: 
The end of 
my artistic 

effort. 

7. Type The End on your picture (as I've done in Figure 10-4). 

8. Go to the File menu and save this as Picture 3. 

I'm sure you'd rather keep playing- this program is addictive. So do what 
you must. Come back to this chapter when you're ready to create a slide 
show to highlight your creative works. 

Printing? If you want to print a picture, simply go to the File menu and 
choose Print -and make your decisions about size, number, quality, and so 
on. You know the dialog-box drill by now! 

Draw Me 
A neat opening activity for teaching Kid Pix to 
a class of readers or early readers is to choose 
the Draw Me option from the Switcharoo 
menu. A silly sentence appears and is then 
read aloud. Here's an example: "I'm a hairy 
eyeball ten feet tall on a funny fat cow that 

goes moo-meow and I howl atthe moon." And 
then the program invites the students to draw 
what they just read and heard described. This 
is also a good source to use when teaching a 
unit on descriptive language. 
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You gotta try this! 
If you use Kid Pix for whole class projects or 
work in a lab situation, there are times when 
you might like to have· a simple template or 
outline of a project ready fo_r the kids when. 
they sit down at the computer: you know, a 
story web already drawn,the·,columns .already 
in place, or the beginnings of a simple picture: 
graph. Giving students somethirig-.to startwith 
saves lots of time- a blessing In a classroom 
or lab situation. Providing a template will en­
able your students to get started on the learn­
ing instead of spending precioustime setting 
up their environrnents. 

Here's what you need to do; 

1. Create· your Kid Pix docu~ent Save yo~Jr 
document and then close.Kid.Pix. 

2. Select your saved document (click it once 
to highlight). 

3. From the ,File menu, chQose Get Info. 
When the Get Info window pops into view. 
you see a box in the bottom right-hand. 
corner. that's titled Stationery pad. 

4. Click inside that Stationery pad box; an X 
will appear. 

CreatintJ a SlideShouJ 

~Jessie 1 Info 

Q JKst.l 

kind: Kid Pix Studio documftlt 
Siz•: 171< on dlslc (15,784 b<,ltH ustd) 

Vber•: Macintosh HD: J•ss;.·s shows: 
Show I: 

Cr••t•d: Sat, Jan 18, 1997, II :45 AM 
HodifiN: Sat, Jan 18, 1997, II :45 AM 
Y•rsion: n/• 

0LockN ~st.ttoMnJ p.ci 

You j!Jstturn,ed your origina[templat~ int() 
a stationery:doqument~ yotvnotic;e.that 
the icon-representing the document now 
looks like a· pad of stationery. 

The.first time &·Student opens your newly cre­
ated stationery document, a window comes 
up asking him. or. her to give the document a 
name~ You .see that the original remains the 
same, and your student now has a personal 
copy. 

Up until this point, the differences between the earlier versions of Kid Pix 
have not made a difference in your ability to learn the program. However, 
getting to the SlideShow component is different in each of the programs. 

0 ~ In Kid Pix 2, simply go to the Switcharoo menu and choose Switch to 
U SlideShow. 
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-~lftey~:ca~- rpUt.:my Kid<Pi~;drawing in 
•my'!GIB.risWorks--.dac_ument? 

Ofcot.Jrse tt~•ntan:llt's~~n easy,wayto:c_Ustom• _ 4. ChoCJ$e Copy from the Edit menu and then 
ize younv()rlJ~~t~~e$~~ng~do~-(lffief1tS:;....,.much quit;Kid Pix • 
. 111ore originatt~an_ a.nv..stcre~,b,Qqgbt:cUp·:art•· · , ~-;:PeJ,~,aJl~W.CiarisWorks word-process-
_Her~·s-~ow:· .. : _· · .: · ~~~·r;t~r-::i:'· ' · ; · :-ing ~o.cumant. Choose the pointer from 

'- -1. Create"your·Kid'PJJJ lilaSterp}ece~ -the Jool _Panel, and then choose Paste 
2. Ytlbile -$tilkh.,_~iti·'Pixl! -~U~k *" 'IVI~ving fro01 the Edit menu. 

Vanlcota·anth:ttoose:asetectlontool'from: If you don't see the Tool Panel, choose 
d.J-,b.~~~t;:id.'V.•screen.-~-':- --_ --" ·- Show Tools from the Options menu. 

llike·to use··thcHas.so. :Note.: lt's>very important that you first select 
3. S~lect{ygj(rif~i(JP,I~:Jmq~~-1i_,i~ij:~ifdi:dr•lt · ,t,~e·ppij1ttl,r, othervvise your image will be en· 

to:'ll~i_rc; __ ~_ ._-,it)_-~, .· · . -',·,· __ .-··i--_:_<_-•·.·-.-_.2_fc:·.'_.: i': _:' ·_;_"_· ~. __ , , teredi~·s.t~xt ~nd you .won't-be ,able to resize it . · •or ~oveiffreely around your document 
When you.: Ill gctoftll~;tttousei 11 ·dashed· Voilal'(our Kid Pix artwork is now part of your 

.. Jin~Jndic:ate_s your-selection: -_word.; processing document 

""' In Kid Pix with the Kid Pix Companion added, you have to quit Kid Pix 
and look inside the Kid Pix folder on your hard drive. You should see 
the SlideShow icon within the folder. Double-click the icon. The 
SlideShow program opens. If you don't see the SlideShow icon, you 
don't have Kid Pix Companion on this computer. Sorry. 

""'If you're using Kid Pix Studio, choose Return to Studio from the File 
menu. When you're back at the opening screen, choose SlideShow. 

After you open the SlideShow program, you see a bunch of empty trucks 
staring at you (as shown in Figure 10-5). Your mission- should you choose 
to accept it - is to fill three of these trucks with pictures you create. 
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Figure 10-5: 
The 

SlideShow 
program. 

1. Click the picture frame at the base of the first truck. 

A screen pops up telling you to "Pick a Picture." You should see your 
saved Kid Pix masterpieces. If you don't, pull down the arrow above the 
scroll bar, choose Desktop, and then Hard Drive. Open up your Kid Pix 
2 file to find your pictures. 

2. Choose Picture I and click Open. 

The picture is now loaded on the first truck. Go ahead and load your 
other pictures on trucks 2 and 3 as you did in the first step. 

3. Now we get to add some sound! See the musical note at the base of 
the trucks? Click the note on the first truck. 

You see another dialog box; this one is asking you to Pick a Sound. Play 
around. Choose a few of the pictures and select Preview. You can press 
Select when you find one you like- or choose the microphone and 
record your own voice as narration! Add sounds to each of your 
pictures. 
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d Pick a Sound! 

( Preulew ) 

n Select ~) 
( C11ncel 

If you choose the microphone, you get another dialog box that works 
just like your tape recorder. 

~ 
(! ~ IIIII.' B :00 

0 :32 

4. Click the last square at the base of the truck to select a transition 
choice. 

The transition (a fade or dissolve) takes you from one slide or picture 
to another. 

If you choose the scissors icon in the Pick a Transition dialog box, the 
transition is quick. Choose any of the others for some really neat 
special effects. 
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5. Go ahead and pick a transition for each truck. 

~Pick a Transition! 

6. You did it! Your show is complete. 

You know if you made all the necessary choices if each icon/picture, 
sound, and transition becomes filled with color. To view the SlideShow, 
press the arrow at the bottom of the page. 

The square arrow plays your show in a loop (over and over again). 

7. You can Save your show, or simply choose Quit from the File menu. 

Our little show is very simple and somewhat silly. However, the educational 
possibilities are endless! In Appendix A, you see ideas for using Kid Pix to 
enrich your curriculum. 
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A few tips 
Ill' Never use the smallest choice pencil 

width.lt's too hard for children (and adults) 
to be sure they close all their lines. When 
the paint bucket is used, paint inevitably 
spills out. 

Ill' Pictures look best when the kids draw 
their own artwork and don't use stamps. 

Ill' The mixer tool messes up your artwork 
fast! Be ready to use the · oh no I" man or 
expect to lose all your work. 

Ill' Kid Pix is not a word processor. Be sure 
your typing is correct before you leave the 
text tool. You can't just go back and insert 
your cursor where you want to make 
changes. You have to erase, refill the back­
ground, and then retype your words. This 
task can be frustrating to students who 
are used to word processing. 

Ill' Allow the kids to use the dynamite tool 
only twice (or so) in a sitting. Without 
headphones, the noise will drive you crazy. 
The kids tend not to get any work done 
because they have too much fun blowing 
things upl 

Ill' The line tool (just below the pencil) is great 
for those students who say they "can't 
draw anything." By pressing the Shift key, 
the line straightens even more. 

II' Put lettering on the page after the back­
ground color has been added. Otherwise, 
the holes in letters such as 0 and P are 
very difficult to fill with the background 
color. 

II' To get higher-quality sound when record­
ing, hold down the ~ key as you choose 
the microphone icon. This cuts your re­
cording time down to 16 seconds, but 
greatly improves the sound quality. 

Ill' Saving your SlideShow as a Stand Alone 
(an option when you choose Save) enables 
anyone with Kid Pix 2 to view your pro­
gram without the original pictures. This 
option is great for teachers who want to 
send SlideShows on a disk to class pen 
pals. 
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Chapter 11 

Faking Your Way through 
The Writing Center and 

The Student Writing 
Center 

eooooooooooooooooooooooooooooeeoooooooooooooeooo 

In This Chapter 
1> An overview of The Writing Center capabilities 

1>- Step-by-step instructions on creating a class newsletter 

li> Grab a graphic 

~ New features included in The Student Writing Center 

oeooooooooeooooooooooooooeoooooooooooooooooooooo 

~e Writing Center and The Student Writing Center are great programs for I beginning word-processing instruction. Either of the programs works 
well as a first step before teaching ClarisWorks. The programs are user­
friendly and nonintimidating; and, in addition to all these qualities, they 
both enable students to create some really nice stuff. Both The Writing 
Center and The Student Writing Center introduce students to general word 
processing terms (font, alignment, and style) and products (reports, news­
letters, and letters). 

A Little HonestiJ. Goes a LoniJ WaiJ. 
The Learning Company has been around educational computing for a while. 
I began using their products in the days of the Apple lie and lie. All their 
products - Reader Rabbit, Super Solvers, and Treasure series included -
are top-notch, solid performers. 
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When they came out with The Student Writing Center, an upgrade from The 
Writing Center, I was pleased to see the company honestly guiding schools 
and individuals toward sticking with The Writing Center if lower-end ma­
chines (like the Classic models, LCIIs, and LCIIIs) were being used -
equipment that just isn't powerful enough to squeeze the most out of the 
upgraded features included in The Student Writing Center. Imagine that: a 
company telling you that you shouldn't necessarily purchase an upgrade the 
organization spent time and money creating. Honesty is so refreshing. 

The Writing Center 
Don't feel as though you're using an inferior product if your school hasn't 
upgraded to The Student Writing Center. The Writing Center is a great 
program that is more than capable of meeting your school and personal 
needs. Read the next few pages and learn the basics for operating in The 
Writing Center environment. 

That SoniJ! 

figure 11-1: 
No more 

When you open The Writing Center, a song that at first sounds rather upbeat 
greets you. This same song, when played by a lab full of computers day after 
day, soon grates on your last nerve. The first chance you get, go to the Edit 
menu and choose Preferences. Deselect the Sound box (by clicking - and 
getting rid of- the x) as shown in Figure 11-1. Now we can continue. 

[iSound 
[1show Ruler 
0 Show lnulslbles 

Preferences 

Ruler-----, ([ OK ll 
® Inches 0 Pleas , • 
0 Centimeters 0 Points Cancel 

0 Conuert Color Pictures to Block & White on Screen Help ... 
umusic for ( Set Default Picture Folder ... I '"' 

your ears." Click on your choices. Then click on OK. 

An Otlertlieu/ 
The Writing Center offers two basic choices - a report or a newsletter. 
Headings are optional with both. Within a newsletter, you can also deter­
mine the number of columns. 
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This program comes with 17 folders full of clip art, which makes finding a 
graphic for your writing an easy task. Not only that, but after you insert a 
graphic, the text automatically wraps around the image, giving the work a 
customized look. Look in Appendix E for information about where printouts 
of all your possible picture choices can be found on the CD. 

The program comes with some standard templates. Just like the automatic 
forms you can create when word processing, a template for The Writing 
Center can do the same thing, and much more. For example, you can create 
awards, cards, and invitations. In addition, you can save your personal 
creations as templates. 

Creatin9 a Newsletter 

Figure 11-2: 
Choosing a 
newsletter. 

I'm not going to review word processing with you. By this point, I'm sure 
you're an expert. (If not, head to Chapter 7.) Instead, we're going to jump 
into desktop publishing and create a newsletter. 

My blurb about the lovely song included with every program probably made 
you curious, and (I hope) you opened The Writing Center. But you couldn' t 
get to the menu bar to make that adjustment, could you? That's because the 
program wants you to make some decisions first (as shown in Figure 11-2). 

The Writing Center~ 

iii 
Report Newsletter Cus tom 

or Letter 

Clltk on your tholte oboue. 

Open Soued 
Document 

Quit 

Help ... 

1. For our lesson, you need to choose Newsletter. 

This program is a little different from others. To make it more "kid 
friendly," there are no little boxes for you to click; simply dick on top of 
the picture you are choosing. 

Now you have a Newsletter Layout dialog box. Our choices are Heading 
or No Heading. 
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Figure 11-3: 
A blank 

newsletter 
screen. 

2. Click on top of the newsletter with a Heading. 

Newsletter Layout 

Hooding No Hooding 

Click on your choice. 

Finally, we come to a screen (as shown in Figure 11-3) that looks 
somewhat familiar. (Oh yeah, the menu bar is usable now, if you want to 
stop and make that little sound adjustment I mentioned earlier.) 

Untilled I 

As you can see, the page is already divided for you. Your insertion point 
is located below a double row of dotted lines. The space above this set 
of dotted lines is called the heading. 

3. Click above the dotted lines, and your insertion point moves to the 
heading. 

4. Now make this really look like it was created by a teacher. Go to the 
Picture menu and select Choose a Picture. 
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5. In the dialog box that appears, double-click the Pictures folder- or 
simply click the Open Folder button at the bottom of the screen. 

If your hard-drive icon appears firs t, open the Miscellaneous folder. 
Then choose the Pictures folder. 

6. A new list of folder choices appears. Use the arrow keys on the scroll 
bar to find the folder titled Nice for Headings and open the folder. 

Ia Miscellaneous ..-1 
D Fun ond Fontosy -o 
D Lines ond Shopes 
D Mlscelloneous R-l 
D Miscellaneous M-Z 

I 

7. Scroll down until you come to the title Worm in Apple. Highlight the 
name; the picture appears for you in the preview area to the left of 
the picture choices. 

8. Under the picture there's a Place in Document button. Click this 
button. 

= HARD DRIUE 

(ell Nice for Heodlngs .... , 

0 First Ptoce 
D MollboH 
D Music 
D Sports 
D Spring 
D Winter 
D Word Bubble 

[J•cl Concel 

I Desktop ) Help ... 

Looking good! Now let's think of a title for our little newsletter. 

9. Click inside the heading and your insertion point appears in the top­
left corner. 

10. Go to the Text menu and choose Alignment. 

11. When the dialog box appears, choose Align Right and then click OK. 
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TeNt Alignment 

I Q RIIgn Left . 

I 0 Align Center . 

I O Justlfled . 
. 

I ® Rllgn Right 

. 

c::E:U 
~ 
~ 

Click on your choice. Then cllct on OK. 

12. Now go back to the Text menu and choose Font. 

What appears is one of my favorite features within The Writing Center. 
This dialog box allows you to see what your font looks like before you 
use it within the document. 

13. Choose the following: Font (Times), Size (48), and Style(s) (Bold, 
Italic). See how the Sample box changes? Click OK if you're pleased 
with the selection. 

..fJinL 

I!;;;· quick br_ow_n fox_ .I 
font Size S l~le(s) 

TaHType Mono ~ 
18 0 Plain c .. OK J TaHType PI 24 181 8old 

TaHTypeCondensed 36 
: 181 11111/t: ( Cancel ) Olln.ll.eii.In.u 

Wedgle 

~ 
72 

0~ 
White Shadow 96 ooomrmm ( Help ... ) 
Zapf Chancery 

!i'l l c 1~ I o-MS llneDniW 

Click on your choices. Then click on OK. 

14. Now type Robinette's (or any other name) and press Return. 

15. Type Weekly and press Return. 

16. Type Newsletter and press Return. 

Figure 11-4 shows the finis hed heading- how do you like it? 
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Ta-dal 

Figure 11-5: 
A sample 

newsletter 
story. 
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CreatiniJ the bodlJ of IJOUr newsletter 
I'll walk you through the creation of a story. You can then work on the 
remainder of the newsletter yourself. 

L Click below the heading, and your cursor moves to the left column of 
the paper. 

2. Go to the Text menu and choose Alignment. This time choose Align 
Center. 

Notice that your cursor automatically moves to the center of the 
column. Now for the first headline. 

3. Go to the Text menu and select Font. 

This time choose Geneva, 14, and Bold for your font, size, and style. 

4. Type SOCIAL STUDIES and press Return. 

5. You need to change the foot before entering your story. Make it 
smaller and change the alignment to Justified. 

6. Now type an imaginary story. Go ahead; type anything. 

I need you to put a couple of paragraphs down so that a picture can be 
inserted later. Figure 11-5 shows some sample newsletter text. 

The students hove enjoyed our 
rst week or study obout the 

e Ages. We hove been Ieeming 
knight s end castles th1s 

I'm glod they ore so excited 
this period In history. 

173 



1 7 4 Part Ill: Acting Like You Know What You're Doing 

Adding a picture 
1. Go to the Picture menu again. Highlight Choose a Picture. 

2. When the dialog box appears, double-click the Picture folder. Open 
the Miscellaneous folder again; this time choose the Fun and Fantasy 
folder. 

3. Within this folder, choose the Knight. Click on the Place in Document 
button. 

I know this isn't where you probably want your picture. And gosh, is it 
big! Don't worry - we can fix everything. 

Do you see the little boxes around your graphic? This means that your 
graphic is selected and ready for you to manipulate. Whenever you see 
these boxes, you can s imply click in the center of the graphic and drag 
it to the desired position. 

But you say it's too large? Well, you have two options. 

4. Either click on one of those little boxes and pull in on the picture to 
adjust the size, or go to the Picture menu and choose Resize Picture . 

5. When you get the graphic the size you want, move it to the desired 
location and click outside the picture to place it. 

Here's the really cool part. If you place your graphic on top of text, the 
text wraps around the picture. Go ahead, try it! 

If you decide to place the graphic somewhere else, simply click on the 
image. Your little boxes reappear, indicating that the graphic is ready 
for you to manipulate it all over again. So resize it, move it, or even get 
rid of it by pressing Delete. You are in control of this situation. 

SOCIAL STUDIES 
r TnrstD'G,nts hove tnJoytO our ''"t wulc f' s tUdy aoout Ult 

t1ddlt <i(l" ye hOve bttn ltDrnlltg 
tlt oDout tm~hts ona cn\ltt uus 
YWttk 1m glad they ort so t l(t1tta 
ot~L-th,~oa H'l tiiSIOf'\l 

our first 
stUdy about 

Ages. Wt 
been ltGmlng 

I obout knights ond 
eostles thiS wttl(. I'm gle<l thty Of"'' 

1
'10 IKCittd about thi S periOd In 
ht•rnn1 



Figure 11-6: 
Now your 

newsletter 
is really 
looking 

good. 

Chapter 11: Faking Your Way through The Writing Center 

That's basically all there is to know in order to fake your way through this 
program. When you finish with this first column, text wraps to the top of the 
next column. Continue working in this same manner. Your newsletter can be 
as many pages as you want. Figure 11-6 shows the emerging newsletter. 

The students have 
enjoyed our rlrst 
week or study about 
the Middle Ages. We 
have been I earnIng 
all about knights and 

this week. I'm glad they are 
ted about this period In 

The Student Writin9 Center 

figure 11-7: 
The Student 

Writing 
Center asks 

you to 
choose a 

document 

While the overall operations of The Writing Center and The Student Writ ing 
Center are similar, the programmers at The Learning Company added some 
substantial upgrades when they created the "new and improved" vers ion. 
The fi rst thing you notice is the increased number of product options that 
greet you in the opening screen (see Figure 11-7). 

Choose e Document 
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After you choose your document type (or open an already saved piece of work), 
you notice a few changes in the document window. In addition to the menu 
bar, you now have an icon bar and a ruler with buttons. Both of these added 
features make it easier for you to access frequently used program functions. 

In addition to the easy access provided by the rulers and icons, you may 
choose Short Menus from the View menu to limit the number of choices 
provided by each of the menu bar headings. Short Menus is a great option 
when you're working with younger students. 

In addition to the new "look and feel," The Student Writing Center also has 
some great new functions. If, for instance, students choose the Report 
layout, they can now have help creating a bibliography entry by choosing 
Create Bibliography Entry from the Report menu. I think the added online 
Help program is also an added bonus. 

The Journal layout is another neat function. Each student can have his or 
her own password to access a private journal. Students can flip through 
journal entries by clicking dates on the calendar or by clicking the Find 
button, searching for specific words or phrases. 

This updated software has an all-new set of clip art, along with the addition 
of borders and letterheads. Check out the printable reference I included on 
the CD of clip art you can find in The Student Writing Center and The Writing 
Center. 

Coming soon ,to a software store neat you 
The Ultimate Writing & Creativity Center is the 
newest product on The Learning Company's 
drawing board. It's aimed at students in grades 
2 through 5 and includes the following: 

1!1" AJull-fe~tured word processor 

1!1" ·1,000 writing projects and ideas . 

1!1" A paint program 

1!1" A multimedia presentation tool 

li!" ,ln~~rac~ive animated help;¢haracter 

,__.,:Spell checker 

~·Journal feature 

II"'. YeU9w "stickies" tp allowte,a,cher, paref1t 
;, and,: peecteedb~ckwit~Quraiteting ltbe' 

,original document 
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Writing Center tips 
II" Use the Spell Check feature (in the Refer­

ence menu) before printing your work. 

II" DQn't use too many fonts. The patchwork­
quilt effect gets confusing for the reader. 
Try to limit yourself to three or four differ­
ent font styles. 

II" Too many graphics clutter up your reading 
space. You want your newsletter to be vi­
sually pleasing- not overstimulating. · 

ltl" RemElmberthatthe graphics on the screen 
appear black and white on your page, un­
less you are working with a color printer. 

Jill' AIJow students to become "columnists" 
and contribute weekly articles for the 
newsletter. 

II" The Border choice under the Text menu 
allows placement of a border around a 
selected text block. 

Jill' Students can draw pictures in Kid Pix, 
save them, and then place them in a Writ­
ing Center document by choosing Desktop 
in the Choose a Picture dialog box. They 
then open the hard drive and Kid Pix to 
find the picture. Finally, they simply place 
the picture in the document and manipu­
late it as if it were a Writing Center 
graphic. 
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Chapter 12 

Faking Your Way through 
The Print Shop Deluxe 

o e o o o o o o o o o o o o o o o o o o o o o o o o o o o o o o o o o o o o o o o o o o o o o o 

In This Chapter 
~ Installing The Print Shop Deluxe 

~Making a card in The Print Shop Deluxe 

~ Exploring the tool palette 

0 0 0 0 0 0 0 0 0 0 0 0 0 • 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 

~e Print Shop put Br0derbund on the map as a major software producer. I ~irst created for use on the old Apple lie and lie computers, The Print 
Shop was and still is a major hit. Back then, everything (including all the 
great clip art) was contained on four huge 51/4'' floppy (you know, the ones 
that are really floppy) disks. Then, as Br0derbund came up with additional 
graphics, the company sold them in packages called The Print Shop Com­
panion. I loved it then, and I love it now - fundamentally, it's still the same. 

However, when Br0derbund came out with its latest version of this old 
classic, The Print Shop Deluxe CD Ensemble, all the information that re­
quired numerous disks was packed onto one CD with a new user interface 
(how things look). That last change really threw folks a curve. Everyone was 
comfortable with the interface they'd been using for years, and the new 
interface was a little intimidating to some. 

GettiniJ. Started 
Obviously, because it's called a CD Ensemble, you need a CD-ROM drive to 
use this program. Like you're required to do for most of the programs that 
now come on COs, you need to install a portion of the program on your 
computer's hard drive. 
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I. Place the CD in your CD-ROM drive. When the CD's icon comes up on 
your desktop, double-click it to open the window. 

2. Double-click on the PSD CD Install icon and follow the directions that 
appear. 

If your computer has a limited amount of hard drive space, click on the 
Install button in the upper-left corner of the window. You see a pop­
down menu appear, offering you the option of a Limited Install- this 
option won't use up as much of your hard drive space, but it does limit 
what you can create without the CD itself in your computer. 

3. After everything's installed, you have to restart your computer. 

4. After you restart your computer, double-click on your bard drive. 
Find the Print Shop Deluxe folder and give it a double-click. In the 
window that appears, double-click the Print Shop Deluxe icon. 

You are prompted to personalize your copy of the program, enter your 
name (or your school's name), and click OK. 

Now you're ready to go! 

Pick a Car" An~ Card 

Figure 12-1: 
Here's the 
deal: The 

deck's 
stacked in 
your favor 

with so 
many 

personalized 
possibilities. 

The first screen you see is the main menu- shown in Figure 12-1. Here you 
see the five choices for new products : greeting card, sign, banner, letterhead, 
and calendar. Three smaller buttons let you open previously-saved work, give 
you access to a help feature, and allow you to cancel and quit the program. 
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Figure 12-2: 
Choosing a 

greeting 
card style. 

In this chapter, I teach you how to make a card with The Print Shop Deluxe. 
Follow my directions step by step, and you'll be rewarded with a great thank­
you note when you're finished. Teachers can always use a thank-you note. 

I. Click the Greeting Card button. 

A screen of greeting card options appears, as shown in Figure 12-2. 

2. Click the Top Fold button (also known as landscape). 

A screen showing your backdrop options appears. Click through your 
choices, and you see a sample appear on the right side of the dialog box. 

3. Choose Blank Page from the Backdrop dialog box. Click OK. 

I always choose Blank Page when the Backdrop choices appear. Why, 
you ask? Well, most of the backdrops are very involved and require 
tons of ink (a rare commodity in the school setting) and, in addition, 
most of the backdrops only look their best when printed in color. If you 
have a color printer and plan to print only one project, you may want to 
try a backdrop on your next project. If, however, you want to print one 
card for each student, a color background on each one can be costly 
(color ink cartridges are tres expensive). I usually print one card and 
then use the copy machine to make the rest of my cards. 

Some color inkjet printers don't have a black ink cartridge. To draw 
something in black, the printer must mix all its colors. Thus, on these 
printers, it takes more ink to print black that it takes to print in color. 

A dialog box appears (as shown in Figure 12-3), prompting you to 
choose a Layout. The Layouts show you different options for using text, 
graphics, borders, and special effects on your card. 
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Figure 12-3: 
Pick out 

your 
favorite 

card layout 

Library: 

No Leyout 
Greeting Card I 
Greeting Card 2 
Greeting Card 3 
Greeting Card 4 
Greeting Card 5 
Greeting Card 6 
Greeting Card 7 
Greeting Card 8 

Lendscape Layout 

Greeltng Card 9 0 

options. 0 lighten Barkdt op I 4t !;j I ~ [ cancel ] 

Figure 12-4: 
Your 

headline, 
graphics, 

and border 
placements 

appear in 
positions 

marked by 
icons. 

4. Choose Greeting Card 9. Click OK. 

The front of your card appears on your screen, as shown in Figure 12-4. 
The gray shaded areas are called placeholders. Placeholders show you 
what elements will be in that position after you finish designing your 
card. The icons and the shape of the placeholders tell you what type of 
element will be in that spot. In this case, you have a headline, two 
square graphics, and a border. 



______ Chapter 12: Faking Your Way through The Print Shop Deluxe 

Figure 12-5: 
Enter text 

for your 
card's 

headline. 

5. Double-click on the Headline placeholder. 

The Headline Text dialog box appears, as shown in Figure 12-5. You 
should see a cursor in the upper-left corner of the dialog box. 

Headline TeHt 

Effect 

Font: I Heather ""I 
Sh11pej " Double Arch Up ""I 

Just i fy: ' Le ft "": A 
( Customize ••. ) C11ncel •••• 

6. Type the word Thanks! and click OK. 

You probably notice some other options in this dialog box. If you're 
feeling confident, try changing the font of your headline, altering the 
shape of your headline, or for those of you willing to accept a chal­
lenge, click the Customize button and do a little experimenting. 

7. Double-click the Border placeholder. 

The Border dialog box appears. On the right side, you see a list of 
border styles. Click on a border style and a sample appears in the box 
on the right side. 

8. Choose the Joined Unes border and click OK. 

The border pops into view on your screen. If you don't really like my 
choice, double-click on the border and the Borders dialog box appears 
again. Make your own choice and click OK. 

9. Double-click one of the graphic squares. 

The Square Graphic dialog box appears (shown in Figure 12-6). You get 
tons of great graphics to choose from. On the left side, you see a list of 
graphic possibilities. Click a graphic and the image appears in the box 
on the right side. 
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library: PSD Squer es 
Pets ~ 

Pumpkin 
Pushpin 
Red Cross 
Restaurant I con 
Running 

I I 

Sale 
Soccer 
Spaceship ~ 

Figure 12-6: 

0 Apply To All Squares Some fun 
graphics for 

your card. (Change Library ... ) ~ ( Cancel ] 

Among the more-confusing aspects of this 
newest version of The Print Shop Deluxe are 
the icons or placeholders that appear on the 
layouts. I think Brederbund put these in to 
make things easier, but to the first-time user 
they can be a little confusing. 

Remember, to work with an area that's repre­
sented by a placeholder, simply double-click 

Square graphic Headline Ruled lines 

f\ 

:1K. ~~ r•.. ~ 
.. ~ r.: 1·-&.<"J:•iEa idl 

\ 

that area of the layout to activate the windows 
that allow you to make your selections. 

Note: Just because your layout is filled with 
placeholders doesn't mean you have to use 
each of them. If you want to get rid of a place­
holder, click it once to select it and then press 
the Delete key. 

Border Miniborder 

.•. 
Text block Row graphic Column graphic 
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10. Choose a graphic and click OK. 

I chose Running Computer. 

Note: If you want to change the size of your graphic, click one of the 
little black boxes that appear when you place the graphic. (If you don't 
see the boxes, click the graphic once and they should pop into view.) 
Click one of the small black squares and drag the corner to make the 
graphic smaller or larger. When you get it just right, let go of the mouse 
button. 

II. Repeat Steps 9 and 10 to fill in the other graphic area of your card's 
front. 

You're finished with the front now. You've done a great job ... don't you 
like that positive reinforcement! 

12. Open the Navigation pop-up menu in the lower-left corner of the 
screen. Click Inside of Card (see F1gure 12-7). 

Now you're going to be faced with many of the same choices you made 
when creating the front of the card- except you'll be interior decorat­
ing this time! 

13. Choose No Layout from the Backdrop dialog box and click OK. 

14. Next, choose Greeting Card 16 from the Layout dialog box. 

The inside of your card appears. This time the placeholders look a little 
different - a good opportunity to learn some new techniques. 

15. Follow Steps 5 through I 0 to insert your headline text and choose a 
graphic for the inside of your card. 

16. Double-click the Row Graphic placeholder (refer to the Placeholder 
information sidebar). 

The Row Graphic dialog box appears (shown Figure 12-8). Scroll 
through your choices or choose Switch Libraries to gain access to more 
choices. 
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Figure 12-7: 
Navigation 
throughout 

the card 
is only a 

click away! 

Figure 12-8: 
Pick your 

preference 
from the 
graphics 

"rows" 
library. 

~~~ 
11JfJ 

fraM.of C.Ont ... 

L Click here to nav1gatel 

Row Graphic 

11-- ~II 
library: PSD Rows 0 Apply To All Rows 

Cups & String 
Dreidels I Football Players ( Change Library ... ) ~ 
Haunted Cemetery 

[ Cancel ) l OK ;) 
Jolly Pumpkins 

.~ JukeboH 

17. Click OK to place your Graphic. 

18. Choose Back of Card from the Navigation pop-up menu in the lower­
left corner of the screen. 

The back of a card isn't supposed to be the focus of attention, so 
choose No Layout from the Layout dialog box. 

II 19. Double-dick the Text tool on the tool palette. 

A funny-looking cursor appears. Click and drag a small text placeholder 
near the bottom center of your card. 

20. Double-click your newly created Text placeholder. 

A cursor appears. Before typing anything, go to the Text menu (at the 
top of your screen) and choose Extra Small from the Size submenu. 
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21. Type in a witty closing statement. 

I typed A Robinette Creation. 

I 
I 
I 
I 

i A Robin&!» Crvation 
I 
I I 

~-------------------------------------------~ 

22. You're done! Choose Print from the File Menu. 

After printing, fold your paper in half and then in half again to create 
your card. 

You may also want to save your work. The Save command is found in 
the File menu. 

The Tool Palette 

Figure 12-9: 
The Print 

Shop 
Deluxe tool 

palette. 

You probably can't help but notice the tool palette on your screen. Most 
programs now offer these palettes as a means of giving the user easy access 
to frequently used commands. 

Figure 12-9 gives the low-down on what The Print Shop Deluxe tool palette 
can do for you. 

Text Tool: 
Enter text and select text to edit. 

View Tool: 

Hand Tool: 
Moves your current project 
around within the window. 

Rotate Tool: -----flo 
Rotates selected objects. rl~===~~~ 

Color Control Panel 

Zooms in or out. 

New Objects Tool: 
Adds new objects 
to your current project 

Delete Tool: 
Deletes a selected object. 

Frame Tool: 
Places a frame (thin line, thick line, 
no line, double line, or drop shadow) 
around a selected object 

Flip Tool: 
Flips a selected graphic object 
horizontally, vertically, or both. 

Item Selector 

lint Slider Color Bar 
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I've barely scratched the surface when it comes to all the possibilities that 
are lurking within this great program. Use the basic knowledge you obtained 
here to dig deeper and go a step or two further! 



Part IV 
Going Online 



In this part ... 
~erybody's talking about the information super­
!;~ighway. Read on and find out what all the buzz is 
about. A modem is the required mode of transportation. 
The World Wide Web is one interesting place to stop for a 
visit. So fasten your seat belt and start your engine! 



Chapter 13 

What Is the Information 
Superhighway, and How Can I 

Hitch a Ride? 
oooooooooooooooooooo~eooeoooooooooooeooooooooooo 

In This Chapter 
f> What is this Internet thing anyway? 

&>The Internet's value in education 

~The modem's role 

1!>- Who are you going to communicate with? 

~What are you going to do online? 

b> Minding your manners 

£i> Scheduling creatively 

000000000000000000000000000000000000000000000000 

Are you tired of simply nodding your head and grinning like you under­
stand everything being said when your friends use words like Web site, 

Internet access, download, and Netscape? Or maybe they're throwing 
around acronyms like FfP, URL, ISP, and BBS? I've been there myself, and I 
know how you feel. Read this chapter and I promise to explain what 
everybody's talking about without insulting your intelligence. Then I want 
you to take the next step and "surf the Net" yourself! 

What Is the Internet? 
The Internet is a worldwide network of computers that are connected by 
telephone lines and various other types of connections. Computers are able 
to communicate with one another when they are equipped with the right 
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hardware and software (you find out more about these requirements later in 
this chapter). Are you with me so far? Within this tangled mass of telephone 
lines we like to call the Internet, a number of different networks exist 
independently and serve a variety of purposes. You see, your computer 
actually becomes part of the Internet when you connect to one of these 
services. 

Here's a brief list of the most common services offered on the Internet: 

I"' E-mail (electronic mail): E-mail is mail sent from your computer screen 
to someone else's computer screen. 

Jill Online services: These services have names like America Online, 
Prodigy, and CompuServe. Online services offer user-friendly interfaces 
and a host of services, including e-mail, WWW access, magazines in 
electronic form, travel services, research aides, and much more. 

I"' WWW (World Wide Web): This system is very popular and gives you 
access to pages and pages of graphics-rich, informative (and sometimes 
not so informative), and searchable resources. 

r. Jill Newsgroups and Bulletin Board Services (BBS): These are the equiva­
lent of an electronic bulletin board. However, instead of bulletin boards 
like those in the front of your local grocery store that contain all kinds 
of information, the newsgroup bulletin boards are organized by topics. 

I I"' FrP (File Transfer Protocol) software and FrP sites: This software 
allows you to download files from FTP sites throughout the world. 
Apple, Claris, Bnaderbund, and all the other "biggies" in the computer 
world maintain FTP sites where you can download software upgrades, 
demo versions of a new product, or product information. 

, Gopher: This program helps you find information on the Net. The 
results of a Gopher search are displayed in menus. These menus may 
contain individual files, documents, or links to other computers. 

FYI: Because we're all educators, I should give you a little history lesson 
now. The Internet was first started in the 1960s by the Department of 
Defense as a means for military researchers and universities to communi­
cate. Soon other governmental agencies and universities began to use the 
service to communicate. As its popularity grew, the Internet (originally 
named ARPANET for Advanced Research Projects Administration Network) 
expanded outside the United States. In the early 1990s, the Internet was 
opened up for commercial access, and that's how you and I now have 
access to what was originally meant for the private use of the Department 
of Defense! 
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What's So Great about the Internet 
in Education? 

,;' Communication: The Internet offers the next best thing to face-to-face 
interaction - direct communication with an expert resource. If you 
have students interested in space travel, they can use the Internet to 
communicate directly with NASA scientists. A French class can easily 
send letters to someone in France. Or a whole class can collaborate 
with a class in another state (or country) to complete an ongoing study 
on pollution. The opportunities are endless! 

J;' Research: The Internet is the most powerful research tool available. 
Textbooks are out of date before they ever reach the students' hands; 
information on the Internet is constantly being updated and is, there­
fore, always current. In addition, with the correct software, students 
can experience online field trips that allow them to be part of scientific 
expeditions where they can observe live video feeds, ask the scientists 
questions, and make suggestions. 

,;' Communication: Many schools now have their own Web pages. They 
use these pages as a means of communication, posting schoolwide 
information (PTA meetings, fund-raiser information) and specific 
classroom information (homework assignments, field trip dates). In 
addition, a school Web page is a great place to show off student work. 
Publishing multimedia projects, poetry, and reports on the Web is a 
wonderful way to instill student pride. 

,;' Instruction: Imagine having the resources you need for your lessons as 
close as a click of the mouse. That's right, all those materials you spend 
hours searching for in vain in your school media center are waiting for you 
on the Internet. Why not go a step further and have your students find 
your resources for you- bet that makes them remember the content! 

Another addedlnternet benefit 
Recently, while working with a group of eager 
third-grade students, I discovered somethingc 
incredible- the Internet requires students to_. 

· us.e ,reading and critical thinkir~g skills• Y'e~, in. 
order to fine-tune a search for lntemetitifor­
mation,.kids must put their brain cells.thmugfi:_ 
some pretty rigorous exercises, and;tf1en:they 
must actually read the pages they,pulf~_op.lf 

after reading they discover that whatthey pull­
lip isn't what they're looking for, that all-.illlPOr.;. 
·~~nt cr~cal thinking jumps back into action.­
The exercise is about more than clicking here · 
and therQ tojump from page to page- using -
the~ Internet actually enhance$ yQur alreaqy -
:e)(istin.g language arts curriculum. 
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TelecommunicatiniJ. 
Telecommunicating is a sophisticated word for what happens after you 
connect your phone to a modem that's attached to your computer. I trans­
mitted this entire book, and my two previous titles, through telecommunica­
tions. That's right: I've never stepped foot in my editor's office. I've never 
even been in the same state! Every word that you see in this book was sent 
from my computer to my editor's computer via telephone lines. Incredible, 
isn't it? 

What's a Modem? 
A modem is the initial means of connection to the world of online comput­
ing. The word modem comes from lllQdulate, demodulate, two terms left over 
from the prehistoric age of telecommunications. Basically, the modem takes 
what's on your computer and magically transforms it into ones and zeros 
(binary code). The binary code is then sent to another modem that 
unencodes the data. This all happens, by the way, faster than you can say 
recess! 

Later, after you've decided that you'd like to access the world of telecommu­
nications from every classroom and office in your school, you might invest 
in a schoolwide network that includes a network connection to a network 
modem hidden away somewhere in the school. However, the first step 
towards that goal is through the use of a modem - a modem is less expen­
sive (initially) than a network modem and is the perfect way to get your feet 
wet in telecommunications. 

A modem is a small rather inconspicuous device that's about the size of a 
box of pencils (only a little thicker). Modems can be external and sit beside 
your computer, or they can be housed inside your computer's hard plastic 
shell. There are even small PC card modems that are the size of credit cards 
and are used with laptop computers. One wire from the modem plugs into 
the phone jack in the wall of your classroom (ha, hal), home, or media 
center. The other wire goes into the modem port on the back of your 
computer. 

If you're now off the floor and finished laughing about a phone jack in your 
classroom wall, you're not going to believe what happens next. Using the 
little box as a translator, your computer can speak its native language to 
other computers worldwide- it doesn't matter whether you're using a Mac 
or a Windows machine. And the message is sent in the same way that you 
would send a message: by making a call over the phone lines. 
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~SUP-~ 
~ 

You may alreally_.~-~ve a m_odem 
I know that this sounds a little crazy, but you - ~at-c:ame 'with the computer and do a little 
may already have a modem and not even know - re~ding ---you may be pleasantly surprised! 
itllf you or·your school recently purchased' :(Most "school" computers don't come with 
a computer, it probably came with a bLillt~in, _ modem~, but most "consumer" computers do 
or internal, modem. Get out the literature _'con\tHvith modems.) 

Speed 
Faster modems cost more. And who cares about speed? You will, the 
moment your students try to send or receive information over the phone 
line. Every minute is precious in a school full of eager-to-learn students. The 
faster the modem, the faster you can send or receive information, thus 
saving valuable time and money. Buy the fastest modem that your school's 
funds can allow. 

Modem speeds vary. (Modem speeds are measured in bits per second, 
abbreviated bps.) You won't find many modems at less than 14,400 bps 
(about $100), and I strongly suggest purchasing a 33,600 bps modem (about 
$200) if it's within your school's budget. And 56,000 bps will soon be the 
standard! Another bonus is that most of today's new computers come 
bundled with an internal modem or an external modem as part of their 
overall package. An ISDN (highest-speed) connection is a device that allows 
high-speed access through regular telephone lines. (The telephone company 
must set up this service for you.) 

Where IJ.OU can stick it 
Boy, have I ever wanted to say that to a few students! 

No, really- I have! 

Anyway, location is an important consideration when using a modem in your 
school. Most schools opt for a central location, such as the media center, for 
a number of reasons: The media center has more room, phone lines already 
lead into the area, and the media center usually has a computer. 
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~ 
~ 

When the Mac or PC makes a phone call, it ties up the phone line just as 
effectively as a teenager ties up the phone line. While your computer is 
using the modem, nobody can use the phone. In the school setting, this 
situation requires installation of a dedicated line, a phone line that is only to 
be used with the specified computer and modem. A dedicated telephone 
line is an expensive necessity. 

At home, you need to keep the following in mind if you can't afford an 
expensive dedicated line: 

I" When you are using the modem and someone picks up the telephone in 
a different room, it will usually disconnect the modem from whatever 
service you are connected to. Spend a few minutes before you go 
online, informing the family that you're about to go online to avoid this 
situation. There's nothing worse than being disconnected in the middle 
of an important file download or while chatting online with a really 
interesting person. 

I" If you have the call waiting service, disconnect it before going online by 
having the modem dial *70. This will prevent any calls from coming 
through while you're online and disconnecting your online session. 

Who are IJOU 9onna calll 
After you have a modem and a phone jack to plug it into, you still need to 
get software to control it. Without some kind of modem software, you can't 
do much more than stare at it. 

Schllol:~tel~p,bonec lines 
More th.an likely, 'f(Jur s«:hoolh(ls· (lfl illf81Jr1Jtf!,d: mode,nf Ita~ difficulty,getting~Q dialtone: (and in. 
phone system ---' if you· have to dial 8 ,();~9 to some cases~ wben you can get C4 dfaltooe, ,you 
get an outside lin~, your school•s<phgne sv.~~ sdll. have to cc.,nffgure the mod.em~to dial an a. 
tem·is integrated. Having an integrated:phorie.: of.9 to;.get out). Unless your phone ·system is 
$ystem means· that,. .along with ea.ch phone· .C{)Ofigur~d sp·ecifically for·,mpdem ~ornmuni­
caiJ you make- you~ te·l~phon.e h~ndsetsend~ caticu1s• dead .air is. all you ·hear when your 
signals· through an electrgnjc $Wi(~~ilo~ b·~- . ·r:nod}!m att~mp~ to cpnnect. To .so.lv~ this 
fo'rQ your can .exits the building.: Be~ause. ·problemj; ·have ttle ,phon~. compaqy· makf an 
y~JU're 'dialing.Q.utWith a,rnode.m,ratber.than an, . a~ju~ent tO. one or more ;of your· lines .or. 
esp,cially cqnft~ure,d h_~ntls~s.Q'rol!titj),s:th~, .. hAtve a:dedicated line illstalled. 
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America Online1 Prodif1.1J1 and CompuSerfle 
Commercial services, also known as online services, used to run on a pay-by­
the-hour rate, and most have package prices for schools. Now these services 
generally charge a monthly fee for unlimited (or almost unlimited) usage. 

Shop around for the best rates. (I was really taken for a ride the first time 
that I purchased an account for my school.) 

Remember that you can't use ClarisWorks as a means of hooking up to 
online services that have their own software (AOL, Prodigy, and so on). You 
can, however, send ClarisWorks documents to others via online services, 
and you can find lots of neat ClarisWorks templates to download from online 
services. 

WWW: The World Wide Web 
The World Wide Web is another connection option. Pages on the WWW are 
full of cool graphics and interactive text. Clicking programmed text that 
appears highlighted on Web pages allows you to jump around inside the 
Web and access tons of cool information. 

Accessing the WWW requires an Internet user account (something like a 
charge card you set up for billing your online time) and some type of Web 
browser software (software that allows you to search the Web). You can't 
use ClarisWorks to access the Internet or the WWW. Contact your Internet 
service provider for details on connection to the World Wide Web and 
names of software options. 

~sUP f1JJ Note: You can use ClarisWorks to access the WWW in a roundabout way if 
~(15 you go through a local university system. Many universities offer something 

~ called shell accounts that set your computer up as a dumb terminal. You 
" ~' dial up the university and then, through their computer, you are connected 

to the WWW. This service is somewhat limited and is still only text-oriented. 

What are IJOU 9onna dol 
After you're connected to another computer (or after you go online, as 
savvy users say), you and your students can do all kinds of neat stuff. 

M J;l' Type messages back and forth to other people. Give students a real-life 
m reason to write! lsn 't that exciting!?! 
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I" Leave typed electronic mail messages for people to find later. This 
feature is called e-mail, and it's really cool. Some very progressive 
schools in my area already have e-mail within the school itself - if 
you're having a bad day, you can e-mail a fellow teacher and request a 
joke or some other type of pick-me-up. 

I" Send documents (written with ClarisWorks, of course) to others. This 
feature is one of the biggies. Students across the world can now share 
reports, pen pal letters, and much more with ease. No more waiting two 
months to hear back from your sister classroom across the country. 
With a modem and a phone line, communication is instantaneous! 

I" With fax software added to your modem (most modems come with this 
tidbit), you can send any document created on your computer to 
anyone with a fax machine. Some of the fax software has capabilities 
that allow you to receive a fax (via your computer) as well! I use this 
feature a great deal for sending documents that I create in ClarisWorks. 

I" Look it up. If you belong to one of the information services (America 
Online, CompuServe, or Prodigy), you can do all kinds of other things. 
As with other electronic bulletin board systems (BBSs), these services 
give you access to tons of information. Look up information in encyclo­
pedias and magazines, read movie reviews, check stock prices, and 
search for ideas on using technology in the classroom. Consult with 
thousands of other educators who "surf the Net." 

I" Create your own Web page. A Web page is a site on the World Wide Web 
(WWW), a site that you create to tell about yourself, your school, your 
class, or your family. Many schools around the country maintain spots 
on the Web. Web pages require special formatting known as HTML 
(HyperText Markup Language). ClarisWorks 4.0 includes an HTML 
translator - read on to find out more. 

Miss Manners on Netit{uette (MindiniJ. 
Your Online Manners) 

Cyberspace (the Internet) is a classroom where your students can be judged 
purely by their thoughts. What a wonderful opportunity for students! 

Kids and adults tend to type things that they might not feel so comfortable 
saying out loud, so take note of these warnings and add a few rules of 
your own. 
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Telecom.rnunU~ation terms 
Baud: Baud and bits per second. (bpsl.refer to· 
how fast a modem can send/receive informa­
tion. The higher the baud· rate, the .faster that 
information can getfrom one place tQ -another. 

BB_S (Bulletil]~oard Service): A BBS. is a sys~ 
tern that enables people to post messages and 
read messages posted by other people. Many 
schools maintain their own BBSs. 

Downloading: Downloading means to move 
information from another computer to your 

MQdem:.A modem is a small electronic device 
,thattranslates what you create on your com­
puter into sounds that can be sent through a 
phone line and received by another modem and 
computer atthe other end of the phone line. 

Online Service: An online service is a com­
mercial service that provides information 
through a user-friendly interface. Examples 
include America Online, Prodigy, and 
CompuServe. 

computer via a modem, via a network, or by _ Shareware: Shareware refers to software, 
other methods. - templates, fonts, or clip art that's available for 

a-mail (Electronic Mail): Electronic mail is the 
term for letters and messages sentto others 
through a computer modem or via a network. 
(If your school or school system is networked, 
you can send e-mail within your school or to 
other.locations within the network.) 

Freeware: Freeware is software, templates, 
fonts, or clip art that doesn't cost anything­
yes, freeware is free of charge I 

Internet Service Provider: An Internet service 
provider supplies you with the connection that 
you need to access the Internet. 

a small fee (usually under $25) that is re­
quested by the. creator. 

Uploading: Uploading means to move informa­
tion from your computer to another computer via 
a modem, via a network, or by other methods. 

WWW (World Wide Web): Also known as the 
Web,· the World Wide Web is a part of the 
lnt~r11et that's full of cool graphics and text 
links that allow you to jump from site to site by 
clicking on hot spots or highlighted text. Ac­
cessing the WWW requires a software pro­
gram known as a browser. 

"""" Never give out personal information online unless you know that the 
need is legitimate. That means no phone numbers and no addresses. 

""""Don't type in all capitals. Leave your Caps Lock key alone. All capital 
letters are hard to read and have a special meaning in the soundless realm 
of online speech (using all caps means that YOU'RE SHOUTING). It also 
means that you're a rank beginner who doesn't know this rule. (Early in 
our cyber-relationship, MacGod Pogue had to painfully teach me this rule 
after I sent him an e-mail written in all caps! See, I was a beginner, too!) 

"""" Don't worry about the flaming. Flaming means unmodulated ranting 
and raving. Being teachers, we are all quite used to this form of commu­
nication from parents. Flaming happens quite often online. You may go 
online and leave an innocent message inquiring about grade-book 
programs for your school. When you return the next day, you may find 
that some cyberjunkie has responded with a message like this: 
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"It's ill informed IDIOTS like you that give classroom technology a bad 
name! ARE YOU CRAZY? You need to stop worrying about making your 
life easier and get on with the business of TEACHING! Use technology to 
help the kids - not YOU!" 

Y' Online, no one can hear you smile. You can't read someone's expres­
sion when they write to you online. You can't see them rolling their 
eyes or pretending to gag as they read your message. I guess some folks 
with too much extra time on their hands (obviously they weren't 
teachers) came up with the following symbols and many more as a way 
of expressing their emotions. The following symbols, called emoticons, 
are used individually or at the end of a sentence when communicating 
online: 

:) smile 

:( unhappy 

;) sly wink 

·-* kissing 

8-) wearing shades 

:-p sticking out tongue 

::::-o shocked 

:-/ skeptical 

::::):-)= Abraham Lincoln 

Y' Others might use acronyms to represent common phrases: 

BTW By the way 

LOL Laughing out loud 

ROTFL Rolling on the floor laughing 

BRB Be right back 

BAK Back at the keyboard 

RTFM Read the (you-know-what) manual 

IMHO In my humble opinion 

GMTA Great minds think alike 

@*#*&! Golly 
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An idea 
While writing this chapter, I came up with a 
neat idea. As you begin to get your students 
familiar with Cyberworld and its etiquette, why 
not have them create some signs, symbols, 
and acronyms of their own - symbols that 

SchedulintJ 

represent feelings and phrases associated 
with the trends and ideas of their generation. 
It might be interesting to see what ideas your 
cyberkids can come up with. 

If you use an online service that charges by the minute rather than by fixed 
fees for unlimited use, read this section; I need to talk to you about schedul­
ing. I'm going to take this time to inform you that exploring online can be very 
addictive, and once you all (you, your students, and other teachers) get a taste 
of what's out there, you won't be able to stop! In my school, we had a problem 
with prepaid online time running out before the quest for more knowledge and 
communication was fulfilled. Telling a group of students that they have to wait 
to see if someone wrote them back is tough. Kids don't like to wait, and neither 
do I. Here are few ideas for making the best use of your online time: 

~Check into local Internet service providers (ISP's) in your area. Many 
offer low-cost Internet access accounts for around $20 to $35 a month 
for unlimited access to the Internet. You don't get the fancy interface of 
an online service, but you do get unlimited time online. 

~ Allow only supervised groups of students access to online time. It's too 
easy for children to get off task, waste time, or (worse yet) forget to 
sign off! (Most services automatically shut down when left idle for a 
period of time- but that's still wasted time, and online time is money!) 

~ Have students do as much work as possible offline. Ask the students to 
use ClarisWorks to create their letters, charts, databases, reports, s lide 
shows, and artwork before they go online. 

~ Keep a log book beside the computer hooked up for telecommunica­
tion. Have teachers keep track of their online time. 
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Y" Use the voucher system. Vouchers work great. Create vouchers or 
coupons that are good for 15 minutes of time online (make sure that the 
total of the vouchers is the same as the amount of time you are given 
each month). Pass the vouchers out to the teachers and tell them that 
they can redeem them at any time that month. Our school allows the 
teachers to exchange vouchers with each other if they want more 
online time in a specific month. The use of vouchers is a fair way to 
give access to all, and those who don't want to use their time can feel 
good about giving it to a colleague who can put it to good use. 

Y" Working with small groups (six or fewer people) is best because 
everyone in the group gets to view the screen and have easy access to 
the keyboard. 

Y" Spend the first few visits online getting acquainted with what there is to 
offer. Don't jump into an activity before the students are familiar with 
the concept of telecommunications. Keeping things simple in the 
beginning and building an understanding of what's out there allows 
students to venture in exciting directions with confidence later on. 

Y" Work with your faculty and your students' parents to come up with an 
Acceptable Use Policy. This policy needs to spell out the expectations 
that the school has for student online use. Acceptable Use Policies deal 
with (among other things) access to online areas, who is allowed to use 
the equipment, and how students are to be supervised. 
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The World Wide Web 
000000000000000000000000000000000000000000000000 

In This Chapter 
~What is the WWW? 

~Web nuts and bolts 

1> How do I jump on the Web? 

~Meet URL 

rP- Internet 101: Netscape Navigator and Microsoft Internet Explorer 

Ill> Great places for a first visit 
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~is chapter represents a small sampling of the cool Internet information I ~ou'll find packed within the pages of Bard Williams' book, The Internet 
For Teachers, 2nd Edition (IDG Books Worldwide, Inc. 1996). Bard is a good 
friend and an Internet guru. I thank him for the gracious donation of parts of 
this chapter. If, after reading this chapter, you become a "web junkie," you'll 
want to pick up all of Bard's wonderful titles: 

Y' Web Publishing For Teachers (IDG Books Worldwide, Inc. 1997) 
ISBN #0-7645-0111-9 

Y' The Internet For Teachers, 2nd Edition (IDG Books Worldwide, Inc. 1996) 
ISBN #0-7645-0058-9 

Y' The World Wide Web For Teachers ( IDG Books Worldwide, Inc. 1996) 
ISBN # 1-56884-604-5 

"Ladies and gentlemen, please return your seat backs and tray tables to 
their upright positions. We're about to take off on a journey you won't 
forget." The World Wide Web (WWW) is somewhere between a visit to the 
library and a roller-coaster ride at Walt Disney World. 

The WWW, most often referred to as simply the Web, has all the things your 
students (and you) will love- dazzling in-your-face graphics, access to 
sound files, a slick graphical interface, and thousands of places to visit, many 
of which are linked to databases, file libraries, and interactive online chats. 
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The Web is by far the neatest thing on the Internet, and more and more 
schools and businesses are jumping on the bandwagon. Public schools are 
creating Web pages that contain information about projects. Universities 
offer Web-tours of their campuses and information about everything from 
campus organizations to whafs on the menu at the cafeteria. Government 
agencies and nonprofit organizations feature access to huge databases of 
information and thousands of retrievable files. Companies such as Apple, 
Microsoft, Levi Strauss, lOG, and Coca-Cola are all sporting fancy new Web 
pages. And there are plenty more examples of how this new medium is 
fueling the excitement about the Internet. 

So ... fasten your seat belt and get ready for the ride of your life! 

What Is the WWWl 
Welcome to the World Wide Web. The Web is the place where the emphasis 
shifts from what information is available to how it is available. The WWW is 
an Internet resource that is built on a computer language called hypertext 
markup language (HTML), a HyperCard-like language that gives even the 
novice user the ability to create a graphical jumping-off point called a Web 
page. You access a Web page by using a computer program called a Web 
browser and click on links (pictures or words) on the screen to jump to 
other Web pages. Each page has a different theme, with graphics, sound, 
movies, documents, and more. 

A good Web browser program, such as Netscape Navigator or Microsoft 
Internet Explorer, is the Swiss Army Knife of the Internet world. It slices, it 
dices, it does just about anything. In fact, the Web browser will probably be 
your primary tool in searching for information on the Internet. 

Using the WWW and a good browser program gives you and your students 
easy access to 

~ Documents available on the Internet 

~ Files containing programs, pictures, movies, and sounds from an FTP 
site (host computers containing files you can copy) 

~ Usenet newsgroups (which are like a bulletin board where you can post 
and read messages on specific topics) 

~ WAIS searches (database searches) 

~Computers accessible through telnet (logging into other people's 
computers) 

~ Hypertext (click-and-go) documents 

~Muchmore 
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Web nuts and bolts 
The WWW was developed and introduced to the world in 1992 at CERN, the 
European Laboratory for Particle Physics. The object was to build an easy­
to-use, distributed, hypermedia system. CERN accomplished its task, and 
more. 

The concepts used in designing the WWW have even earlier roots - all the 
way back to 1960 when a guy named Ted Nelson came up with the idea of 
hypertext, a way to link documents that are stored on different computers. 
The hypertext concept is familiar to people who use HyperCard and 
HyperStudio on the Macintosh. (See the sidebar titled "Getting hyper" for 
more information on hyper-stuff.) 

·Getting hypet-
The Web offers users an adventure in . (or'jusUinks),ellable.~.a user to move betwf:)G,i) 
.hypermedia~ fueled by hypertext arid data.in ,a nonlinea~Jilaflne.r.You're justaslikely· : · 
hyperlinks. Irs a truly hyper place. that's per~· · to hear: a sound when·~lic~ing on a hyperliriked . 
feet for hyper students (and teachers)~ word whUe browsing a· hypermedia file, for 

example, as you :are to view a picture. 

The language th~t~e.b programs use to cre.­
~ate hyperlinks · is caned HyperText Transfer 
Protocol (HTTP}~· HTTP enables users to cre• 
·ate their own Web pages and postthem:tothe 
Internet and ensures thatthe file will be read· 
able by Web browsers. When ·you enter a 
WWW addres~, you enter the following text 
before the Web address: 

Hypermedia is a term used to describe the 
union of hypertext and multimedia. The term 
hypertext, coined . by Ted Nelson, describes 
text that, when ·selected with the click of a 
mouse, zips the user to another source of re­
lated information. For example, clicking the 
hyper-linked word "projects" in the sentence, 
"There are many .on-line projects that NASA · 
offers to students/' might whisk you away to 
another site .(residing on another computer 
halfway across the globe} that offers a list of. http: ll 
specific projects and information abo~t how · · The prefix tips off the Internet. that the: URL. · 
to participate. , (Uniform R.esourc~t~ocator- an h'ftf;!~ne~.;r:~~ : · 

Multimedia refers to the union of different data 
types, such as text, graphics, sound, and 
sometimes movies. Hypermedia connects 
these data types together. With hypermedia, 
highlighted and linked te>«t called hyper/inks 

source address) you're looking for is a·www 
address, a.ndnota; Gopher or FTP s.ite. So,:. iO.' 
the address, http: /www. a o 1 • bi ue·. com, 
the http : I l tells you and the Net that the 
site you seek is orrthe Web. 
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How do I jump on the Web? 
It's possible to access the Web through a text-only browser if your connec­
tion to the Net won't let you display graphics; or you can use one of the 
many browsers that offer slick, graphical interfaces that make browsing 
easy. 

If you're connecting through an online service or through a commercial 
Internet provider, you've got it made. You can use a graphical browser such 
as Mosaic, MacWeb, Netscape Navigator, or Microsoft Internet Explorer. 
Browsers read documents, called Web pages, that provide information or are 
jumping-off points for other information resources. The browser finds the 
Web pages by using an address called a URL. 

Meet URL 
URL stands for Uniform Resource Locator. A URL lists the exact location 
(address) of virtually any Internet resource, such as a file, hypertext page, 
or newsgroup. 

URLs look like this: 

AWWWpage 

A newsgroup 

A Gopher site 

A telnet session 

http://www.apple.com/education/ 

news://news.lists 

gopher://gopher.tc.umn.com 

telnet://ibm.com 

The first part of the URL, the junk before the colon, tells the browser what 
method to use to access the file. The part of the URL that's after the colon 
indicates the address of a host computer. 

Netscape NafliiJator and Microsoft 
Internet Explorer 

Netscape is the grandchild of Mosaic, a freeware program that enables users 
to browse the World Wide Web. Microsoft soon followed with Internet 
Explorer, which is now Netscape Navigator's main rival. These browsers 
provide users of Macintosh with a fast, easy-to-use interface that makes 
zipping around the Web easy. It's feature-rich, provides access to the Web, 
Gopher, and FTP resources. 

So, what are we waiting for? Let's go! 
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GettintJ IJOUr browser 
In case you don't have an Internet connection, the CD includes sign-on 
software for AT&T WorldNet Service, an Internet service provider. All you 
need is a computer, a modem, a phone line, and the AT&T WorldNet Service 
software. When you sign up, you can also choose between Netscape Naviga­
tor and Microsoft Internet Explorer for your browser. You won't get the most 

. recent version of either browser- but you'll probably not notice the 
difference. 

ConnectintJ to the World Wide Web 
After you retrieve your copy of Netscape Navigator or Microsoft Internet 
Explorer, you're ready to fire up the program and get surfing! These are the 
leaders in browser interfaces for a very good reason - they're very easy to 
use and very powerful. Using Netscape Navigator or Microsoft Internet 
Explorer is as simple as starting the program and entering a URL (an 
Internet address). Here's how, using Netscape Navigator as an example: 

1. Double-click the Netscape icon, and your Mac will automatically 
access your PPP or SUP control panel and make your Net connection 
as it launches Netscape. 

Netscape automatically logs you onto the Netscape home page, shown 
in Figure 14-1. 

As you move your mouse over some of the words and pictures on the 
home page (they're blue or purple if you have a color monitor), the 
mouse pointer turns into a pointing hand. Clicking on these words or 
pictures takes you to another Web page. 

2. To browse the WWW, either click one of the hypertext items on the 
screen (often underlined in a different color) or click the Open 
button (38-L) at the top of the screen and enter an URL. 

Want a cool place to start? Try WEB66. Click the Open button (SC-L) at 
the top of the screen and type this URL (address): 

http://Web66~col~d.umn.edu/ 

When you click OK, you're whisked away to the University of 
Minnesota's College of Education site. Easy, huh? 
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Figure 14-1: 
The 

Netscape 
home page. 

Figure 14-2: 
The Web66 
home page. 

HtUffo: l~ttp :1/wvv .notse.po.e«n/ 
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. r•• • 

YOUll CU I Ul 10 NI'\VIGI\IING ltll-, Ntl "'•...:.:: 

cuuu to 1 coMPANY k 1 t.NIUll'llln 1 1 Nt IUAI't 1 I oM uot• 
INttkNf:l l"kOOUCt\ SOLUIION\ UlVI:l OI'lW~ SIOMl ASSISJANCt SOftWAUt 

NETSCAPE AND EXCITE T EAM UP 

JULY 17, 1997 GET THE LATEIT NETHAPE SO fTWAA£ 

II Netscape and Exci1e unveil plans "launch 
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NET SCAPE SPONSORS 

Figure 14-2 shows what you'll see when your browser reaches Web66. 

I!B Netscape: Web66 Home P11ge 
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You'll want to spend the next few minutes clicking and browsing. Notice 
that the button bar at the top of the Netscape window has buttons for 
Back (SC-[), which returns you to the last WWW site); Home, which 
returns you to Netscape's home page; and Stop (SG-.), which cancels 
your request and tries another WWW site. 

Don't get excited if you encounter a 404 not found error or a Connec­
tion refused by host error. It just means that the WWW site is busy, 
has moved, or that your URL wasn't typed correctly. Retype the URL or 
try again later. 

Occasionally, your browser will fail to load pictures correctly, and then 
it displays a "broken icon" graphic. Click the Reload button at the top of 
the screen, and Netscape will refresh the graphics on your screen. 

3. When you finish surfing, exit Netscape by choosing Quit from the File 
menu. 

Remember that you've just quit the browser, not the Net itself. You can 
do other Internet tasks or return to your PPP or SLIP control panel to 
terminate your connection. 

The Web provides several pages that are lists of other sites or that contain a 
searchable database of Web addresses. Here are a couple of jumping-off 
points on the Net. From these sites you can get virtually anywhere. Use the 
Open button and try each of these URLs: 

. 'http::/lwww.yahoo".,co.m , 
; http.: /lwww. net~:u·rf~-com/.nsditndex. html 
: h~~P :llww_w:~~ell'.,.com- - -

Happy surfin'! 

Sat1in9 the cool stuff 
Your first time on the Web, you're likely to go bananas, surfing from page to 
page and marveling at all the great information and cool graphics you see. 
Forgetting where you've been is very easy. Luckily, Netscape has a simple 
way to remember where you've been. It's called a Bookmark. 

Setting a Bookmark is easy. Simply get to the Web page that you want to 
save and choose Add Bookmark from the Bookmark pull-down menu. The 
items will be added to the list in the order that you enter them. 

Your Bookmark list is now available, and you can "resurf" a Web page, 
Gopher address, or FTP site by choosing that location directly from the 
Netscape Bookmark menu. No more messy URLs! 
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You can add, delete, and reorganize your Bookmarks by choosing View 
Bookmarks from the Bookmark pull-down menu. Don't look now, but you 'II 
have a hundred or so WWW sites in your Bookmark before you know it, so a 
bit of organization goes a long way. 

Microsoft Internet Explorer also lets you add a bookmark - only they call 
bookmarks "Favorites." If you are using Internet Explorer, simply use the 
Favorites pull-down menu and choose Add to Favorites. Arrange your 
favorite sites by choosing Organize Favorites. It's almost too easy. 

Cyberfinder to·the rescue 
Imagine never having to leave your desktop to 
organize and access your favorite web sites .. 
If you're constantly pulling up the same great 
teacher reso~rce page, tracking the·latest in~ 
formation from NASA,.()rgetting software up­
dates, CyberFinder from Aladdin Systems c.an 
make your life a lot easier. lrsthe only Internet 
bookmark manager that operates from your 
Finder (aka desktop) - you don't have to go 
online or open another programto· access and 
manage your favorite bookm_ar.ks; Here· are a 
few of CyberFinder's highlights: · 

I"' Create bookmarks right in your Finder and 
then automatically launch any· site right 
from your Finder. Organizing your book­
marks with CyberFinder is. also an easy 
task. 

~ .· Cyberfander allows you to navigate to any 
tn~rQetsjte from any ap_pUcation. · 

~· Cyp~rFlnder relies. on your ,already in­
s~alled ·tnternet browser· ·application 
(Netscape, ·Mosaic; and so on}, :so you 
won'fha\/e to learn how ~o navigate Within 
a· new program. 

~ Enables you to catalog your bookmarks in 
anyway you want You don~thavetq store 
you~ bookmarkswithineach individual ap-· 
plication. Instead, CyberFinder allows. you 
to keep .all of your bookmarks handy ·on 
your Desktop. 

Visitthe Aladdin Systems web site to dovvnload a 
freetrialversion(www .a 1 addi nsys. com). 
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NafliiJ.atiniJ the taniJ.Ied Web 
Finding things in the Web can be a bit tough . There are thousands of Web 
pages out there, with more being added every day, so it's tough for any one 
place to have a full listing of what's on the Net. 

Luckily, after you're on the Web, you can do keyword searches by using one 
of the Web's many search engines. One of the best Web search engines is 
WebCrawler. The WebCrawler 's URL is http: I /www . webcrawl er . com 

WebCrawler searches for documents whose titles or content match your 
keyword. Using the WebCrawler is easy; simply enter the search term and 
click Search. 

Other Web search engines that you'll probably want to check out are: 

AltaVista 
Excite 
Info seek 
Lycos 

http: //www.altavista.digital. com 
http://www.excite . com 
http://www.infoseek .com 
http://www.lycos . com 

You or your students can easily create your own home page. If you're 
connected to the Internet via a SLIP or PPP account and your information 
provider has room on the server, you're well on your way. Your school's 
home page might include 

,;~Links to other schools' home pages 

,;~Links to favorite reference resources (including Gopher sites) 

,;~ Links to home pages created by your s tudents 

,;~ A picture of your school 

,;~ Information about your school and the surrounding community 

To learn how to create your own home page, visit Web66 at the following 
URL: http : // Web66 . coled.umn.edu 

There you find complete instructions. With a standard word processor and a 
few special commands, you're in business. 

Need another resource for information about creating a home page? Try 
http://www.acu .edu/dev/makeasav er. edu 
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·It's easy to create,your own hom'e pag:e· 
I once thought that you needed a computer 
programmer to create a home page for the 
www.-Yes, I write books about computers, 
and I was intimidated by the idea of Web pub­
lishing. Then I heard about Claris Home 
Page ..,..... it gives you the ability to create dy­
namic yvebpagesthat look great. Clads. Home 
Page 'has· automatic programming feature~ 
that do all the complicated HTMLwork,behind 
the. scenes - it looks and acts like . a word 

processor. After you're ready-to postyourfiles,­
Ciaris Home Page make$ it easy with a built-in 
publishing feature that automatically consoli­
dates your files and uploads them to a desig-
nated server. · 

Check out the fully functional copy of Claris 
Home Page . on the CD thafs located in the 
back of this book. Thistfialversiortexpires 90 
days after installation on your computer. 

How not to tJ.et cautj.ht in the Web 
Here are some points to ponder that will save you loads of time and a few 
gray hairs: 

. Y' If images are coming in too slowly, deselect Auto Load Images from the 
Options menu. This will give you a text-only interface. When you've 
reached a page you'd like to examine more closely, clicking the Reload 
button will show the Web page's graphics. 

· Y' If at first you don't succeed ... sometimes the third time's the charm. 
WWW pages can be very busy. 

Y' Remember that you can copy, print, or save the text and graphics that 
are displayed on any WWW page. 

Y' Want to write your own WWW page? ClarisWorks has a neat HTML 
(Hypertext Markup Language) translator available for download on 
most online services or from the Claris Web site at http : I I www • 
claris.com 

Netscape also enables you to capture the HTML code from any other WWW 
page. It's a great way to learn, but no cheating, please! 

Great places for a first flisit 
All dressed up and no place to go? Try these great educational Web links for 
your first surfing outing. Choose the Netscape Open button and type the 
following URLs exactly as you see them. Be sure to mind your capital letters. 
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The Web goes 3-0 
What's the next level in Web exploration? The 
Web goes 3-DI A software program called 
WebSpace is the first commercially available 
three-dimensional viewer for the World Wide 
Web. The program, which runs on Power 
Macintosh, Windows, and UNIX platforms, 
works along with popular Web browsers. With 
the WebSpace viewer the possibilities are 
amazing. The programmers, Silicon Graphics, 
claim that users can 

I" Fly through 3-D worlds, exploring event 
venues, cities, libraries, museums, tourist 
resorts, and imaginary places. 

I" Inspect 3-D models of products in online 
catalogs. 

I" Visualize information such as stock mar-
ket trends in 3-D. 

The technology also creates a new standard 
called VRML (Virtual Reality Modeling Lan­
guage), an open, platform-independent file 

format for 3-D graphics on the Internet. Simi­
lar in concept to the core Web text standard 
HyperText Markup Language (HTML), VRML 
encodes computer-generated graphics into a 
compact format for transportation over the 
network. As with HTML, a user can view the 
contents of a file- in this case, an interactive 
3-D graphics file - as well as navigate to 
other VRML HworldsH or HTML pages. In addi­
tion, VRML is infinitely scalable so that as us­
ers navigate through virtual worlds and ap­
proach objects, greater levels of detail 
emerge. 

This new technology has some very exciting 
possibilities for education. The days of elec­
tronic field trips in 3-D are not far away I 

For more information on VRML and WebSpace, 
point your Web browser to http : I I 
webspace. sgi .com 

I" Visit the K-12 Outpost and explore a great collection of K-12 WWW 
links: http : llk12 . cn idr.org 

I" Check out Apple Computer's home page that's just for educators: 
http : llwww. education.apple. com 

I" View a great weather map: http: I l www. mit . ed u: 8001 I usa. html 

A Science Activity: Visit the Centers for Disease Control and Prevention's 
Internet sites and find out about the latest nasty diseases that are creeping 
into the human population. From Brazilian fever to cat-scratch disease, you 
can find pathogens everywhere. The CDC maintains a Web site at http: I I 
www .cdc .g ov 
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~~·~~~~~~~~~~~~~~~~~~~~ 
Citing Internet resources 

Now that teachers and students are becoming comfortable using the Internet as a research 
resource, the big question being asked is "How do I cite Internet information?" Yes, someone 
put that information out there - and you need to give that person, company, or organization 
credit. 

World Wide Web 

Structure: 

Author. Title of Item. (Online) Available http://address/filename, date of document or download, 
if document is not available. 

Example: 

Robinette, Michelle. This is My Family. (Online) Available http:// robinette.edu/family, May 14,1997. 

Online Sounds, Images, or Video Clips 

Structure: 

Description or title of sound, image, or video clip. (Online Sound Image or Video Clip) Available 
http://address/filename, date of document or download, if document is not available. 

Example: 

First Day of School. (Online Video Clip) Available http:// robinette.edu/norton, May 3, 1997. 

These are just a few examples. Your students might be using other Internet sources like Gopher, 
FTP, use net Newsgroups, online sounds, e-mail, tel net, or other online information. If you'd like a 
complete listing of online citations, check out the following: 

MLA Citation Guide: http://www.cas.usf.edu/english/walker/mla.html 

APA Style of Notation: http://www.uvm.edu/-xli/reference/apa.html 
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Whack it! 
WebWhacker (The ForeFront Group Inc.) is 
one of the better Internet software invest­
ments you can possibly make. Irs easy. Before 
you meet with a group of kids, you simply go 
online and whack off (download) the pages 
you'd like kids to access. Students can then 
"surr the whacked pages from the computer 
desktop without an Internet connection. You 
can whack entire web sites or just the first 
few pages of a site. When you download a 
site, what you see when connected to the 
Internet is exactly the same in the whacked 
version you download- all the graphics, text, 
and HTML remain intact. 

What's so great about whacking? You never 
have to wait for a site to load. You won't be 
bothered by annoying disconnections, and 
your kids won't be able to access sites that 
aren't age-appropriate. In addition to all that, 
you minimize the actual amount of online time 
and expense. 

Using WebWhacker is also a great way to 
demonstrate the Internet to a group of stu­
dents, parents, or fellow teachers without ever 
having to wait for a connection or hope that a 
particular site can be accessed. It's Web simu­
lation without an actual connection! 
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In this part ... 

W~ll, I've teased you. I've told you all the options. 
've given you extensive lists of great software. 

I've even taken you on a short trip down the information 
superhighway. Now I'm sending you back to your school­
back to reality. And sometimes, reality bites! 

Keep your chin up, make the most of what you've got, and 
be determined to strive for more. 

In this part I give you some ideas on ways to get the most 
out of that single, lonely computer that may be sitting in 
the corner of your classroom. I also discuss the major 
components involved in creating and managing a Mac lab. 
And finally, I give you some great ideas on ways to keep 
your school and community aware of your technological 
accomplishments - and to convince these groups to 
spend more money. 
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The One-Mac Classroom 
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In This Chapter 
l1t> Why only one Mac? 

&lJ> Mac wish list 

0> License to learn 

Ill> A time and place for everything 

1>- Managing the one-Mac classroom 

rr> One-Mac Activities 
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~e Lonely Guy. It makes me so sad to see a poor, lonely guy sitting in the I ~orner of the room, sometimes humming quietly, other times simply cold 
and inactive. No, I'm not talking about a child. I'm talking about the unused 
Mac. I know, you don't mean for it to happen- it just does. You don't have 
time to preview software, make sure everyone gets a turn, and monitor 
progress. So you just ignore the lonely guy. 

That's not good. Nothing is worse than an unused computer. It just sits there 
making you feel guilty for not using something that was supposed to be a 
valuable addition to your classroom, and it makes your students angry and 
frustrated because they are rarely allowed to use it. Read on and find out 
some easy ways to incorporate your lonely Mac into your day-to-day 
classroom activities. 

WhtJ OnltJ One] 
I want to begin this discussion by questioning why you have only one Mac. If 
your school already has a lab (or two) and is now placing computers in 
classrooms as it can afford the purchases, I agree with the placement of 
your computer. However, if your school doesn't have a lab of any sort, you 
may need to discuss the possibility of creating one before you get too 
attached to your Mac. 



The assumption that every teacher needs a computer just isn't true. Teach­
ers need a computer if they are going to use it. Studies have shown that labs 
are the best way to get students and teachers comfortable with computer 
use. It makes sense; you have a room filled with computers, an eager group 
of students, and their teacher. In a lab, everyone can accomplish something 
without having to fit time on the computer in with other classroom obliga­
tions. The Jab gets everyone psyched about computers and wanting one for 
the classroom. Then it's time for one (or two, or three ... ) per teacher. 

On the other hand, placing a single computer in a classroom with a teacher 
who isn't familiar with it - along with a group of kids who (for the most 
part) have never used one- puts everyone at a disadvantage. The teacher 
has to find a way to work it into her schedule, and the students end up 
fighting over whose turn it is. 

As I step down from my soapbox, I leave you with this: Get a lab first (even a 
small one- kids don't mind pairing up) and then work on the computers for 
each classroom. Doesn't it make sense for everyone involved to be comfort­
able with an expensive creature before placing it in their environment? 

Placement 
It's the week before school starts, you rearranged your room five or six 
times, and people keep dropping off more stuff for you to store: the over­
head projector, the new reading series, the math manipulatives, and- oh 
yeah - the potting soil for your science kit. Everything is just peachy. And 
then in walks your media specialist with your new computer! Great, where 
does it fit into your interior decorating scheme? 

Well, like the overhead, the tape player, the plant light, your coffee pot, and 
the TV, it needs a plug. You also need to make sure you put it away from the 
chalkboard and pencil sharpener -too much dust. And you may want to 
position it in a way that allows you to continue teaching while a few children 
are working. (You need to remain the main attraction.) 

Take the next few days to work out your decorating problem and then come 
back to this chapter. 

Basic Wants and Needs 
Children have a hard time discerning between wants and needs. Especially 
when schools sell ice cream and chips as snacks. You tell me, are those 
wants or needs? 
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A computer has very few needs- keep ~t dust free, don't turn it on and off, 
keep food and drink away from it, and use it. 

g
~tPRo~ 1 

~ ~ Catalogs are full of wants for your computer! Here's the basic list for the 
~ lonely computer in your classroom: 

Y' Set of speakers: These are great for whole-group instruction. But be 
sure to use special shielded (and self-powered) computer speakers ($20 
andu~. I 

Y' Headphones: These are a must. Th~y keep you from competing with 
the computer for attention. (I've gotten a pair for $1 at the drugstore.) 

Y' Disks: It's best if you buy a disk for each student so that you can save 
space on your hard drive. You can get disks preformatted if you don't 
want to take the time to initialize one for each student, and the cost 
difference isn't that substantial (abbut $8 for a pack of ten). 

Y' Dust cover: This one explains itselfl· ($12-20). You can get these covers 
for your keyboard, too. I 

I 

Y' Printer: A printer would be a wonderful convenience for you; however, 
it's not a necessity. If your kids save to disks, you can take the disks 
later to a computer with a printer. (See Chapter 4 for details.) 

Y' CD-ROM drive: It sure would be nice because so much software now 
comes on CD. 

I 

Y' Software and CDs: You don't need much to be productive in the 
classroom. If you have too many choices, the students spend all the 
computer time fighting over what tb use! ClarisWorks (Chapter 6) and 
some type of grading program (Chapter 8) are a must. 

HeiJ, I Want MIJ Deskto~ on Tf/! 
An LCD panel (around $1,000) allows you to show what's on your monitor 
through the overhead projector, and a TV converter box (around $200) or a 
converter card (around $400) makes it happen on your TV screen. I think 
they're great when you want to show a new program to the entire class. The 
LCD panel is portable, yet fragile - and not always clear. The converter 
cards actually go inside your computer, and they aren't portable (unless you 
take your computer). TV converter boxes are portable, and some even come 
with cool remote controls. If you have an AV Mac, you're already set to 
display on a TV screen and don't need either of these additions. 
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A Possible Solution 
It resembles a laptop, weighs less than four 
pounds, and was designed to handle the 
bumps and bruises of a child's backpack. With 
the eMate, Apple has finally come up with a 
solution for schools (like mine) that can't af­
ford to purchase multiple computers for every 
classroom. Priced at around $750 ($700 if you 
order in quantities of eight), the eMate en­
ables schools to quickly meet their goal of one 
computer for every student. 

This affordable yet serious learning tool was 
designed specifically for schools based on in­
put from educational researchers, teachers, 
and students. It has a built-in, full-featured 
word processor (yes, you can format your 
text), a drawing application, spreadsheet, 

graphing calculator, note-taking tools, address 
book, Web browser (you'll need the optional 
modem), and a calendar. Students can use the 
keyboard to enter information or the stylus (a 
pen without ink that you use to write directly 
onto the screen). 

Schools are buying class sets of eMates and 
placing them on a cart with a computer or just 
a printer. With a simple cable connection, the 
information stored on an eMate can be printed 
to a Mac printer. Or, with another simple cable 
connection, students can download their infor­
mation to a computer (Mac or IBM-compat­
ible). With all this going for it, I'm sure the 
eMate has a bright future in classrooms 
around the world. 
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Using lJOUr classroom TV as a monitor 
A number of companies produce converters that let your classroom televi­
sion work as an additional monitor, which is great for whole-group instruc­
tion on a new program - much better than having 25 kids gathered around 
the computer station. 

Many of the converters also include remote controls that allow you to zoom 
in on specific areas of the screen. And some come with the capability to let 
you make marks (electronic) on the screen when you move the mouse ­
kinda like the sports guys who draw those lines showing you the football 
plays. What will they think of next? 

I suggest connecting one converter to a TV on a rolling cart and having it 
available on a checkout basis for individual classrooms. Please note that the 
audio portion of your program can be heard through your computer, so 
external speakers might be a nice addition as well. 

These converters are manufactured by a number of different companies and 
have names like TelevEyes/Pro, TVAtor, AverKey, PresenterMac/PC3. They 
range in price from $150 to $500. 

TheAV Mac 
If you have an AV Mac, you don't need a converter to use your TV as a 
monitor. Simply run a cable from your Mac's Video Out jack to your VCR's 
input jack. Do the same with the sound cable. 

Now here's the tricky part: Open the Monitors control panel and click 
Options. You see a special box of options. Choose Display Video on Televi­
sion and Flicker Free Format. Click OK. A warning dialog box appears. Click 
Switch. In a few seconds, your monitor goes dark- and the image appears 
on your TV screen! 

Understand that the picture won't be all that clear. The Mac's monitor is of 
much higher quality than most TV screens. 

A License to Use 
I always start the year by giving the class an overview of the care and 
feeding of our Mac. I explain the basics and how I expect the students to 
treat the machine. Don't be afraid to discuss the cost and privilege of 
housing a computer in your classroom. Finally, I set up consequences for 
those who aren't capable of following the rules. 



At the end of our training, I have each child show me that he or she can 
function independently on the Mac. Each student should be able to do the 
following: 

Jll' Open and close a program 

Jll' Save work to a disk 

Jll' Open work saved on a disk 

Jll' Print 

Jll' Shut down the computer at the end of the day 

Then each child is given a computer license (which can be suspended, if 
1\ 1ER4t. needed). 

~~~~~~~~~~~~~~~~~~~~~~~~~~~~~~ 
U.se scr~.~n s.~q!;·~~·:·~~~~~~in.g_t~,~ls:. 

o·on't worry; a screen shotdoe~n't reqtiire:~nv· 
fancy photo equipment. Your Mac. has ever,..: ·· 
thing you need[Taking screen shots and th~~ .· 
printing them is a great way to create soft-. 
ware reference materials, center activitiesf · 
and step .. by.:.step. instructions. A' screen stiof: , 
is· just what it·sounds like, a pictureof-vvhat · 
you see on your screen. 

"" If you, have System 7.5 or earlier, press 
H-Shift-3. and youill hear a soundt~at 
really mimics the sounifa tamara makes ; 
as it takes a picture. After· that, a riew 
file--- n~:~med Picture 1-appears on YD.ur . 
hard d{ive. I suggest that you name .th~ 
pictures you ta.ke :as soon. as possi.ble~ 
Othel'\'lfise, you'll be opening and· closiniJ 
pictliresJtiStto see what they contain: The• . 
screen shots taken using·this method cap­
ture the entire screen. 

I" If your-computer has System 7.6 or higher, 
you have• more-refined screen shotC.apa:., 
bilities~ Take a· picture.·ot your screen by 

·pr~~$i,~g . 8$-Shift-4 •. WbeiJ :you do: tiji~~ 
cross~airs appearthafyou click and drag. 

. to.setectthe region of the screen yo~ want 
to s~ve as a screerq~hot Ori ·ifyou~pres~ 
the Caps. Lock key~ a -~.~U's ... eye· appears 
and you simply position it over the'Wintlovv· · 
you.wantto capture as a screen shot and 
clickthe mouse button,_and the computer 
will ·only save that win.dow as a screen 
shot 

,;,· My··favorite screen capture so~ate :is 
Flash It~ (Nobu Toge), ·a ·little shareware 
·program you can down.ioad from the World 
Wide Web or America Online. This pre;~~ 
grajn: .gives a variety of options ·for · 
selec.ting_what you want as a,scre·~n-~hot~ 
·m·akes;iteasy to save anltname ·.your :shot, 
and offers ·a "capture cursor" or "no cur­
sor" in your shot 
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The ScheduliniJ Dilemma 
I know. How do you determine who gets to use the computer and when? 
There is no easy answer to this question. I've tried just about everything. 
Does everyone get an assigned time? Do they get to use the computer when 
they finish their work? Do they get to use it when they've gotten a piece of 
writing through final editing and are ready to publish? All these options are 
viable, but I believe this choice should be up to each teacher. Just don't let 
the computer sit unused. Develop a system that works for you while - at 
the same time -you allow maximum usage of the computer. 

Assigned times 
In theory, this idea sounds great. Every child gets an assigned time on the 
computer every day. However, in practice, this strategy is hardly feasible. 
The average school day is 61/2 hours long. Now take out 30 minutes for 
lunch, 30 minutes for recess, 30 minutes for art, music, or PE- along with 
the 30 minutes wasted getting into class and getting ready for buses - and 
you are left with only 41/2 hours of actual classroom time. You would have to 
pair the students up and assign each pair a IS-minute time slot in order to 
accommodate the entire class. 

But what about the introduction to the language arts lesson that you want 
everyone to hear, or the crucial math lesson? And there's always the spelling 
test on Friday mornings. Each of these little side trips takes someone away 
from computer time. Believe me, you won't hear the end of the when-can-I­
make-up-my-time-on-the-computer questions. And this is at the elementary 
level. More than likely, high school and junior high teachers see a new batch 
of students every 45 minutes! 

An assigned time sounds great in theory, but it's difficult to make the notion 
work unless you have a small class. 

When IJOU finish IJOUr work 
This strategy sounds feasible. However, gifted Anna, who finishes her work 
in ten minutes, is on the computer every day - and she has a Mac at 
home -whereas Susie, who is slower, never seems to get time on the 
computer and really could use the reinforcement. I just hate these dilemmas! 



As a publishing center 
I use the computer as an extension of the writing process - an incentive for 
the students to finish a written piece of work. I require that writing is ready 
to be published before the kids go to the computer, and then I have a variety 
of possibilities for publishing (Newspaper, The Writing Center, Book Version 
EasyBook, Slide Show, Kid Pix 2, Report, ClarisWorks, and Multimedia 
HyperStudio ). Usually, students are at different levels of the writing process, 
and we don't get too backed up, but I have a sign-up sheet ready if needed. 

Use a chart 
A pocket chart sometimes works well to make sure that everyone gets a turn 
on the computer. Place cards with student names on them in pockets on the 
chart. After children have had a turn on the computer, they turn their cards 
over so that their names don't show. When all the names are turned over, 
you flip the cards and start the rotation again. You might try keeping an egg 
timer at the computer and designating a certain time limit for each visit. 
(Try not to make it less than 30 minutes.) 

Jh,s.e·: k.i.:l_t,inQ~Idi,bl~·! 
r· • ..~ ~: . _,' ~-. r· ' ' , , ' . . , ;·. . . ' •• ' : . ,' .' ' . , . '. - '" ~ , 

Tom Snyder'Productions has .created· a num~, students work in teams. By reading (yes, from 
·bar of alt~iitclusiva 'kits that:work great in thei paperl) the advice· of experts~ the students 
one-co~:~~plitet classr·oom~ Most of the kit$- decide on a course of action. They then enter · 
includewarkb~oks to go alo·ng withthethem.e~: their decJsiol)s,.and the compiJter in turn.giv~s 
as·vvell·~s .. v~ry d~t~il~d~te.~.c,m~(s:guidQs.J:hQ -.. tbam· f~(jdb~ck and guidan~e. Th·e computer 

· cornp~ter,~er-ves as-an informati_()n:ciissernin~~ · also .gives :tlje st[Jdents cons:equences base4 
· tor and receiver,., As the.students work through· on·their goats and the actions -they ·decide ·to 

the lessons, the computer also serves ·asoa take.ln·the-:end, the groups are given a score 
guide and. ke_eps track of progress based on based onth~ir decisions -·a11d the impact of 
the·data.s.tlid.ents enter. thQse decisipns on the comm_unity~ 

This. con~ept shows ·the ·-s~u(fenbvthat 'tiler) .Other topics :in-the· Decisions; D~cisioos. se~­
compUter c.an't do aU the work--they have 'to ' ries include: Urbanization, :Violence in the 
iindand enter1he informationtttemselves_. The Medit1, Colonization, and Bevolotionary War. 

__ coQp~r~tiY~: l(!~rning and cfassroo_m discus- · Call Tcnl) Sny~~r Productions:~t~OQ-342-0236. 
sions cre~te~ through theu$·e:ofthe programs 
~r~ wen worthihe (ver'i reasonable) pricel .. ' 

One of myfavorite kits Is Decisions, Decisions:· 
The Environment In this program, the students 
are given a re~l-world problem to solve. The 
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Numbered cups 
Divide the school day into numbered bloc ks of time. Label plastic cups with 
corresponding numbers. Then, using a clc ss list to keep track, place the 
cups on students' desks to show who wil be using the computer that day 
and at what times. After completing their turn on the computer, the students 
place the cups on the teacher's desk to b used the next day. 

Ask a friend 
As you can see, there's no easy way to cu e the one-Mac classroom dilemma. 
One solution is to get your Mac a friend. I ind one or two friends who would 
be willing to give up their Macs for a wee or two. Work out some type of 
rotation where each of you can have a "m ni-lab" of computers in your room 
for a specified number of days. (It's best f you can keep the Macs on rolling 
carts.) By creating a rotating mini-lab, y01 could focus your classroom 
activities around the schedule and have a group of students ready to 
publish or create a project when the com t:mters make their way back to your 
room. And by having a larger number of cpmputers, more students have 
access at a given time. 

We~ve .all_ heard that teaching others is one· _ enlist your own teaching assistants. If one 
. of the best ways to learn .. r'll never ·fo~g-et .. · ~,orJwo. qf your st~dents are experts with a 
. the year I was required to teacllthird.;qraders ~. sJ:uicific program or even the l'nternet, let 
all ·'~bqut ancient. Egyptl What was first a. jbem lend you a hand. This will not only help 
spacy::proposition soon' became fun. You see-, ' YQU but will also build their self confidence, 
as I taught the subject, I expanded my own enhance their communication skills, and ex­
knt)wledge and became a more curious and pand their own knowledge. It also allows the 
inquisffi\te,learner. · · others in your class to realize that students 
Why notlefstudenb; enjoy this same experi- can be viewed as leaders- a nice message. 
ence~ lnste~d of trying· to manage· a whole 
c18$SrO:om'Or lab·full oftectmology questions,, 

.. .. 



A Few of Mu Faflorite Actiflities 
I'm giving away a few of my tried-and-true activities with the hope that you 
take these ideas and use them to ignite that creative spark that I know 
resides within each and every teacher. 

Classroom journal 
I first started this project when I was teaching first grade. At the end of each 
week, I chose one child to create a journal page that highlighted the week's 
activities. In first grade, a journal page consisted of a detailed drawing and a 
couple of sentences. I then mounted the journal page on the wall as part of 
an ongoing timeline. It served as a great visual reference, and the kids fought 
over who would get to create each week's entry. 

With a classroom computer, you can create daily entries and then print 
them either to hang on the wall or to add to a binder. Let the students add, 
draw or paint frames to their word-processing documents (or create the 
journal in one of these environments) and add text blocks. 

OniJ.oiniJ storlJ center 
Why not make creative writing entertaining? My kids fight over who gets to 
make the daily addition to our ongoing "novel." 

Here's how I create an ongoing novel: 

Ill" The first day of school, I start a new word-processing document with a 
simple sentence like, "It was the first day of school, and all the students 
were a little nervous." 

·~ Ill" Then, as a class, we add on to this story starter- I type as the stu­
dents dictate. We discuss rules for tasteful entries and decide on an 
author rotation. 

Ill" The story evolves over the school year and (trust me!) proves to be 
quite entertaining. Your non-writers will soon be begging for time at the 
keyboard! 
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Skill--and--drill retlieUI station 
This particular idea was custom-made for all the third-grade teachers out 
there who spend the majority of their math instruction time drilling the 
multiplication tables. I don't care how creative your teaching methods are, 
multiplication tables just have to be memorized! 

Here's your simple solution (and don't forget that this solution can work 
with any information that you want students to memorize): Create a slide 
show of multiplication facts. Keep your slides simple - use a large font and 
have just the problems on one slide and the answers on the next. Set the 
slides to advance every five seconds (or sooner) and have the show running 
whenever you have down time (for example, before the last bell, during bus 
call, and while lining up for lunch). I know that this idea sounds simple, but 
just reading the screen and facing the time factor invoke a type of challenge 
that kids seem to thrive on. Before you know it, they're asking you to speed 
up the slides, and the multiplication facts are mastered! 

Monthi1J class magazine/newspaper 
This is the coolest use of technology that I've ever seen! Your class can 
create an electronic magazine that highlights individual student achieve­
ment. Requiring each student to submit his or her favorite piece of writing 
for the magazine is a great way to start. From there, create a cover that lists 
the titles and then add all the titles to a slide show that has a professional 
look and feel (add complementary colors, keep the backgrounds consistent, 
and the like). This project really wows parents and instills a great deal of 
pride in students. 

Check out this book! 
After yl)qr students 11re QQ""fortable using 
the. c.omputer,·why not teach them (and your- . 
S@.lf).:&,bQutthe inner workings of the machine?' 
Ooe· qf my favorite non-techie resources is 
How Computers Work by Ron White. Ron 
gives simple descriptions that are easy to 

und~r$tand .. However, the best part ofthis 
book is the illustrations. The breakaway style 
drawings show the guts of a mouse, a roooitor, 

·a disk drive, a CD-ROM drive, a printer, a 
modem, and much more. 



.. 

Research base/project planner 
Lay out an upcoming project on the computer and then, as information is 
gathered, check off your progress and start creating a class database to 
record information or a spreadsheet to check off class progress. I start out 
with a great outline. Then I add a spreadsheet that works great for creating 
a combination checklist and schedule in order to keep track of specific 
aspects of the project, along with their completion dates. Last, I set up a 
database where gathered information can be entered. When the time to get 
started on the end product arrives, my students have all the information 
that they need, right in the classroom. Even if the final product isn't going 
to be a report or slide show created with ClarisWorks, having the neces­
sary information in the classroom is a great help when creating a poster, 
diorama, or display. 

c' 

Tips for the o.n.e.-;c.omp~t,er· :classrof),m . 
II!' Always hold whole-class in'strtu;:tion on . 

any new software you intend to have avail­
able. Your goal is for the students to work 
independently while at the computer. 

·"'·Include. keyboarding instruction or•.dJiUs 
for the first five or ten minutes: of :8 · · 
student's visit to the computer. . . · ·· · 

II!' Never allow students to transport the 
computer to or from another classroom. 

Jill' Never allow the students to eat or drink· 
while. working atthe computer. 

~ Display student work that's bee11 donQ on 
the computer. This shows· the rest of 
the school (including PTA members 
and· principals) what a great thing the 

COI!JJillter is-and itmayc~nvince·som:e• . 
one :to ~pend more money I . 

- . -

II!' Ke~p track of who. ha-s. time on· the· 
corJiputer. Make.sure:thatavficyone g,ets a 
~~hahc.e,' :Ypu ~oo~t )Nam ,ohild·~.e.n or· P1lr., 
~Ot$ to CQR)plain, abQljt~(hu;k· .of); time Ofl 
th~•t~omputer. · · · 

II!' Encourage the use of spell;.check and 
thesaurus features found in most· 
wo-rd-processing prngrams .. This is Cl. 
,grtl~t;~CJY. to incotp,Qr~t.~,.IC~ng~~g;'~~:~ c. 

;in:s~rudtio·n -- ·and it -ijJJps· ;perfect:th,e : .. 
. ~~Ad~n~: W,,ritin.o. 

,- Above all, don't forget about:yourself. :Gat 
·tm the .computer and use.itl 



Chapter 16 

The Mac Lab 
ooooooooooooooooooooooooooooooeooooooooooooooooo 

In This Chapter 
b> ~etworking 

...... Printing savvy 

fDI>- Lab management 

~ Software solutions 

oooooooooooooooooooooooooooooooooooooooooooooooo 

'fdeally, every school should have at least one Mac lab. Two or three would 
~~e even better! If your school has a lab, I hope this chapter gives you a 
few new ideas or insights- and if your school doesn't have a lab, maybe 
this chapter can help you develop a plan to create one in the future. 

The Computers 
Well, of course, if you're going to create a computer lab, you need comput­
ers. Don't wait until you have one computer for every child in a class to 
create your lab. I've worked in schools where students had to double up on 
computers, and they did just fine. As a matter of fact, their creative writing 
became incredibly creative when they worked together. 

A miniMac lab works well for small groups of children. Many schools create 
these smaller labs in their media centers. As interest and funding grow, 
these labs can increase in size and eventually move to larger areas. 

Netu/orkiniJ 
In simple terms, a network exists when you connect any two or more com­
puters together. Businesses use networks to connect hundreds of Macs at a 
time. This setup allows computers to share files and send e-mail messages 
to one another. In the school setting, the major reason for creating a net­
work is to be able to share printers. There are two types of networks: a Wide 
Area Network (WAN) and a Local Area Network (LAN). 
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Figure 16-1: 
Setting up 

background 
printing. 

~ Wide area networks can exist within a single school or connect all the 
schools in a system or state. 

~ Local area networks are usually local to a building and are easy to 
create when you're working with a group of Macintosh machines. You 
see, all Macs come with a built-in networking system called LocalTalk. 
LocalTalk does have its limits: You can only have up to 30 devices 
(computers, printers, scanners, and so on). 

Connecting a network is best left to professionals. If, however, you want to 
try a little networking on your own, check out More Macs For Dummies, 3rd 
Edition, by David Pogue. 

Printers 
The printers in your lab are a vital component. Consult Chapter 4 for info on 
the various types of printers available. What I give you now are a few tips on 
using printers in the lab setting. 

~ Don't allow students to always print in color. This practice becomes 
costly when the lab is being used daily by five or six classes. Save color 
for those specia l creations. 

~ When setting up your printer, be sure to check background printing­
which simply means that, after you press Print, you can continue 
working on your computer while the printer prepares your document. If 
you're not sure whether or not background printing has been enabled 
on your printer, choose Chooser from the tl menu, click on your 
printer's icon, and then click the On button beside the Background 
Printing choice (as shown in Figure 16-1). 

~ If students print each time they visit the lab, us ing a laser printer in the 
lab setting can prove to be costly as well. Replacing the toner cartridge 
in a laser printer can cost more than $75. 

Iii Chooser 

~ l? IQ Selecto printer port: 

II 0 

AwltSNrt DV 3.1 (Applthlc) ... ""' ~ ~ 
G~ .... x 

:n 
Bockground Printing: ~On 0 Off 

to AppleTolk 0 Act1va on restert 
® lnoclive 

7.~ 
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I" When using paint programs like Kid Pix Studio, discourage the use of 

solid background colors if the pictures will be printed. The printer uses 
up loads of ink as it fills in that background. (Don't limit the use of 
anything if the pictures will be part of an on-screen slide show!) 

I" Purchase enough printers to have at least one for every four or five 
computers. Otherwise, you spend the last 15 minutes of lab time 
waiting for everyone to finish printing. 

Lab Management 
So you have the lab, the computers, and plenty of printers. What comes 
next? A good plan for use and management is a must. 

Staffing IJOUr lab 
I'd like to see every lab staffed by a certified teacher. In today's financial 
crunch, this may not be realistic, so a teacher's aide or parent volunteers 
with extensive computer training might have to suffice. Just make sure that 
whoever runs your lab is ready to answer basic computing questions and 
troubleshoot when problems arise (or at least know where to call for the 
answers). 

TechnologiJ Coordinators 
These positions are popping up at the local school level all across the 
country. In my opinion, the creation of these positions shows incredible 
foresight on the part of the administrators at each school. The responsibili­
ties of the technology coordinator should not include working in the lab and 
seeing classes during the entire school day. Instead, the technology coordi­
nator should be free to do the following: 

I" Train staff members on computer hardware and software 

I" Develop lessons that integrate classroom curriculum with technology 

I" Conduct small-group instruction with students 

I" Preview new software and hardware 

I" Attend technology conferences and workshops 

I" Troubleshoot problems with lab and classroom computers 

I" Keep administrators and the community informed on local technology 
activities 



I 
II' Create long-range and short-term technology plans and goals for the 

school 

II' Oversee the technology budget 

II' Recruit, train, and schedule volunteers to help in school computer labs 

MakintJ the lab teacher's life easier 
The lab teacher's life can be improved in a number of ways. Many of these 
adaptations are focused on maintaining student behavior so that the lab 
teacher can instruct without complications. To a student, a computer is as 
much fun as recess - and that level of excitement needs to be maintained 
while learning new facets of technology usage. 

9-\'PRo~ 

/ The following is a list of things that help the teacher maintain a little control 
~ while still feeding the enthusiasm of the students: 

lnllest in a desktop·protection proiJram 
Such programs include At Ease (Apple, $29 for single use) or FoolProof 
(SmartS tuff Software, $39 for single use). Both programs allow you to 
protect items on your hard drive. At Ease is good for young children who 
don't need to see the desktop. (A file folder with buttons for each accessible 
program covers the entire desktop.) 

I prefer FoolProof because it has easy ways to set up folders for students' 
saved work- which isn't quite as easy with At Ease. Both FoolProof and 
newer versions of At Ease allow you to see the Finder. 

Consider a ketJhoard.fockiniJ pro9ram (if IJOUr tab is networked) 
Purchase ScreenShare (White Knight Software, $249 for lab site), which 
allows you to lock the student keyboards as you broadcast a program to all 
the computers for instructional purposes. This setup encourages students 
to pay attention instead of working ahead or experimenting on their own. 
(See the sidebar "ANAT: Apple Network Administrator Toolkit" for a descrip­
tion of the most popular new management program in schools.) 

Create open communication with teachers 
Come up with a system that keeps the lab teacher informed about class­
room curriculum at each grade level. Use this information to plan lab 
activities for the students. We all know that students take away more from 
an activity when the learning is relevant to - or an extension of - previous 
learning in the classroom. 
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Schedule IJOUr lab wiselu 
Lab scheduling is an important subject, and one that causes great conflicts 
in most schools. Some prefer to have an open sign-up system (first come, 
first served); others distribute vouchers that allow teachers lab time (when 
your vouchers for the month are gone, you can't go); still others use the lab 
as a special-area class (like art, music, or PE). My only advice is to meet as a 
school and come up with a plan that best suits the individual environment­
just make sure that the computers are always being used! 

Set aside time for lab maintenance 
I shut down the labs within my school one or two days during each grading 
period. I then use this downtime to clean the computers (vacuum, dust, 
wipe down screens) and "clean up" the hard drives (make sure that strange 
files haven't found their way onto the hard drive and that saved work is 
located in the correct place). 

I also use this time to run Norton Utilities, a diagnostic program that gives 
my computers a thorough "check up." If this program does find a problem, it 
can usually make any necessary repairs. 

ANAT: Apple Network. Administrator Toolkit 
Uttht Johnny is having trouble with a: :co.lll· 
puter ptJJgral]l. H~'~ on a computer acr~~sthe: 
room,.ormaybe even ln- anQ~herr~o~· Qn your:· 
·computer :screen you're · ~bJe :~~i.:pqlf,up: . 
what's happening on his scree11~ ~p.e!lk;:into 
your Mac's microphone to give him verbal 
dire·c:tion$_.(yep~ 'he hears it on hi$ computer's 
sp·eake(s); ~nd even control his scte·en,'from 
your own screen to show him howi to_ sofv~ 
his. problem. Sounds like something.-outof a 
science fiction movief right?' Well, ifyou"have· 
a nErt.wtirked Mac lab, this can. be ale~l.tty. . 

th_e -APril~. Network Admin is~rat~r. ·]"b·qtkit 
softWare-~isVIihatmakes allthis:magih;happen .. '. 
(fflasthe applications you.need to Cf.)JJtrOI a,nd 

manage all the systems on your networkfrom 
a $inglepoint The Toolkit includes At Ease for 
.WorkgrQups 4.0 software to protect ·your 
·~ppUcations;_ documents, COs, and system 
settingst Ap_ple. Network Assistant softWare to 
!manage a ·group of networked Macintosh 
computers fro.m a central location; and Apple 
Q.ser and Group Manager software to save 
you time and effort by letting you consolidate 
user lists from multiple sources. The features 
an~_too numerous to mention here, but let me 
-t.~ll. vou, it's w~n:th looking into. 



Software Selection 
Personally, I'd go the productivity route. You can accommodate all grade 
levels and all subject areas - and you can meet those needs with a minimal 
amount of software. Yep, I'd say two programs (lab-pack or site-license 

~~ :::1
1

::t:::::o:~:::::~s: 

~ 
1;1' Elementary- ClarisWorks and Kid Pix Studio 

1;1' Middle- ClarisWorks and HyperStudio 

1;1' High- ClarisWorks and Persuasion 

Of course, you could add to your collection as time and money become 
available. I suggest becoming a master of a few really good programs before 
you go out searching for more ways to spend school money. Turn to Appen­
dix B for my software picks broken down by type, grade level, and subject. 

Create. _a litlle:.~-tJtJ.iotl~IJ · 
Wouldn't it be nice if you didn't have to walk 
students through the setup or design of a par­
ticular project you have in mind an~ could, 
instead, get them started right away Qn . an 
intended activity? You know, have,~ th~ 
heading already created, the: font style and ·. 
size chosen, special margins set, and other 
formatting options already established. This 
can be a reality, if you create a stationer{ pad 
of a document Here's what you need to do: 

1. Create the document yo~'cl iika each 
student to access and save the document~ 
Close the program you used to create your 
document 

2. Select your saved document (click on it. 
once to highlight). 

3. From the File menu, choose Get Info~ 

When the Get Info window pops into view, 
you see a box in the bottom right-hand 
corner that's titled Stationery pad. 

_ i Click inside that box 'and an :X; will 
appear. 

You just turned your- original teniplat~ Imp 
,~ ~~tion~ry ~.ocum~nt- you rlotic~ that 
:tfie}f:Qn. r~pr(Jsen~tng the docuJ:lle~mow 

· :tooks·Uke a .pad of stationery~ · 

The· first time a sttident opens your newly 
~created stationery document, .a .w.indow 
~om~s. up asking him or he.r to. gi~e .the 
.~ocumertt ~- name~ You $ee; tile; ~,tig~nal 
remains the sam~;~ and the stu~enthas.:a 

. perso.nal copy. · · · · 

.flote: If you're using ClarisWorks,vo9 ca~n 
aptually choose to save Your worlcas a 
-~'ionery pad fro111 th~ ClarisWorks··$ave 
window (the window 1hat·appears -.when 

· you.chooseSavefronrthe File. menu). · 
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So How Do I Pay for All This? 
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 

In This Chapter 
!)> Show off in front of the right people 

~ Create a circle of informed friends 

I>- Beg like a child 

oooooooooooooooooeoooooooooeoooooooooooooooooooo 

1 you've gotten this far in the book, or just turned to this chapter because 
you're curious, I know that you are a believer! Now I want to share with 

you some ideas for getting others around you involved and excited -
including your local administrative-types. After you've convinced some of 
those "significant others," it's easier to get them to open up the checkbook 
and fund your cause. 

Show Off Your Computer Prowess 
You know it's working, the kids know it's working, so now tell the rest of the 
world! Keeping your local community informed is one of the best ways to get 
the things you want for your school. 

Parents and other taxpayers have ways to get what they want from a school 
system by simply flexing their my-taxes-pay-your-salary muscles. For 
example, Tommy (fictitious name, of course) fell on the playground one 
afternoon and ended up with a pretty bad scrape on his knee (no stitches or 
anything, just a little blood). Well, the next day his father was up at our 
school bright and early walking around on the playground. He then came 
inside and informed me and my principal that his son would never have 
been hurt if there weren't any rocks on the playground. He then left in an 
angry huff, and we all had our little silent giggle -let's see, the playground's 
outside, there are rocks outside .... Anyway, the next day the county had a 
crew of six - yes, six - men out on that playground picking up rocks. You 



see, Daddy had flexed those my-taxes-pay-your-salary muscles and called 
the district office, which resulted in another waste of taxpayer money to 
pick up less than a wheelbarrow full of pebbles. For what the county had to 
pay those workers, I probably could've bought a printer or two for the lab. 

So let's try and redirect some of that taxpayer muscle by participating in 
some of the following activities. 

Put out a press release 
If your class just communicated with students in Russia on the Internet, put 
out a press release. 

If little Susie's slide show won an award at a technology conference, put out 
a press release. 

If 95 percent of your faculty participated in a technology fund-raiser, put out 
a press release. 

Get the picture? You may not always get coverage, but more than likely 
you'll at least get a little blurb and picture in the local paper. What may be 
ho-hum to you may amaze your fellow taxpayers. Amazement gains recogni­
tion ... and recognition gains respect for your program. And remember, a 
little respect goes a long way when budget time rolls around. 

Let Apple give·: you· a hand 
Stop what you're doing right now and dial this topics · ••• including technology. To say the 
number: 1-800•365-7080 ext. 200. When you least, my workshop was the most informative 
call this number, Apple hooks you up with an arid most popular. 
Apple operator who sets you up with . every-
thing you need to conduct an Apple Family Workshop$ lik~th,is inform and entertain and 
Computing W(Jrkshop. The kitthey send comes letp~rE:tnts in on the mystery we calltechnol­
complete with a script, demo COs, and work- ogy. When they'r~ i~formed, parents are usu­
booksl I used the kit as part of a PTA meeting ~Uy more than wllhng t~ back you and your 
where we had mini-workshops on a variety .of _ school technolc)gy pursuats. 
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Teach afternoon classes 
Yeah, I'm sure most of you are already either teaching or taking part in a 
computer-literacy class. But have you ever thought of making it available to 
parents in your school ... free of charge? Lots of adults out there are eager 
to learn about computers, yet they're intimidated by the whole idea. Why 
not give them this opportunity? When they get excited (and, believe me, 
they will), they're going to be some of your biggest supporters. You won't 
have to convince the PTA to help pay for your online service or buy the 
laser printer you really want for the teachers. The parents will be so into 
computers, they'll be coming to you asking what you want them to buy next! 

Use school newspapers 
This one is easy. If your PTA puts out a monthly newsletter, ask for a small 
amount of space for a technology column. Use this space to brag about the 
students' accomplishments and tell about goals for the future of the technol­
ogy program. 

Another great newspaper idea is to have a school newspaper staff. Using the 
computer to create the newspaper is an education for the students. Within 
the paper you might have a section in which you highlight "technology stars 
of the month." In this section you could talk about teachers around the 
school who are doing great things with their computers. (We teachers love 
to see our name in print; recognition is so hard to get these days.) 

TechnologlJ week 
This week of recognition usually falls in February. It's actually perfect timing. 
Everyone's over Christmas, bored with winter, and anxiously awaiting spring 
break. Why not add some excitement by creating a week-long celebration of 
technology? Invite local merchants and professionals to give presentations 
on ways in which they use technology. 

This strategy accomplishes two goals: It lets the kids see how technology is 
important for their futures, and it ushers those oh-so-important taxpayers 
into your building, thereby raising their awareness of what's going on at the 
local school level. Many companies end up volunteering services or supplies 
after they see how involved your program has become and how much you 
still need to make it complete. 



Remember Your Friends 
Don't become isolated from the rest of the world. Don't try and reinvent the 
wheel, as they say. I've learned more from my fellow technology coordina­
tors than I could have ever learned on my own. Here are some great ideas 
for sharing with colleagues. 

Throw a software part11! 
That's right, invite anyone who's interested to come and "play" with your 
new software. Only remind them of the importance of sharing when we play 
with our friends and require them to bring along some of their "toys." This 
activity is loads of fun, and it's a good way to get a look at some of the new 
programs you may be thinking about buying. 

Halle a document exchan9e 
One of my good friends at another school came up with the idea of sharing 
our creative talents by putting these creations on a disk and sharing them 
with each other. Once a month he sends out a memo announcing a theme 
(forms you created, workshop ideas, Kid Pix lessons, and so on) and asks 
everyone to send him samples (on disk) along with one blank disk. He then 
compiles all these samples and sends you a disk with everyone's best work. 

Remember: Only share documents you created, not software. It is illegal to 
copy software. 

Create a software trailer or office 
At my school district's main office we have a trailer full of software to be 
checked out for preview. It's a great deal! Most of the software was given to 
us by the various companies in hopes that- after previewing- we'd 
decide to make a purchase for our school. Most of the really big companies 
are eager to send you their stuff. 

Deflelop a technolo91J center 
This project is one of my system's goals. Plans are underway to construct a 
center that will house the latest in technology. Much of this work is being 
done in conjunction with Apple and IBM. These companies will keep the 
center equipped with their current products and provide training to the 



----------- Chapter 17: So How Do I Pay for All This? 2!, 1 
center's staff. This center will be open to the public and will be available for 
teachers to visit individually or as a group for training. Eventually, I'm sure 
that the software-preview trailer will be incorporated into this same facility. 

OkaiJ •.• You Want Cot~ Hard Cash! 
Yeah, yeah, yeah, everyone's informed now, and maybe a few dollars or 
supplies have come your way- but you want the big bucks, you say? There 
are ways to make money for your school without having to beg or show off. 

Sell blank disks 
At my school, a blank computer disk is part of each student's basic supply 
list. Most families don't want to go out and buy a box of ten disks just so 
their children can have one to bring in to school. So, before registration day, 
buy boxes of disks and have individual disks for sale when the kids come to 
meet their teachers. I sell the disks for $2 each (you can get a box of 30 for 
around $15). All the money I make from selling the disks goes towards ink 
and toner cartridges for the school printers, software I want to purchase, or 
time off for teachers to take technology staff development courses. 

Hold summer computer camps 
The week after school's out, we hold a half-day camp for students. We have a 
morning and afternoon session, and parents provide the transportation. I 
love this idea because, unlike the school day, I get to work with the kids for 
an extended period of time, and we can get into more-involved projects on 
the computer. We charge $50 a child and usually have a waiting list. Some 
schools turn the camp into an ali-day camp and rotate the kids between 
computers and tennis or basketball instruction. This is a fun and easy way 
to make a couple thousand dollars for your technology program. 

Schedule after--school clubs 
This idea works something like summer camp, except that you meet with a 
group of kids once or twice a week. Parents like this one, too, because it 
gives them some time to regroup before picking up their kids - and the cost 
is minimal (we charge $8 a week for one two-hour session). That may not 
sound like much, but if you get 10-20 kids a week, that money helps buy 
paper, disks, and ink cartridges when you need them. 



Seek parent donations 
When we chose America Online for the school's access to the World Wide 
Web, we didn't have the funds to pay the account up front. So we devised a 
plan to offer access only to the fifth-grade students and ask their parents to 
give donations in order to get the service up and running for this first year. 
Believe it or not, it worked. We not only received enough to prepay for one 
year's service, but we also had a little left over to buy additional time if we 
needed it. 

Do a fund-raiser 
Sell something, sell anything! Any number of fund-raiser companies will 
come to your school and show you their wares. The percentage you make 
off each sale is usually pretty substantial and well worth the month-long 
headache of arranging the whole deal. 

Use Your WorJ .. Processing Skills 
You're surely a master by now. So put those skills to work and round up a 
little dough! 

Write a 9-rant 
Every year, millions of dollars in grant money goes unclaimed. I do know 
schools that have received huge grant awards. It's pretty incredible thinking 
that you could get thousands of dollars just for writing a big, thick document. 
Many books on grant writing are available, and I've seen a new flood of classes 
on the subject. If you have the time (ha, hal), it's worth a try. America Online 
has a Grant Information Center in their Scholastic Network area. The grant 
information is updated on a regular basis (keyword: SN GRANTS). 

Find a corporate sponsor 
What is it they say? "It never hurts to ask." Write a big company and, once 
again, show off. Tell them about your incredible pursuits and how the 
company's sponsorship would enable you to reach new heights. One school 
in my district has a division of Apple as their sponsor. They get all the new 
"stuff" when it comes out, and in return, they act as a test audience. Another 
school has a local department store as a sponsor - and they've gotten all 
the video supplies for their multimedia pursuits absolutely free. I'm sure it's 
a big fat tax write-off for the companies, so give it a try! 
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Other Cool Stuff You'll 
Want to Buy 

•••••••••••••••••••••••••••••••••••••••••••••••• 
In This Chapter 
... All the extra "stuff" everyone wants to buy 

•••••••••••••••••••••••••••••••••••••••••••••••• 

~ere's never enough time to include it all. You know what I mean -the J ~ell's about to ring, and you realize (once again) that you didn't make it 
to that health lesson. Why is health so hard to work in? Anyway, all the 
"extras" mentioned in this chapter are just that- extras that aren't neces­
sary but that would be really great to have. Now that you know the bas ics, 
adding these things to your technology inventory should be simple and fun. 

Scanner 
A scanner takes a picture of something and then puts it on your Mac's 
screen. After that, you can manipulate it any way you want (what control!) . 
This means you can crop, erase, add to, copy, and paste. 

Scanners look and act like the copy machine you probably have sitting in 
your work room -only they're a lot smaller, and paper never gets jammed 
inside. You can also find smaller handheld scanners (they're sometimes 
awkward to operate, though) and neat little photo scanners that accommo­
date a regular s ize photo. 

What's it flOOd for? 
The uses in the school setting are incredible. 
You can scan a copy of Johnny's first story 
and then copy it into Kid Pix, where he can 
add his own illustrations and print it for Mom. 
Or better yet, get involved in that portfolio 
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idea we (and the whole world) discussed earlier, and keep Johnny's work in 
an electronic portfolio that's easy to pull up when Mom or Dad comes for a 
conference; the electronic portfolio takes up a lot less space than that milk 
crate with hanging file folders. 

Another neat thing to do is scan photos or newspaper clippings to incorpo­
rate into text files . Why not add that scanned photo of your principal kissing 
a pig at the fall festival to the school newspaper you create with The Writing 
Center? Or the graph from the newspaper clipping showing the incredible jump 
in test scores since your school devoted more time and money to technology 
pursuits? 

Cost? 
Flatbed scanners can be bought for as little as $400, or they can run as high 
as $5,000, depending on the quality of the image you desire. Handheld and 
photo scanners are a good bit less - usually under $300. 

The higher the dpi (dots per inch), the better the scan appears on the 
printed page. That's because the image Is digitized into bunches of little 
dots, and the closer the dots are together, the clearer your scan will be. 

PaperPort to the rescue 
If you have a fax/modem, you have the ability 
to fax anything from your computer screen. 
Simply hold down the Option key before you 
go to the File menu. When you do so, you see 
that the Print option is replaced with the Fax 
command. Then it's as simple as typing in your 
fax number and possibly adding a cover sheet. 

What's difficult is trying to fax a hard copy 
that wasn't created on your computer. I don't 
own a scanner, so I can't just scan the image 
and then fax it, but I really don't need a full size 
fax machine. That's why PaperPort is such a 
neat invention. The PaperPort by Visioneer 
($200) fits neatly between your keyboard and 
monitor (much smaller than a flatbed scanner) 

and looks something like the paper roller part 
of an old typewriter. You simply slide your pa­
per into the front of the PaperPort, and the 
image on the paper is scanned. After the im­
age appears on your screen, you can fax it out 
to someone, file it with other papers, or edit it. 
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Di9ital Camera 
All the schools in my area are buying digital cameras as fast as they can 
come up with the money. These neat machines fall into the "who'd have ever 
thought of it" category. These cameras work like any other (only no focus­
ing)- but they don't use film! Most models allow you to take between 30 
and 96 pictures (in color!). The pictures are saved in a digital format and 
then downloaded into your Mac by simply connecting the two with a serial 
cable. It's tres easy and fun, fun, fun! 

After you load the pictures into your computer, you can crop them, rotate 
them, scale them larger or smaller, and even zoom in on specific areas. And, 
of course, you can import these pictures into any of your other applications. 

What's it good for? 
Are you kidding? Take a digital camera on a 
field trip and then come back to create a 
presentation showing everything you did and 
learned. Or have the camera with you at the 

PTA performance and then use the pictures in the PTA newslette r. An 
electronic class scrapbook or diary can be enhanced with the addition of a 
few photos showing the highlights from the school year. We use a digital 
camera to take pictures of the kids who are having a birthday; we then 
import these into a slide show we run just before we broadcast the morning 
announcements on closed-circuit TV. 

I'm sure that by this point, you've already thought of a few more ways you 
could use a digital camera to meet your own needs. 

Cost? 
Like scanners, the price of a digital camera depends largely upon the clarity 
of the image it creates and what bells and whistles are included. The most 
popular camera used in education is the Apple QuickTake 200, which 
currently lists for about $560. I know others who swear by the Casio QV30 
and the Kodak DC40. Both cameras allow you to take more pictures than the 
QuickTake 200, and the Casio QV30 has a viewfinder that allows you to 
review images before downloading them into your Mac. 
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Too cool and too cheap to pass up 
Connectix makes an affordable ($99 black­
and-white; $200 color) alternative to the more­
expensive digital cameras. It's called the 
QuickCam. This little device is a round ball 
(about the size of a billiard ball) that sits on a 
triangular base. The QuickCam can take both 
video and still shots. 

I must mention a few limitations, however. You 
can't take this camera on the road (unless you 
have a laptop). Unlike the very portable 
QuickTake, the QuickCam must be connected 
to a Mac in order for you to operate it. Also, 

TouchWindouJ 

the pictures taken with the QuickCam aren't 
nearly as clear as the QuickTake - but the 
price is definitely right! 

This device allows children to do what we're constantly telling them not to 
do - touch the screen. A touch window is simply a screen that attaches to 
your computer monitor, and whe n you touch the screen, the computer picks 
up on the response as if the mouse had been clicked. By touching the 
screen, children can make selections, move objects, pull down menus, and 
even draw graphics. 

The Touch Window is ideal for special-needs 
children who may have limited fine motor 
skills or mobility. It's also great for preschool 
and kindergarten children who may not have 
had exposure to the computer and are not 
familiar with the mouse. 

Before we purchased this device, our special-needs children weren' t able to 
use the computer. Now, they love using the Br0derbund Living Books and 
other interactive titles. 

Costl 
The Touch Window is made by EdMark and costs $300. 
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Power Book 
I want one. I want one. I want one. I'm sure everyone has seen a laptop 
computer by now, and you probably think that they're mainly used by 
business types on airplanes. Well, that's the way these small wonders are 
portrayed in commercials and magazine ads. However, the laptop is making 
huge headway in the education business as well. 

Apple makes many different models and sizes. They come with different 
configurations (speed, RAM, and hard-disk space), and you also have the 
choice of color or black-and-white screens. The price range varies consider­
ably based on the features you desire. 

A laptop doesn't have to be plugged in, thus making it portable. That's the 
whole deal. Once charged, most laptops run for about three hours before 
they need to be recharged. 

What's it IJOOd forJ 
Well, if you had a laptop at home and pur­
chased some of the same software you had at 
school, you could take things home to edit or 
create. You could even enter grades on your 
gradebook program while sipping Kool-Aid on 
the deck as you watch your kids play. 

Some schools are buying laptops for teacher 
checkout. Isn't that kind? They know they don't pay us enough to be able to 
purchase one of our own, so they give us loaners - it's really a wonderful idea. 

I've also heard of schools purchasing class sets of laptops and storing them 
on a rolling cart with a printer. This makes it easy for teachers to roll the 
cart to their classrooms and have their own labs for a period of time - an 
appropriate alternative these days when so many of our schools are over­
crowded and space for computer labs can only be considered after regular 
classrooms have been created. 

CostJ 
You can get a black-and-white PowerBook with 8MB of RAM and a 500MB 
hard drive for under $1,000 through mail-order houses. Or you can go for it 
and get a PowerBook with a color screen, tons of memory, and lightning 
speed for around $2,000. (I'll probably have to settle for something some­
where between the two.) 
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So you want to buy a computer 
Memorize this number and call it at least once 
a month to check prices: 1-800-959-2775. This 
number connects you with the Apple Educator 
Advantage program. It's a great deal. As long 
as you're a teacher, working at least 20 hours 
per week, you're eligible for great discounts 
on a select group of Apple computers. The 
inventory and the prices are always changing, 

so it's worth calling before you rush out to the 
local computer superstore. On the other hand, 
I admit that I sometimes see better prices in 
local stores. 

PS: Apple even offers a reasonable financing 
plan! 

Apple Presentation SlJstem 
The Apple Presentation System allows you to use your television as a 
monitor. Imagine being able to teach students a new program as they view it 
on your classroom television. 

What's it IJOOd for] 
If you're in a one-computer classroom, you know how difficult it is to teach a 
new program to a group of students crowded around one small computer 
monitor. Being able to transfer that image to a television makes using the 
computer as an instructional tool an easy feat. 

My favorite use for this technology requires that you have a VCR hooked up 
to the television you're using. Believe it or not, some families have yet to 
purchase their own computers, which means that parents aren't always able 
to view the cool slide shows and multimedia presentations their children 
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create. By recording what appears on the television screen, you can send 
home a VHS tape of a computer presentation. Isn't that cool? One teacher in 
my school combined different computer clips from the entire year, added 
some live video, and had multiple copies made as end-of-the-year gifts for 
her kindergarten students! 

Cost? 
Call your local Apple dealer to see whether adding an AV card is a possibility 
with your specific Mac model. If you choose to go the Apple Presentation 
System route, it'll cost about $250. 

Trackball 
A trackball is something like a mouse turned upside down and placed on a 
stationary base. You move the cursor by rolling the ball that sits on the top 
of the base. Clicking is accomplished by pressing a button that's located on 
either side of the rotating ball. 

Cost? 

What's it fJOOd for? 
Some folks just never get the hang of mouse 
manipulation- especially younger students. 
Microsoft even makes a trackball for the 
younger set that has a ball that's about the 
size of a grapefruit (currently for PC users 
only). It's all a matter of personal preference 
and getting something that works best for 
your students. I have a few friends who swear 
by trackballs and think a mouse is just a waste 
of time. I still prefer my mouse, thank you. 

Trackballs aren't an expensive add-on. The price can range anywhere from 
$25 for a very basic model on up to $80 for a trackball that enables you to 
program its buttons to automatically perform certain tasks (such as save, 
print, and close). 
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Di(/.ital Tablet 
These tablets come in a variety of different shapes and sizes and look 
something like a thick sheet of heavy-duty plastic. The surface of the tablet 
is loaded with tiny sensors that track the movements of a special pen as it 
moves across the tablet. Most of the newer tablets enable you to adjust the 
amount of pressure required to register an image, which is a nice option 
when working with children. The pens can be cordless or attached, and 
some can be programmed to perform keyboard shortcuts. Many of the 
tablets also come with neat beginner's drawing programs. 

Cost? 

What's it good for] 
Kids seem to like the tablets because they can 
really "draw" instead of trying to draw with a 
mouse or trackball. I think each school should 
have at least one tablet. Most of the tablets 
are sensitive enough to allow you to trace 
over a sheet of paper. 

The prices vary depending upon the size of the tablet. A 4-x-5-inch tablet can 
cost $450, and a 12-x-12-inch tablet can cost as much as $850. When you're 
shopping for a tablet, check out the features: Is the pen cordless? Does the 
pen have an eraser feature? Does any software come bundled with the 
tablet? What are the pressure levels of the tablet? Can you custom-set the 
pressure sensitivity to meet your students' needs? Can you program the pen 
with corresponding keyboard shortcuts? 

Headphones 
Whether you're in a Mac lab or in a one-Mac classroom, you need to buy 
headphones. My Mac lab instructor found some at one of those "dollar 
stores," and we bought out their entire stock! Don't spend tons of money on 
something that's bound to need replacing before the end of the school year. 

What's it good for] 
Sanity. It's pure and simple: What you can't hear won't drive you crazy. Well, 
I guess the fact that your students can concentrate on what they're doing, 
instead of listening and watching their neighbor's computer, is another plus. 
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Costl 
I said it before, and I say it again: If you're buying for your school, find the 
cheapest headphones you can! If you're buying for your own personal use, 
headphones range from $1 (my personal favorites) all the way up to $40. 

Zip Drille or Jaz Drille 
These cool little external hard drives are lifesavers. Let's face it, there's 
bound to come a time when you're going to want to share some of your 
computerized creations with friends. But guess what? Your cool slide show 
probably won't fit on your trusty old floppy disk. What's an educator to do? 

Well, you could buy a standard external hard drive, but after its space is 
filled, you're shopping for another one. Or you can buy one of Iomega's cool 
cartridge drives. The drive doesn't store all your information inside like a 
standard external hard drive would. Instead, your information is stored on 
little cartridges that are about the size of a regular floppy, only thicker. The 
cartridges for the Zip drive hold 100MB of information, and the cartridges 
for the Jaz drive hold 1GB of information. 

Costl 

What's it fJOOd for? 
Because you can keep buying new cartridges 
as you fill them up, you have constant access 
to high-capacity, portable storage. I take my 
Zip drive with me when I go to other schools 
or to conferences. Doing so allows me to 
share my kids' great creations as well as copy 
inspiring works offered up by my colleagues. 

The Zip Drive retails for $150 and comes with one cartridge (100MB). Extra 
Zip cartridges will run you about $13 each. The Jaz Drive retails for $399 and 
comes with one cartridge (1GB). Extra Jaz cartridges cost $90 each. 
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Newton Messa9ePad 2000 
This little device enables you to easily download handwritten notes, data, 
and other information into your Mac at a time that's more convenient. The 
MessagePad is smaller than a standard steno pad and comes with a pen for 
entering information with "digital ink," or you can use the on-screen key­
board. The MessagePad can even recognize my handwriting, so I know its 
character recognition skills are top-notch. 

Cost? 

Many teachers are already using the Newton 
to take anecdotal records on individual 
students, make personal notes about class­
room performance, record grades, and much 
more. Aurbach and Associates, the company 
that created Grady Profile Portfolio Assess­
ment, recently released Grady Profile Compan­
ion, a software package designed especially 
for the Newton MessagePad. Using the Grady 
Profile Companion with your MessagePad 
enables you to easily keep track of individual 
student performance and later download the 
information into each student's personal 
portfolio on your Mac. 

The Newton MessagePad 2000 retails for $950 and comes bundled with 
Pocket Quicken and Newton Back-up Utility. 

eMate 300 
I predict that these clam-shaped, kid-friendly computers are destined to be 
standard issue in classrooms across the country. The eMate 300 has a built­
in full-featured word processor (yes, you can format your text), a drawing 
application, spreadsheet, graphing calculator, note-taking tools, address 
book, Web browser (you'll need the optional modem), and a calendar. And 
get this, it costs around $750 and weighs less than four pounds! 
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If your school can't afford a computer for 
every student (what school system can?), the 
eMate is the perfect solution. Purchasing a 
class set of eMates and placing them on a cart 
with a high-quality printer (or two) is a great 
way to give the whole class computer access 
at a reasonable price. 

The fact that the product was designed to withs tand the bumps and bruises 
of a child's backpack means that you won't have the worries that come 
along with students carrying around traditional laptops . The full-day battery 
life is another bonus. The eMate allows students to enter information via a 
keyboard or stylus (an inkless pen), and the screen displays the width of a 
full page. Students can even draw images right on the screen, and these 
images can be integrated right into their text documents. You can also 
download your information to a Macinstosh or IBM-compatible computer. 

Cost? 
The base price for a single eMate is $749, or purchase an 8-pack for $5,599 (a 
savings of $50 per eMate) . Early indications show that this product is being 
well received by schools , so look for lower prices in the near future. 

Fonts for Teachers 
I can't begin to count the number of hours I've s pent in front of the televi­
s ion - creating handwriting practice pages . If you never taught kindergar­
ten or first grade, you probably haven't dotted row after row of uppercase 
and lowercase letters or dotted a child's name over and over again. My 
husband was always questioning if that was really what I s pent all that time 
in college to learn. 

What's it fJOOd for? 
Now, a number of software companies that have developed fonts especially 
for use as handwriting practice. The fonts come in dotted-line versions, 
dotted versions with arrows showing which direction the children need to 
move their pencils, and solid line versions. Most companies have cursive 
and manuscript versions -a few have even created D'Nealian versions. 
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The teachers at my school use the solid line versions in 72 point or higher to 
create name tags, desk tags, labels for items in the classroom, and instruc­
tions for centers. These fonts are also great for typing student stories in 
versions that are easy for fellow classmates to read. 

Cost] 
Prices vary ($35-$65) depending upon the vendor and the number of other 
fonts that come bundled with the school fonts. 

Here's a list of the companies who make these cool fonts: 

I
~ Primary Fonts (Forest Technologies) 1-800-624-2926 

~Primary Fonts II (Forest Technologies) 1-800-624-2926 

~School House Fonts (Signature Software) 1-800-925-8840 

~School Font Collection (Mountain Lake Software) 1-800-669-6574 

EasiJPhoto Reader 
It's a pint-sized scanner that's just the right size for photographs. Using 
EasyPhoto takes much less time than a normal scanner- a big bonus. You 
simply pop the photo in place, push a button, and then watch the photo's 
image show up on your computer screen. Save the scanned image, and then 
you're free to use it in any number of applications. 

What's it fJOOd for 1 
Your kids might not have access to a digital camera, but I bet that they have 
a few family snapshots. In addition, you probably take tons of pictures 
during the school year. Wouldn't it be cool to add your classroom photos to 
your weekly newsletter, create a slide show for Open House, or create 
classroom stationery that includes a class photo. Kids can add interesting 
photos to their reports, posters, newsletters, and other projects. 

Note: As an added bonus, this cool tool also comes with software to help 
you use your scanned photos in calendars, cards, and screen savers. 
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Let Apple show you the ropes 
After more than ten years of research on 
teaching and learning with computers (Apple's 
Classrooms of Tomorrow), Apple is now 
offering complete staff-development products. 
Apple took what they learned in their research 
and used that information to develop work· 
shops that deliver information teachers need 
(no more wasting school money on staff 
development that was intended for the busi­
ness world) and come packaged in workable 
time frames (no more all-day workshops). In 
addition, Apple can send in one of its Apple 
Certified Trainers (all certified teachers them· 
selves) or provide your technology coordina­
tor with a Leader's Kit to help him or her per­
sonally deliver the staff development 

Apple divides its staff-development work­
shops into tiers or levels. Within each tier, there 
are a number of different staff-development 
offerings: 

Cost? 

Tier One: Getting Started With Technology 

From this tier, you can choose workshops on 
the Internet, productivity software, Macintosh 
basics, or an introduction to multimedia. 

Tier Two: Integrating Technology 

Within this tier, there are workshops on 
multimedia and curriculum integration or 
technology and curriculum integration. 

Tier Three: Leading With Technology 

Tier three workshop titles are Leadership 
Workshop for Technology Program Develop­
ment; Consulting Services; Teaching, Learn­
ing, & Technology - A Planning Guide; and 
Teaching, Learning, & Technology- Planning 
for Staff Development 

For more info, call 1-800-800-APPL (2775) or 
checkouthttp:/ /education.apple.com/ 

At an outlay of $199, you could probably afford to purchase two or three to 
share within your school! I'd buy one for home, too. Just imagine the 
Christmas gifts you could create! 

Lite Pro 
I remember when an overhead projector with an LCD was a real treat. Now 
there's a new (yet a little more expensive) alternative- the LitePro projec­
tion system. It's a full-featured multimedia projector that enables you to 
connect your computer, VCR, laser disc player, and camcorder and view the 
projected images and accompanying sounds with unbelievable clarity. 



Whether you're conducting whole-class computer instruction or sharing 
classroom multimedia projects with your PTO or PTA, this projection 
system makes everything look as good as it does on your computer screen. 
Every school needs at least one. There's even a remote control that controls 
your mouse, allowing you to interact with your audience instead of hovering 
over your computer! 

Cost) 
These great machines don't come cheap, but they're worth every penny. 
The LitePro lists for $3,995; and a higher-end version lists for $5,529. 
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In this part ... 

saved the best for last! 

In this part you find all the stuff we teachers love to get 
our hands on. The lesson plans were designed to be easy 
to customize to fit any grade level or subject area, and the 
software lists are sure to be a welcomed guide. My buddy 
David Pogue graciously gave me permiss ion to reprint his 
super glossary and troubleshooting pages that I'm sure 
you will soon have well-worn. And the About the CD 
appendix is where you start in order to take.advantage of 
the nifty CD included with this book. 



Appendix A 

Mac Activities to Enrich 
Your Classroom 
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1/lthin this appendix, you find ready-to-use activities based around two W ~oftware titles: Kid Pix (including Kid Pix 2, Kid Pix Studio, and other 
versions) and ClarisWorks. That's right. With a small software investment, 
you can also participate in all the amazing activities found here. 

Don't forget that I'm a teacher, and I know how your mind works. Take these 
ideas and branch out on your own. We teachers are notorious for taking 
someone else's inspired plans and adapting them to fit our own needs. Go 
for it! 

The lessons are divided by curriculum area. I'm not including a grade level or 
age group with the activities, because - after you read through a lesson -
you'll more than likely think of ways to adapt it to the grade you're teaching. If 
you need a quick review of the two programs used, turn to Chapter 10 for Kid 
Pix questions or Chapters 6 through 9 for ClarisWorks help. 

The activities in this section were created by my new good friend Norma 
Jean Gottschalk- isn't that a great name! Yes, Norma Jean, teacher 
extraordinaire, came up with every idea you see in this appendix. I guess a 
book of her own is the next step! 

And now an invitation: If you have a favorite ClarisWorks or Kid Pix activity 
or group of activities that you'd like to share with the world, please send 
them to me at mn e t t e@a o 1 . com and you may see your name and idea show 
up in the 4th edition of this book. Please check out the activities on the CD 
and the ones listed here- don't send an idea that's already been printed. 

Note: The activities listed here are new to this 3rd edition of Macs For 
Teachers. The activities that appeared in the first two editions can be found 
on the Macs For Teachers CD. 
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Kid Pix 

Figure A-1: 

LaniJUaiJe Arts 
Slide shows, which are always entertaining, are even more fun when they are 
classroom-created! Use Kid Pix to create letter pictures. Add a large letter in 
a cool font and then suggest that the students draw pictures that begin or 
end with the given letter. When you're finished, save and import the master­
pieces into the Slide Show part of Kid Pix. The students love watching their 
own moving alphabet. You can even hook up that LCD screen for Parent 
Night and play your slide show for parents to watch! 

Digital puppets? Sounds like something out of some outer-space school? 
Create your own using the Digital Puppets option in the program. Let each 
student create a puppet and then encourage everyone to write and record a 
dialog to accompany his or her puppet. You may want to create a setting to 
help the students get started. (For example, the story takes place in the 
woods, the seaside, a city, and so on.) 

Inspire students to create their own hidden pictures! Assign each student a 
letter and let him or her create a picture and then "hide" the letter in the 
picture as many times as possible (as shown in Figure A-1). Print the pic­
tures and let a partner find the hidden letters. 

Kids can ~~~~~ 
have fun 
"hiding" 
letters in 

their 
original 

artwork. 

___,_ __ , 
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FigureA-2: 
Word 

pictures are 
possible 

with Kid Pix. 

Kid Pix Studio has an endless supply of cool backgrounds and stamps. 
Create some interesting pictures and use the text tool to include story 
starters to go along with your pictures. Give the files intriguing titles and 
keep these in a folder on your desktop. Let the students choose the one they 
want and complete the story you started. Print the results and compare the 
endings. 

Turn some words into works of art! Think up words that might display their 
own meanings (as shown in Figure A-2). Take the words to Kid Pix and have 
some fun! 

Assign each student a letter and ask him or her to draw it on the screen. 
Kids can then create a picture around the letter including several items in 
the picture that begin with the letter which was assigned to them. For 
instance, the letter "b" could be turned into a boat on blue water with 
billowy clouds in the sky. 

Kid Pix 

figure A-3: 
The 

addition of 
a few lines 

Math 
Experiment with geometric shapes to create 3-D designs (shown in Figure 
A-3). Turn flat circles into cakes! Flat squares into cubes. Print the results 
and design other objects! 

cantake c=> 
2-D images --7 

to 3-D. c=:::> 



Pair your students, asking one student to design a whole sheet of various­
sized lines of different images (as shown in Figure A-4). Encourage the use of 
color and unusual pictures, symbols, or letters. Use the tools to make the 
rows look great! Print and have the second partner measure the lines and 
record the results. 

--• •D• • • • u+ • • L:. 
FigureA-4: * ~* ** *• * {! G 

A 
measuring )I 

exercise 0 X X X X 0 xoxoxo 
can be ~--

created ~-fl A 
with R Be 

different D EF GHIJKLffiD 

line lengths. r ' • ' 

Figure A-5: 
Stamps can 

be used to 
make an 

illustration 
of a 

potential 
word 

problem. 

Use the stamps to illustrate word problems that the students write for each 
other (as shown in Figure A-5). Print the problems and let partners work 
them out. 

Create a graph showing the hair color and eye color of the students in your 
class or your school. Use the line tool to create a bar graph and the stamps 
to show hair color and eye color. Encourage the students to be creative and 
find stamps to represent eye color! 

'' 
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Kid Pix 

Figure A-6: 
Stamps can 

form 
categories. 

Figure A-7: 
Stamps can 

provide 
classifying 

practice. 

Science 
Use the stamps in the Kid Pix program and sort them into the correct animal 
categories (as shown in Figure A-6) There are a ton of stamps, and this is a 
great sorting activity! 

Memmels 

d 
p 
~ 

B1rds F1sh ' , 
'~ )t~ 

Outer space is always a popular unit of study. Using their knowledge of the 
planets and the vast unknown, students can design their own planets. They 
can even name it whatever they choose; encourage them to make names 
representative of their particular planets. The finished products are fun to 
print out on iron-on transfer paper and put on white T-shirts. Because there 
isn't any text used, there's no need to reverse before printing. Plan an "end 
of unit" celebration day when everyone wears their outer-space T-shirts! 

When studying the animal families, enlist the help of the students to make a 
sorting game. Divide the class into groups such as mammals, fish, birds, and 
so on. Let each student draw and add color to an animal representative of 
the group to which he or she is assigned. Print all the animals and mount on 
foam board. Trim and add a self-adhesive magnet on the back of each 
animal. Use a metal filing cabinet to sort all the animals into the correct 
groups. When the school year is over, each student has a refrigerator 
magnet to take home! 

Classifying is an important skill. Use the stamps in Kid Pix to classify items 
according to their observable properties. Set up categories such as "metal," 
"glass," "plant," and so on (see Figure A-7). 

metal Glass plant 



2 6fl Part VI: Appendixes 

Kid Pix 

Figure A-8: 
Students 
can add 

details to 
coloring 
pictures. 

Social Studies 
Most of the younger students have lessons on cooperation. Let them pair up 
and try this cooperation activity: 

1. No voices! (This is a quiet activity - what a bonus!) The first student 
uses one tool and makes one line or shape. 

2. The second student gets to add one line, shape, or stroke. 

Now remember: No one is talking, so there is no exchanging of ideas as 
to what this creation will be in the end! 

3. Students continue taking turns and developing a picture. Allow them to 
work together until both students feel the creation is finished. Talk 
about cooperation! 

Studying about the rain forest? the ocean? Use the coloring pictures to set 
the stage and let your students add the details to the drawing (as shown in 
Figure A-8)! 
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Figure A-9: 
Graphics 
become 

"persona­
lized" 

with added 
stamps and 

name labels. 

Everyone seems to enjoy a unit on Native Americans. The younger students 
all love making bead necklaces to go along with this type of unit. Let each 
student design his or her own beads! Draw designs on the screen and paint 
in with bright colors. Print the colorful sheets, cut into long, skinny tri­
angles, and roll around a straw to form into beads. Glue the tip down, let 
dry, and string. "I made my own necklace!" will take on a new meaning! 

Animals are the subject of many units and always a popular research topic. 
Allow each student to choose an animal and do research on it. Use the Slide 
Show option to create a presentation on the animals. This would be a great 
project for a PTA presentation or perhaps, a presentation to a senior citi­
zens' home! Many different subjects could be used to tailor the show to your 
needs. 

Atlanta 

Kid Pix 

Health 
A full-body picture is the starting point for this activity. Ask each student to 
draw himself or herself with all the details (or at least almost all!). Then, 
using the pencil and text tools, identify the main parts of the body that each 
of the senses uses (such as mouth for taste, nose for hearing, and so on). 
The pictures would be fun to publish as a classroom book. 

Give each student a health goal to use in this activity (as shown in Figure A-10). 
Let the students find all the stamps in the program that could be used to 
accomplish the goal. Encourage the students to use all the stamp options. 
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Figure A-10: 
Goals 1 will mow you staM~K which are things I use 

can be tokeepde.anandhealthy. 

illustrated ~ ~ E) 
witha ..I:::J.. '\ 
stamp -

collection. 

Figure A-11: 
What kid 

could resist 
cooking up 

a model 
kitchen? 

Create a safe house. Use the stamp libraries to furnish the home and put all 
the details where they belong (as shown in Figure A-11). There are coloring 
pictures of all the rooms in a house in Kid Pix. Use all of them to create an 
entire house. Encourage your students to choose items that reflect their 
personalities and that follow all the health and safety rules they've studied. 

-+-'l--'llr-11 

Invite your students to use the stamps in Kid Pix to classify foods into plant 
or animal origin (as shown in Figure A-12). 
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Encourage your students to create timelines to represent their lives. They 
can use stamps or draw their own pictures to mark important events -
another great idea for a classroom book! 

CfarisWorks 

Figure A-13: 
Name tags 

with clip art 
reflect 

personal 
tastes. 

Language Arts 
During the first week of school, coach your students to experiment with 
different fonts and different sizes of fonts to create their own name tags. 
Depending on the level of expertise, the students can also add clip art to 
"spruce up" their tags (as shown in Figure A-13). Print and laminate for their 
desk tops, lockers, or cubbies. 

Jake cfrnlth 
~-~~­
~·V.~ 

Help your students write several paragraphs describing themselves. Encour­
age the students to include unique qualities such as "is sorta a clown" or 
"known to my family as a computer geek." (Both are what my family would 



Figure A-14: 

agree I could include in my paragraphs!) This would be a great time to 
include a lesson on the Check Document Spelling command in the Edit 
menu. Print the student's self-description and bind the pages into a book for 
parents to read during your Open House or Curriculum Night. This is also a 
great method for you to learn a bit more about your students! 

Most of us write weekly or monthly newsletters for the parents. Why not 
enlist the help of your students? Use the stationery that ClarisWorks already 
has set up for a newsletter or design your own template. You may want to 
establish the topics and let the students write the stories. Use a digital 
camera to include pictures in the newsletter. The students learn, the parents 
love it, and you have a well-written, interesting newsletter! 

Prepare templates for a class dictionary. Use cute fonts and perhaps a bit of 
clip art to brighten the pages. Keep the templates in a folder on your 
desktop. Let the students add their own words to the dictionary pages. 
Encourage them to include detailed descriptions of their words (as shown in 
Figure A-14). This will be a great resource for the students as the year goes 
by and the lists on the pages grow. Depending on how often your students 
contribute to the lists, you may even want to print the pages each semester 
and bind them into a personalized classroom dictionary to put on your 
bookshelf. But don't delete the originals! Keep those on your desktop and 
continue adding to the dictionary until the end of school. Time and budget 
permitting, you might want to print the "end of the year" edition for each 
student to take home . 

Words and 
meanings apple • . .. 

a red frui.t 

letter~:~~e~ alli.9ator a lon,9 reptile whi.oh li.ve.s 

i.n, the .swamp.s of Flori.rla 

Create a database of books that the students have read. After each student 
completes a book, enter the information such as title and author into a 
record on a database. Encourage the students to record their comments 
about the book. As the database grows and the year goes by, the students 
will need to perform a search on the title of the book they want to enter. If 
the entry already exists, they simply add their comments to the ones 
already recorded. Allow the students to access the database whenever they 
are stumped as to what book to choose for a report or project. Or encourage 
students to find an entry about a book that interests them, read it, and then 
discuss it with the student who posted the first entry. 
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figure A-15: 
New words 

can be 
sounded 

out aloud 
from a 

spreadsheet 

figure A-16: 
A book 
report 

template 
makes fill-in 

easy and 
orderly. 

Using the spreadsheet option, set up a word-family worksheet template (as 
shown in Figure A-15). Allow each student to write the new words in the 
cells and then print the spreadsheet so that he or she can sound out the 
words to a partner. 

Write some funny, interesting, and/or informative stories of your own. But 
wait, throw out all the rules and fill up the stories with grammar and punc­
tuation mistakes! Make them into templates and store on your desktop in a 
folder. Let the students trade places with you, correct your work, and print 
out the perfect stories. 

Suggest that your students record their adventures from the weekend. Add 
lots of details. Now print and circle all the adverbs and adjectives. Go back 
to the original story and use the Thesaurus command in the Edit menu to 
change all the original adverbs and adjectives to brand new ones! 

Set up a template for a book report (as shown in Figure A-16). Keep a copy of 
it on your desktop for students to fill in on the computer or print and fill in 
as they read their books. 

T~ 
Author 

Character 1 
Naroo 
Notes on character. 
What too character does. 

Character2 
Name 
Notes on character. 
What the character does. 
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ClarisWorks 

Math 
Many of the lower-grade classrooms in elementary school keep a running 
tally of the number of sunny days, cloudy days, rainy days, and foggy days. 
At the end of each month, turn this information into several different types 
of graphs (pie, bar, line). Let the students compare and contrast the differ­
ent types. Using the pie and bar graphs, allow them to color the sections to 
better represent the different types of weather. Keep a classroom book of 
the graphs so that students have a log of the past months' weather activity. 

After a lesson on word problems, allow students to create their own prob­
lems on the computer. Encourage them to include pictures (clip art) as well 
as words to communicate their problems. 

Make a classroom cookbook using favorite recipes from each student. 
Before typing up the recipes, ask the contributing students to convert the 
recipes to metric measurements if you're studying the metric system. 
Double or halve the recipe if you're working on fractions. Type up the 
recipes and import an original drawing of the food featured in the recipe. 
Print and let the students present the cookbooks to someone special! 

ClarisWorks 

Figure A-17: 
Descriptive 
clues lead 

to object 
definition. 

Science 
An important part of any science curriculum is observation. Provide objects 
for the students to observe and then describe using words (as shown in 
Figure A-17). Begin with basic shapes such as a cube or a cylinder. Encour­
age students to print their descriptions and then read them to partners. Let 
the partners guess which objects are being described. 

1. My object has no sides. 
2. My object has a top and a bottom. 
3. My object can be any color. 
4. My object can be made or many materials. 
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Figure A-18: 
Students 

seethe "big 
picture" 

when they 
sort entries 

under 
headings. 

After completing a classroom experiment, allow the students to record their 
experience. For clarity and emphasis, encourage them to add clip art and 
use different fonts and styles. Keep a running log of all the experiments by 
printing the written work and storing in a binder. During your Open House 
or Curriculum Night, let parents browse the notebook- they love to see 
just what their children are doing in the classroom! 

In addition to the usual weekly/monthly newsletter you write to the parents, 
involve your students in writing a monthly science newsletter. This would 
be a great time to experiment with fonts and styles. Include summaries of 
science experiments, photos of the results, and plans for future experiments 
and units of study. (What a wonderful opportunity to include a wish list for 
science materials!) Encourage the students to break out of the templates 
provided and design their own layouts. Parents love the additional informa­
tion about the classroom happenings, and the students are reinforcing their 
science experiences. 

Set up a spreadsheet with "Animal," "Plant," and "Mineral" as headings 
(shown in Figure A-18). Give the students lists of all sorts of things in the 
world. Ask the students to sort the items into the correct categories. Print 
the results and exchange papers to compare answers. 

--+···········--··-............................. j... .. _ .................... ,_ ................ j ..................................... _ ....... !---· 
1 Animal I Plant I Mineral l 

=t~~----~·at~:::::=:::~c=~:~f.!~I~J::~~=~~~!r=::~r 
I horse I rose I glass l 

j~~i~]~i 
ClarisWorks 

Social Studies 
The differences between needs and wants is sometimes a difficult concept 
(occasionally, for us teachers, too!) Let your students record their own 
needs and wants on a template you set up using the column function in the 
Format choice of your menu (shown in Figure A-19). Print the resulting lists 
and let the students work in pairs to edit the lists. Amazing to see what 
students put in these categories! 
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Figure A-19: 
Students 

learn 
through 

listmaking. 

Figure A-20: 
Morse code 

permits a 
personal 

touch. 

NEEIJS 

shelter 
food 

clothing 
love 

WANTS 

new computer game 
ice cream for dinner 
new Beanie Baby 

another pet 

When studying about long-ago, work in a mention of Samuel Morse, the 
inventor of the Morse Code. Give students copies of the code and turn them 
loose with the computer! Let them dash and dot up a storm and then have 
partners attempt to read their messages (as shown in Figure A-20)! 

Everyone has a Web page these days so why not let your students create a 
Web page for their favorite people in history? You don't need Internet access 
to view the pages, just a copy of your favorite browser to display the 
finished products. ClarisWorks comes with an HTML primer, which is great 
help, and there's even a stationery style already prepared for you! Let your 
students do the research and then turn them loose to create a Web page! 
Encourage them to include pictures and graphics. 

(This Is great fun) 

If Internet access is an option for you, encourage your students to use it to 
communicate with the outside world. Write an e-mail message to the Presi­
dent! The President's e-mail address is pres i dent@whi tehouse. gov. You'll 
want your message to be letter perfect, so compose the message in 
ClarisWorks and cut and paste it into your e-mail program. Expect a re­
sponse within a few days! If this idea appeals to you, there are tons of people 
to write to in our government. To get your students started, check out the 
following Web page for e-mail addresses of congressional representatives: 
http://www.vote-smart.org/congress/index.html 

When studying families, your students might want to trace their lineage 
and chart it on a family tree (as shown in Figure A-21). Use the painting 
program to create the tree; add some color to make it easier to read and a 
bit prettier, too! 



________ Appendix A: Mac Activities to Enrich Your Classroom 2 73 

Figure A-21: 
Family tree 
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CfarisWorks 

Figure A-22: 
Healthy 

habits 
start with 
each box 
checked. 

Health 
Create a personalized health habits checklist (shown in Figure A-22). Use the 
checklist option on the Style Sheet to place the check off box at the begin­
ning of each habit listed. Start the students off by suggesting the obvious, 
such as brushing teeth in the morning, flossing teeth, washing face, and so 
on. Print the lists in column form and laminate. The students can take the 
lists home and mark on them with a water-based marker each day. 

0 Brush my teeth In the morning. 

0 Floss my teeth In the morning. 

0 Wash my face. 

0 Brush my hair. 

0 Eat a good breakfast. 

Losing teeth is a major big deal in the lower grades. Make this a learning 
experience by scanning in a picture of a complete set of teeth. Make a file for 
each student with the picture of the teeth and keep the files in a folder on 
your desktop. When students lose one of their teeth, let them open their 
files and mark off the teeth on the graphics (as shown in Figure A-23). 
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Figure A-23: 
Records 
like the 

"lost tooth" 
update 
teach 

computer 
skills and 

health 
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Figure A-24: 
You can't 

Ben's Teeth 

I lOst my first top tooth on September 2. 
I lOst my first bottom tooth on October 3. 

ClarisWorks contains some great templates just waiting for you to use! 
Select "In Case of Emergency," which is located in the Stationery group. 
Instruct your students to fill it out with the information they already know 
(as shown in Figure A-24). Provide phone books for them to look up num­
bers if they need to do so. Print, laminate, add a bit of magnetic tape to the 
back, and they have a great resource to keep on the refrigerator at home. 
(Parents can fill in the missing information after the magnet arrives home.) 

IN CASE OF EMERGENCY + 
The Phone here Is • 
The Address here 1 s 
The neerest hospltel Is loceted et 
The phone number of the hospltel Is 

have too ~limli!IIIDB:mD:ml···· 

manyof ~~~~~~~========~~~~~~ some ~ 
refrigerator f'--=-'c.:.=---------t===...;.;.;.:;;.::.;...-1 
reminders! 
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The Lists! 
GOGGGOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOOO 

In This Chapter 
~My opinions aren't gospel 

..,.. Comprehensive lists of my favorite software for students 

r> The best teacher-productivity software 

ooooooooooooooooooooooooooooooocoooooooooooooooo 

~e educational software market changes on an almost daily basis, and I i~'s my job (my never-ending job) to stay informed. So the lists contained 
in this 3rd edition of Macs For Teachers have undergone some major renova­
tions and additions. Take a look and see what you think! 

A Disclaimer 
Let me just say this up front. This list is by no means gospel- but then 
again, what list is? It seems to me that every review or list I read has a slant 
of some sort; many of the folks doing educational software reviews don't 
even hold degrees in education and probably haven't set foot in a classroom 
since they were students themselves. My most valuable advice seems to 
come from computing friends and colleagues who actually use the stuff. In 
that respect, my list probably comes closer to being accurate than any 
others I've seen - I'm not employed by any of the software companies, and 
I make zilch when I mention their names! 

These are my favorite picks, based on what I've used or seen used in the 
school environment, what colleagues here and across the country have 
successfully used, and what I've used on a preview basis. Most of the 
software titles are available in school versions. A school version usually 
costs a little more than the home version but includes some printed mate­
rial intended to help you use the software in the classroom. 

The titles on the lists are in no specific order. Most of the titles come in 
CD-ROM versions only; however, many manufacturers of less-interactive 
programs will provide you with floppy disk versions for a small fee. All 
programs in each category are of supreme quality. 
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~SUP -fiP 
~~ Note: I include a copy of the software list portion of this chapter on the 

~ CD-ROM that comes with this book. Feel free to print the list and share it 
, , l with your administrators or fellow teachers. 
~= lJ 

So How Much Does It Costl 
You will notice that I didn't include prices in my very lengthy lists of great 
software titles. I have a number of reasons for this omission. The first reason 
is the incredible price variations I found when compiling this list. 

Afewd~fi~i~ipns 
home version: This version is sometimes re-. ~ive.you a break on the per·~~py.priee.Jhese 
fetred' to as: a consumer versioiland 'is what l~b packs usually-come with the same binders 

· You can buy if yo_u go to a store in your local _ · as]he school ver~ions. 
man or computer superstore. · 

neiW~rk version: A network versiorrc?~ s.~b­
school versioQ: A school version; can contain st~nti~lly more than a sir~gle•user v.8.r.$J~.n and 

. any number of additions to or variations from i~ sp~cially formattedto function ina network 
the home version. Software companies often. where multiple computers can access a ~iogle 
add special "school-type" clip art, fonts, tern- file· server. Software companies sometimes 
plates, or examples that have an education·at limitthe number of machines that may be con­
slant. In addition, school versions usually: nect~d to the network, so a site license is 
come vvitlj a)fnder fuU Qf .lesson pl~n$, pos~.. : .~Prrietimes a better deal~ 
ers, teaching ·aids, curriculum integration 
ideas, and blackline masters. · · sitidicense: A site-lic_ense agreemr:mtalf9ws 

ihe-legal copying of a software· product within 
academic version: This term is sometimes in• ·a~ spec-ific· district or building. The prices .are 
terchangeable with school version. However,. atwilys greatly reduced from the ·single ver­
in most cases, ao academic versic:m refers to·a :: slo:n p_rice. Depending on the agreem~·nt:there 
reduc_ed rate,: on a singl_trcopy of: a:.$OftW_are .. ·-m~Y.bestipulation$.·o~.ex~ctty.ho.w-r:m:ti1Y cop­
product at a price that's only available to edu• . 'ies:may·be made and th~ time period forwh'ich . 
cators. In order to get the price, you usually the agreement is good. A site license is the 
have to fax proof of employment, pay with a ·Way to go if you need the same title on every 
school purcha_se order, or show a student·ID. cpmputer in your school. 
AIWliYS ask mail-order comp~Jnies whether -· 
they offer this-pricing structure when makiiltf NotE.J:MilnY school.systems.~re Stll[tiP.gto p~r~ 
·p.e_r.so. nai'.·.Pu._r.-.c .... _ha.s._es; ··'· sav_. e._d. o_v. e. r $_50 0. _n·· ~hasesitelicenses.forsoftware.title~th~tare ~ommonly used throughout ~he system. ·Buy;. ·· 
MicrQsottwo·rd by receiving an academic vet- irig in bulk usually brings a lower price~ Make 
sion price I St!re that your school systems haven't already 
lab pack: Lab packs usually have five copies. purcbi~sed a title you're planning to buy with 
of a single title and usually (but not always) , those hard.:earned local school fundsl 



Mail-order vendors' prices were different from mall or computer outlet store 
prices, and then I found out about the book fairs that come to schools and 
sell software alongside the books! In addition, the prices quoted for educa­
tional software vary based on what type of "packaging" you choose - lab 
pack, home version, school version, network version, site license .... The 
options are limitless! 

Where Can I BuiJ These Titles] 
Your school more than likely has a supplier it likes to use. However, I find 
that it's sometimes cheaper and usually easier to go through one of the 
following companies: 

~ II" Educational Resources (800-624-2926) 

I ~<"Learning Services (800-877-3278) 

Both of these companies have great plans for school system purchases and 
are more than willing to send you a catalog containing all their products ... 
including the ones in these lists! 

You can also find most of these titles in the big computer store chains. 
However, you pay a premium price and rarely get an educational version of 
the software. 

laniJ.UtfiJ.e Arts (WritiniJ) 
It's a simple fact: Good writers are usually good readers and good readers, in 
turn, are usually good writers. Yeah, you've heard it before, but getting kids 
to write is like pulling teeth .... Believe me, I've been there! These titles tend 
to stimulate kids into writing because they make writing an adventure, and 
they turn out a printed product that looks great! 

The Amazing Writing Machine ( Bn?lderbund, early elementary-middle 
school). Combine the art smarts of Kid Pix with a great word processor, toss 
in a few good story starters, cool backgrounds to write upon, and you still 
haven't covered all the components of The Amazing Writing Machine. A 
great journal and address book round out the features. Students can write or 
spin (change a story BniJderbund saved for you) an essay, letter, story, 
poem, or journal entry. 

The Student Writing Center (The Learning Company, elementary-middle 
school). Great introductory word-processing program. I use this program 
before introducing students to ClarisWorks. Very easy to understand. If you 



have an older Mac, ask the salesperson about getting The Writing Center. It's 
an earlier version of the same program that has a few less frills and runs 
better on older machines. 

EasyBook (Sunburst, early elementary-middle school). Too-cool program 
that eliminates all the cutting and pasting involved with creating "real books" 
for students. After a child types in a story, the program prints the book 
(fronts and backs of pages), so all you have to do is fold and staple! 

ClarisWorks 4.0 (Claris, all ages). Give the demo on the CD a try! Best piece 
of software ever created. Buy it now. Read Chapters 6 through 9 if you need 
to be convinced! 

ClarisWorks for Kids (Claris, early elementary). It's a scaled down version 
of my all-time favorite software package. An icon-based interface that's easy 
to manipulate is only the beginning. This program has an Art Pad (Drawing), 
Writing Pad (Word Processing), List Pad (Database), and Graphing Pad 
(spreadsheet). In addition, there are hundreds of great clip art images, "kid 
fonts," lined paper, an easy-to-understand filing system, an Internet link, and 
tons of great templates. 

PageMaker (Adobe, middle school-college level). A page layout program 
that's got all the bells and whistles. Not for those new to the computer. I 
suggest that all high schools buy this program and use it to create their 
school newspapers. 

l.anfJ.UIAfJ.e Arts (ReadinfJ. Detlelopmentl 
Comprehension) 

The titles on this list not only help your kids learn to read, but also (hope­
fully) give them a little help in remembering and understanding what they 
read. And yes, you will find that I do believe that phonics still has a place in 
early reading instruction. 

Accelerated Reader (Advantage Learning Systems). My school houses this 
program in the media center, and every grade level participates. In a nut­
shell, you get software covering a large variety of trade-book titles. Students 
read the book and then show they understood what it's about by taking a 
test on the computer (the questions aren't easy to answer unless you 
actually read the book). The students are then given feedback on their test 
results. The computer keeps track of each child's progress and can compile 
a variety of reports for teachers and parents. This program is taking off like 
crazy and is a great success: The kids in my school are reading more and 
remembering what they read just so that they can come and take a test! 



Reader Rabbit's Interactive Reading Journey (The Learning Company, 
early elementary). I love this program because it teaches reading through 
phonics, simple sight words, and repetition. The CD comes with 40 
storybooks that are used as part of the interactive multimedia experience. 

Allen Tales ( Bn~derbund, early elementary-middle school). In an effort to 
prove that an alien is not the author of some of the best-loved works of 
children's fiction, contestants read passages from great Newberry Award 
winners and then solve puzzles and answer questions. 

UWe Planet (Little Planet Software, early elementary). A great combination 
of early reading comprehension and writing (you can find a demo on the 
CD). This program was developed in cooperation with the Learning Technol­
ogy Center at Vanderbilt University. It features a great multimedia 
storybook, story starters, sentence builders, and much more! 

Beginning Reading (Sierra, early elementary). This program presents a fun 
way for early readers to learn rhyming words, two-letter sounds, alphabetiz­
ing skills, vocabulary, and story-reading skills. All Sierra's programs feature 
a "talking tutor" to enable students to work alone or get the help they need 
easily. 

Word Munchers (MECC, early elementary). This game has been around 
forever and is still great. Just think of PacMan gobbling up words with a 
certain vowel sound, and you have a good picture of Word Munchers. I like 
the phonics link; personally, I still feel we need to teach those letter and 
vowel sounds. 

Grammar Games (Davidson & Associates, Inc., middle school-high school). 
Students not only learn basic grammar and punctuation skills, but also have 
loads of fun doing it on this jungle-adventure game. 

Midnight Rescue (The Learning Company, upper elementary). This program 
requires students to read short passages and then recall facts, make infer­
ences, and draw conclusions on their reading. In addition to all this school­
type stuff, the game is entertaining. 

Word Attack 3 (Davidson &Associates, Inc., upper elementary-middle 
school). This exciting game teaches students the definition and spelling of 
over 3,200 words and includes crossword puzzles and mazes. 

Reading Maze (Great Wave, early elementary). This program keeps records 
for you! Okay, it teaches early readers basic vocabulary and has lots of 
different skill levels. But, as I said before, it also keeps records for you! 
That's right. This program keeps up with each student's progress and leaves 
you free to worry about whose turn is next on the computer. With the large 
number of skill levels, you could use this game for the entire school year, 
and the students would still find it challenging. 
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SuperSolvers Spellbound (The Learning Company, upper elementary). This 
interactive program includes over 1,000 words for sharpening spelling skills. 
It allows teachers or students to add up to 3,000 words to the lists. 

Romeo & Juliet Center Stage (Sunburst, middle school-high school). This 
new package combines two videotapes and a CD to bring you everything 
you ever wanted to know about this famous work. On the CD, you can visit 
the Verona Courtyard where all the action takes place. From this courtyard, 
you can view the entire performance (you can even select specific scenes or 
acts from a control panel), meet the cast members, read the script, or use a 
notepad to write down your own notes. The videos contain behind-the-scenes 
footage and a full performance video of the play. 

Read, Write, and Type (The Learning Company, early elementary). My 
daughter can't get enough of this interactive program. I love it when I walk 
by the computer and hear her sounding out words and see her using the 
proper fingers to hit the correct keys. After she's written the requested text, 
reading is a natural extension. No, it doesn't exactly teach youngsters how 
to type, it just helps them become aware of the keyboard location. True 
keyboarding skills are usually introduced around third grade. 

£-Books (Electronic StoriJhooks) 
Electronic books turn reading into an interactive adventure. The best 
e-books are based on titles that were already successful before becoming 
electronic versions. I highly recommend every title on this list. 

living Books (BniJderbund, early elementary). I highly recommend every 
title in this series. Br0derbund starts with quality children's trade books and 
then enhances them with interactive hilarity. You can not only enjoy the 
benefits of having narrators read the books but also appreciate each 
illustration's variety of characters and items that can be clicked to "per­
form." Each story is also read in another language. In that aspect, I can see 
these stories being used to enhance many of the foreign-language classes 
that are now being taught at the elementary level. 

Just Grandma and Me 
Little Monster at School 
Sheila Rae the Brave 
Arthur's Birthday 
The New Kid on the Block 
Green Eggs and Ham 
Arthur's Reading Race 

Dr. Seuss's ABC 
Berenstein Bears Get in a Fight 
Arthur's Teacher Trouble 
Harry and the Haunted House 
The Tortoise and the Hare 
Stella/una 



Math 

Chicka Chicka Boom Boom (Simon & Schuster Interactive, early elemen­
tary). I love the book, and the CD just takes the great text one step further. 
This CD has a great interactive version of the book, along with tons of neat 
games and sing-alongs. 

Scholastic's Smart Books Series (Scholastic, upper elementary-middle 
school). Finally- some great electronic books for older readers. Scholastic 
has done a super job, adding neat information to enhance already great 
titles. Many of these titles are probably already part of a reading list in your 
existing social studies curriculum. 

Exploring the Titanic 
Favorite Greek Myths 
Malcom X 
If Your Name Was Changed at Ellis Island 

I hated math as a student, and as an adult I'm still a little nervous when it 
comes to anything that has to do with geometry or algebra. I just can't 
remember all those formulas. Maybe if I'd had a few of these titles to play 
with, I'd be a little better off today! 

Number Maze (Great Wave, elementary-middle school). As students solve 
math problems, they work their way through the maze. This program is very 
easy to customize for the difficulty level needed for your students - it 
ranges from picture addition to difficult division and word problems. 

Schoolhouse Rock: Math Rock (Creative Wonders, elementary). If like me, 
you grew up singing all those cool Schoolhouse Rock songs, you're going to 
love this program. In addition to the 11 original animated videos that are 
sure to help children remember their math facts, there are fun and challeng­
ing learning activities. 

Tabletop and Tabletop Jr. (Bn2Jderbund, elementary-high school). Tabletop 
and Tabletop Jr. are two programs designed to teach beginning and ad­
vanced data and information skills. By working with attributes, place value, 
and plotting, students learn mathematical theory. 

Math Keys ( MECC, early elementary-middle school). This program was 
created by MECC with the help of Houghton Mifflin and brings the world of 
manipulatives to the computer screen. We have this program on every 
computer in my school. I love the fact that students are expected to write 
down what they did when working a problem. The probability exercises 
are also very stimulating- kids work well in small groups and don't want 
to stop! 



Counting on Frank (Creative Wonders, upper elementary-middle school). 
This software practices what all those math folks have been preaching: real­
life problem-solving and hands-on learning. Frank is presented with a variety 
of problems throughout the day and needs your help to solve them. The 
online help feature is great for the more visual learner. 

Math Heads (Theatrix, upper elementary-middle school). Wow! This non­
intimidating look at pre-algebra doesn't make the puberty-set run for cover. 
Instead, the artsy graphics, great characters, and innovative approaches put 
a fresh slant on a usually boring subject. The focus on mental calculation 
skills, logical reasoning, and data interpretations will also be appreciated 
by teachers. 

Math Workshop ( Bn2Jderbund, elementary). You get a lot of bang for your 
buck with this title. Seven rooms are in the math lab of sorts, and each room 
is filled with activities that make learning the basics a little less painful. I 
love the spatial orientation, estimation, and problem-solving aspects of this 
program - all of which are rare in most math software. The wide variety of 
difficulty levels and the capability to store information on up to 40 students 
are also big pluses. 

Bit Bot's Math Voyage (Sanctuary Woods, early elementary). Cool graphics 
and a great sound track add to the learning experience that takes place in 
Bit Bot's submarine. Playing the nine games teaches students 15 math 
concepts. You can choose from four levels of difficulty (a nice plus in the 
classroom setting). The prize for a correct answer is an exotic fish for your 
own personal aquarium. 

Snootz Math Trek (Theatrix Interactive, early elementary). Flarn and Foozle 
(two Snootz) take you through five different activities that teach map 
reading, sequencing, cause and effect, codes, symbols, and geometric 
shapes. Your students will think that they are playing, but they're really 
taking in some important math concepts. 

Number Munchers ( MECC, all grades). The granddaddy of all skill-and-drill 
programs. And it's still fun! Number Munchers is just like PacMan - only the 
little guy eats up numbers, factors, or multiples of numbers instead of 
little dots. 

The Cruncher (Davidson & Associates, Inc., upper elementary-middle 
school). This is a really great spreadsheet program for the junior set. Using 
this program makes it easy to enter data and create easy-to-read charts and 
graphs without having to understand a ton of formulas and functions. 

Geomebic Golfer ( MECC, middle school-high school). Through flipping, 
rotating, or reflecting polygons, students try to get the shapes in the hole 
with the least number of strokes. 



MicroWorlds Math Links (LCSI, middle school). This program provides open­
ended practice with math concepts that are important, yet tend to get slighted 
in most traditional math books. No drill and practice here- instead, 
students spend time developing a deeper understanding of math concepts. 

Alge-Biaster 3 (Davidson &Associates, Inc., middle school-high school). 
This program covers a full year of algebra instruction in a fun, non-threaten­
ing way. Where was this program when I was in high school? 

Math for the Real World (Davidson & Associates, Inc., upper elementary­
middle school). Students apply math skills to real-life situations. There are 
over 4,000 word problems, super graphics, and music that help answer the 
consummate student question, "When will I ever use this in the 'real world'?" 

Social Studies/Histor1JlGeoiJ.raph1J 
These areas of study used to rely on old black-and-white photos and out-of­
date maps and globes as supplementary materials. Now teachers have 
exciting products, some of them almost custom-made for specific subject 
areas, to enhance the learning process. 

Travelrama USA Deluxe (Sanctuary Woods, upper elementary-middle 
school). Using a road map as their guide, students embark on a cross­
country trip to learn about the geography of the United States. This CD may 
be played individually or in groups of up to four students. 

TlmeUner (Tom Snyder Productions, all grades). Many schools say they 
couldn't do without this software. You can create timelines of various sizes 
and include small illustrations to accompany labels that you attach to 
identify time periods. 

Vital Unks (Davidson & Associates, Inc., upper elementary-middle school). 
We bought this program (all six modules) to replace our social studies text 
books in fourth and fifth grade. Yep, this incredible package does a much 
better job covering the time periods: Up to 1775, 1776-1840s, 1830s-1880s, 
1870s-1920s, 1920s-1950s, and 1960s-present. Each of the time periods is 
packaged as a unit complete with laser disc, VHS tape, CD-ROM, teacher's 
guide, and cassette of music from the time period. The information is very 
comprehensive. 

GeoSafari Multimedia (Educational Insights Interactive, upper elementary­
middle school). When I taught third grade, I had a freestanding GeoSafari 
game in my classroom and I couldn't keep students away from it! This new 
CD is just as engaging, with 45 different multiple-choice games containing 
over 3,000 facts. Students can play alone or in groups of up to four players. 
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World Discovery Deluxe (Great Wave, upper elementary-high school). This 
is a fun, interactive global history and geography game. Twelve interactive 
and challenging games test students' knowledge in the areas of politics, 
places, people, and events. Students can also create their own games, add 
questions, and create tournaments for multiple players. 

His Name Was lincoln (Sunburst, middle school-high school). This two-CO 
set is based on the book of the same name by Pulitzer Prize-winning author 
James M. McPherson. This in-depth look at Lincoln's life is incredible! The 
narration is done by Michael Moriarty, and Chris Sarandon is featured as the 
voice of Lincoln. 

Museum Madness ( MECC, upper elementary-middle school). A science and 
history museum is closed for repairs, and all the displays are mixed up. It's 
your students' job to make things right again. Using their knowledge of 
history, students must restore the exhibits to their original display. 

My FirSt Amazing World Explorer ( DK Multimedia, elementary). A multi­
level first exposure to maps takes children on trips to exotic as well as 
familiar places. Along the way, they earn stamps in their passports, send 
postcards, and collect snapshots to add to their sticker books. There's also 
a treasure hunt, a matching game, and a stamp-creating activity. This 
program keeps track of student play, and a certificate is awarded when a 
student's passport is filled. 

Science 
This area of software development has grown in leaps and bounds over the 
past year. You'll notice titles with lots of vivid photographs and video 
footage that actually put a student into a situation, instead of simply pre­
senting standard text to read. Today's students are able to get very clear­
cut, easy-to-grasp answers to their scientific queries. 

One Small Square: Backyard (Virgin Sound and Vision, early elementary­
middle school). A too cool way to look at earth science. This CD is based on 
the critically acclaimed Scientific American book series by the same name. It 
reminds me a little of some of the cool backyard scenes from Honey, I Shrunk 
the Kids. Students are given up-close 3-D views of one small square of a 
backyard. There's a backyard laboratory with 12 experiments, great cut­
away views, and a personal field journal. You must see this one! 

Buptz Science Carnival (Theatrix, early elementary-upper elementary). 
This CD teaches kids to think like scientists. You know, the whole hypothesis 
and conclusion route. Magnetism, Water, and Light are just a few of the 
topics covered. The freedom of choice, high manipulation factor, puzzles 
(over 200), and carnival atmosphere make this title a winner. 



CyberCrafts: Hand.On-Learning Fun With Electronics (Phillips Media 
Home and Family Entertainment, upper elementary-high school). This CD 
and hands-on activity kit teach the basics of electricity and how it's used in 
radios, metal detectors, red lights, sirens, burglar alarms, intercoms, and 
more. After they achieve a sound knowledge base, participants are then sent 
to build these items on their own with the components provided. The 
projects have three levels for the 25 projects: No Sweat, Mind Bender, and 
Brain Fryers. 

What's the Secret? (Volumes 1 and 2) (3M Learning Software, upper elemen­
tary-middle school). Are you tired of answering all those "why?" and "what 
if?" questions? These titles start out by posing a question and then leading 
students through scientific evidence and examples to answer the question. I 
love the "Science Try Its"- ideas for experiments you can do away from the 
computer. 

How Your Body Works (Minds cape, upper elementary-middle school). This 
CD amazes everyone who sees it. The user-friendly aspect is apparent from 
the start, and the CO's appeal just grows from there. I love the video seg­
ments that are a part of the Body Tours, and the Disorders file was eye­
opening as well. 

Microsoft Dinosaurs (Microsoft, upper elementary-high school). This 
dinosaur exploration is incredibly easy to use and full of fun facts. The 
ability to cut and paste the images has allowed me to create some pretty 
amazing presentations. The personal dinosaur dig is a favorite with kids. 
(My husband liked the PBS Quick Time movie.) 

RedShift2 (Maris, middle school-high school). Imagine having your own 
planetarium right in your classroom. What's really neat is this CO's capabil­
ity to show you the stars and planets that are visible from your particular 
location. You can even print out star charts for students to use when 
observing on their own. Another neat feature is the capability to zoom in up 
to a factor of 9,999 to get detailed views of the plants and other elements of 
the solar system. 

Science Sleuths- Volumes 1 and 2 ( VideoDiscovery, middle school). 
These programs allow students to use a virtual lab to unravel tons (over 600 
per title) of scientific mysteries. The mysteries have six different levels of 
difficulty, a nice adaptation for classrooms with students on different levels 
of understanding. I love the notebook feature where students are required to 
keep records of their findings. The labs also contain maps, databases of 
scientific information, charts, and videos. 

A.D.A.M. The Inside Story (A.D.A.M. Software, upper elementary-high 
school). This one is just like those overlays that appeared in our biology 
books back in high school ... only 100 times more interesting. You peel back 
layer after layer of Adam in this interactive anatomy lesson. 
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The Ultimate Einstein (Simon & Schuster Interactive, middle school-high 
school). An interactive look at the work and life of this incredible scientist. 
Simulated experiments, video clips, and audio clips make this CD an infor­
mative resource. I especially like the virtual encounter where Einstein 
responds to your scientific queries. 

Operation Frog (Scholastic, middle school-high school). Simulated frog 
dissection ... need I say more? Okay, maybe a little more. Students must 
select the proper instruments and then probe and examine just as they 
would in a normal hands-on dissection. 

A Field Trip to the Sky (Sunburst, upper elementary-middle school). This is 
a very complete study of the solar system and all its elements. There's a great 
lab where you can explore the sun and its effect on the world, photo albums 
of still shots, movies, and sounds; and a Field Guide full of information. 

The Nine-Month Miracle (AD.AM. Software, middle school-high school). If 
you are responsible for teaching those awkward "birds and the bees" classes, 
you may want to give this CD a try. The CD takes you on a journey from 
conception through delivery in a tasteful manner. You see actual in-body 
photography and video footage of different stages of a baby's development. 

Critical Mass: America's Race to Build the Atomic Bomb: (Orbis Software, 
middle school-high school). This documentary is anything but boring! 
Newsreel-type clips provide the historical content, and a virtual office 
exposes you to the decision-making process and the people involved. 
Clicking on a person in the office links you to detailed biographies of the 
person, or you can view a slide show that gives current information on the 
atomic bomb. Best of all, you can take virtual tours of some of the key sites, 
such as Los Alamos. 

Reference 
Our kids probably will never have to lug piles of encyclopedias and other 
reference materials through a library or spend tons of time at the copy 
machine making copies of information- remember, encyclopedias can't be 
checked out overnight! 

American Heritage Children's Dictionary (Houghton Mifflin Interactive, 
early elementary-upper elementary). This electronic version of the picture 
dictionary has 13,000 words. It's easy to click and find out more about each 
word: syllables, parts of speech, and word forms. In addition, it has great 
sound effects, animation, and over 2, 700 illustrations. 



3D Atlas (Creative Wonders, upper elementary-high school). This one is a 
must-buy (as the demo on the CD should convince you)! It takes the stan­
dard atlas to the mat. This program lets you rotate a 3D version of the globe; 
zoom in on areas you wish to explore; and access political, geographical, 
and environmental data. Add to that satellite images and QuickTime movies 
that take you to the action - and you get the idea of how incredible this CD 
really is. The 3D Atlas 97 demo is on the Macs For Teachers CD. 

Flrst Connections: The Golden Book Encyclopedia (Hartley, early elemen­
tary). A totally interactive learning experience (with more than 1,500 articles 
and 2, 700 graphics) makes this encyclopedia a top-seller for the younger set. 
My favorite aspect is the constantly available notebook that enables stu­
dents to jot down information and then print it or copy it into another 
application at a later time. A great bookmark feature allows students to mark 
an article before moving on to another area. 

Time Magazine Reference Collection (Softkey, upper elementary-college). I 
was surprised at the amount of information this one CD held! Time Almanac 
features information from weekly Time issues for the years 1989-1994 and 
then condenses information decade by decade for the years 1920-1988. The 
Top Stories section of each decade's screen quickly shows the students 
what written information, QuickTime movies, or photos are available for 
that time period. 

PC Globe Maps 'N' Facts (Br0derbund, upper elementary-high school). 
This program is very straightforward and easy to use. The maps are clear 
and concise. Students can get detailed information quickly and can custom­
ize a map to meet their needs. 

Cartopedia ( DK Multimedia, early elementary-middle school). I love this 
program! It contains over 600 maps covering over 25,000 place names, 
physical properties, and political information. The navigation panel has 18 
easy-to-understand symbols. Click on the symbols to find out climate, GNP 
statistics, crime rates, historical data, and much more. 

Grolier's Multimedia Encyclopedia (Grolier, all ages). This CD has all the 
bells (and whistles, too). Its main attraction for me is its cross-referencing 
capabilities and the Knowledge-Tree feature (information webs) that allows 
children to take a subject from the general to the specific in no time. 

Encarta (Microsoft, all ages). This one is my favorite for many reasons: It's 
visually appealing, it's easy to use, and it incorporates text with graphics, 
sound, animation, and maps. I love the timeline feature (which alone is a 
wonderful teaching tool). 



Microsoft BooksheU (Microsoft, upper elementary-college). I'm amazed by 
this CD! It contains The American Heritage Dictionary, Rogel's Electronic 
Thesaurus, The Concise Columbia Encyclopedia, The Hammond Atlas, The 
World Almanac and Book of Facts, Bartlett's Familiar Quotations, and The 
Concise Columbia Dictionary of Quotations. Can you believe all that is on one 
CD? And not only that, but this CD is easy to use. I probably would have 
gotten straight Ns in high school if I'd had access to this marvel of marvels. 

Our Times: Multimedia Encyclopedia of the 20th Century (Vicarious, 
upper elementary-middle school). James Earl Jones narrates this new 
reference source that covers history. The CD is very easy to maneuver 
through and features over 52,000 articles, great video footage, and historical 
photographs. It's a combination of the book Our Times and the Columbia 
Encyclopedia (5th Edition). 

What is a Bellybutton? (Time/Life M Publishing, early elementary). This 
one is too cute! If you teach preschoolers or the early elementary grades, 
this CD would be a wonderful part of your health curriculum. It answers 
questions in "kids peak" with the help of a sweet little girl and her cuddly 
bear. Why doesn't it hurt when I get my hair cut?, Why do I squint when I go 
outside?, and "Where does the food go when I swallow? are just a few of the 
precious questions answered by this program. 

Foreign language software is fun ... tons of fun compared to my experiences 
learning a new language. French 101 gave me the shakes. The titles in this 
list are superb, and all come in a variety of languages. 

Who is Oscar Lake? (Language Publications Interactive) 
Transparent Language Series 4.0 (Transparent Language) 
Rosetta Stone PowerPac (Fairfield Language Technologies) 
Berlitz Uvel (Sierra Online) 

Simulation 
Simulation titles fool students into learning. Yep, they think it's all a game, 
but in reality, simulation titles are masters of integrating all types of subject 
matter into one really exciting game. 

SimTown (Maxis, upper elementary-middle school). Students build a city 
from the ground up and then are challenged to make the city thrive and 
prosper, based on the decisions they make. This version is much more "kid 
friendly" than SimCity 2000. 



SimCity 2000 (Maxis, middle school-high school). This program has the 
same premise as SimTown, but it's more intense. The player has more 
control over the environment, and the graphics are more realistic, less 
cartoonish. 

Be sure to check out all the other Sim titles by Maxis: SimAnt, SimEarth, 
SimFarm, SimTower, and SimLife. They're all super; it just wouldn't be fair to 
fill up my list with Sim titles. 

DlnoPark Tycoon ( MECC, elementary-middle school). This program 
incorporates math, economics, business, and science to help children set up 
and run a theme park. This program develops problem-solving skills by 
requiring students to experience profit and loss, buying and selling, estimat­
ing, predicting, and analyzing. 

Crosscountry USA ( Didatech, upper elementary-middle school). In this 
program, students take on the role of a truck driver assigned to deliver a load 
of merchandise across the country. By using maps and problem-solving skills 
(when to rest or eat), students try to move their cargo to its destination. 

The Oregon Trail ( MECC, upper elementary-middle school). I like the 
original version better than The Oregon Trail II. It's hard to believe, but this 
program has been around for over 15 years! This software simulates a 
westward trip across the United States in the 1800s. 

Nile: Passage to Egypt (The Discovery Channel, upper elementary-high 
school). Students navigate their own boats down the Nile. The bow of the 
boat is equipped with a media player that gives more information on sites 
along the way. There are also artifacts, games, movies, and tours. Over 300 
topics are covered during the journey ... quite an informative trip. 

MayaQuest ( MECC, upper elementary-high school). Check out the demo on 
the CD. Probably the hottest new software title in the world. Students are 
involved in an interactive bicycle journey through the Mayan ruins. Along 
the way, they investigate archeological sites, explore their surroundings, 
and keep journal entries. An Internet connection allows students to down­
load new information to change their adventures. The MayaQuest 96 
Internet Home Page (http: I /www. mecc. com/mayaques t. html) also allows 
kids around the world to follow and participate in the yearly two-month 
interactive expeditions led by bicyclist and explorer Dan Buettner. 

The Amazon Trail (MECC, middle school). Students learn navigation and 
map-reading skills (along with practicing decision-making) while traveling 
through South America. The goal is to find a cure that will save the Incas 
from a mysterious disease. 
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Eagle Eye Mysteries (Creative Wonders, elementary-middle school). A total 
of 50 mysteries that get harder and harder. Students keep track of clues, 
interview witnesses, and read maps to solve each case. 

Where in the World Is Carmen Sandiego? ( Bn2Jderbund, upper elementary­
middle school). By now, I'm sure you've all heard of this title or seen the TV 
show on PBS. It's been a top-seller forever. The USA version is also just as 
wonderful. 

Nigel's Adventures in World Geography (Lawrence Productions, elemen­
tary-middle school). A Carmen competitor. It's actually a great choice for 
students who aren't old enough to enjoy Carmen. Travel with Nigel, a 
photographer who's searching for that perfect photo. On the way, students 
learn all about countries and continents. 

Freddl the Fish and the Case of the Missing Kelp Seeds (Humongous 
Entertainment, early elementary). This company has created a string of 
great simulation titles aimed at the younger set. You'll be amazed at how 
adept early elementary students are at problem-solving. Check out these 
other great simulation titles by Humongous: Putt Putt Saves the Zoo, Pajama 
Sam, Putt Putt Joins the Parade, and Fatty Bear's Birthday Surprise. 

Gregory and the Hot Air Balloon ( Br0derbund, early elementary). This is 
Myst (a totally interactive mystery) for the early set. No, it's not as mysteri­
ous, but it does teach young learners to problem solve on their own. The 
main character, Gregory, enlists your child's help to get back home. Along 
the way there are tons of great diversions to keep a child entertained. 

Earlu LearniniJ. 
I'm the mother of two preschoolers, so trust me when I say the titles on this 
list are great. I've played them all and probably heard each of their theme 
songs one time too many! 

A to Zap (Sunburst, preschool-early elementary). An alphabet-learning tool 
that features great voices from "real kids." Each letter in the alphabet has an 
activity highlighting a word that begins with that specific letter. 

How Things Work in Busytown (Computer Curriculum, preschool-early 
elementary). This CD highlights following directions, sorting, matching, and 
the roles of community helpers, with the assistance of Richard Scary's 
wonderful world. The seven activities each have two levels of play. My 
favorite activity is collecting the trash (a community helper) and then 
sorting the trash! The songs are pretty cute, too! 



How Many Bugs in a Box? (Simon & Schuster Interactive, preschool-early 
elementary). Uses cute little creepy-crawly bugs to teach sorting, counting, 
memory, matching, and eye-hand coordination skills. I like the fact that the 
activity levels can be individually set for each of the games on the CD. 

Hsher Price Sing Alongs: Barnyard Rhythm and Moos (Davidson & 
Associates, preschool). This CD is just plain fun! It's full of great songs and 
animated music videos. My favorite song is "I am a Horse." If you teach 
kindergarten or preschool, you need this CD for your music time. 

Alphabet Express (School Zone, preschool-early elementary). School Zone 
has done a great job with this CD. It incorporates letter recognition, begin­
ning phonics, and handwriting skills into one great package. It even allows 
you to print handwriting practice sheets for your students! 

The Playroom, The Treehouse and The Backyard (Bn;:tderbund, preschool­
early elementary). These programs are old favorites for the preschool set. 
My daughter's preschool has each of these titles on every computer it owns. 
The activities keep little ones fascinated for hours. 

JumpStart Kindergarten, JumpStart Preschool, and JumpStart Toddlers 
(Knowledge Adventure, preschool-early elementary). The entire JumpStart 
series delivers a lot of bang for the buck. The titles are full of neat activities, 
all accessible from a classroom setting that's full of neat "clickables" that 
initiate animation and activities that teach essential early learning skills. 

My Flrst Incredible Amazing Dictionary ( DK Multimedia, preschool-early 
elementary). Over 3,000 sound effects are in this baby, so you know that 
kids are gonna love it! This CD introduces kids to 1,000 words and their 
meanings through a very-easy-to-manipulate interface. 

Nick Jr. Math Play (Viacom New Media, preschool-early elementary). This 
program features the Nick Jr. (daytime programming on Nickelodeon) 
characters and contains over 25 activities designed to build early math 
skills. I love the parent/teacher features that give details of student 
progress, as well as activity ideas to increase your child's math skills. 

Millie's Math House ( Edmark, early elementary). Millie the cow is the 
delightful guide through six games that teach early math skills. My daughter 
loves this one! 

Bailey's Book House (Edmark, early elementary). Everyone with a young 
learner needs this program. The five activities make early reading a fun 
activity, not a chore. I would highly recommend any of the Edmark titles. 



KidsTime Deluxe (Great Wave Software, preschool-early elementary). This 
is a solid title that should be a part of every preschooler's collection. Five 
activities allow children to explore early learning concepts in a user-friendly 
environment. My son loves the sorting activities and the dot-to-dots. Try the 
demo on the CD. 

Countdown (Voyager, preschool-early elementary). Cool games and 
realistic graphics make this simplistic, yet engaging, program great for very 
early learners. I love the fact that this program is multilingual: Students can 
learn to count in French, German, English, Italian, and Spanish. 

Multimeelia Composition/AuthorintJ 
This is probably my forte. I spend most of my time at my school working 
with small groups developing multimedia reports and projects. Using these 
products is a great way to reinforce subject matter and expose students to 
multimedia production at the same time. 

HyperStudio (Roger Wagner Publishing, upper elementary-adult) This 
probably ranks in the top three on my list of favorite software programs 
(and I've included a demo on the CD). HyperStudio is the ultimate multime­
dia program! You don't have to learn a difficult scripting language in order to 
create interactive multimedia presentations. The latest version even in­
cludes Internet capabilities. Buy this program! 

Kid Pix Studio (Bnifderbund, all ages). I won't bore you with expanded 
coverage. Check out the demo on the CD and read Chapter 10 for the 
specifics on this superstar! 

Hollywood (Theatrix, upper elementary-middle school). This cool little 
program allows students to create their own animated short films. Not only 
do students choose their characters and backgrounds, but they're also 
given the artistic freedom to choose character moods, voices, and hobbies. 
Writing the script is the educational part, but the real fun begins when the 
characters act out the script the student has written. 

Imagination Express (EdMark, early elementary-upper elementary). 
Imagination Express is a series of titles based around the following themes: 
Castle, Neighborhood, Rain Forest, Ocean, Pyramids, and Time Trip USA. 
Each title allows the student to create an interactive story. The background 
choices are great, and the stickers (characters, props, and so on) can be 
animated or have sound added to them. My favorite in the series is Time 
Trip USA. 

The Multimedia Workshop (Davidson & Associates, Inc., middle school­
high school) This is a really all-inclusive program. You get a writing work­
shop with an easy-to-use word processor, a video workshop, a paint/draw 



workshop, and a library full of photos, clip art, sound clips, and QuickTime 
movies. By combining all these areas, students can produce some very 
impressive reports or presentations. 

Opening Night (MECC, upper-elementary-middle school). Students select 
the actors; write the scripts; choose the settings, costumes, and lighting; 
and ultimately direct their own lifelike, on-screen plays. A very cool product. 

Critical ThinkinfJ. 
When you watch children using the software in this list, you may think that 
they are just playing. However, the type of playing that takes place involves 
critical thinking- an important learning skill. 

Playskool Puzzles (Playskool Children's Educational Software, preschool­
early elementary). Five activities that will keep your youngster involved and 
thinking! You'll have to pull your child away from this one! 

Logical Journey of the Zoomblnis (Bnaderbund, upper elementary-middle 
school). Help the Zoombinis escape to a new land by solving 12 puzzles that 
become more challenging as the adventure progresses. I know a few adults 
who can't stop playing this game! 

Thinkln' Things Collections 1, 2, and 3 (Edmark, early elementary-middle 
school). All three of the Thinkin' Things collections are wonderful! Logical 
thinking, memory skills, and problem-solving are highlighted in each of 
these programs. Collection 1 is probably better suited for elementary 
students. Collections 2 and 3 are best for upper elementary and middle 
school students. 

The Lost Mind of Dr. Brain and The Time Warp of Dr. Brain (Sierra Online, 
upper elementary-adult). In order to restore Dr. Brain's mind, one must 
solve ten different puzzles. This CD keeps your students on their toes! The 
ability-level setting feature makes this title great for a wide range of ages -
my husband loves it! 

Incredible Machine (Sierra Online, elementary-adult). This software has 
earned all kinds of awards! It's great because it's open-ended ... the possi­
bilities are endless. You get 150 puzzles to solve (by creating your own 
machine), or you create your own puzzle with the vast array of unusual 
parts. 

TesseiMania! Deluxe ( MECC, middle school-high school). Inspired by the 
works of M.C. Escher, students create tessellations, which look like cool 
interlocking shapes but are actually the basis of some pretty sophisticated 
mathematical concepts. The outcome is a really cool visual. 
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Strategy Games of the World Vols I and II (Ed mark, upper elementary­
middle school). My own kids aren't old enough to play these CDs, but my 
husband and I love them! Each CD contains three classic strategy games 
which students can adapt to three different levels of difficulty. Be careful -
the games are addictive. 

Trivia Munchers Deluxe ( MECC, upper elementary-middle). A fast-paced 
arcade-style game that questions students in seven categories: animals, 
sports, astronomy, health and diet, music, famous people, and geography. 

Fine Arts 
This area of computer software was left out in the cold for a while. Now, 
quite a few really good titles that address a variety of age levels are on the 
market. 

With Open Eyes (Voyager, preschool-middle school). Photographs of over 
200 pieces of art from the Art Institute of Chicago are featured on this CD. 
Each work of art has activities and games that relate to the work and help 
students better understand the artist's intentions. 

Art Gallery (Microsoft, upper elementary-college). This CD takes you 
through the National Gallery in London and enables you to view over 2,000 
masterpieces. Along the way, you also pick up some interesting facts about 
the artists and the time periods in which they lived. 

A Passion for Art (Orbis Software, middle-high school). True art lovers will 
love this virtual museum visit. Walking through the art gallery room by room 
with the capability to zoom in (close enough to see brushstrokes) on any of 
the over 300 paintings is a thrill. There's also a cool slide show feature and 
the capability to sort the works by artist or title. 

Masterpiece Mansion (Philips, upper elementary-middle school). You're 
trapped in an art museum, and the only way you can get out is to solve a 
series of puzzles and games on artists, time periods, and culture. Great 
artwork (150 pieces) and interesting artist biographies make this CD a great 
resource. 

JuiHard Music Adventure (Theatrix, preschool-early elementary). This CD 
was created with the help of the highly acclaimed Julliard School. The action 
takes place in a castle where students are introduced to rhythm, instru­
ments, melody, musical styles, and orchestration. 

Making Music (Forest Technologies/Voyager, elementary). This CD is 
described as Kid Pix for the ears. It allows students to see and hear the 
music they create. It's an intuitive and fun program that turns even the 
youngest student into a composer. 



Leonardo (Softkey, upper elementary-high school). It's like sneaking into 
Leonardo's studio and flipping through his notebooks, peeking at his 
sketches, and drinking in his original artwork. This CD allows you to take a 
look at his inventions and learn about his life. There's also a database of 
articles and artwork. 

CreatiflitiJ 
The cool thing about creativity titles is the fact that they can be used to 
teach just about any curriculum area- draw a cutaway of the earth's 
layers, illustrate this math problem, write a rebus story .... 

Kid Pix Studio (Br0derbund, preschool-upper elementary). See Chapter 10 
for the details on this incredible product. Don't forget about the demo on 
the CD. 

flying Colors (Davidson & Associates, Inc., upper elementary-adult). Flying 
Colors doesn't get the glory it's due. I describe this program as Kid Pix on 
steroids. The color choices are unbelievable, the background choices are 
more than interesting, and the stamps number close to 1,000. 

The Print Shop Deluxe (Br0derbund, upper elementary-adult). A demo of 
this great program is on the CD. I started using The Print Shop back in the 
days of the Apple lie. I was a pro at creating banners for every birthday and 
baby shower in the school. This newest version is full of neat clip art and 
great text manipulation features, and all these bonuses can be used in your 
cards, signs, calendars, business cards, letterhead, and (of course) banners. 

Adobe PhotoDeluxe (Adobe, upper elementary-adult). The easiest way to 
customize your photos. Get rid of red-eye, combine photos, or add tons of 
different special effects. There are also some cool templates that make it 
simple for students to create classroom calendars, greeting cards, newslet­
ters, flyers, and much more. 

Orly's Draw-A-Story (Br0derbund, elementary). Let a sweet little character 
named Orly tell your students a story. As she tells the story, Orly invites her 
audience to draw characters, props, and backgrounds to accompany the 
story. After they create all of the additional "props," the entire story can be 
viewed in the "junkyard" theater. The manual is filled with tons of extension 
activities. 

Adobe Primere (Adobe, middle school-high school). This is an award­
winning digital movie-making and production tool. I could easily spend a 
whole semester working with students on creating digital movies that 
enhance curriculum experiences. Create QuickTime movies that contain 
titles, credits, transitions, special effects, sound tracks, and much more. 
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KeiJ.hoardinfJ 
I start keyboarding instruction in third grade. When it comes to keyboard­
ing, I believe in the "no-frills" approach. If a program is too cute, the kids 
tend to be more enchanted with what's happening on the screen and don't 
concentrate on proper finger placement or accuracy. The programs listed 
here are my favorites: 

UltraKey (Bytes of Learning) 
Mavis Beacon Teaches Typing ( Mindscape) 
Typing Tutor 7 (Simon & Schuster Interactive) 

Test ReflieuJ 
I can personally attest to the benefits of test review programs. The immedi­
ate feedback and the test-taking hints are invaluable. When I decided to go 
for my doctorate, I used Your Personal Trainer for the GRE in hopes of 
achieving stellar test scores - and it worked. I went into the testing situa­
tion confident, familiar with the testing procedure, and armed with tips to 
help me perform my best. 

All three of the programs listed here could do the same for your students 
who are about to take the SAT or PSAT. 

Your Personal Trainer for the SAT (Davidson & Associates, Inc.) 
Inside the SAT (Princeton Review) 
Score Builder for the SAT (The Learning Company) 

Internet 
WebWbacker (Forefront, upper elementary-adult). This program enables 
you to save Internet sites and browse them offline. That's right, you choose 
and save only the sites you want your students to have access to. No more 
wasted online time. It's a natural for education because it cuts down on the 
time involved in web searching and those awful disconnections. It's so 
realistic that kids actually think they're connected to the Internet. 

Claris Home Page (Ciaris, upper elementary-adult). This is by far the 
easiest way to create your own Web page. If you're not up to learning 
complicated HTML code, this is the software for you! 



Teacher ProductiflitiJ. 
Every month I hear about new teacher titles that are on the market. This list 
highlights a few of my favorites. Be sure to check out the demos and "free 
stuff" many of these companies have provided on the CD that's in the back 
of this book. 

EasyGrade Pro (Orbis Software). This is my favorite gradebook program. It 
is the most user-friendly of all the programs out there, and Orbis offers a 
really reasonable site-license rate that allows teachers to make copies of the 
program for home use. A demo is on the CD. 

Lesson Plan Designer Plus (SuperSchool Software). If you're tired of writing 
lesson plans over and over again, this program is for you. Lesson Plan 
Designer Plus enables you to enter goals and objectives. (Lesson Plan 
Designer Plus even provides you with a comprehensive list of objectives.) It 
gives you an Internet scrapbook where you can enter your favorite Web 
pages and notes, a scanning organizer, and an area to keep running records 
on your math or reading groups. 

Test Designer Supreme (SuperSchool Software). Allows teachers to create 
essay, multiple-choice, and true-or-false test questions. Strengths of this 
program are the layout choices, the ease of use, the database for storing 
questions, the option to take the test on the computer, and the program's 
support of five languages. 

MakeTest (Mountain Lake Software). Store frequently used questions and 
answers, assign difficulty levels and topics to your questions, and print tests 
and answer keys. You can even import graphics and equations to enhance 
your tests. Examine the demo on the CD! 

IEP Writer Supreme (SuperSchool Software). Special education teachers 
have been waiting for a program like this one! Yes, a software program that 
makes writing those IEPs a breeze. Tons of stored goals and objectives are 
ready to be slipped into your plan. You can even contact SuperSchool and 
have them create electronic versions of the forms your school system 
requires you to use! 

Teacher's Tool Kit (Hi-Tech of Santa Cruz). Four programs that help you 
create customized word searches, word scrambles, fill-in-the-blank quizzes 
or study sheets, and multiple-choice tests. 

The Print Shop Deluxe CD Ensemble (Bnaderbund). I've already discussed 
this program in the Productivity section (and the demo is on the CD). As a 
teacher, I like this software for creating thank-you notes, certificates, busi­
ness cards, and stationery. It also creates some great banners for birthdays 
and other classroom celebrations. 



SchoolWorks Teacher (Micromedia Publishing). A great collection of 
ClarisWorks templates for the classroom teacher. Really cool! 

Norton Utilities (Symantec). This software helps to keep your hard drive 
trouble-free. It can help you recover something you threw away or fix a 
floppy disk that may be unreadable. Another plus is its capability to maxi­
mize your hard drive by defragmenting spaces left when you continually 
take software on and off the hard drive. 

FoolProof (SmartStuff Software). This desktop security system lets your 
class use the computer and see the desktop while enabling you to lock 
certain files (like your grade book or the midterm exam) and prevent the 
trash can from being used. Many schools are now switching to this program 
instead of using At Ease. Examine the demo on the CD. 

CllckArt Images (T/Maker). These clip-art images are funny, inexpensive, 
and easy to access. Need I say more? 

School Font Collection (Mountain Lake Software). This font collection has 
all the basics, even a great D'Nealian-style font. It even has a font that prints 
those neat arrows alongside the letters that show beginning writers how to 
make their letters correctly. 

Spelling ToolKit Plus (MECC). This program builds your spelling lists and 
then creates puzzles and tests using your word list. Spelling ToolKit Plus 
comes with a huge supply of words (including all the words from four of the 
major spelling textbook publishers), or you can customize the already 
existing list. After you've created your list, you can use the words to create 
standardized tests, coded word puzzles, configured word puzzles, embed­
ded word puzzles, word scrambles, word searches, study sheets, and 
crossword puzzles. 

Schoolhouse Fonts (Signature Software). Signature Software has created two 
sets of great looking font collections, including true cursive fonts that 
completely connect the letters. 

PenFont (Signature Software). This font is created after you send them a 
sample of your handwriting. Isn't that the coolest?! Yep, your own handwrit­
ing can be turned into a font that appears in your font menu! 

Crossword Creator (Centron). All you do is enter a list of words and let 
crossword creator do the work. You can enter the clues yourself or get help 
from the on-board thesaurus. I've created crossword puzzles to correlate 
with each of my social studies units, author studies, and science themes. 

Teacher's Fonts I and Teacher's Fonts II (Forest Technologies). Forest 
Technologies has come up with a great collection of school fonts. The 
collections contain handwriting fonts, historical fonts, holiday fonts, and 
seasonal fonts. 



S.T.A.R. (Advantage Learning Systems, Inc.). S.T.A.R. stands for Standardized 
Test for Assessment of Reading. It's a computerized version of the IRI's 
(Individual Reading Inventory), but it takes less than 15 minutes to adminis­
ter! The student scores correlate with standardized norm-referenced tests. 

Inspiration (Inspiration Software, upper-elementary-adult). Originally 
designed for use in the wonderful world of business, this concept mapping 
software has become even more popular in the world of education. After all, 
we teachers have also been known to do some pretty intensive planning ... 
like everyday! With simple mouse clicks, Inspiration makes it easy for 
teachers to create great story webs, lesson plans, concept maps, flow 
charts, outlines, semantic maps, and more. Students can use Inspiration to 
map out reports, presentations, multimedia projects, and study guides. 
Another bonus is the integrated outline view that allows students to see 
how the visual representations interpret themselves into an outline form. It's 
rare when a student actually understands and appreciates the power of a 
good outline, and this software helps to make the connection between the 
visual organization of ideas and the actual outline. 

I personally like Inspiration because it's easy to use and it allows me to 
quickly move my ideas to a visual format and then later move, add, or 
rearrange until I make things the way I want. I wish I'd had this software 
when I first had the idea for this book series. I had so many ideas for things I 
wanted to include and ended up with reams of unorganized handwritten 
notes. This software will take your brainstorming sessions to a new level! 

No, I didn't forget how to spell! 
After reading this list of software titles 
(CiarisWorks, PageMaker, ClickBook, 
EasyBook), you probably think that I've forgot­
ten how to spell, or that I'm fascinated with 
compound words. It's not me, it's those pro­
grammers and software executives. Today, 
having a space in your program's name just 

isn't cool, and it's very rarely done. Yes, it bugs 
me, just like those stores that use R instead of 
the word ARE and the beauty salons that spell 
"cuts" with a k. And then parents complain to 
us that we just don't put enough emphasis on 
spelling these daysl 
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Appendix C 

Troubleshooting by David Pogue 
eoeooooooooooeooooooooooooooooooooooeeoooooooooo 

f~s appendix was taken from Macs For Dummies, 4th and 5th Editions. 

It turns out that about 90 percent of the things that go wrong with your Mac 
can be solved using the same handful of troubleshooting steps. To save you 
reading and me writing, I consolidated them all at the end of this appendix 
under the heading "The Problem-Solving Cookbook." As you read through 
the symptom-by-symptom listings, I refer you to one or another of those 
steps. 

The Mac Freezes or Crashes 
There are two scary conditions that are enough to make even semipro Mac 
jockeys swallow hard. The first of these conditions, a system crash, occurs 
when the following message appears on the screen: 

Sorry, a system error occurred. 
"Finder" 

unimplemented trcp 

Your current work session is over, amigo; you have to restart the computer. 
(Safest way to restart is to press the Restart switch, as described in "The 
Restart switch" at the end of the chapter.) Anything that you've typed or 
drawn since the last time you saved your work is gone. 

A system freeze is different- and, as horrific computer nightmares go, it's 
preferable. You get no message on the screen; instead, the mouse cursor 
freezes in place. You can't move the cursor, and nothing that you type 
changes anything. The Mac, as far as you can tell, has silicon lockjaw. 



The most common cause of troubles 
that need sho:oting 

Get used to the computeristic-sounding word 
extension. 

An extension is a little file in your Extensions 
folder (which is inside your System Folder). 
Each extension adds a specific new feature to 
the Macintosh: a screensaver, fax capability, 
and so on. You know those little icons that 
march across your screen when you turn on 
the Macintosh? Those are your extensions. 

An extension runs all the time; it's like a pro­
gram that you can't quit. It gets launched when 
the Mac turns on, and it's running in the back.:. 
ground during your entire workday. 

But the people who wrote the After Dark 
screensaver program, for example, have never 

even met the programmers who wrote the 
FaxPius faxing extension, let alone figured out 
how to make their two little programs cpexist. 
Suppose you have both After Dark and 
FaxPius in your Extensions folder. Also sup­
pose that each little extension program, in the 
background,· simultaneously reaches for the 
same morsel of electronic memory. 

. "Sorry, a system error occurred." 

In other words, extension conflicts (the tech­
nical term) are among the more common 
causes of ptoblerns on the Mac. You can fin~ 
th~ solution in this chapter. 

Escaping a SIJ.Stem freeze right now 
First resort: Try the amazing "Force Quit" keystroke, 88+0ption+Esc (see 
"The amazing 'Force Quit' keystroke" at the end of this chapter). That 
should get you out of the locked program, at least. 

Last resort: If the Magical Force-Quit Keystroke doesn't work- and 
sometimes it doesn't- you have to restart the Mac. This time, see "The 
Restart switch" at the end of this chapter. 

Escaping repeated SIJ.Stem 
freezes and crashes 
Ninety percent of the time, freezes and crashes are related either to memory 
or to extension conflicts. 

First resort: Increase the amount of memory allotted to the program that 
you are using, as described in "Giving more memory to a program" at the 
end of this chapter. Give the program ISOK more, for example. 
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Second resort: Something, or several somethings, are clashing in your 
System Folder. (See "Solving an extension conflict" at the end of this chapter.) If 
you're in a hurry to get your work done and can't take the time, just restart 
your Mac while pressing the Shift key. That turns all extensions off. 

Third resort: Maybe one of your programs is either (a) buggy or (b) out of 
date. The first problem is likely if you're using Microsoft programs; the 
second problem is likely if you have recently upgraded something -your 
Mac or your System Folder version, for example. You can't do anything but 
contact the software company and hope for the best. 

Fourth resort: You may have a SCSI conflict on your hands, especially if 
more than one external gizmo is plugged into your Mac. (See "Solving SCSI 
nightmares" at the end of this chapter.) 

Fifth resort: If nothing so far has stopped the crashes, some weird memory­
related thing may be going on under the hood. Some programs are allergic to 
virtual memory, for example; so your second step should be to turn off 
Virtual Memory (open your Memory control panel and click the Off button). 
Or, if you have a Power Mac, try turning virtual memory on. And if you're 
advanced enough to know what 32-bit addressing is, go to the Memory 
control panel and turn it off, if your Mac lets you. A lot of older programs 
break out in puffy hives when that is on. (But a lot of newer programs shriek 
if it's off.) 

Last resort: If the crashes still haven't stopped, something in your System 
Folder may be gummed up. You're in for a 20-minute, but very effective, 
ritual known as a clean reinstall of your System Folder. (For instructions, see 
"CAUTION: Change the H and • symbols to you-know-what" at the end of 
this chapter.) 

Error Messages 
Let's start the troubleshooting session in earnest with a few good old 
American error messages. Yes, kids, these are the '90s equivalent of "DOES 
NOT COMPUTE." These are messages, appearing in an alert box, like the 
fictional one shown here, that indicate that something's wrong. 

A serious and mysterious problem has 
deueloped, deep Inside your computer where 
you'll neuer get et lt. 
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''Application not found'' 
First resort: Not everything in the Mac world is meant to be a plaything for 
you; the Mac reserves a few files for its own use. If a thing came with your 
Mac - the Scrapbook file, the Clipboard file, and so on -you at least get 
something when you double-click its icon. The Clipboard file opens into a 
window where you can see the most recent stuff that you copied; the Note 
Pad file automatically launches the Note Pad desk accessory; and extensions 
or control panels at least identify themselves (by means of a message on the 
screen, such as "System Extension: This file adds functionality to your 
Macintosh"). 

But if you double-click an icon that belongs to non-Apple software - any 
icon in the Preferences folder, for example, or various other support-file 
icons for non-Apple stuff- you just get a beep and an unhelpful error 
message. 

That's what's going on most of the time. 

Second resort: Every now and then, you 'II double-click a file that you 
created and still get the "Application not found" message. 

So if you double-click a ClarisWorks document, but the ClarisWorks program 
itself isn't on your hard disk, the Mac shrugs and asks, in effect, "Yo - how 
am I s'posed to open this?" To remedy the situation, reinstall the missing 
program on the hard disk. 

Third resort: Sometimes, you get the "Application not found" message even 
if you're sure that the document's parent program is on the disk. (You 
double-click a ClarisWorks document, for example, and you're told that the 
application- ClarisWorks- can't be found, even though it's sitting right 
there on the disk in plain sight!) 

In a situation like this, the Mac's genealogical gnomes have become con­
fused: The computer has lost track of which program is associated with 
which kinds of documents. Don't ask me how such confusions happen; just 
rejoice that the problem Is easy to fix. In the words of Mac gurus every­
where, "You gotta rebuild the Desktop." (For instructions, see "Rebuilding 
the Desktop file" at the end of this appendix.) 

Last resort: There's one more circumstance under which you'll get this 
message: if you try to open a generic text or graphics file that's not associ­
ated with any particular program. 

(Sigh!) Yes, I know, this contradicts everything you've learned about pro­
grams and documents being like parents and children. But suppose that 
someone who isn't sure which brand of word processor you own wants to 
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give you a memo that she wrote. The smart thing would be for her to give 
you the memo in text-only format: a generic, no-frills, raw-typing format. 
Text-only format is a text file or, as the weenies say, an ASCII (pronounced 
ASKie) text file. No matter which program was used to create this file, any 
word processor (even on non-Mac computers, for that matter) can open it. 

A text file, however, isn't double-dickable. (Actually, the Mac generally 
offers to open a text file with SimpleText, but just pretend that I have a point 
here.) To read the file, launch your word processor first and then choose the 
Open command from the File menu (as in the left-hand illustration). 
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The usual list box appears, and you see the text file listed there (now, take a 
look at the right-hand illustration). Double-dick to open it. 

The same applies to generic graphics documents. These files, in technical­
sounding formats like PICT, JPEG, and GIF, can be opened by almost any 
program (America Online, for example, can open all three). Yet if you try to 
double-click a generic graphics file, you are told, "Application not found." 
Once again, the solution is to launch your graphics program first (America 
Online or ClarisWorks, for example) and then open the file via the Open 
command. 

11Can't emptiJ trash" 
First resort: A locked file is probably in the Trash can. Press Option while 
choosing Empty Trash from the Special menu. 

Second resort: You may be trying to throw away a document that you're 
still working on. Or maybe the Mac just thinks that you're still working on it. 
Be sure that the file isn't open on the screen. Sometimes, you even have to 
quit the program you were using before that document is considered 
trashable. 

Third resort: Maybe the Mac has become confused about the trashability of 
some file in the Trash. Restart the Mac and try again. 



Last resort: About once in every Mac user's life, the Mac gets so confused 
that it simply will not empty the Trash, even if you tried all the logical 
things. 

In this case, it's your System Folder that's having the psychotic break. The 
trick is to start up from some other System Folder - the handiest of which 
comes on your all-important Disk Tools (or Utilities) disk. (Or, if your Mac 
came with a system-startup CD-ROM disc, use that.) This special startup 
disk comes with every Mac ever made, so you can't claim helplessness on 
this point. 

Turn off the computer. Put Disk Tools (or Utilities) into the disk drive. Then 
turn the Mac on. When the computer is running, you should at last be able 
to empty the Trash. 

'~n error occurred while UlritiniJ to the disk'' 
Something went wrong while you were trying to save a document - prob­
ably your disk was full, or it's a flaky floppy disk. (See "Floppy-Disk Flukes," 
later in this appendix, for more information on flaky floppies.) 

''Microsoft Word prefers 20!.,8Kof 
memorlJ. 2000K is aflailahle'' 
Once again, you're out of memory. The Mac will give you the chance to 
launch the program anyway - but it'll run slowly and may crash if you get 
too ambitious with your work. (See "Giving more memory to a program," at 
the end of the appendix, for a more lucid explanation.) 

Numbered error messa9es 
This may strike you as hard to believe, but the numbers in some error mes­
sages (Type 11, Type 3, Error 49, and so on) are no help at all. They're 
valuable only to programmers, and even then not very. For example, a Type 1 
error means "bus error," a Type 3 is "illegal instruction," and Type 20 is 
"stack ran into heap." Reali Ill Illy helpful. 

Of the 200 Mac error messages, only one lets you remedy the situation: -39, 
which means that something's wrong with the disk (or the file you're trying 
to work with is corrupted somehow). All the others are caused by the usual 
problems: Some program didn't have enough memory, or you had an 
extension conflict, or your System Folder needs re-installing. 
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Out of MemorlJ 
Your Mac has a fixed amount of memory. Think of the Mac as a station 
wagon. You can pack it with camping gear, or you can pack it with your kid's 
birthday-party friends, but probably not with both. Even if you manage to 
cram in the kids and the gear, if you then try to cram in the dog, somebody 
in the family is going to say, "There is not enough room to take Bowser." 

That's what the Mac is trying to tell you. 

Each program that you open consumes a chunk of the Mac's limited memory. 
You're entitled to run as many programs as you want simultaneously- the 
Note Pad, the Calculator, your word processor, and so on -provided that they 
all fit into the amount of memory your Mac has. If you try to open one too many 
programs, you'll get that message about the dog. (You know what I mean.) 

First resort: Quit programs 
If you're told that you're out of memory, the easiest way out of the situation 
is to quit one of the programs you're already running. (You quit a program 
by choosing Quit from the File menu.) So if you're running Word and you try 
to open ClarisWorks, and you're told that there's not enough unused (free) 
memory, you just have to quit Word first. 

Often, you may have programs running and not even know it. Remember 
that just because a program has no windows open doesn't mean it isn't 
running. When you're done working on something, did you just close the 
window, or did you actually choose Quit from the File menu? If you didn't 
actually Quit, then the program is still running, and still using up memory. 

To get rid of that program, choose its name from the Application menu (in 
the upper-right corner of the screen - to the right of the question-mark 
menu). Then choose Quit from the File menu. 

Second resort: Make the Mac gitle back 
Quitting programs, of course, isn't a very convenient solution- especially if 
having multiple programs open is part of what you're trying to do, such as 
copying numbers from the Calculator to Word. Therefore, your next attempt 
to solve the problem should be to make the Mac itself use less memory. 

Yes, indeed, the Mac's own behind-the-scenes operations use memory like a 
silicon hog- at minimum, System 7.5 grabs 2.5MB of your memory. If your 
Mac has only 4MB to begin with, you can see why running out of memory 
can happen easily. 
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Here are some tricks to make the Mac use less memory: 

Y' Use fewer extensions. The little auto-loading programs whose icons 
appear across the bottom of the screen when you start the Mac. Each 
extension that didn't come with your Mac (screensaver, fax software, 
virus checkers, and so on) eats up another nibble of your memory. 

A few particularly memory-hungry extensions: QuickTime (200K); After 
Dark (300K); Adobe Type Manager/ATM (SOOK or more); QuickDraw GX 
(ISOOK or more). 

And how do you turn off extensions? (See "Solving an extension con­
flict" at the end of the appendix.) 

Y' Check your Disk Cache. This little gimmick is something that you can 
blissfully ignore for most of your computing days ... until you start 
running out of memory. 

Suppose that you're innocently word processing, and you make some 
text boldface. Because the word-processing program resides on your 
hard disk, the Mac consults the disk to find out how it's supposed to 
create bold type. This disk-reading business takes, say, one second. If 
you use boldface a lot, those one-second disk searches are going to 
cumulatively slow both you and your Mac. 

Therefore, the Mac reserves a piece of memory, called the Disk Cache, 
just for such frequent pieces of information. Now when you make text 
boldface, the Mac consults the disk (taking one second), but it stores 
the "how-to-make-bold" information in the Disk Cache. The second time 
that you need to create bold text, the Mac already knows how to do it; 
your text becomes bold in 1/wo second (because memory delivers 
information to the Mac's brain 100 times faster than the disk does). 
Cumulatively, all the little tidbits of information that the Mac stores in 
the Disk Cache give you quite a speed boost. 

The larger this piece of memory is, the faster your Mac will go. But there's 
the rub: If you make this Disk Cache memory too big, you use memory that 
you could be using to run programs. 

Even if I've totally lost you, here's what to do when you're strapped for 
memory. From the S menu, choose Control Panels, and double-click 
Memory. Clicking the arrow, as shown here, makes the Disk Cache smaller. 
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This has been a long explanation for a small reclamation of memory, I know, 
but it feels good to know what's going on behind the scenes, doesn't it? 

Third resort: DefratJ.ment IJOUr RAM 
Sometimes, the Mac will appall you. Here it is, the equivalent of a whole 
roomful of 1950s-style computers, yet it can't even add. 

Here's the scenario. Your Mac has 5MB of memory, let's say. You know your 
System uses 1.5MB. And you're running Excel, which, in this fantasy, takes 2MB. 

Then you try to launch ClarisWorks, which we'll suppose needs 1.5MB of 
memory. You get the out-of-memory message. How can this be? After all , the 
System (1.5) and Excel (2) together use only 3.5 of your 5MB. There ought to 
be 1.5MB left over, right? What's going on? 

Memory fragmentation is going on, if you must know. It works like this. At 
noon, you start the Mac. Your memory usage looks like this: 

Total Memory: 5 megs 

I I 
System (1 .5) free memory 

Then, at 12:05, you open the Calculator. For this example, let's say that its 
memory requirement is half a megabyte. 

When you then launch Excel, your Mac's memory map looks like this: 

(free) 

At 12:15, you close the Calculator. Your memory map looks like this: 

(free) 

free (.5) 



If you look at this last illustration, you see that you can't launch ClarisWorks 
(which needs 1.5MB) now because there isn't 1.5MB of contiguous memory 
left! Because of the sequence, you inadvertently chopped your remaining 
memory into two smaller chunks, neither of which alone can accommodate 
ClarisWorks. 

The solution to the 1-know-1-have-enough-memory-to-launch-this problem is 
to quit all your programs so that only the Finder is running and then launch 
all the programs that are supposed to fit in your Mac's memory. This time, it 
will work. 

Fourth resort: Get RAM Doubler 
Here's a fascinating possibility for the RAM-shy Mac fan: Buy a $50 program 
called RAM Doubler. 

RAM Doubler uses several potent, deeply technical tricks to make your Mac 
behave as though it has twice as much memory as it really does. Most 
people who try it love it. The rest get their money back! 

The only fundamental understanding of RAM Doubler that you need is this: 
It lets you run more small programs at the same time. It doesn't let you run 
one big program that requires more real memory than you have. 

So Billy Bob, who has a 4-meg PowerBook and wants to run ClarisWorks and 
Kid Pix at the same time, has it made in the shade. He no longer has to quit 
Kid Pix just to free enough memory to launch ClarisWorks. RAM Doubler lets 
him keep both programs going. 

Jenny Sue, however, wants very much to run Photoshop or Myst on her 
4-meg LC. She's out of luck. Those programs require about 5 megs of memory 
apiece. RAM Doubler's double-memory tactics don't let you run any big 
programs that you couldn't run before. 

Fifth resort: Use flirtual memorlJ 
Here's another rather technical, but interesting, possibility for avoiding out­
of-memory problems. Fortunately, this solution lets you run programs 
whose combined memory requirements add up to much more than your 
Mac should be able to handle. Unfortunately, it requires you to learn a new 
term. Ponder this trade-off for a moment; then read on, if you dare. 

The new term is virtual memory. (Virtual means fake, as in "virtual reality.") 
Under this scheme (unique to System 7 and later), the Mac attempts to use 
the hard disk as emergency memory. 
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Suppose your Mac has 4MB of memory, but you want to run both Limerick­
Writer (which requires 2MB) and BrailleMeister (which also requires 2MB). 
Because your System requires 1.5MB by itself, you can see that 2 + 2 + 1.5 is 
going to equal more than your 4MB. 

If you were using virtual memory, though, the Mac would allow you to run 
both programs simultaneously. Where would it get the extra 1.5MB of 
memory that it needs to fit everything in? It would use an empty hunk of 
hard-disk space. 

Read this slowly: When you're in LimerickWriter, the Mac stashes the excess 
1.5MB worth of BrailleMeister information on the hard disk. Then, when you 
bring the BrailleMeister window to the front, the Mac quickly feeds that 
1.5MB worth of information back into actual memory, displacing the same 
amount of LimerickWriter instructions (which, needless to say, it writes 
back onto the hard disk). Each time you switch programs, the Mac juggles 
the overflow. 

This switch doesn't take place instantaneously; that's a lot of information for 
the Mac to shuttle back and forth between memory and the hard disk. In 
fact, you may have quite a Jag when you switch from one program to an­
other. A little waiting sure beats not being able to run those two important 
programs at the same time. 

For some mysterious technical reason, the amount of hard-disk space that 
the Mac needs to perform this stunt isn'tjust the amount of pretend memory 
you want to add to your real memory. That is, if your Mac has 5MB of 
memory, and you'd like your Mac to think that it has 8MB, you can't just set 
aside the difference (3MB) in hard-disk space. Golly, no. You have to allow a 
chunk of disk space that's the size of all the memory, real and imagined- in 
this case, 8MB. 

Okay. All that having been said (and read), Jet's get to the actual process of 
using virtual memory. Follow these steps: 

1. From the tl menu, choose Control Panels and then double-click 
Memory. 

The control panel appears, like this: 
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See the Virtual Memory area? If not, your Mac isn't equipped for this 
feature. (Some of the older ones aren't, including the original Classic 
and the original LC.) 

2. From the pop-up menu, specify the hard disk that you want the Mac 
to use as its temporary fake-memory dumping ground. 

If you have only one drive -the one inside your Mac -skip this step. 

3. Using the little up- and down-arrows, specify how big you want that 
virtual-memory file (on your hard disk) to be. 

Remember: There has to be a chunk of empty hard-disk space that's big 
enough to hold the total of your real memory and the extra, phony 
memory that you'd like to have. 

Don't create total memory more than double your real memory. If you 
have 4MB of RAM, your total memory (including virtual) shouldn't 
exceed 8MB; things will get so slow as to be unworkable. 

Oh, yeah: If you're going to set virtual memory higher than 8MB, you 
also need to turn on the 32-bit addressing switch (if your Mac displays 
one in the Memory control panel). 

The Mac may tell you that your disk does not have enough room. 
Maybe it's time to go on a cleaning binge. 

4. When you're done with your virtual-memory setup, restart the Mac. 

Last resort: BuiJ more 
After a certain point, knocking yourself out to solve out-of-memory prob­
lems reaches a point of diminishing returns. You get so worn out from 
workarounds that they're not worth doing. 

At that point (or much sooner), just buy more memory. You can get it from 
any mail-order company (such as Mac Connection). You can install memory 
yourself, fairly easily, in some models. Installing memory in other models -
like PowerBooks - is trickier and requires some funky tools. Anyway, when 
you call a mail-order company to buy memory, tell them what Mac you have 
and find out what you need. Sometimes, the company will send you a how-to 
video, which is very handy- and when you're done with it, you can use it 
to record Seinfeld. 

Installing memory yourself can be easy as pie or hard as nails, depending on 
your Mac model. For the fewest headaches, get someone (like your favorite 
computer store) to install it for you. 

Having lots of memory to kick around in is a joy. Your Mac runs faster, has 
fewer crashes and glitches, and acts like a new machine. It's a situation that 
I heartily recommend. 
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Startup Problems 
Problems that you encounter when you turn on the Mac are especially 
disheartening when you're a new Mac user. It does wonders for your self­
esteem to think that you can't even turn the thing on without problems. 

No ding1 no picture 
First resort: Chances are very, very, very good that your Mac simply isn't 
getting electricity. It's probably not plugged in. Or it's plugged into a power 
strip that has an On/Off switch that's currently set to Off. Or (if it's a 
PowerBook) the battery is completely dead; plug in the adapter for ten 
minutes before trying again. 

Second resort: If you have a two-piece Mac, you normally turn the machine 
on by pressing the triangle key on the keyboard. Maybe the keyboard isn't 
plugged in. Check that. 

Third resort: Here's another PowerBook possibility. It may be that the 
internal circuitry known as the power manager has gotten drunk again. 
Unplug the Power Book and take its battery out. Let it sit like that for ten 
minutes. Then put it together and try again. 

Last resort: If none of those steps solved the problem, your Mac is as dead 
as Elvis. Get it in for repair. But that's virtually never the actual problem. 

Ding1 no picture 
If you hear the startup chime (or ding) but the monitor doesn't light up, 
something's wrong with the monitor. 

First resort: Is the screen brightness turned up? On most Macs, a bright­
ness dial is on the edge of the monitor. On a Classic, you have to use the 
Brightness control panel. 

Second resort: I don't mean to insult your intelligence- but is it possible 
that you have a screensaver program installed? (You know, like After Dark ... 
flying toasters, all that?) Some Macs, like the 7200 and 7500, have a built-in 
screensaver that kicks in after a few minutes. 

To find out if a screensaver program is the cause of the current blackness, 
press a key or click the mouse button. If the screen picture doesn't appear, 
read on. 



Third resort: If you have a two-piece Mac, the monitor has to be (1) plugged 
into the Mac, (2) plugged into a power source, and (3) turned on. (Not 
everybody realizes that the monitor has an On/Off switch.) Often, the 
monitor is plugged into the AC outlet on the Mac itself; that's okay. 

Last resort: Does your monitor require a graphics card? Some old models 
do. (Of course, if your Mac needs a graphics card, you would have discov­
ered this problem the day you got your system.) 

Picture, no dint}. 
Every Mac makes a sound when it's turned on. In fact, even if you've set the 
volume level of your Mac's speaker to zero (by using the Sound control 
panel), you still get a sound when you start the Mac. 

First resort: Look at the little speaker jack in the back of the Mac. If some 
kind of plug is in it- some kid's Walkman headphones, a cord connected to 
a stereo, or a pretzel stick - no sound can come out of the Mac speaker. 

Last resort: There's a remote possibility that somebody, mucking around 
inside your two-piece Mac, unplugged the speaker-wire cable. Find that 
person, yell firmly into his or her nearer ear, and insist that the cable (inside 
the Mac) be reconnected. 

Four musical notes (or crash sound) 
If you hear an arpeggio, a lick of the Twilight Zone theme, a drum or flute 
solo, or a car-crash sound, something's seriously wrong inside the Mac 
(Apple's sense of humor at work). 

Fortunately, 50 percent of the time, you hear this sound just after installing 
new memory. It means that one of the memory chips is loose or defective­
something that you (or whoever installed the memory for you) can fix 
relatively easily. And 40 percent of the time, it's a SCSI problem. Read on. 

First resort: If you just installed or otherwise messed around with the 
memory chips in your computer, that's certainly the problem. Reopen the 
Mac. Carefully remove each memory chip and reinstall it, checking the little 
centipede legs to make sure that they're not bent. (Come to think of it, get 
someone who knows what he or she's doing to accomplish this.) 

Second resort: The other common source of funny startup notes is a SCSI 
problem of some kind. (Yes, I know that we haven't defined this in a while; 
for instructions, see "Solving SCSI nightmares," later in this chapter.) For a 
quick fix, just unplug any external hard drive or scanner from the SCSI jack 
(the very wide one) in the back of the Mac and try starting up again. 
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Last resort: If it's truly not a memory-chip or SCSI problem, call your Apple 
dealer. This baby's sick. 

A t(uestion mark blinks on the screen 
The blinking question mark is the Mac's international symbol for "I've 
looked everywhere, and I can't find a System Folder anywhere." 

The blinking question mark means that your hard drive's not working right­
or that it's working fine, but your System Folder got screwed up somehow. In 
either case, here's what to do. 

First resort: After ten seconds of panic, turn the Mac off and try starting 
again, or just press the Restart switch. (See "The Restart switch," at the end 
of the appendix.) 

Second resort: Find a floppy disk with a System Folder on it. The best bet is 
the white System disks (or the startup CD) that came with your Mac. The 
floppy called Disk Tools or Utilities usually does the trick. Put it into the disk 
drive and turn the Mac on. 

After you're running, find the program called Disk First Aid. Run it and use 
the Repair button. About 40 percent of the time, Disk First Aid can repair 
your hard drive. 

Third resort: If the hard-drive icon still doesn't appear, read "Solving SCSI 
nightmares," later in this appendix. 

Fourth resort: Try zapping the PRAM (pronounced PEA-ram). See "Zapping 
the PRAM," at the end of the appendix. 

Last resort: If nothing works, and you still can't make your hard-drive icon 
appear on the screen, your hard drive is sick. Call your local dealer or Mac 
guru, and do not freak out - chances are very good that all of your files are 
still intact. (Just because the platters aren't spinning doesn't mean that 
they've been wiped out, just as your Walkman tapes don't get erased when 
the Walkman runs out of batteries.) 

In fact, you can probably rescue the data from your disk yourself. Buy a disk­
recovery program, such as Norton Utilities or MacTools Deluxe. That'll let 
you grab anything useful off the disk and may even help heal what's wrong 
with it. 



Some craziJ. pro9ram launches itself 
efleriJ. time IJ.OU start up 
In the words of Mac programmers everywhere, "It's a feature, not a bug." 

Inside the System Folder, there's a folder called Startup Items. Look inside it. 
Somebody put a program or document in there. 

Anything in the Startup Items folder automatically opens when you turn on 
the Mac. This feature is supposed to be a time-saver for people who work on 
the same documents every day. 

Ffopp1J. .. Disk Flukes 
Floppy disks are cheap and handy and make excellent coasters. But when 
they start giving you attitude, read on. 

Mac keeps askin9 for a disk IJ.OU
1fle ejected 

First resort: You probably ejected the disk by using the Eject Disk command 
in the Special menu. In general, that's a no-no, precisely because (in systems 
before Mac OS 8), the Mac will continually ask for it . 

. .s,SUP -~ w V You can get out of this scrape by pressing 88-period several times. Next time, 
~ eject a disk by choosing the Put Away command from the File menu (or by 

4
_ ~) dragging the disk icon to the Trash can). 

Last resort: Sometimes, even if you use Put Away, a ghost of the disk's icon 
remains on the screen; the Mac keeps asking for it, and pressing 88-period 
doesn't solve anything. In this case, you probably opened a file on that disk, 
and it's still open. As long as something on that disk is open, the Mac won't 
forget about the disk; it would be like canceling the space program while 
some astronauts were in the middle of a mission. 

Choose the program in question from the Application menu, and make sure 
that you close all documents. Now you should be able to drag the disk icon 
to the Trash can. 

Vou can1t 9et a floppiJ. disk out 
First resort: Press 38+Shift+ 1. That should pop out the disk, even if you 
can't see its icon. 
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Last resort: Use the paper-clip trick: Straighten a paper clip and push it 
slowly but firmly into the tiny pinhole to the right of your disk drive slot. 
That'll shove the disk out. 

Efler1Jthing's Slow 
Of course, if your Mac has seemed too slow since the day it arrived, maybe 
you just bought a model that's too slow for your demanding tastes. There's 
nothing for it except to upgrade to a faster model - or, if it's a Power Mac, 
to make sure you're using Power Mac-specific programs. 

But if the Mac has begun acting slower since you've owned it, something 
may indeed be wrong. 

First resort: After several months of using a Mac, it actually does slow 
down. The problem is a bloated desktop file; the solution is described in 
"Rebuilding the desktop file," later in this appendix. 

Second resort: Choose Control Panels from your ei menu. Open the one 
called Memory. Is virtual memory turned on? If so, you've accounted for at 
least some of the sluggishness. 

Third resort: While still in your Control Panels window, open the one called 
Views. Is "Calculate folder sizes" turned on? If so, turn it off; it's slowing 
down the works. 

Fourth resort: Just to be secure, read "Solving SCSI nightmares" at the end 
of this appendix. A SCSI problem can also make your Mac act like it's on 
So min ex. 

Last resort: If your hard drive is rather full, perhaps it needs to be 
defragmented. (See "Defragmenting your hard drive" at the end of the 
appendix.) 

The l'roblem .. Solfling Cookbook 
Okay- now you've read about everything that can possibly go wrong. This 
section contains everything you can possibly do to fix the problem. Remem­
ber, you'll almost never find out what caused the problem to begin with; just 
be happy that the following techniques are magical in their ability to cure 
things. 



RebuildiniJ. the Desktop file 
The Desktop is a very important file on your disk. How come you've never 
seen it? Because the Desktop file is invisible. (Yes, Mac icons can be invis­
ible. Remember that fact if you ever get involved in antiterrorist espionage 
activity.) The file is something that the Mac maintains for its own use. 

The Mac stores two kinds of information in the Desktop file: the actual 
pictures used as icons for all your files and information about the parent­
child (program-document) relationships that you're having trouble with. 

If the Desktop file becomes confused, two disturbing symptoms will let you 
know: the "generic icon" problem, where all your icons show up blank white 
and the "Application not found" message that appears when you try to 
double-click something. 

Another Desktop-related problem: Over time, this invisible file gets bigger 
and bigger; remember, it's having to store the pictures of every little icon 
that crosses your Mac's path. And just because you throw some icon away 
after using it doesn't mean that its image gets cleared from the Desktop file -
it doesn't. And the bigger your Desktop file gets, the slower your Mac becomes 
in its efforts to open windows, display icons, and start up in the morning. 

Resetting your Desktop file, therefore, has two delightful benefits. First, it 
cures the generic-icon syndrome and the "application not found" problem 
(because it re-learns the relationships between files and their pictures). 
Second, it makes your Mac faster (because it purges all the unnecessary 
leftover icon images from its invisible database). 

Rebuilding the Desktop file involves forcing it to unlearn the misconceptions 
that are giving you trouble and then to relearn the correct relationships 
between documents and the programs that gave birth to them. Here's how you 
do it. Tum the computer on. As it starts gearing up, press and hold the Option 
and sg keys. Don't let go. Keep them down until the Mac explicitly asks you 
whether you want to "rebuild the Desktop." (Obviously, you should click OK.) 

After that's done, your document double-clicking will work, your icons will 
return, and your Mac, having been cleansed of all obsolete icons, will run 
faster and more smoothly. 

ZappiniJ. the PRAM 
The PRAM is a tiny piece of battery-sustained memory. In this little area of 
memory, the Mac stores several pieces of information even when the 
computer is turned off: the clock time, your various control panel settings, 
choice of desktop pattern, and so on. When the PRAM memory itself gets 
corrupted, a whole category of goofy problems can result. 
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First, turn off (or restart) your Mac. Then turn it on again, but hold down 
four keys at the same time- 38, Option, P, and R-and don't let go until 
you hear the startup chime. (Afterward, you may have to reset your Mac's 
clock, desktop pattern, and mouse settings by choosing Control Panels from 
your • menu and opening the control panels called Date & Time, General, 
Desktop Patterns, and Mouse.) 

The amazing ''Force Quit11 keiJstroke 
Here's this amazing keystroke for escaping a frozen program: 8£-0ption-Esc. 
(This is about the only time that you ever use the Esc key.) 

If it works, you get a dialog box that says, "Force [this program] to quit?" 
Click Force Quit, and you exit the program that you were working in. 

So what's the big whoop? Well, if you had several programs running, this 
technique dumps only the one that you were working in - the one that 
crashed. You now have a chance to enter each of the other programs that 
are still running and save your work (if you haven't done so). Then, to be on 
the safe side, restart the Mac. 

The Restart switch 
Every Mac has a Restart switch. Sometimes, you'll find two buttons side by 
side somewhere on the Mac's casing- and the one with a left-pointing 
triangle is the Restart switch. Sometimes, as on older PowerBooks, there are 
two little back-panel holes that you're supposed to stick a pin into . 

... ~SUP _.411 
~ All the other models - especially recent ones - have a secret Restart 
~ :;;v~t~~~~~~~;~s Control, the 8C key, and the On button (or power key) at 

In every case, pressing Restart is the same as turning your Mac off and then 
on again, except that it doesn't suddenly send a wall of electricity thudding 
into the machine's delicate electronics. Therefore, Restart is gentler to your 
Mac. Keep the Restart switch in mind when you have a system freeze or crash. 

So/fling an extension conflict 
Okay, here it is - the long-awaited extension-conflict discussion. 



See, each extension (a self-loading background program, such as a screensaver, 
that you install in your System Folder) was written by a programmer who 
had no clue what other extensions you'd be using. As a result, two exten­
sions may fight, resulting in that polite disclaimer "Sorry, a system error has 
occurred." 

~s UP -(JJ These things are easy to fix, once you know the secret. Shut off your Mac, 
~Cfj and then turn it on again. But as the Mac is starting up, hold down the Shift 

v key and keep it down until (1) you see the message "Extensions off" or (2) 
,·0 ·_i, you arrive at the Desktop, whichever you notice first. 

Your Mac probably won't give you trouble anymore - but now, of course, 
you're running without any of your cute little extension programs. No 
screensaver, no fax software, and so on. 

If the point of this exercise is to pinpoint which extensions aren't getting 
along, you have three choices. One is free, but takes a lot of time. Another is 
easier, but only works if you have System 7 .5-something. The third way costs 
$50 or so, but works automatically. 

Y' The hard way: Burrow into your System Folder to find the Extensions 
folder, where these little guys live. Drag a few of their icons out of that 
folder onto the Desktop; that's how you prevent selected extensions 
from loading. You don't have to throw the extensions away; just take 
them out of the System Folder and then restart the computer. (Use the 
Restart command in the Special menu.) 

If the Mac doesn't crash this time, you can pretty much bet that one of 
the extensions you removed was the guilty party. If the Mac does crash 
again, repeat the whole process, but this time take some more exten­
sion icons out of the System Folder. 

Through trial and error, you eventually should be able to figure out 
which pair of extensions don't get along. Sometimes, just renaming one 
so that it alphabetically precedes its enemy is enough to solve the 
problem. 

Y' The System 7.5 way: Use the same method given under "The hard 
way." But instead of burrowing into your System Folder to turn off 
extensions, try this. While the Mac is starting up, press and hold the 
spacebar down. Eventually, if you have System 7.5 or later, you'll be 
shown a complete list of your extensions. 

You can turn off selected extensions just by clicking their names. 
Figuring out which specific extensions are causing your headaches is 
still trial and error, but at least it's easier to switch them on and off. 

Y' The easy way: Buy a program called Conflict Catcher. This program 
does many useful things for managing your extensions, but its main 
virtue is catching conflicts. It can figure out, all by itself, which exten­
sion (or extensions) caused your Mac's problems. All you have to do is 
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sit there, restarting the Mac over and over, each time telling Conflict 
Catcher whether or not the problem has been solved yet. By the time 
the process is over, the program will emblazon the name of the errant 
extensions on your screen; you then can dismember, disembowel, or 
trash them as you see fit. 

Conflict Catcher also lets you rearrange the order in which your exten­
sions load simply by dragging their names around in a list. Oddly 
enough, switching the order of your extensions often solves extension 
conflicts, too. 

(Tip: A free three-day demo version is available on America Online. It 
lasts just long enough for you to figure out which extensions were 
driving you crazy.) 

Sol"intJ SCSI ni9htmares 
I've tried to shield you as much as possible from the term SCSI and all that it 
entails. But because SCSI's a common source of trouble, it's time to put on 
the overalls and get dirty. 

If there's nothing attached to your SCSI jack in the back of the Mac (for 
example, a scanner or a Zip drive), you have no SCSI problems, and you 
should skip this entire section. You don't know how lucky you are. 

What's SCSI J 
They pronounce it "scuzzy," for some reason. Here on the East Coast, we 
used to pronounce it "sexy," which I prefer, but the Valley girls and boys 
held sway. 

Anyway, SCSI stands for Small Computer System Interface (or Serial Inter­
face, or Standard Interface, depending on where you look it up; it's such a 
messed-up technology that nobody can even get the name right). SCSI 
describes the widest connector on the back of your Mac: the SCSI port. It 
also describes the fattest cable of any Mac appliance: the SCSI cable. It 
describes the kind of hard drives, scanners, Zip drives, CD players, and 
other gadgets that you attach to this jack: SCSI devices. It also describes the 
type of information that flows from those devices through those cables to 
that jack along the SCSI chain. 

But frankly, the term that you hear most often is SCSI problems. 

Examples: some SCSI appliance (a scanner, a CD-ROM, a Zip drive, whatever) 
doesn't work right. Or your whole Mac is acting slow and weird. Or your 
Mac won't start up at all. 



What's especially frustrating to people who write computer books is that 
you can't pin SCSI down. Even if you obey the "rules" (which I'll give you 
anyway), things still go wrong. 

The only good thing to say about SCSI problems is that once you figure out 
the problem with your setup, that problem is gone for good. 

The rules of SCSI 
Rule # 1: When the Mac attempts to talk to various devices along a SCSI 
daisy-chain, it must be careful not to say "start scanning!" to the hard drive 
or "start spinning!" to the scanner. In other words, it has to address its 
messages carefully. 

For that reason, every SCSI device in the world has a SCSI address between 0 
and 7. Usually, a little number wheel that looks like a one-digit odometer is 
on the back or the bottom of your SCSI device. Each SCSI device connected 
to your Mac must have a different SCSI number (address) so that the Mac 
can speak to each appliance individually. 

The Mac, which is part of the chain, has a SCSI number, which is always 7. If 
you have an internal hard drive, it has a SCSI number, too -and that 
number is always 0. (If your Mac has a built-in CD-ROM player, its address is 
always 3.) So for your external drives, scanners, and so on, you can choose 
numbers from 1 to 6; just make sure that no two devices have the same 
number, or you're cruisin' for a bruisin'. 

Rule #2: I wish I didn't have to mention SCSI Rule #2: The last device on the 
chain has to be terminated. 

When I say terminated, I mean taken out and shot. 

The second meaning for terminated is a little bit more complicated. 

As the Mac sends its little instructions to the various SCSI devices attached to 
it, it shoves those instructions out the door with such force that they some­
times go all the way to the end of the cable and bounce back toward the Mac. 
Sometimes, the instructions make it all the way back, in which case you get 
nutty problems like a hard-drive leon showing up twice on the screen. 

To soak up any messages that were pushed with too much oomph, you're 
supposed to put an electronic shock absorber at the beginning and the end 
of the line of devices. This absorber is called a terminator, Arnold 
Schwarzenegger notwithstanding. 

If your Mac has an internal hard drive, as most Macs do, you don't have to 
worry about the beginning terminator: Your SCSI chain is already terminated 
inside. And if you also have only one SCSI device outside your Mac, you 
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don't need a terminator on the outside end. (I'm perfectly aware that this 
contradicts Rule #2, but it doesn't contradict Rule #3, which is that these 
rules don't always apply. Including Rule #3.) 

After you have two or more SCSI things attached to the back of your Mac, 
though, it's time to start thinking about termination. You add termination by 
attaching a three-inch stopper plug (called, obviously, a terminator) to the 
empty SCSI jack of the last device on the chain. Some devices, however­
such as Zip drives - have a terminator switch on the back or bottom. You 
can just flip this switch between the terminated and unterminated positions. 

Worst of all, some devices may or may not be internally terminated, meaning 
that you can't tell whether or not they're already terminated. Rule #4 is that 
you don't want a device in the middle of the chain to be terminated! The 
only way to find out whether a device is internally terminated (if that 
information is not in the owner's manual) is to call the cheap, lazy company 
that made it. If it is internally terminated, that device must go at the end of 
the SCSI chain. (Is this the most pathetic technology ever, or what?) 

Rule #5: If your SCSI setup isn't working, try rearranging the physical order 
of the devices in your SCSI chain. It makes no sense, but sometimes rear­
ranging makes things work when nothing else does. Anyway, at this point, 
you're entitled to be a little irrational. 

Rule #6: Your SCSI cables can make or break the entire operation. If every­
thing else seems hunky-dory, it's conceivable that the trouble is their 
combined lengths. They're not supposed to add up to more than 20 feet or 
so, and (like speeches and Willie Nelson songs) the shorter the better. 

Oh, and while we're talking about SCSI cables, you should know this: They 
go bad. It's true. One rich guy I know threw out an 800MB hard drive be­
cause he thought that it had died permanently. Upon rescuing it from the 
dumpster, an enterprising Mac buddy discovered that the drive was fine; the 
cable had been crimped by a piece of furniture. After he spent $30 on a new 
SCSI cable, the drive was as good as new. It's probably worth replacing, or at 
least switching, the cables if you're still having SCSI problems. 

Another guy I know solved his SCSI woes by switching his cable from one 
SCSI jack on his CD-ROM player to the other (of the two identical SCSI jacks). 
It makes absolutely no sense, but that's what happened. 

Rule #7: Okay, you've made sure that every device has its own address. If 
you have more than one external SCSI device, you've terminated the last 
one. But things still aren't working right. 

In this case, try taking off the terminator. I'm perfectly serious. SCSI Rule #8 
is: If a rule isn't working, try breaking it. 
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Someday, we'll laugh and tell our grandchildren, "Why, when I was your age, 
we used to have to add terminator plugs to our external devices!" Until that 
golden day, though, we have to put up with this cranky and unpredictable 
technology. Good luck to you. 

GirliniJ more memorlJ to a proiJram 
When you turn on your Mac, about 2 or 3 megabytes of its available RAM 
(memory) gets used up by your System Folder's contents - your operating 
system. Then, every time you launch a program, a little bit of the leftover 
free RAM gets used up. 

Here's how to find out where your memory is going at any particular mo­
ment: go to the Finder. From the ti menu, choose About This Macintosh. 
This helpful dialog box appears, showing several important numbers about 
your use of memory: 

This is how much memory your Mac has. (If you want 
to convert this number to megs, mentally replace 
the comma with a decimal point) 

Abou Tills Moclntosh 

EJ H-t.tese. Uox 
st•t .. s.nw .... •7.0 .1 • 
C ~.,. c.rr.utw. nc. 1983·1 991 

Tet.•l..._.t : _G,~ .. ,.. tunuH a~ ~ 
~ OtdcDr•v -zr I ~ 
~ ....... ~. 20K I 
§I fn.M«tr Pro 1 •.• 1,024K -=:l 
C Svsttm Sonw .... • 

.,._ ......... 1,0'2o4K -=:l 

~ 

This is the largest 
chunk of memory you 
have left, into which 
you can open more 
programs. (There may 
be smaller chunks 
available, too.) 

In the bottom part of the box, you can see what's already taking up memory 
and how much memory each program is taking up (see those bars?). 

You may find it useful, however, to change the amount of memory that each 
of your programs uses. If you're experiencing a lot of system crashes, for 
example, the program may need a bigger memory allotment. If memory is at 
a premium, you may be able to give a program less memory, freeing some for 
other purposes. 

Here's how: 

1. Quit the program whose memory appetite you want to change, and 
then click its icon. 

2. From the File menu, choose Get Info. 
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3. Change the number In the Preferred size box (in older systems, It's 

called the Current size). 

This number is the amount of memory that the program will actually 
consume when you run it. Unless system crashes make your life more 
interesting, don't set the Preferred (Current) size much below the 
Suggested size, though. 

,_ 
CAUTION: Chan9e the 88 and II 
SIJmhols to IJOU·know-what! 
This procedure is just a wee bit technical. But it's amazing how many 
problems it solves. font problems, crash problems, freeze problems, glitch 
problems, weird things you can't even describe very well - all of them go 
away when you do a clean install. 

As the gears of your System Folder grind away day after day, little corrup­
tions and rough edges can develop. The following procedure replaces your 
old, possibly corroded System Folder with a brand-spanking-new one. It's 
nearly guaranteed to wipe out any erratic, bizarre crashes, or freezes that 
you've been having; after all, it restores the Mac to the exact condition it 
was in the day it left the factory. 

This process requires the System Software Installer that came with your 
Mac. You find it in one of three forms: as a system CD that came with your 
Mac; as a pile of white Apple floppy disks that came with your Mac; or, if you 
have a Performa that doesn't have a CD-ROM drive, you were supposed to 
have made your own set of Apple Backup disks. (If you're really stuck, you 
can always buy the latest version of the Mac's system software from Mac 
Connection or a similar outfit.) 

Step one: Install the fresh software 
This first step depends on which system version you have. 

If you have Mac OS 8 or later: Insert system CD. Double-click the Installer 
icon. On the welcome screen, click Continue; on the next screen, select the 
Perform Clean Installation option. Then continue with the usual installation 
process. 

If you have System 7.6-something: Insert system CD. Double-click the 
Installer icon. After you click the Start button on the Software Installations 
screen, click the Options button on the regular Installer screen. You're 
offered "Create additional System Folder (clean install)"- that's the one 
you want. 
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If you have System 7 .5-something: Insert system CD (or the first Installer 
disk). Double-click the Installer icon. Click continue. At the main installation 
screen- where you'd normally click the Install button- press 88-Shift-K, of 
all things. You're asked which you want: a brand-new System Folder, or just 
an updated existing System Folder. You want the whole new one. Click your 
choice, click OK, click Install, and then follow the directions. 

If you have earlier System versions: Open your System Folder. See the 
Finder icon? The purpose here is to separate it, folder-wise, from the System 
suitcase icon. Drag the Finder out onto the desktop, for example. 

You're doing beautifully. Now close the System Folder window, press Return, 
and rename the System Folder. (Call it "Old System," or something like that.) 

Finally, take the Install Me First disk (or your Performa Apple Backup disk or 
startup CD-ROM) and insert it. Double-click the icon called Installer; then follow 
the directions on the screen, feeding floppy disks into the drive as requested. 

Finally, take the Install Me First disk (or the Apple Backup disk, or startup CD), 
and insert it. Double-click the icon called Installer, and then follow the 
directions on the screen, feeding floppy disks into the drive as requested. 

Step two: Restore IJOUr personal heloniJ.iniJ.s 
The results of all these shenanigans is a virgin, clean System Folder, free of 
any corruptions. Your Mac will run smooth, fast, and trouble-free- I 
guarantee it. 

Unfortunately, all your customized fonts, control panels, preferences, and el 
menu items are stranded back in your old System Folder!Ideally, you should 
install each of these items from their original, store-bought disks. If that's 
too much hassle, set up your old System Folder and your new System Folder 
side-by-side in tall, skinny, list-view windows. Now copy anything that's not 
in your new System Folder, item by item, from your old System Folder to 
your new System Folder. (Key folders to compare with their newer counter­
parts: the Preferences, Extensions, Control Panels, Apple Menu Items, and 
Fonts folders.) Do so with care, however, so that you don't simply reinstate 
whatever problems you were having. 

De(ra9menting lJOUr hard dri(le 
Over time, you create and throw away a lot of files. 

Your hard drive, if you'll indulge me, is like a closet maintained by a guy 
who's always in a hurry. When guests are coming over, he cleans up the 
living room and throws everything into the closet, although not particularly 
neatly. Every now and then, when he gets time, he unpacks the closet and 
repacks it neatly, putting everything in a tidy, organized place. 
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The hard drive, too, is in a hurry. When you ask it to save a file, it doesn't 
wait around: It shoves that file wherever it can find space. Sometimes, that 
even means sticking the file in two places, splitting it as necessary. Over 
time, more and more files are stored on your hard disk in pieces. It's no big 
deal: When you need that file again, the hard drive remembers where all the 
pieces are and is perfectly able to bring the file back to the screen. 

But all this hunting for pieces slows the drive down. And like our busy closet 
keeper, you'll find it very satisfying, every six months or so, to reorganize 
the files on your disk so that they're each in one piece, neatly placed end to 
end on the hard-drive surface. 

You can defragment your drive (which is the term for it) in two ways. First, 
you can copy everything onto other disks, erase the hard drive, and copy 
the files back onto it. Second, you can buy a program just for defragmenting 
your drive. These programs are called things like Norton Utilities and 
DiskExpress. 





Appendix 0 

The Technobabble 
Translation Guide 
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access privileges- Permission to do something 
on the Mac. Appears only in the context of "You 
can't do that because you don't have access 
privileges.~ Pertains either to File Sharing (you 
haven't been allowed access to a certain net­
worked folder) or Macintosh System 7.5 (some­
body turned on "System Folder protection~ in 
your Macintosh or General control panel). 

active window- The window in front. Usually, 
only one window can be active; you can recognize 
it by the stripes across the title bar, like this: 

H11rd Drlue 
29 M8 tn disk 

[}] 
Systtm Fo1dtr 

alert box - A message that appears on the 
screen. Unfortunately, as in most relationships, 
the Mac tends to communicate only when 
something is wrong. 

0 The resale ualue of your computer system 
h11s just sunk to 2S'l. of wh11t you p11ld for lt. 

00 
alias- A duplicate of a file's icon (not of the file 
itself). Serves as a double-clickable pointer, or 
reference, to the original file, folder, or disk. A 
feature of System 7 or later. Indicated by an 
italicized icon name. 

Apple menu- The menu at the far left-end of 
your menu bar, marked by the 41 symbol- a 
piece of black or multicolor fruit. In the • menu, 
you find a list of your desk accessories (mini­
programs, such as the Calculator), as well as any 
files, folders, documents, control panels, and even 
disks (or thei r aliases) that you care to see there. 
To add something to the 41 menu, drop its icon 
into the Apple Menu Items folder within your 
System Folder. 

AppleShare - Some kind of trademarked name 
for the way that interconnected Macs communi­
cate with one another. 

Apple Talk- Another trademarked name, also 
having to do with Macs talking to one another. 
You may need to know this term if you have a 
laser printer, because Apple Talk is the language 
that it speaks to your Mac. To print, you must 
make sure that Apple Talk is active. Choose the 
Chooser from the 41 menu, and you see where you 
turn Apple Talk on or off. 

application - Nerd word for program. 

Application menu -The rightmost menu in the 
menu bar (if you have System 7), marked by an 
icon. This menu lists whichever programs you 
have open and displays a check mark next to the 
frontmost program. You can switch from one 
program to another by choosing names from the 
Application menu. 

background printing- A feature that returns 
control of the Mac to you immediately after you 
use the Print command; the Mac will print your 
document, taking its own sweet time, always 
giving priority to what you're doing on the screen. 
The alternative, known as background printing is 
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off, takes less time to print but takes over the 
Mac, preventing you from working and displaying 
a "now printing" message until the printing is 
over. 

backup -To make a copy of a file for use In case 
some horrible freak accident befalls your original 
copy (such as your throwing It out). 

Balloon Help- A feature of System 7 and later. 
See the little question mark in the upper-right 
corner of your screen? It's a menu. Choose Show 
Balloons from it; then point to various elements of 
your little Mac-screen world. Cartoon balloons 
pop out to identify what you're pointing at. 

baud rate- The speed of a modem (see modem). 
Directly related to the price. 

BBS -An electronic bulletin-board system. 
That's where a Mac in somebody's house Is 
connected to a phone line or two so that you can 
dial in with a modem (see modem) and post 
messages for other people to see. You can also 
read other people's messages. A BBS is a good 
place to advertise that you're selling your used 
Mac stuff and to get dates. 

beta test- Means test, but adding a Greek word 
makes it sound more important. Used when 
applied to software or hardware: When a program 
is still so buggy and new that a company doesn't 
dare sell it, the company gives it away (to people 
who are called beta testers) in hopes of being told 
what the bugs are. 

binary - How a computer thinks. Or anything 
that can only be in one of two conditions, such as 
a Morse-code signal, a light switch, or a public 
restroom. 

bit- You'd think that it's the past tense of byte 
(see that entry). Actually, it's a tiny piece of 
computer information that's not even big enough 
to bother with. 

bitmap -A particular arrangement of black dots 
on your white screen. To your eye, a particular 
bitmap may look like the letter A ( bitmapped 
text) or a coffee mug (a bitmapped graphic); to 
the computer, it's just a bunch of dots whose 
exact positions it has to memorize. 

boot- (1) (v.) To start the computer. (2) (n.) 
Western footwear. 

bps - Bits per second. The technically proper 
way to measure the speed of a modem (instead of 
baud, which everybody still says out of force of 
habit). 

bug- A programming error in a piece of 
software, caused by a programmer too wired on 
Jolt and pizza, that makes the program do odd or 
tragic things when you're working to beat a 
deadline. 

button - You have to deal with two kinds of 
buttons: the big square one on the mouse, and the 
many oval or round ones on the screen that offer 
you options. 

byte- A piece of computer Information made up 
of bits. 

cache - A trick, involving a special piece of 
memory, that makes a Mac faster. You can adjust 
the everyday cache In the Memory control panel; 
If you're willing to pay for speed, you may be able 
to buy for your model a cache card, which uses 
high-speed memory to pull off the same speed 
enhancement. 

Caps Lock- A key on your keyboard that makes 
every letter that you type come out as a capital; It 
doesn't affect numbers. Press it to get the 
capitals; press it again to return to normal. 

CD-ROM - A computer compact disc that 
requires a special $200 player. CO-ROMs can show 
pictures, play music or voices, display short 
animations and movies, and display reams and 
reams of text. 

character- (1) A single typed letter, number, 
space, or symbol. (2) The scoundrel who got you 
into this Macintosh habit. 

Chooser - A desk accessory, therefore listed In 
the • menu, that lets you specify what kind of 
printer you have. Failure to use this thing when 
you set up your Mac is the #1 reason why 
beginners can't print. 

click - The cornerstone of the Macintosh 
religion: to point the cursor at an on-screen object 
and then press and release the mouse button. 

clip art - Ready-made graphics - cutesy little 
snowmen, city skylines, Santa Clauses, 
whatever - to dress up newsletters, party 
invitations, and threatening legal notices. 
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Clipboard -The invisible holding area where the 
Mac stashes any text or graphics that you copy by 
using the Copy command. The contents of the 
Clipboard get vaporized when you turn off the 
Mac (or copy something new). 

clock speed - The speed of your computer, 
measured in megahertz (MHz), and determined 
by the studliness of the main processor chip 
inside. 

close box - The little square in the upper-left 
corner of a window (as opposed to the little 
square who sold you the Macintosh), which, when 
clicked, closes the window. 

Close box 
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command- Something that you'd like the Mac to 
do, such as Print or Save or Make Me Rich. See 
also menu. 

Command key - The one on your keyboard, 
right next to the spacebar, that has a 3C (Com­
mand) symbol on it. When you press this key, the 
letter keys on your keyboard perform commands 
ins tead of typing letters - for example, 3C-P = 
Print, 3C-S = Save, 3C-Q = Quit, and 3C-Z = Undo. 

Control key - A keyboard key that generally 
does absolutely nothing. 

control panel - A window full of settings that 
pertain to some aspect of the Mac's operation. 
There's a control panel for the mouse, another for 
the keyboard, another for the monitor, and so on. 
To view the selection of control panels, choose 
(what else?) Control Panels from the tl menu. 

copy- The command that places a copy of 
something (whatever text or graphics are first 
selected) in the invisible Macintosh Clipboard. 
Accomplishes nothing unless you then click 
somewhere and paste. 

CPU- What it stands for is central processing 
unit. What it means is the actual computer- in 
the case of two-piece Macs, the box that contains 
the real brains. As distinguished from things like 
the monitor, the printer, and the keyboard. 

crash - A very ugly moment in every Mac user's 
life when the Mac abruptly malfunctions , usually 
with scary-looking sounds and visuals. Requires 
restarting. 

CRT- The CRT is the screen. If you must know, it 
s tands for cathode ray tube. This term is not really 
used anymore. 

cursor- The pointer on the screen whose position 
you control by moving the mouse across the desk. 

database -An electronic list of information -
for example, a mailing list- that can be sorted 
very quickly or searched for a specific name. 

default- (I) The factory settings. For example, 
the default setting for your typing in a word 
processor is single-spaced, one-inch margins. 
(2) De blame for hooking you on de Mac hobby. 

defragment - To restore, in one contiguous 
chunk, something that's all broken up and 
scrambled. Usually refers to the information in 
memory or on a hard disk, but can also be applied 
to hamburger meat. 

Delete key- In the typewriter days , this key was 
named Backspace. In my opinion, it still s hould be 
called that. 

deselect- To unhighlight some selected text or 
graphic. (You us ually do it by clicking someplace 
else.) 

desktop - (1) The top of your desk, where the 
Mac sits, as in "I don't want a laptop; I want a 
desktop computer." (2) (Capitalized) The home­
base environment, where you see the Trash can, 
icons, and ali that stuff. Also known as the Finder. 
(3) The actual (usually gray) background of that 
home-base view. You can drag an icon out of its 
window and onto this gray tablecloth, and 
announce to your coworker that you just placed 
an icon on the Desktop. 

desktop file - A file the Mac maintains for its 
own use, in which it stores information such as 
what your icons should look like and which kinds 
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of documents can be opened by which programs. 
This file is invisible, but when it becomes 
damaged or bloated and starts causing problems, 
it's not quite invisible enough for most people. 

desktop publishing - The act of cranking out 
nice-looking printouts from your Mac instead of 
paying to have the work typeset. Despite the fact 
that the PowerBook is equally adept at creating 
beautiful printouts, the term laptop publishing still 
hasn't quite caught on. 

dialog box -The message box that the Mac puts 
on the screen when it needs more information 
from you (for example, the one that appears when 
you print, asking how many copies you want). 

digitize - Computerese for digest. To convert 
sound, pictures, video, or any other kind of real­
world sensory experience into the Mac's own 
numerical digestive tract. 

digitizing board - A circuit board that converts 
video or TV pictures into files on your Mac. 

DIMMs -The memory chips for certain Power 
Macs made in 1995 or later (see SIMMs). 

disk - Oh, come on; you know this word. 

disk cache - A secret feature for making your 
Mac faster at the expense of memory. The Mac 
memorizes a few things that you do a lot and 
keeps them in a wad of memory called the disk 
cache, where they're immediately accessible. You 
set the size of the disk cache (the amount of 
memory reserved) in the Memory control panel. 

disk drive -The machinery that actually reads 
what's on a disk. If we're talking hard disk, the 
disk and the drive are built into a single unit. If 
we're talking floppy, the disk drive is the slot in 
the face of the Mac into which you insert a floppy 
disk. 

document -A file that you create with a 
program. Examples: a memo (using a word 
processing program), a logo (using a graphics 
program), or a spreadsheet (using a spreadsheet 
program). 

documentation - A five-syllable way of saying 
user's guide. 

DOS- Synonym for IBM-style computers, meaning 
the computers of the world that aren't lucky 
enough to be Macs. Stands for Disk Operating 
System. 

dot-matrix -A kind of low-quality printer, such 
as the lmageWriter, and the printouts that it 
makes. 

dots per inch - A gauge of visual clarity, both on 
printouts and on the screen. The Mac's crystal­
clear screen became famous for having a very 
high resolution - 72 dots per inch, or 72 dpi. A 
laser printer is much sharper, though, capable of 
printing at 300 or 600 dpl. 

download - To transfer a file from one computer 
to another over phone lines. If you're on the 
receiving end, you download the file. If you're on 
the sending end, you upload the file. If you're the 
phone company, you love the file. 

downloadable font- Every laser printer comes 
with a basic set of typefaces built into it. You're 
welcome to use fonts that aren't in that built-in 
set, but the Mac has to send them to the printer 
(the printer downloads them) before the printer 
can start spitting out pages. 

dpl - Dots per inch. 

drag- (1) To position the cursor on something, 
hold down the mouse button, and move the 
mouse while the button is still down. (2) What it 
is when your disk drive breaks the day after the 
warranty expires. 

drawing program- A graphics program (such as 
MacDraw or ClarisDraw) that creates circles, 
squares, and lines. The Mac stores each object 
that you draw as an object unto itself, rather than 
storing the status of each screen dot. See also 
painting program and bitmap. 

driver- A smallish file on your disk that tells the 
Mac how it's supposed to relate to a specific piece 
of equipment (such as a printer or a scanner) that 
it's never heard of before. A translator. 

e-mail - Electronic mail; messages that you read 
and write on the Mac screen without ever printing 
them. May also be short for Earth-mail, because 
no paper (and no rain-forest acreage) is involved. 
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Enter key- A key (obviously) with the word 
Enter on it. It almost always does the same thing 
as the Return key. 

EPS file - A type of graphics file. Characterized 
by extremely sharp, smooth printing on a laser 
printer; a large file size on the disk; and, often, 
difficulty in printing. 

Ethernet- A system (wiring, connectors, 
software) of connecting Macs together in an office 
network. Faster than the free, built-in system 
(LocalTalk) that comes with every Mac. 

expansion slot - The connector socket for an 
add-on circuit board inside most Mac models. 
Used to add circuit boards for fancy new features 
like networking, pro graphics, and so on. 

extended keyboard - A slightly more expensive 
keyboard than the "standard" one. The extended 
keyboard has a row of function keys (Fl, F2, and 
so on) across the top, which don't do anything, 
and a little bank of keys that say Page Up, Page 
Down, and other stuff. 

extension - Miniprogram that you install by 
dropping it in your System Folder (whereupon the 
Mac puts it in the Extensions folder). From that 
moment on, the extension will run itself when you 
turn on the Mac and will be on all the time. 
Examples: virus protectors and screen savers. 

fax/modem- Like a modem (see modem), but 
also lets you send or receive faxes from your Mac 
screen. 

File Sharing- A built-in feature of System 7, 
wherein you can make any file, folder, or disk 
available for other people to go rooting through 
(as long as they're connected to your Mac by 
network wiring). 

flnder- The "home-base" view when you're 
working on your Mac. It's the environment where 
you see the Trash, your icons, and how little 
space is left on your disk. Also known as the 
Desktop or "that place with all the little pictures." 

FKEY- One of those cool techno-sounding 
words that nobody's ever pinned down to one 
meaning. Can refer to (1) the row of keys across 
the top of some keyboards: the function keys, 
labeled Fl, F2, and so on. Or (2) a special built-in 

keyboard shortcut involving the 38 and Shift keys 
plus a number. The 38-Shift-3 combination key, for 
example, takes a snapshot of the screen, and 38-
Shlft-1 ejects a floppy disk. 

flat-file database - A shopping list, Rolodex, or 
phone book; a simple collection of information. 
On a Mac, you can do things to your database like 
search or sort; flat-file means that the database 
doesn't have fancy interconnections to other lists, 
as a "relational" database does. 

floppy disk- The hard 31/2-inch-square thing that 
you put into your disk-drive slot. Comes In three 
capacities: 400K (single-sided), BOOK (double­
sided), and 1,400K (high-density). 

folder- In the Mac world, a little filing-folder 
icon into which you can drop other icons (such as 
your work) for organizational purposes. When you 
double-click a folder, it opens into a window. Also 
the name of the high-speed machine that creases 
and envelope-stuffs the junk mail that you're 
going to start getting from computer companies. 

font- (1) Apple's usage: a single typeface. (2) 
Everyone else's usage: a typeface family or 
package. 

FPU - See math coprocessor. 

fragmentation -When something gets broken up 
into little pieces. Usually refers to the files on 
your hard disk (which, over time, get stored in 
little pieces all over the disk, making It slower) or 
to the memory in your computer (see defragment). 
Also can apply to your window after you throw 
the computer through it in frustration. 

freeze - When your cursor becomes immovable 
on your screen, you can't type anything, your Mac 
locks up, and you get furious because you lose 
everything you've typed in the past ten minutes. 

function key- See FKEY. 

GIF- A kind of graphics file, most often used on 
America Online and the Internet. Requires a 
special program, such as the America Online 
program, to open and view it. 

gig- Short for gigabyte (GB), which is 1024 
megabytes, or a very big hard drive. 
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grayscale - A form of color image or color 
monitor on which all the colors are different 
shades of gray, like all the images in this book. 

hard copy -A synonym for printout. A term 
used primarily by the kind of people who have car 
phones and say, "Let's interface on this." 

hard disk -A hard drive. 

hard drive -A hard disk. That is, the spinning 
platters, usually inside your Mac but also 
available in an external form, that serve as a giant 
floppy disk where your computer files get stored. 

hardware - The parts of your computer 
experience that you can feel, touch, and pay for. 
Contrast with software. 

highlight - To select, usually by clicking or 
dragging with the mouse. In the Mac world, text 
and icons usually indicate that they're selected, 
or highlighted, by turning black. 

icon -A teensy picture used as a symbol for a 
file, a folder, or a disk. 

ink-jet printer- A printer that sprays little jets of 
ink onto your paper to create an image. 

insertion point- In word processing, the short, 
blinking vertical line that's always somewhere in 
your text. It indicates where your next typing (or 
backspacing) will begin. 

+ The insertion point is right before thisjword. 

Internet - The worldwide network of computers 
joined by phone lines. Incorporates the World Wide 
Web, e-mail, and other features (see Chapter 13). 

JPEG -Another graphics-file format found most 
often on America Online and the Internet (see 
G/F). This one has higher quality. 

K - Short for kilobyte, a unit of size measurement 
for computer information. A floppy disk usually 
holds BOOK or 1400K of data. All the typing in this 
book fills about 1500K. A full-screen color picture 
can be around IOOOK of information depending on 
the format it's stored in. When your hard disk gets 
erased accidentally, it's got OK (that's not Okay). 

kerning - In type-intensive Mac work, such as 
creating a newspaper headline, the act of 
squishing two letters slightly closer together to 
make better use of space so that you can fit the 
phrase AN ALIEN FATHERED MY TWO-HEADED BABY 
on one line. 

label - A System 7 text tag or color tag, used to 
identify icons by category. 

landscape - Used to describe the sideways 
orientation of a piece of paper. Also the natural 
environment outdoors that you gradually forget 
about as you become addicted to the Mac. 

laser printer - An expensive printer that creates 
awesome-looking printouts. 

LCD - The technology that creates the flat 
screen on the PowerBook laptop computer, 
marked by the tendency for the pointer to fade 
out if it's moved too quickly. Stands for either 
Liquid Crystal Display or Lost the Cursor, Dammit. 

logic board - The main circuit board inside your 
Mac. Often at fault when your Mac refuses to tum on. 

Mac OS- The System software (the behind-the­
scenes operating software) that makes a com­
puter act like a Mac. As distinguished from DOS or 
Windows. 

macro - A predefined series of actions that the 
Mac performs automatically when you press a 
single key- such as launching your word 
processor, typing Help! I'm being Inhabited by a 
Mac poltergeist!, and printing it- all by itself. 
Requires a special macro program such as 
QuicKeys or Tempo. 

mall merge - Creating personalized form letters 
with a word processing program. Considered to 
be perfectly polite unless somebody catches you. 

math coprocessor- The kid whose algebra 
homework you used to copy. (Just kidding.) 
Actually, a specialized chip inside certain high­
level Macs that kicks in to handle certain very 
intense number-crunching tasks -data analysis 
and stuff. Does nothing for word processing and 
other normal tasks. Also called an FPU (floating­
point unit). On newer chips, the math copro­
cessor is no longer a separate chip; Instead, it's 
built into the CPU. 
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MB - Short for megabyte. 

megabyte - A unit of disk-storage space or 
memory measurement (seeK). Used to measure 
hard disks, memory, and other large storage 
devices. There are 1024K in a megabyte. 

memory- The electronic holding area that 
exists only when the Mac is turned on; where your 
document lives while you're working on it. 

menu -A list of commands, neatly organized by 
topic, that drops down from the top of the Mac 
screen when you click the menu's title. 

menu bar- The white strip, containing menu 
titles, that's always at the top of the Mac screen. 
Not to be confused with bar menu, which is a 
wine list. 

modem -A phone attachment for your Mac that 
enables you to send files and messages to other 
computer users all over the world, and prevent 
anyone else in the house from using the phone. 

modifier keys - Keys that mess up what the 
letter keys do. Famous example: the Shift key. 
Other examples: 3C (Command), Option, Control, 
and Caps Lock. 

monitor- What you should do to your blood 
pressure when you find out how much computer 
screens (monitors) cost and weigh. 

motherboard -See logic board. 

mouse button - The square or rounded plastic 
button at the far end of the top of the mouse. 

multimedia - Something involving more than 
one medium, I guess. On the Mac, anything that 
gives you something to look at and listen to, such 
as a CD-ROM game. 

network- What you create when you connect 
Macs to each other. A network lets you send 
messages or transfer files from one Mac to 
another without getting up and running down the 
hall with a floppy disk in your hand (a networking 
system fondly called SneakerNet). 

NuBus- The special kind of expansion slot (see 
expansion slot) found in any Mac 11-style computer 
and most Quadra-style computers. Contrast with 

PDS, the slot in a Macintosh LC, or PC/, the slot in 
the most-recent Power Macs. (And no, there was 
never an OldBus.) 

NumLock- A goofy key, named by numskulls, on 
the keyboard. Pretty much does nothing except in 
Microsoft Word, where it switches the functions of 
the keys in the number pad. 

OCR- Short for optical character recognition. You 
run an article that you tore out of Entertainment 
Weekly through a scanner, and the Mac translates 
it into a word processing document on your 
screen, so you can edit it and remove all refer­
ences to Cher. 

online- Hooked up, as in "Let's get this 
relationship online." In Mac lore, it means hooked 
up to another computer, such as America Online. 

painting program- (1) A program with the word 
Paint in the title (for example, MacPaint or 
UltraPaint) that creates artwork by turning individual 
white dots black on the screen. (2) An adult­
education course for would-be watercolorists. 

paste - To place some text or graphics (that you 
previously copied or cut) in a document. 

PC - Stands for personal computer, but really 
means any non-Macintosh (i.e., inferior) com­
puter; an IBM clone. 

PDS - Stands for processor direct slot and is the 
kind of expansion slot (see that entry) in a Mac LC. 
Incompatible with NuBus (see that entry, too). 

peripheral- (1) Any add-on: a printer, scanner, 
CD-ROM drive, dust cover, and so on. (2) The kind 
of vision by which you see your spouse leaving you 
forever because you're too consumed by the Mac. 

PICT -A confusing-sounding acronym for the 
most common kind of picture file, as in "Just 
paste that image of Sculley's head into your word 
processor, Frank; it's only a PICT file, for heaven's 
sake." 

pixel - One single dot out of the thousands that 
make up the screen image. Supposedly derived 
from picture element, which still doesn't explain 
how the x got there. 
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pop-up menu- Any menu that doesn't appear at 
the top of the screen. Usually marked by a down­
pointing black triangle. Doesn't actually pop up; 
usually drops down. 

Paper:! us Letter·~ 

Layout:! 1 Up •I 

port - A jack or connection socket in the back of 
your Mac. 

portrait- A right-side-up piece of paper; the 
opposite of landscape (see that entry). Also a 
right-side-up monitor that can display a full page 
(as in "a portrait display monitor"). 

PostScript- A technology, a printer, a trademark, 
a kind of font, a computer code language for 
displaying or printing text or graphics, a way of 
life. All of it means high-quality type and graphics, 
and all of it means heaping revenue for Adobe, the 
company that invented it. 

PowerBook -A Mac laptop and the first of many 
Apple trademarks to contain the word Power. 

Power Macintosh -A Mac whose primary brain 
is the PowerPC chip. 

PowerPC chip- The very fast main processor 
chip inside a Power Macintosh. 

PowerTalk- A special feature of System 7 .5, 
designed for very sophisticated network setups in 
offices. Provides a desktop mailbox icon for 
electronic messages sent to you by your 
officemates (and may someday also be able to 
receive your messages from services such as 
America Online). Absolutely impossible to figure out. 

PRAM -Parameter RAM: the little piece of 
memory maintained by your Mac's battery. Helps 
explain why the Mac always knows the date and 
time even when it's been turned off. 

printer font - The printer half of a PostScript 
font (the other half is the screen font). Must be in 
your System Folder, and you must have one 
printer font for each style (bold, italic, and so 
on). An eternal nuisance. 

PrintMonitor- A program that launches itself, 
unbidden, whenever you try to print something 
when background printing is turned on (see 

background printing). PrintMonitor is also the 
program that tries to notify you when something 
goes wrong with the printer, such as when a piece 
of paper gets horribly mangled inside. 

program -A piece of software, created by a 
programmer, that you buy to make your Mac do 
something specific: graphics, music, word 
processing, number crunching, or whatever. 

Publish and Subscribe - A fancy new version of 
copy-and-paste that's part of System 7. Lets you 
paste information (such as a graphic) from one 
document into another (such as a memo) in such 
a way that when you make a change in the original 
(the graphic), the copy (the memo) is changed 
automatically. 

QuickTime- The technology (and the little 
software extension) that permits you to make and 
view digital movies on your Mac screen. Does 
nothing by itself; requires QuickTime recording, 
playing, and editing programs. 

QuickTime VR - A special kind of QuickTime 
movie that enables you to change the camera 
angle of a still photo by dragging your cursor 
around inside the picture. Increasingly common 
on the World Wide Web. 

quit - To exit or close a program, removing it from 
memory. Or to exit or close your job, having 
gotten sick of working in front of a computer all day. 

radio button - What you see in groups of two or 
more when the Mac is forcing you to choose 
among mutually exclusive options, such as these: 

A system error has occurred. What result 
would you like? 

0 Loud, static buzzing 
® Quietly blink to bl8ck 
0 A two-minute fireworks display 

RAM- Term for memory (see memory) designed 
to intimidate non-computer users. 

RAM disk - A way to trick the Mac into thinking 
that it has an extra floppy disk inserted. The RAM 
disk is actually a chunk of memory set aside to 
resemble a disk (complete with an icon on the 
screen). A built-in option on most Macs and 
PowerBooks. 
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reboot - Restart. 

rebuilding the Desktop - One of several 
desperate methods that you can use in the event 
that something screwy goes wrong with the Mac. 
Involves holding down the 3C and Option keys 
while the Mac is starting up. 

resize box - The small square in the lower-right 
corner of a window that, when dragged, changes 
the size and shape of your window. 
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RISC - Stands for reduced instruction-set comput­
ing and means a very fast processor chip, such as 
the PowerPC chip inside a Power Macintosh. 

ROM - A mediation mantra that you can use 
when contemplating the ROM chips, where the 
Mac's instructions to itself are permanently etched. 

sans serif - A font, such as Helvetica or Geneva, 
with no little "hats" and "feet" at the tip of each 
letter. 

scanner - A machine that takes a picture of a 
piece of paper (like a photocopier) and then 
displays the image on your Mac screen for editing. 

Scrapbook - A desk accessory, found in your • 
menu, used for permanent storage of graphics, 
text, and sounds. (Not the same as the Clipboard, 
which isn't permanent and holds only one thing at 
a time.) To get something into the Scrapbook, 
copy it from a document, open the Scrapbook, 
and paste it. To get something out of the Scrap­
book, use the scroll bar until you see what you 
want, and then copy it (or cut it). 

screensaver- A program (such as After Dark) 
that darkens your screen after you haven't 
worked for several minutes. Designed to protect 
an unchanging image from burning into the 
screen, but more often used as a status symbol. 

scroll bar - The strips along the right and 
bottom sides of a Mac window. When a scroll 
bar's arrows, gray portion, or little white (or gray) 
square are clicked or dragged, a different part of 
the window's contents heaves into view (scrolls). 
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serif (n., adj.) - A term used to describe a font 
that has little ledges, like little "hats" and "feet," 
at the tip of each letter, such as Times or this font. 

shareware - Programs that are distributed for 
free, via an electronic bulletin board or on a 
floppy disk, from user groups. The programmer 
requests that you send $10 or $20 to him or her, 
but only if you really like the program. 

Simple Text - An extremely basic word processor 
that comes free with every Mac. 

slot - An expansion slot (see that entry). 

software - The real reason you got a computer. 
Software is computer code, the stuff on disks: 
programs (that let you create documents) and 
documents themselves. Software tells the 
hardware what to do. 

startup disk - A startup disk is a floppy or hard 
disk that contains a System Folder. The startup 
disk is the one that you designated to be in 
control (in the event that you have more than one 
to choose among). The Startup Disk control panel 
is what you use to specify the startup disk. 

System 6 - An older version of the Mac's 
controlling software. Faster, but harder to use, 
than System 7. Requires 1MB of memory or less. 

System 7 - The more recent version of the Mac's 
controlling software. More attractive, easier to 
use, more powerful, and slower than System 6. 
Requires at least 2MB of memory and, because it's 



a lot of software, a hard disk (it doesn't fit on a 
floppy). Generically, refers to any flavor of System 
7: Version 7.0, 7.1, 7.5, or whatever. 

System 7.1- The first version of the Mac System 
software that's not free; you have to buy it. Adds 
two features to System 7: a Fonts folder, which 
contains all manner of font files (TrueType, 
screen fonts, and printer fonts); and WorldScript, 
which enables you to convert all Mac screen 
elements to a different language, such as Japa­
nese. (WorldScript requires special drop-in 
language modules.) 

System 7.5- Another version of the System 
Folder, which, again, you must purchase unless 
your Mac came with it. Under the hood, System 
7.5ls much the same as System 7.1. But it comes 
with about 50 new control panels and extensions 
that perform stunts such as giving submenus to 
your ti menu to providing a floating "control 
strip" for your PowerBook. 

System 7.6 - Yet another version of the System 
folder, but referred to as Mac OS 7.6. 

System 8.0- (Mac OS 8) The latest (as of this 
printing) version of the System folder. Yes, you'll 
have to purchase this if your computer didn't 
come with the software; nothing's free these days! 
It comes with tons of new enhancements. Check 
out Chapter I for all the details. 

System crash - When something goes so wrong 
inside your Mac that a bomb appears on the 
screen with the message "Sorry, a System error 
has occurred" - or not. Sometimes, the whole 
screen just freaks, fills with static, and makes 
buzzing noises, like a TV station that's going off 
the air. 

System disk- A startup disk (see that entry). 

System file - The most important individual file 
inside a System Folder. Contains the Mac's 
instructions to Itself, and stores your fonts, 
sounds, and other important customizatlon 
information. A Mac without a System file is like a 
broke politician: It can't run. 

System folder- The all-important folder that the 
Mac requires to run. Contains all kinds of other 
stuff that's also defined in this glossary: the 
System file, the Finder, fonts, desk accessories, 
printer fonts, and so on. 

TIFF- Stands for tagged image file format and is 
the kind of graphics-file format created by a 
scanner. 

title bar- The strip at the top of a window where 
the window's name appears. Shows thin horizon­
tal stripes if the window is active (in front of all 
the others). 

toner- The powder that serves as the "ink" for a 
laser printer. Runs out at critical moments. 

trackball -An alternative to the mouse. Looks 
like an 8-ball set in a pedestal; you roll it to move 
the pointer. 

True Type - A special font format from Apple 
that ensures high-quality type at any size, both on 
the screen and on any printer. Rival to PostScript, 
but costs much less (nothing, in fact; it comes 
with System 7). 

upload - To send a file to another computer via 
modem. See also download. 

user group - A local computer club; usually 
meets once a month. Serves as a local source of 
information and as a place to unload your 
obsolete equipment to unsuspecting newcomers. 

video card - A circuit board that most Mac 11-
series Macs need to display anything at all on the 
monitor. On some Macs, it's just for Video In. 

VRAM - Stands for video RAM. Memory chips 
inside your Mac that are dedicated to storing the 
screen picture from moment to moment. The 
more VRAM you have, the more colorful your 
picture (and the more you paid for your Mac). 

window- A square view of Mac Information. In 
the Finder, a window is a table of contents for a 
folder or a disk. In a program, a window displays 
your document. 

WYSIWYG - Short for what you see is what you 
get- one supposed reason for the Mac's 
superiority over other computers. Theoretically 
means that your printout will precisely match 
what you see on the screen (but isn't always 
true). 

zoom box- The tiny square in the upper-right 
corner of a window (in the title bar) that, when 
clicked, makes the window jump to full size. 
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About the CD 
OOOOOOO~OOOOOOOOOGOOOOOOOOOOOOOOOOOOOOOOOOOOOOOO 

1n the first edition of this book, a measly 1.4MB floppy disk greeted 
readers from its pocket inside the back cover. The 2nd edition featured a 

shiny CD-ROM packed with tons of neat stuff! And now in this 3rd edition, 
the CD graduates to new greatness with all kinds of fresh ideas. The Macs for 
Teachers CD is filled with an assortment of demonstration versions of com­
mercial software, ClarisWorks templates, fonts, clip art, and an ample supply 
of quick reference documents for application in the classroom and lab. 

To access the software on this CD, you can use the wonderfully simple CD 
interface called the Activity Board. On the Activity Board you find books 
stacked against a chalkboard. Each book represents a category of software 
that you can access with a simple mouse click on the note. You can read 
more about the Activity Board in the section "Using the Activity Board," 
later in this appendix. 

SIJ.stem Requirements 
Before using the CD, make sure your Mac meets the following system 
requirements: 

~ You need a CD-ROM drive - double-speed or faster. 

~ Your Mac needs a 68030, 68040, or PowerPC processor. 

~You need to be running your computer with System 7.1 or higher 
(System 7.5 is recommended). 

~ You need at least 4MB of free RAM for most programs. (Free RAM is the 
amount of memory available to the Mac when no other programs are 
running. You can check your available memory by clicking on the Apple 
menu in the Finder and choosing About This Macintosh.) In some 
cases, turning on virtual memory can help if you're a little short of 
memory, but some demos may run erratically. 

~ Make sure you have a monitor that's capable of displaying at least 256 
colors or grayscale. 

J" If you want to sign on to AT & T WorldNet Service (using the software 
available on the CD), you need a modem connected to your computer. A 
modem speed of at least 14,400 bps is recommended. 



V' You also need about 4MB of hard disk space available (so you can 
install Adobe Acrobat Reader 3.0). You need this software if you want to 
open, read, or print the electronic documents found in the Macs For 
Teachers PDF Files folder, located in the Resources folder on the CD. 
These documents include the software lists found in Appendix B, an 
Acceptable Use Policy for Internet activity, quick reference printouts of 
all the ClarisWorks clip art, Student Writing Center clip art, and Kid Pix 
graphics (a big help when it comes to planning student projects before 
the kids actually sit down at the computer). 

V' You need up to 65MB of additional hard disk space to install most of the 
demos and free software on the CD. I say "most" because there are 
some demos which are primarily for your information only. That is, you 
won't gain anything from copying these movie-like demos 

V' You also need QuickTime 2.0 or later installed on your computer to run 
some of the demos. QuickTime, basically, is software that helps your 
computer play tiny movies. This software is available on our CD as part 
of the World Discovery Demo software. Please see the "Installing 
Support Software," later in this appendix, to install the QuickTime 
software. You can also download the latest version of QuickTime (as of 
this writing, Version 2.5) from Apple's QuickTime World Wide Web 
home page at http: I /qui ckti me. apple. com. 

Installation Instructions 
To install the items from the CD to your hard drive, follow these steps: 

I. Insert the CD into your computer's CD-ROM drive. 

2. Double-click the CD icon when it appears on your desktop. 

3. Double-click the Activity Board icon. 

The Activity Board opens up, showing you the license agreement. 

4. Since you surely want to use the CD, read through the license agree­
ment, nod your head, and then click on the Accept button. 

From here, the CD interface appears. The CD interface enables you to 
run or install the programs on the CD without wading through layer 
after layer of folders. 

The software on the interface is divided into categories whose names 
you see on the screen. 

5. To view the items within a category, just click the category name. 

A list of programs in the category appears. 
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6. For more information about a program, click on the program name. 

Be sure to read the information that's displayed. Sometimes a program 
requires you to do a few tricks on your computer first, and this screen 
tells you where to go for that information, if necessary. 

7. To install a program or run a demo, click the Continue button. If you 
don't want to install the program, click on the Cancel button to 
return to the previous category screen. 

Once you click on a Continue button, the CD interface drops to the 
background while the CD begins installing the program or running the 
demo. 

When installation is done, the interface usually reappears in front of 
other open windows. Sometimes the installation confuses the Mac and 
leaves the interface in the background. To bring the interface forward, 
just click once anywhere in the interface's window. 

8. To move back to the category screen from a program list, click the 
Go Back button. 

9. When you're done installing programs, click on the Quit button to 
close the interface. 

You can eject the CD now. Carefully place it back in the plastic jacket of 
the book for safekeeping. 

To run some of the programs, you may need to keep the CD inside your 
CD-ROM drive. This is a Good Thing. Otherwise, the installed program 
requires you to install a very large chunk of the program to your hard drive, 
which prevents you from installing other software. 

Installation Steps for Support Software 
To use some of the demos, you need to install QuickTime software. 

If you aren't sure whether you have QuickTime on your computer, you can 
check by looking in the Extensions folder. If you have QuickTime already 
installed, you find several files with names such as QuickTime or QuickTime 
Musical. If QuickTime's nowhere to be found, you need to install it before 
you try to run demos from the CD. 

To install QuickTime 2.0, follow these steps: 

1. Insert the CD into your Mac's CD-ROM drive and double-click the CD 
icon when it appears on your desktop. 

2. Double-click the Classroom folder. 

3. Double-click the Great Wave Software folder. 



4. Double-click the World Discovery Deluxe Demo folder. (The leon 
looks more like a globe than a folder, by the way.) 

5. Double-cllck the QuickTime Installer icon. 

Follow the installer's brief instructions. You need to restart your Mac 
after installation is complete. 

To begin exploring the CD, just double-click the Activity Board icon from the 
Macs For Teachers CD window. 

The Software 
Here's a brief description of the demos and free software available on the 
Macs For Teachers CD. Be sure to pay attention to any special requirements 
for the demos: Some demos work better if you copy them from the CD first. 
And you may need to think carefully before installing some software. 

Acrobat PDF Resources: When I needed more room for the 3rd edition 
"stuff," I just couldn't part with any of the chapters that were original to the 
1st and 2nd editions of this book- so I simply moved them to the CD! Yep, 
the following PDFs were actual chapters in Macs for Teachers, 1st and 2nd 
editions: More Cool ClarisWorks Stuff, Hot Topics in Education, Top 10 
Sources for Mac Info, Mac Activities, and The Lists. When you open these 
files, they look just like pages from the book - very easy to read! 

I also include PDFs that are useful resources for clip art found in ClarisWorks, 
HyperStudio, Kid Pix, and The Student Writing Center. And finally, I provide an 
Acceptable Use Policy for Internet access that you can use as a model for 
handling the legalities of students accessing the Internet. To read the files, you 
need to install Adobe Acrobat Reader, which is on the CD. 

Adobe Acrobat Reader 3.0, from Adobe Systems Inc.: Adobe Acrobat 
Reader 3.0 enables you to view documents with the same graphics and 
formatting that the documents contained when they were created - without 
having the original application. Miraculous! Acrobat Reader 3.0 also includes 
a plug-in for Netscape Navigator, which enables you to view Acrobat Reader 
documents within a Web page. 

AT&T WorldNet Service: If you don't have access to the Internet and the 
World Wide Web, you can sign up for an Internet account with AT&T 
WorldNet Service, which includes two popular and prevalent Web browsers: 
Nets cape Navigator and Microsoft Internet Explorer. AT & T WorldNet Service 
is a pay-per-use Internet service provider. To sign on, you need a modem 
connected to your computer, a phone line, and a credit card to register. 
Note: If you currently use another Internet service provider, be aware that 
installing AT & T WorldNet Service software may change your computer's 
Internet software configurations. You may not be able to access the Internet 
through your original provider after you install AT & T WorldNet Service. 
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3D Atlas Demo, from Creative Wonders: This demo describes and demon­
strates 30 Atlas, a cool geographic and scientific reference with full motion 
video and animation. If you can't run this demo from within the Activity 
Board, exit the Activity Board, open the Classrooms folder, open the Cre­
ative Wonders folder, and double-click the AtlasDemo icon. 

Clarls Home Page 2.0, from Clarls Corporation: Claris Home Page is a new 
program that makes it easy for you to design and create pages for the World 
Wide Web without knowing much about HTML, the webmaster's program­
ming language. This trial version expires 30 days from installation to your 
computer. 

ClarlsWorks 4.0 Trial, from Clarls Corporation: ClarisWorks is a program 
that integrates a word processor, a spreadsheet program, drawing and 
painting programs, a database, and communications program into a single, 
easy-to-use package. This trial version cannot save files, and some key 
utilities are unavailable. 

ClarlsWorks for Kids: ClarisWorks for Kids is a scaled-down version of my 
all-time favorite software package, ClarisWorks. An icon-based interface 
that's easy to manipulate is just the beginning of the wonder. This program 
has an Art Pad (drawing), Writing Pad (word processing), List Pad (data­
base), and Graphing Pad (spreadsheet). In addition, there are hundreds of 
great clip art images, "kid fonts," lined paper, an easy-to-understand filing 
system, an Internet link, and tons of great templates. 

ClarlsWorks Templates and clip art: I gathered up several ClarisWorks 
template documents you may find useful. In addition, the ClarisWorks Users 
Group and K-12 MicroMedia Publishing have generously provided additional 
templates and clip art for your work. Special Requirements: If you don't 
have a full working version of ClarisWorks on your computer, you can use 
the ClarisWorks 4.0 Trial software to view the templates. To get any real use 
out of the templates, however, you may need to purchase the full version of 
Claris Works. 

Easy Grade Pro Demo, from Orbis Software: This versatile grade-book 
program demo tracks up to 12 students before limiting some of its features. 
Easy Grade Pro can also record attendance, book numbers, behavior, 
seating, parent contacts, and more. 

Fonts: Dracula Font, from Mountain Lake Software, and SigSchoolllnes, 
from Signature Software: If you like spooky-looking fonts, Dracula Font is for 
you. And, remember how you learned to draw your alphabet in school? 
SigSchoolLines shows each character surrounded by those horizontal-line 
guides that sprawl across chalkboards. Special Requirements: Before you can 
install any fonts on your Mac, quit all programs running in the background. 



FoolProof Security Demo, from SmartStuff Software: FoolProof Security is 
designed for the school environment. It protects the configuration of 
computers in a multi-user setting by preventing users from dragging, 
renaming, or deleting files. FoolProof Security also disables file-altering 
items on the hard disk, directs file saves to specific locations, and more. 
This demo has disabled the hard disk locking feature, but all other features 
are accessible. Special Requirements: You need a password to install both 
the FoolProof documentation and software. Please call SmartStuff at 800-671-
3999 to get your password before you try to install FoolProof. Don't install 
this software until you understand exactly how to operate it, or you may 
accidentally lock out features on your computer. Note: This demo is not 
compatible with the Desktop Printing software available on some comput­
ers. See the FoolProof Read Me document for more information on disabling 
this software. 

Grady Prome Demo, from Aurbach & Associates: This demo shows how you 
can keep portfolios of your students' work. Grady Profile saves students' text, 
graphics, sounds, pictures, and movies. You can also annotate any part of the 
portfolio and add evaluations. This demo allows you to use the portfolio 
included with the demo, but won't let you make other portfolios. 

HyperStudio Journal Sampler, from Simtech Publications: HyperStudio 
Journal is a valuable resource for techniques, artwork, sounds, buttons, clip 
art, and more for your HyperStudio work. This sample issue provides you 
with some goodies from past editions. 

HyperStudio Mini-Preview, from Roger Wagner Publishing: HyperStudio is 
a full-featured multimedia authoring program. This mini-preview demo 
enables you to save any new projects (maximum of four cards). Because this 
mini-preview version of HyperStudio allows you to import and export 
screens without any limitations, the software can also be used as a painting 
program. And, if you have a video digitizer handy, you can use HyperStudio 
to capture and edit your work. Special Requirements: The Activity Board 
will install a "working copy" of the HyperStudio program. The working copy 
requires only 14MB for the entire program! You need to have the CD in the 
CD-ROM drive to use the working copy. 

Inspiration: Originally designed for use in the wonderful world of business, 
this concept- mapping software is now even more popular among educators. 
With simple mouse clicks, Inspiration makes it easy for teachers to create 
great story webs, lesson plans, concept maps, flowcharts, outlines, semantic 
maps, and more. Students can use Inspiration to map out reports, presenta­
tions, multimedia projects, and study guides. There's also an integrated 
outline view that enables students to make the connection between the 
visual organization of ideas and the actual outline. 



Appendix E: About the CD 3!, 5 
Kid Pix Studio Interactive, from Broderbund Software: This presentation 
tells you about the Kid Pix series of authoring programs for children. If you 
can't run this demo from within the Activity Board, exit the Activity Board, 
open the Classroom folder, open the Broderbund folder, open the Kid Pix 
Studio folder, and double-click the Kid Pix Studio Interactive icon. 

KidsTime Deluxe Sample Demo, from Great Wave Software: This demo 
contains five entertaining programs that introduce young children to comput­
ers and early learning skills. The demo enables you to try out any of the 
programs for up to 3 minutes at a time before returning you to its launcher. 

little Planet Demo, from Anchored Instruction: Part of the Literacy series 
from Anchored Instruction, this interactive demo shows how children can 
author their own "books" - complete with music and voice annotation. If 
you can't run this demo from within the Activity Board, exit the Activity 
Board, open the Classroom folder, open the Anchored Instruction folder, and 
double-click the Little Planet Demo icon. 

MakeTest Demo, from Mountain Lake Software: This is a demo of Mountain 
Lake Software's test-generation program. This demo has disabled its preview 
function, and the word "DEMO" will appear at the top of your printouts. 

MayaQuest Demo, from MECC: MayaQuest is a world exploration project 
that directly contacts students in the classroom to discuss archeological, 
historical, and geographical finds in Central America. This non-interactive 
demo tells you more about the commercial educational software that 
enables a player to tour Central America by bicycle and uncover the myster­
ies of the Mayan culture. If you can't run this demo from within the Activity 
Board, exit the Activity Board, open the Classroom folder, open the MECC 
folder, and double-click the MayaQuest icon. Virtual memory might conflict 
with this software. If you experience system freezes when attempting to run 
this software, try turning virtual memory off from the Memory control panel. 

My Secret Mac Diary, from Super School Software: In addition to what its 
name implies, My Secret Mac Diary can also let kids record addresses, 
school assignments, and more. Special Requirements: To change the 
password or enter into the Diary, type in TEACHER. 

Plan To Teach Demo, from Mountain Lake Software: This is a demo of 
Mountain Lake Software's versatile lesson-planning program. In addition to 
lesson plans, Plan To Teach can also store special information for substitute 
teachers, seating chart tools, and more. This demo does not support 
printing, templates, or document creation. 

The Print Shop Deluxe Demo, from Broderbund Software: This is demo of 
the venerable greeting card and poster-making software program. You can 
make just about anything you want, but the demo cannot save your work. 
This demo program might show some problems running on Power 
Macintosh or compatible systems. 
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Science Sleuths Demo, from Vldeodiscovery: The Science Sleuths series of 
products is introduced in this interactive demo. Children can examine and 
make scientific tests to solve various mysteries. This demo allows you to 
participate a little bit in such a quest. If you can't run this demo from within 
the Activity Board, exit the Activity Board, open the Classrooms folder, open 
the Videodiscovery folder, open the Resources folder, and double-click the 
Science Sleuths Demo icon. 

World Discovery Deluxe Demo, from Great Wave Software: Learn about 
geography, national anthems, and landmarks; view satellite imagery and 
detailed maps, and more. This demo includes 3 of the 69 maps included with 
the full version. If you can't run this demo from within the Activity Board, exit 
the Activity Board, open the Classroom folder, open the Great Wave Software 
folder, open the World Discovery Deluxe Demo folder (it looks more like a 
globe than a folder), and double-click the World Discovery Demo icon. 

If You'fle Got Problems (of the CD Kind) 
We tried our best to compile demo programs that will work on most Macs 
with about 8MB of RAM. Alas, some programs may not work for some 
reason. The likeliest problem is that you have only 8MB of real RAM, but 
don't have certain settings turned on. If you get "low of memory" messages, 
try these tips. 

Ill' Open the Memory control panel, and make sure that 32-bit addressing 
is switched on (especially if you have more than 8MB of real RAM on 
your computer), and that virtual memory (VM) is switched on. Demos 
that show QuickTime movies may run in a jerky fashion with VM 
running, however. You need to restart the computer after changing 
these settings. 

~ Disable unneeded system extensions that eat up memory. System 7 .S.x 
users can use the Extensions Manager to do this; users of System 7.1 or 
earlier need to open their System Folder, open the Extensions folder, 
then move the unneeded extensions out of the folder. Restart your 
computer afterward. 

If you have a problem using the Activity Board, or if you have difficulty 
running the programs from the CD that we don't resolve here, please call the 
lOG Books Worldwide Customer Service phone number: 1-800-762-2974. 
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conventions, used In book, 6-7 
converters, TV /monitors, 223 
copy,331 
copyrights, software, 70 
corporate sponsors, computer 

funding, 242 
Countdown, 292 
Counting on Frank. 282 
CPU (central processing unit), 331 
crash, 331 
Creative Wonders, 281-282,287,290 
creativity software, 295 
criteria, database search, 143 



Critical Mass: America's Race to 
Build the Atomic Bomb, 286 

critical thinking software, 293-294 
Crosscountry USA, 289 
Crossword Creator, 298 
CRT (cathode ray tube), 331 
The Cruncher, 282 
curly quotes, versus straight 

quotes, 116 
cursors, 331 

I-beam, 97 
Insertion point, 97 
mouse pointer, 13 
spllling paint, Kid Pix, 156 

custom Install, printer drivers, 61 
CyberCrafts: Hands-On-Learning Fun 

With Electronics, 285 

•D • 
databases, 137-148,331 

check boxes, 85 
ClarisWorks Version 4 enhance-

ments, 84-85 
class-list, 137-141 
columnar lists, 144-146 
described, 137 
field creation, 138-139 
field text entry conventions, 

140-141 
mall merge documents, 146-148 
names field, 85 
naming when saving, 141 
pop-up menus, 85 
printing, 141 
printing mall merge 

documents, 148 
radio buttons, 85 
record info field, 85 
record navigation, 142 
saving, 141 
searches, 142-143 
selecting from ClarisWorks 

menu, 138 
serial number field, 85 
sorting records, 143-144 
uses, 137 

Davidson & Associates, Inc. 
Alge-Biaster 3, 283 
The Cruncher, 282 
Fisher Price Sing Along: Barnyard 

Rhythm and Moos, 291 
Flying Colors, 295 
Grammar Games, 279 
Math for the Real World, 283 
The Multimedia Workshop, 

292-293 
VItal Links, 283 
Word Attack 3, 279 
Your Personal Trainer for 

the SAT, 296 
decimal tabs, setting, 114 
Decisions, Decisions: The Environ­

ment, 226 
dedicated lines, modem communica­

tions, 196 
default, 331 

Define Database Fields dialog 
box, 139 

defragment, 331 
Delete key, 97-98, 133, 331 
descending order, database 

sorts, 144 
deselect, 331 
desktop, 16-19,35-54,331 

folder creation, 36, 38 
menus, 35 
moving Trash, 52 
opening folders from, 102 
protection programs, 50-51 
relocating Icons, 17 
saving documents/files to, 102-103 
saving files to, 89 

desk accessories 
AppleCD Audio Player, 42 
Automated Tasks, 42 
Calculator, 42 
Chooser, 42 
Control Panels, 42 
Find File, 42 
Jigsaw Puzzle, 42 
Key Caps, 42 
Notes Pad, 42 
Recent Documents, 42 
Recent Servers, 42 
Scrapbook, 42 
Shut Down, 42 
SimpleSound, 42 
Stickles, 42 

Desktop file 
described, 331-332 
rebuilding, 318 

desktop publishing, 332 
devices, SCSI, 321 
dialog boxes, 64, 332 
dictionaries, adding words to spell 

checker, 92 
Didatech, Crosscountry USA, 289 
digital cameras, 245-246 
digital tablet, 249 
digitize, 332 
digitizing board, 332 
DIMMs (dual in-line memory 

modules), 332 
DlnoPark Tycoon, 289 
The Discovery Channel, Nile: 

Passage to Egypt, 289 
Disk Cache, 308, 332 
disk drive, 332 
DlskExpress, 327 
DlskFlt, 109 
disks, 332 

one-Mac classroom require-
ments, 221 

opening documents from, 106-107 
renaming, 51 
saving to, 89 
selling to raise funds, 241 
versus memory storage, 100 

Display dialog box, 129 
DK Multimedia 

Cartopedla, 287 
My First Amazing World 

Explorer, 284 

Index 

My First Incredible Amazing 
Dictionary, 291 

document exchange, computer 
funding, 240 

documentation, 332 
documents, 332 

avoiding underline as 
emphasis, 115 

backing up to a floppy disk, 109 
changing font style/size, 113 
character formatting, 112-113 
citing Internet resources, 214 
copying/pasting graphics, 120 
cutting/copying/pasting Clipboard 

text, 116 
desktop folder, saving to, 102-103 
e-mail attachments, 198 
first time save, 100-107 
floppy disk, saving to, 89, 105 
folder, saving to, 89 
font styles, 115 
Insertion point location, 97 
lesson-plan template, 122-124 
letterheads, 117-122 
mall merge, 146-148 
naming when saving, 101 
openlng,87-88, 106-107 
page numbers, 116 
paragraph formatting, 113-114 
picture Insertion, 161 
resaving, 107 
save changes before closing 

message, 106 
saving as Stationery, 86, 107-108, 

120-122 
scroll bar/box navigation, 115-116 
selecting entire, 109 
sizing/moving graphics, 119-120 
spell checking, 91-92 
Stationery creation, 236 
subfolder, saving to, 103 
text formatting, 110-111 
text Insertion, 97-98 
text selection techniques, 

98-100, 109 
viewing Invisible characters, 112 

donations, computer funding, 242 
DOS (Disk Operating System), 332 
dot-matrix printers, 55-56, 332 
dots per Inch (dpl), 332 
double-clicking, mouse technique, 19 
download, 199,332 
downloadable font, 332 
down-pointing triangles, menu 

command access, 37 
dpi (dots per Inch), 332 
drag,332 
dragging, mouse technique, 15 
drawing programs, Kid Pix, 

151-166,332 
Drawing, ClarlsWorks Version 4 

enhancements,85 
drawings, Kid Pix program creation, 

154-160 
drivers, 61, 332 
drives, 76, 251 
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dust covers, one-Mac classroom 
requirements, 221 

dynamite tool, cautions, 165 

•E• 
Eagle Eye Mysteries, 290 
early learning software, 290-292 
EasyBook, 278 
EasyGrade Pro, 132, 297 
EasyPhoto Reader, 254-255 
e-books (electronic storybooks) 

software, 280-281 
Edit menu 

Copy command, II 0 
Cut command, 110 
Paste command, 110 
Preferences command, 112, 168 
Select All command, 109 
Undo command, 99, 110 
Writing Tools command, 91 

editing strip, spreadsheets, 128 
Edmark,246,291-294 
education spreadsheets, 

described, 126 
Educational Insights Interactive, 

GeoSafari Multimedia, 283 
Educational Resources, 277 
educators 

Apple staff-development 
workshops, 255 

Mac Jab control guidelines, 
234-235 

multimedia lab, 74 
students as, 227 

edutainment, 71 
e-mail, 192, 198-199, 332 
e-mail addresses 

author, 7, 259 
IDG Books Worldwide, Inc., 7 

eMate, 222 
eMate 300, 252-253 
emotlcons, 200 
Encarta, 287 
Enter key, 333 
EPS file, 333 
eraser tool, Kid Pix, 157-158 
error messages, troubleshooting, 

303-306 
Ethernet, 333 
Excite, 211 
expansion slot, 333 
extended keyboard, 333 
extensions 

conflict resolution, 319-321 
conflict troubleshooting, 302-303 
described, 302, 333 
disabling on startup, 320 
memory requirements, 308 

Extensions folder, extension 
storage, 302 

external modems, 195 

•F• 
Fairfield Language Technologies, 

Rosetta Stone PowerPac, 288 
fax/modems, 244, 333 
faxes, student uses, 198 

Field Trip to the Sky, A, 286 
fields 

columnar report order, 146 
database types, 138-139 
mall merge selections, 147-148 
sort order selections, 144 
Tab key navigation, 140-141 

fifth-grade, 69-70 
File menu 

Duplicate command, 52 
Get Info command, 51-52 
Library command, 118 
Mail Merge command, 147 
Make an Alias command, 41 
New Folder command, 36, 38, 93 
Open command, 87-88, 106 
Page Setup commands, 62 
Print command, 63, 130 
Put Away command, 50,316 
Quit command, 105, 209 
Save a Picture command, 155 
Save command, 89, 100-101, 141 
Show Shortcuts command, 132 

File Sharing, 333 
files 

closing, 104 
Desktop, 318 
duplicating, 52 
e-mail attachments, 198 
first time save, 100-107 
naming when saving, 101 
opening, 87-88 
opening previously saved, 106-107 
re-saving, 107 
saving,89, 102-103,105 
Stationery, 120-122 

Find File, 42 
Find Request form, database record 

search, 142-143 
Finder, 16-19, 333 

described, 16 
opening folders from, 103 

fine arts software, 294-295 
First Connections: The Golden Book 

Encyclopedia, 287 
Fisher Price Sing Alongs: Barnyard 

Rhythm and Moos, 291 
FKEY, 333 
flaming, 200 
Flashlt, 224 
flat-file database, 333 
flip book, database navigation, 142 
floppy disks, 27-28, 48-50, 333 

backing up work to, I 09 
copying, 49, 52 
Eject Disk command versus Put 

Away command, 316 
ejecting properly, 50, 316 
ejecting when shutting down, 53 
initializing, 48-49 
manually extracting from drive, 

316-317 
naming conventions, 48 
opening documents from, 106-107 
opening files from, 87-88 
saving work to, 105 
storage capacity, 28 

troubleshooting, 316-317 
viewing contents, 49 

Flying Colors, 295 
folders, 36, 333 

closing, 39 
collapse/expand, 51 
copying floppy disk to/from, 49 
creating, 93-94 
creating on desktop, 36, 38 
dragging to Trash, 39 
Extensions, 302 
file hierarchy, 101-104 
Fun and Fantasy, 174 
naming conventions, 36, 38, 93-94 
Nice for Headings, 171 
opening from Finder, 103 
opening from the desktop, 102 
saving documents/files to, 102-104 
saving to, 89 
Startup Items, 316 
subfolders, 103 
System, 19,315 
untitled, 36 

Font menu, changing selected font 
type, 113 

fonts, 57-59, 333 
changing selected, 113 
limiting styles In documents, 115 
loading new, 59 
newsletters, 172, 177 
sizing, 113 
spreadsheets, 130 
teacher additions, 253-254 

FoolProof, 50-51, 234, 298 
force quitting (31:-0ptlon-Esc), 

302,319 
The ForeFront Group, Inc., 

WebWhacker,215,296 
foreign language software, 288 
Forest Technologies, 254, 294, 298 
Format menu 

Alignment command, 130 
Color command, 130 
Column Width command, 127, 134 
Font command, 130 
Insert Footer command, 116 
Insert Header command, 116, 130 
Row Height command, 134 
Size command, 130 

forms, Find Request, 142-143 
FPU. See math coprocessor 
fragmentation, memory, 

309-310,333 
Freddi the Fish and the Case of the 

Missing Kelp Seeds, 290 
freeware, 199 
freeze, 333 
FTP (File Transfer Protocol), 

described, 192 
full justified text, 114 
Fun and Fantasy folder, 174 
function key. See FKEY 
fund-raisers, computer funding, 242 

•G• 
general learning reference CDs, 77 
geography software, 283-284 



Geometric Golfer, 282 
GeoSafari Multimedia, 283 
GIF, 333 
gig (gigabyte), 30-31, 333 
Gopher, 192, 206 
Gottschalk, Norma Jean, 259 
Grammar Games, 279 
Grant Information Center, America 

Online, 242 
grants, computer funding, 242 
graphics 

browser broken leon, 209 
copying/pasting, 120 
disabling to speed up Web 

browser download times, 212 
greeting cards, 183-185 
newsletters, 177 
sizing handles, 119-120, 174, 185 
sizing/moving in documents, 

119-120 
Graphing Calculator, 46 
grayscale, 334 
Great Wave Software, 279, 

281,283,292 
greeting cards, 180-187 
Gregory and the Hot Air Balloon, 290 
Grolier's Multimedia 

Encyclopedia, 287 
groups, Internet usage, 202 

•H• 
handles, graphics sizing, 119-120, 

174, 185 
handwritten notes, when to use, 117 
hard copy,334 
hard disks, 28-29, 48, 334 

backups, 107-108 
blinking question mark startup 

problem,315 
copying to, 49 
defragmenting, 326-327 
folder/file hierarchy, 101-104 
Print Shop Deluxe CD Ensemble 

storage requirements, 
179-180 

storage capacity, 29 
versus memory temporary 

storage, 29-33 
viewing contents, 48, 88 

hard drives, 334 
hardware, 334 

Apple Presentation System, 
248-249 

digital cameras, 245-246 
digital tablet, 250 
EasyPhoto Reader, 254-255 
eMate 300, 252-253 
headphones,250-251 
Jaz drive, 251 
Ute Pro, 255-256 
Newton MessagePad 2000, 252 
PaperPort, 244 
PowerBook computers, 247 
scanners,243-244 
TouchWindow, 246 
trackballs, 249 
Zip drive, 251 

Hartley, First Connections: The 
Golden Book 
Encyclopedia, 287 

headers, 130, 133 
headings, 170-172 
headline placeholder, greeting 

cards, 183 
Headline Text dialog box, 183 
headphones,221,250-251 
Hewlett-Packard DeskWrlter, 56 
hierarchy, folders, 101-104 
highlight, 334 
His Name Was Uncoln, 283 
history software, 283-284 
Hi-Tech of Santa Cruz, Teacher's 

Tool Kit, 297 
Hollywood, 292 
home version, software, 276 
horizontal scrollbars, 18 
Houghton Mifflin Interactive, 

American Heritage Children's 
Dictionary, 286 

How Many Bugs In a Box?, 291 
How Things Work In Busytown, 290 
How Your Body Works, 285 
HTML (Hypertext Markup 

Language),83 
capturing code in a Web 

browser, 212 
ClarlsWorks now supports, 83 
Web resource language, 204 

HTTP (HyperText Transfer 
Protocol), 205 

Humongous Entertainment, Freddl 
the Fish: Case of the Missing 
Kelp Seed, 290 

HyperCard Player, 46 
hyperllnks, 205 
hypermedia, 205 
HyperStudlo, 236, 292 
hypertext, 205 

•I• 
1-beam cursor, relocating insertion 

point cursor, 97 
lcons,334 

described, 16 
Kid Pix program toolbox, 153-154 
moving, 17 
moving multiple, 38-39 
renaming, 51 
selecting, 38-39 
selecting by name, 51 
used in book, 6-7 

IEP Writer Supreme, 297 
Images 

document Insertion, 161 
Internet cite resource 

conventions, 214 
resizing, 17 4 
sizing handles, 174 

lmageWrlter printers, spooler 
programs, 63 

Imagination Express, 292 
Incredible Machine, 293 
lnfoseek, 211 
Inkjet printers, 55-56,61,334 

Index 

Insert Cells dialog box, 133 
insert mode, text entry, 97-98 
Insertion point cursor, 97, 334 
Inside the SAT, 296 
Inspiration Software, Inspiration, 299 
Instruction, Internet uses, 193 
Integrated phone system, 

described, 196 
Internal modems, locating In 

computers, 195 
Internet, 191-202, 334 

Acceptable Use Policy, 202 
ARPANET, 192 
citing resources, 214 
described, 191-192 
disabling call waJtlng, 196 
educator uses, 193 
group usage, 202 
history, 192 
HTML (hypertext markup 

language) support, 204 
modem requirements, 194-199 
netiquette, 198-201 
Netscape Navigator connections, 

207-209 
online services, 197 
reference updates, 76 
scheduling access times, 201-202 
search engines, 211-212 
service types, 192 
software, 296 
URL, Web address conventions, 

205-206 
uses, 198 
voucher system usage, 202 
VRML (Virtual Reality Modeling 

Language),213 
Web page uses, 198 
whacking (WebWhacker) sites, 215 
WWW (World Wide Web), 197 

Invisible characters, viewing, 112 
ISDN connections, modems, 195 
ISP (Jnternet Service Provider), 

199,207 
Italics, versus underline 

emphasis, 115 
Items 

Apple menu addition/deletion, 41 
locking, 52 
rescuing from Trash, 40 
selecting, 17-18 

• J. 
Jaz drives, 251 
Jigsaw Puzzle, 42 
journals, classroom, 228 
JPEG, 334 
Julllard Music Adventure, 294 
JumpStart programs, 291 
justification, types, 114 

•K• 
K (kilobyte), 334 
kerning, 334 
Key Caps, 42 
keyboard shortcuts, 37-39 
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keyboarding software, 296 
keyboards, 95-100,234 
keys 

Command, 38 
Control, 38 
Delete, 97 
Delete (Backspace), 97-98 
modifier, 38 
Option, 38, 52 
Return, 95, 111-112 
Shift, 38, 320 
spacebar, 115 
Tab,64, 140-141 

Kid Pix, 70, 236, 260-267 
Draw Me options, 159 
erasing pictures, 158 
health activities, 265-267 
Inserting Into ClarisWorks 

documents, 161 
language art activities, 260-261, 

267-269 
math activities, 261-263, 270 
newsletter picture Insertion, 177 
opening, 152 
paintbrushes, 157 
pencil width settings, 165 
picture creation, 154-160 
saving pictures, 155 
science activities, 263, 270-271 
slldeshows, 160-165 
social studies activities, 264-265, 

271-273 
spilling paint cursor, 156 
student activities, 260-267 
template creation, 160 
text entry, 158-159 
toolbox, 153-154 
versions, 151 
versus word processors, 165 

Kid Pix Studio, enhancements, 
152, 295 

KidsTime Deluxe, 292 
kindergartners, multimedia 

programs, 70 
Knowledge Adventure, 

JumpStart, 291 
Kodak DC40 digital camera, 245 

• L • 
lab pack, software, 276 
label, 334 
LAN (Local Area Network), 232 
landscape, 334 
language arts software, 277-280 
Language Publications Interactive, 

Who Is Oscar Lake?, 288 
laser printers, 55, 57, 334 
LaserWrlter Utility (or Apple Printer 

Utility), 47 
Lawrence Productions, Nigel's 

Adventures In World 
Geography, 290 

Layout menu 
Find command, 142 
New Layout command, 145 

LCD (Liquid Crystal Display), 334 

LCD panel, overhead projections, 
221-223 

LCSI, MicroWorlds Math Unks, 283 
Learn option, spell checker, 92 
The Learning Company 

computer support levels, 167-168 
Midnight Rescue, 279 
Read, Write, and Type, 280 
Reader Rabbit's Interactive 

Reading Journey, 279 
Score Builder for the SAT, 296 
The Student Writing Center, 

167-168, 175-177, 277-278 
SuperSolvers Spellbound, 280 
Ultimate Writing & Creativity 

Center, 176 
Writing Center, 168-175 

Learning Services, 277 
left tabs, setting, 114 
left-justified text, 114 
Leonardo, 295 
Lesson Plan Designer Plus, 297 
lesson-plan template, creating, 

122-124 
letterheads, 117-122 
libraries, clip art, 118-119 
line tool, drawing straight lines, 165 
links, Web page, 204 
lists, columnar, 144-146 
Ute Pro projection system, 255-256 
Little Planet Software, Little 

Planet, 279 
Living Books, 280 
LocaiTalk, laser printer drivers, 61 
log books, Internet activity, 202 
logic board, 334 
Logical Journey of the 

Zoombinis, 293 
The Lost Mind of Dr. Brain, 293 
Lycos, 211 

•M • 
Mac lab, 231-236 
Mac OS 8, features, 20-21, 334 
MacConnection, 72 
macro, 334 
Macs. See also computers 

disabling extensions on 
startup, 320 

educators advantages, 6 
force quitting, 302 
freeze/crash recovery, 301-303 
operating system information, 22 
portable computers, 247 
power switch locations, 11-13 
reset switch, 71 
Restart switch, 301-302, 319 
shutting down, 23-24 
slow performance trouble­

shooting, 317 
turning on, 11-13 

MacWarehouse, 72 
MacWeb, 206 
MacZone, 72 
magazines, student activity, 228 
mail merge, 146-148, 334 

Mailing Label Assistant, 
ClarisWorks, 83 

MakeTest, 297 
Making Music, 294 
Marls, RedShift2, 285 
Masterpiece Mansion, 294 
math coprocessor, 334 
Math for the Real World, 283 
Math Heads, 282 
Math Keys, 281 
math software, 281-283 
Math Workshop, 282 
Mavis Beacon Teaches Typing, 296 
Maxis, 288-289 
MayaQuest, 289 
MB (megabyte), 335 
MECC (Minnesota Education 

Consulting, Consortium), 66 
The Amazon Trail, 289 
DlnoPark Tycoon, 289 
Geometric Golfer, 282 
Math Keys, 281 
MayaQuest, 289 
Museum Madness, 284 
Number Munchers, 282 
Opening Night, 293 
The Oregon Trail, 289 
Spelling ToolKit Plus, 298 
TesselManlz! Deluxe, 293 
Trivia Munchers Deluxe, 294 
Word Munchers, 279 

media center, modem location 
advantages, 73, 195-196 

megabyte, 30-31 
memory, 29-31, 335 

application allocation techniques, 
324-325 

CD-ROM requirements, 76 
conflict troubleshooting, 302-303, 

307-312 
defragmenting, 309-310 
determining available, 30-31, 

73-74,324 
Disk Cache settings, 308 
extension requirements, 308 
quitting open applications to free 

up memory, 307 
RAM (random access memory), 

30-31, 73-74 
RAM Doubler, 310 
releasing, 45 
System usage reduction, 307-308 
upgrading considerations, 312 
versus disk storage, 100 
versus hard disk storage 29-33 
virtual, 310-312 

menu bar, described, 14, 335 
menus, 40-45, 335 

appearance differences, 40 
Apple, 40-44 
Applications, 44-45 
desktop, 35 
down-pointing triangles, 37 
grayed out (not available) 

Items, 15 
keyboard shortcuts, 37 
mouse selection techniques, 14-16 



right-pointing triangles, 37 
messages 

404 not found, 208 
an error occurred while writing to 

the disk, 306 
application not found, 304-305 
can't empty trash, 305-306 
Connection refused, 208 
error, 303-306 
numbered errors, 306 
out of memory, 306 
save changes before closing, 106 
Sorry, a system error occurred, 

301-302 
Mlcromedia Publishing, 

SchoolWorks Teacher, 298 
microphones, 162, 165 
Microsoft 

Art Gallery, 294 
Bookshelf, 288 
Dlnosaurs,285 
Encarta, 287 
Internet Explorer, 204, 206 
Works, 81 

MicroWorlds Math Links, 283 
middle/high school, ClarisWorks 

program uses, 69 
middle-school students, multimedia 

programs, 71 
Midnight Rescue, 279 
Millie's Math House, 291 
Mindscape, 285 
mistakes, undoing last action, 99, 

110, 154 
mixer tool, cautions, 165 
moderns, 194-196,199,244,335 
modifier keys, 38, 335 
monitors, classroom TV as, 223, 335 
Mosaic, 206 
motherboard. See logic board 
Mountain Lake Software 

MakeTest, 297 
School Font Collection, 58, 254, 298 

mouse, 13-17,19,97-100 
mouse button, 335 
movies, QuickTirne, 71 
multimedia, 71,205,335 
multimedia composition/authoring 

software, 292-293 
multimedia software, 69-71 
The Multimedia Workshop, 292-293 
multiple programs, quitting 

applications to free up 
memory, 307 

multiple views, 23 
rnultlplle windows, 19-23 
Museum Madness, 284 
My First Amazing World 

Explorer, 284 
My First Incredible Amazing 

Dictionary, 291 

•N• 
names field, database, 85 
Nelson, Ted, 205 
netlquette, 198-201 

Netscape Navigator, 204, 
206-210,212 

network version, software, 276 
networking, Mac lab, 232-233 
networks, 232,335 
New Document dialog box, 86 
New Layout dialog box, 145 
newsgroups, 192,206 
Newsletter Layout dialog box, 

169-170 
newsletters, 169-177 
newspapers, student activity, 228 
Newton MessagePad 2000, 252 
Nice for Headings folder, 171 
Nick Jr. Math Play, 291 
Nigel's Adventures In World 

Geography, 290 
Nile: Passage to Egypt, 289 
The Nine-Month Miracle, 286 
Nobu Toge, Flashlt, 224 
Norton Utilities, 298, 327 
Notes Pad, 42 
notes, handwritten, 117 
NuBus, 335 
Number Maze, 281 
Number Munchers, 282 
numbered error messages, 306 
numbers, Including In all document 

pages, 116 
NumLock key, 335 

•0• 
OCR (optical character 

recognition), 335 
One Small Square: Backyard, 284 
one-Mac classroom, 219-230 

activities, 228-230 
AV Mac uses, 223 
classroom TV as monitor, 223 
computer license agreement, 

223-224 
displaying student work, 230 
eMates, 222 
food/drink restrictions, 230 
hardware requirements, 221 
keyboarding Instruction/drills, 230 
language arts Incorporation, 230 
overhead projections, 221-223 
placement, 220 
reasonsfor,219-220 
screen shots as teaching tools, 224 
students as teachers, 227 
time scheduling, 225-227 
time tracking, 230 
wants/needs, 220-221 
whole class software 

Instruction, 230 
ongoing story center, 228 
onllne,335 
online citations, 214 
online services, 192, 197, 198-199 
Open dialog box, 87-88 
Opening Night, 293 
operating systems, 20-22 

reinstalling, 325-326 
Rhapsody System software, 24-25 

Operation Frog, 286 
Option key, 38,52 
Options menu, Display 

command, 129 
Orbis Software 

Index 

Critical Mass: America's Race to 
Build the Atomic Bomb, 286 

EasyGrade Pro, 132, 297 
A Passion for Art, 294 

The Oregon Trail, 71,289 
Organize menu, Sort Records 

command, 143 
Orly's Draw-A-Story, 295 
Our Times: Multimedia Encyclopedia 

of the 20th Century, 288 
overhead projections, one-Mac 

classroom requirements, 
221-223 

overtype mode, text entry, 99 

•P• 
PageMaker, 278 
pages, 64, 116 
paint bucket tool, Kid Pix, 154-155 
paintbrushes, Kid Pix, 157 
painting, 335 
paper, pin-fed, 56 
PaperPort, 244 
paragraphs 

breaks, forcing, 95, 111-112 
formatting, 113-114 
justification types, 114 
selection techniques, 109 

parent donations, computer 
funding, 242 

A Passion for Art, 294 
paste, 335 
PC (personal computer), 335 
PC Globe Maps 'N' Facts, 287 
PDS (processor direct slot), 335 
pencil tool, width settings, 165 
PenFont, 298 
periods, one space after, 95 
peripheral, 335 
Persuasion, 236 
Phillips Media, 285, 294 
Pick a Transition dialog box, 163-164 
PICT, 335 
Picture menu 

Choose a Picture command, 170 
Resize Picture command, 174 

pictures 
document insertion, 161 
drawing in Kid Pix, 154-160 
drawing versus stamps, 165 
erasing, 158 
inserting in newsletters, 177 
newsletter body addition, 174 
newsletter heading addition, 

170-171 
resizing, 17 4 
saving, 155 
sizing handles, 174 
slideshow selections, 162 

pin-fed paper, described, 56 
pixel, 335 
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placeholders, greeting cards, 
182-184 

The Playroom, 291 
Playskool Children's Educational 

Software, Playskool 
Puzzles, 293 

Playskool Puzzles, 293 
Pogue, David, 8, 232, 301-328 
pointing, mouse technique, 14-15 
pop-up menu, 85, 336 
port, 336 
portable computers, 24 7 
portrait, 336 
postal mall, JOG Books Worldwide, 7 
PostScript, 336 
PostScript laser printer, 57 
Power Macintosh, 336 
power switch, Mac locations, 11-13 
PowerBook, 16, 247,336 
PowerPC chip, 336 
PowerTalk, 336 
PRAM (parameter RAM), 

318-319,336 
presentations, 91, 237-242 
PresenterMac/PC3, 223 
press releases, computer funding 

technique, 238 
Primary Fonts, 254 
Primary Fonts II, 254 
Princeton Review, Inside 

the SAT, 296 
Print dialog box, 63-64 
The Print Shop Deluxe, 179-188, 295 
The Print Shop Deluxe CD 

Ensemble, 297 
printer drivers, 61 
printer font, 336 
printers 

Apple lmageWriter II, 56 
Apple StyleWrlter, 56 
Chooser setup, 60-62 
dot-matrix, 55-56 
Hewlett-Packard DeskWrlter, 56 
Inkjet, 55-56 
laser, 55, 57 
Mac lab, 232-233 
network,232-233 
one-Mac classroom require-

ments, 221 
PostScript laser printer, 57 
selecting from Chooser, 232 
switching between, 117 
typeface format differences, 

116-117 
types, 55-57 

printing 
back to front, 64 
background,62-63 
cancellng,64 
Chooser settings, 60-62 
databases, 141 
greeting cards, 187 
mail merge documents, 148 
number of copies, 64 
preparing for, 60-63 
selected pages for, 64 
spreadsheets, 130 

PrintMonitor, 336 
problem-solving cookbook, 317-327 

application memory allocation, 
324-325 

disabling extensions on 
startup, 320 

extension conflicts, 319-321 
force quitting, 319 
hard disk defragmentation, 

326-327 
rebuilding the Desktop file, 318 
Restart switch, 319 
SCSI conflict resolutions, 321-324 
System software reinstallation, 

325-326 
zapping the PRAM, 318-319 

Prodigy, 197 
productivity software, 68-70 
project planner, student activity, 230 
protection programs, 234 
Publish and Subscribe, 336 
publications 

The ClarisWorks Reference For 
Teachers, 83, 139 

How Computers Work, 229 
The Internet For Teachers, 203 
Macs For Dummies, 8, 55, 301 
Macs For Teachers, 3 
More Macs For Dummies, 232 
Web Publishing For Teachers, 203 
World Wide Web For Teachers, 203 

•0• -question mark, startup problem, 315 
QulckCam digital camera, 246 
QulckTime, 336 
QuickTime movies, force quitting, 71 
QulckTime VR, 336 
quit, 336 
quote characters, straight versus 

curly, 116 

•R• 
radio button, 85, 336 
RAM (random access memory), 

30-31,73-74,336 
RAM disk, 336 
RAM Doubler, 310 
Read, Write, and Type, 280 
Reader Rabbit's Interactive Reading 

Journey, 167,279 
reading development/comprehen-

sion software, 278-280 
Reading Maze, 279 
reboot, 337 
rebuilding the Desktop, 337 
Recent Documents, 42 
RecentServers,42 
record info field, database, 85 
records, 142-144 
RedShlft2, 285 
Redux, 109 
reference CDs, 76-77 
reference software, 286-288 
Replace option, spell checker, 92 
reports, columnar lists, 144-146 

research base, student activity, 230 
research, Internet uses, 193 
reset switch, rebooting 

computing, 71 
resize box, 337 
Restart switch, system freeze/crash 

recovery,301-302,319 
Retrospect, 109 
Return key, forcing paragraph 

breaks,95, 111-112 
Rhapsody System, 24-25 
right tabs, setting, 114 
right-justified text, 114 
right-pointing triangles, menu 

command access, 37 
ruse (reduced instruction-set 

computing), 337 
Roger Wagner Publishing, 

HyperStudlo, 292 
ROM,337 
Romeo & Juliet Center Stage, 280 
Rosetta Stone PowerPac, 288 
Row Graphic dialog box, 185-186 
Row Graphic placeholder, greeting 

cards, 185-186 
row headers, deleting entire 

row, 133 
rows, 133-134 
ruler, 87, 114 

•S• 
S.T.A.R. program, 299 
Sanctuary Woods, 282-283 
sans serif, 337 
Save dialog box, 89-90 
Save File dialog box, 100-101 
scanners,243-244,337 
schedules, telecommunications, 

201-202 
Scholastic, 281-286 
School Font Collection, 254, 298 
School House Fonts, 254 
school newspapers, computer 

funding advertising, 239 
school version, software, 276 
SchoolZone,AiphabetExpress,291 
Schoolhouse Fonts, 298 
Schoolhouse Rock: Math Rock, 281 
schools, Integrated phone 

systems, 196 
SchooiWorks Teacher, 298 
Science Sleuths (Volumes 1 

and 2), 285 
science software, 284-286 
Score Builder for the SAT, 296 
Scrapbook,42, 119,337 
screen captures, 224 
screen shots, as teaching tools, 224 
screensaver,337 
ScreenShare, 234 
scroll bar, 18, 337 

database record navigation, 142 
document navigation, 115-116 

scroll box, document position 
location indicator, 115 

SCSI (Small Computer System 
Interface), 321-324 



;earch engines, Web site searches, 
211-212 

;earches 
criteria selections, 143 
database, 142-143 
Gopher, 192 
online services, 198 
Web site, 211-212 

second-grade, ClarlsWorks program 
uses,69 

selected text, 98-99, llO 
serial number field, database, 85 
serif, 337 
5et Field Order dialog box, 146 
shareware, 199, 337 
Shift key, disabling extensions on 

startup, 38, 320 
Shortcuts palette, ClarisWorks, 132 
Shut Down, 42 
Sierra Online, 279, 288, 293 
5ignature Software, 58, 254, 298 
sill-and-drill review station, 229 
SimCity 2000, 289 
SimTown, 288 
5imCity, 72 
Simon & Schuster Interactive, 281, 

286,291,296 
SimpleSound, 42 
SimpleText, 337 
simulation software, 71-72, 288-290 
site license, software, 276 
size box, 18 
Size menu, changing font size, 113 
skill-and-drlll software, 66-68 
Skip option, spell checker, 92 
slideshows, 160-165 
slot, 337 
SmartStuff Software, FoolProof, 

50-51,234,298 
smileys, 200 
Snootz Math Trek, 282 
social studies software, 283-284 
Softkey, 287, 295 
software 

academic version, 276 
CD versus floppy disk instal-

lation, 77 
copyrights, 70 
creativity, 295 
critical thinking, 293-294 
described, 337 
disclaimer, 275 
early learning, 290-292 
electronic storybooks, 280-281 
fine arts, 294-295 
foreign languages, 288 
home version, 276 
Internet, 296 
keyboarding, 296 
lab pack, 276 
language arts, 277-280 
math, 281-283 
multimedia, 69-71 
multimedia composition/ 

authoring, 292-293 
network version, 276 

one-Mac classroom require­
ments, 221 

productivity, 68-70 
reading development/comprehen-

sion, 278-280 
reference, 286-288 
reference CDs, 76-77 
school system suppliers, 277 
school version, 276 
science, 284-286 
simulation, 71-72,288-290 
site license, 276 
skill-and-drill, 66-68 
social studies/history/geography, 

283-284 
System, 325-326 
teacher productivity, 297-299 
test review, 296 
version numbers, 75 
writing, 277-278 

software party, computer 
funding, 240 

software trailer/office, computer 
funding, 240 

songs, disabling In Writing 
Center, 168 

Sort Records dialog box, 143-144 
sorts, database records, 143-144 
sounds 

Internet cite resource 
conventlons,214 

quality hints, 165 
slldeshow addition, 162 
startup problem troubleshooting, 

313-316 
spacebar, aligning text, 115 
spaces, after periods, 95 
speakers, one-Mac classroom 

requirements, 221 
special effects, slideshow transi­

tions, 163-164 
Special menu 

Eject Disk command, 50,316 
Empty Trash command, 40, 51 
Shut Down command, 23-24 

Special Needs, 47 
specific learning reference CDs, 77 
Speech Recognition, 47 
spell checker, Writing Center, 177 
Spelling dialog box, 91-92 
Spelling ToolKit Plus, 298 
spllllng paint cursor, Kid Pix, 156 
spooler, programs, 63 
spreadsheets 

business uses, 126 
cells, 127 
character formatting, 129-130 
ClarisWorks Version 4 enhance-

ments, 85 
column width settings, 127 
column/row insertion, 133 
creating, 126-132 
deleting column/row, 133 
described, 126 
display settings, 129 
editing strip, 128 
education uses, 126 

filling cells, 132 
fonts/sizes, 130 
headers, 130 
naming when saving, 129 
printing, 130 

Index 

resizing column/row, 134 
selecting from New Document 

window,127 
text alignment, 130 
text colors, 130 
uses, 134-135 

Square Graphic dialog box, 183-184 
staff, Mac lab, 233 
stamp tool 

Kid Pix, 155 
versus drawn pictures, 165 

startup disk, 337 
Startup Items folder, trouble­

shooting, 316 
startup problems 

blinking question mark, 315 
ding, no picture, 313-314 
disabling extensions on 

startup, 320 
four musical notes (crash sound), 

314-315 
no ding, no picture, 313 
picture, no ding, 314 
Startup Items folder, 316 
troubleshooting, 313-316 

Stationery 
creating a presentation, 91 
document summary 

information, 121 
documents, 236 
Kid Pix program templates, 160 
saving document as, 86, 107-108 
saving letterhead as, 120-122 

Stickles, 42 
straight quotes characters, versus 

curly quote characters, 116 
Strategy Games of the World 

Volumes I and II, 294 
student activities, 260-274 

CDC Web site information, 214 
ClarlsWorks, 69 
classroom journal, 228 
health,265-267,273-274 
Internet acronyms/symbols 

creation, 201 
Internet Information search, 193 
Kid Pix, 70-71,260-267 
Kid Pix program Draw Me 

options, 159 
language arts, 260-261 
math, 261-263 
media center, 73 
monthly class magazine/ 

newspaper, 228 
newsletter columnists, 177 
one-Mac classroom, 228-230 
ongoing story center, 228 
project planner, 230 
research base, 230 
science, 263 
sklll-and-drill review station, 228 

(continued) 
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student activities (continued) 
social studies, 264-265 
telecommunications, 198 
Web page uses, 211 

The Student Writing Center, 
175-177, 277-278 

students, 223-224, 227 
Style menu 

Bold command, 112-113 
Italic command, 112 
Underline command, 112 

StyleWriter printers, deactivating 
AppleTalk, 61 

subfolders, 103 
summer computer camps, computer 

funding, 241 
Sunburst, 278,280,283, 286, 290 
Super Solvers, 167 
SuperSchool Software, 297 
SuperSolvers Spellbound, 280 
suppliers, school system 

software, 271 
Switcharoo menu 

Draw Me command, 159 
Switch to SlideShow command, 160 

Symantec, Norton Utilities, 298 
symbols, 27, 200 
syntax, command conventions, 

17-18 
System 6, 337 
System 7, 337-338 
System 7 .1, 338 
System 7 .5, 338 
System 7.6, 20, 22,338 
System 8.0, 338 
system crash, described, 107,338 
System disk, 338 
System file, 338 
System Folder 

blinking question mark startup 
problem, 315 

described, 338 
opening, 19 
viewing contents, 19 

system freeze/crash, trouble­
shooting, 301-303 

System software, reinstalling, 
325-326 

•T• 
T /Maker, ClickArt Images, 298 
Tab key, 64, 140-141 
tab markers, ruler types, 114 
Tabletop Jr., 281 
Tabletop, 281 
tabs, settings, 114 
teacher productivity software, 

297-299 
Teacher's Fonts I, 298 
Teacher's Fonts II, 298 
Teacher's Tool Kit, 297 
technology center, computer 

funding, 240-241 
technology coordinators, Mac lab, 

233-234 
technology week, computer funding 

technique, 239 

telecommunicating, 194 
telecommunications 

Acceptable Use Polley, 202 
dedicated telephone lines, 196 
disabling call waiting, 196 
faxes, 198 
Integrated phone system 

concerns, 196 
ISDN connection advantages, 195 
log books, 202 
modem requirements, 194-196 
netiquette, 199-201 
online services, 197 
scheduling access times, 201-202 
terms, 199 
uses, 198 
Web page uses, 198 
WWW (World Wide Web), 197 

telephone numbers 
Apple Computer, 50 
Apple Educator Advantage, 248 
Apple Family Computing 

Workshop, 238 
Apple staff-development 

workshops, 255 
Educational Resources, 277 
Learning Services, 277 
MacConnections, 72 
MacWarehouse, 72 
MacZone, 72 
Mountain Lake Software, 58 
Signature Software, 58 
SmartStuff Software, 50 
Tom Snyder Productions, 226 

telephones, dedicated modem 
lines, 196 

TelevEyes/Pro, 223 
televisions, as monitors, 223 
telnet, URL conventions, 206 
templates 

Kid Pix, 160 
lesson-plan, 122-124 
Writing Center, 169 

terminators, SCSI, 323-324 
TesselMania! Deluxe, 293 
Test Designer Supreme, 297 
test preparation software, 67 
test review software, 296 
text formatting, typewriters versus 

word processor, 110-111 
Text menu 

Alignment command, 171 
Border command, 177 
Font command, 172 

Text placeholder, greeting cards, 
186-187 

text-only browsers, 206 
Text-to-Speech, 47 
Theatrix Interactive, 282, 284, 

292,294 
Thinkin' Things Collections 1, 2, 

and 3, 293 
TIFF (tagged image file format), 338 
Time Magazine Reference 

Collection,287 
The Time Warp of Dr. Brain, 293 

Time/Life lVI Publishing, What Is a 
Bellybutton?, 288 

TimeLlner, 283 
title bar, 18, 338 
Tom Snyder Productions, 226, 283 
toner, 338 
tool box, displaying, 118 
tool palette 

displaying/hiding, 88 
Print Shop Deluxe, 187-188 

Tool panel, New Sort command, 143 
toolbox, Kid Pix, 153-154 
TouchWindow, 246 
trackballs, 16, 249, 338 
trackpads, PowerBook mouse, 16 
transitions, slldeshows, 163-164 
Transparent Language, Transparent 

Language Series 4.0, 288 
Trash, 39-40, 51-52 
Trash Info dialog box, Warn before 

emptying, 51 
Travelrama USA Deluxe, 283 
Treasure series, 167 
The Treehouse, 291 
Trivia Munchers Deluxe, 294 
troubleshooting, 301-328 

an error occurred while writing to 
the disk message, 306 

application not found error 
message, 304-305 

can't empty trash error message, 
305-306 

error messages, 303-306 
extension conflicts, 302-303 
floppy disk flukes, 316-317 
Mac freezes/crashes, 301-303 
memory conflicts, 302-303, 

307-312 
memory defragmenting, 309-310 
numbered error messages, 306 
out of memory error message, 306 
printers, 61 
problem-solving cookbook, 

317-327 
RAM Doubler, 310 
slow performance, 317 
Startup Items folder, 316 
startup problems, 313-316 
System memory requirements, 

307-308 
virtual memory, 310-312 

TrueType,338 
TVAtor, 223 
typefaces, multiple printer formats, 

116-117 
typewriters, 95-100, 110-113 
typing techniques, versus 

keyboarding, 95-100 
Typing Tutor 7, 296 
typographical errors, erasing with 

Delete (Backspace) key, 97-98 

•U• 
The Ultimate Einstein, 286 
Ultimate Writing & Creativity 

Center, 176 
UltraKey, 296 



underlining, avoiding as 
emphasis, 115 

undoing last action, 99, 110, 154 
untitled folders, renaming, 36 
uploading, 199, 338 
URL (Uniform Resource Locator), 

205-206 
user group, 338 

•(/• 
version number 

Kid Pix, 151 
software, 75 
System software, 20-22 

vertical scrollbars, 18 
Vlacom New Media, Nick Jr. Math 

Play, 291 
Vicarious, Our Time: Multimedia 

Encyclopedia of the 20th 
Century, 288 

video card, 338 
video clips, ~nternet cite resource 

conventions, 214 
VideoDiscovery, Science Sleuths 

(Volumes 1 and 2), 285 
View menu 

by Name command, 23, 51 
Hide Rulers command, 114 
Page View command, 127 

views, multiple, 23 
Virgin Sound and Vision, One Small 

Square:Backyard,284 
virtual memory, 310-312 
Visioneer, PaperPort, 244 
Vital Links, 283 
voucher system, Internet usage, 202 
Voyager, 292-294 
VRAM (video RAM), 338 
VRML (Virtual Reality Modeling 

Language),213 

•W• 
WAN (Wide Area Network), 232 
Web browsers 

described, 204 
disabling graphics, 212 
MacWeb, 206 
Microsoft Internet Explorer, 

204,206 
Mosaic, 206 
Netscape Navigator, 204, 206-210 
text-only Interface, 206, 212 

Web pages, 198,204 
Web sites 

Aladdin Systems, 210 
Alta Vista, 211 
APA Style of Notation, 214 
Apple, 255 
Apple Computer educator home 

page,213 
Apple eMate, 7 
bookmarking, 210 
CDC (Centers for Disease 

Control), 214 
Claris, 212 

Clarls HTML translator, 212 
Excite, 211 
lnfoseek, 211 
K-12 Outpost, 213 
Lycos, 211 
MayaQuest 96, 289 
MLA Citation Guide, 214 
Netsurf, 206 
Newton, 7 
online citations, 214 
Robinette, Michelle, 214 
VRML Information, 213 
weather map, 213 
WEB 66, 208, 211 
Web page creation 

Information, 211 
WebCrawler, 211 
WebSpace, 213 
Well,209 
whacking (WebWhacker), 215 
Yahoo, 208 

WebCrawler, 211 
WebSpace, 213 
WebWhacker,296 
What Is a Bellybutton?, 288 
What's the Secret? (Volumes 1 

and 2), 285 
Where in Time Is Carmen Sandlego, 

71,290 
White Knight Software, 

ScreenShare, 234 
White, Ron, 229 
Who Is Oscar Lake?, 288 
Williams, Bard, 203 
windows, 17-24, 338 

closing, 17, 104 
components, 18-19 
expanding, 52 
expanding/collapsing with View 

buttons, 88 
minimizing, 20 
multiple, 19-23 
multiple views, 23 
opening, 17 
viewing contents by name, 23, 51 

With Open Eyes, 294 
Word Attack 3, 279 
Word Munchers, 279 
word processor, 93-124 

avoiding underline as 
emphasis, 115 

boldfacing text, 113 
changing font style/size, 113 
character formatting versus 

typewriters, 112-113 
ClarlsWorks ver 4 enhance. 

ments, 84 
copying/pasting graphics, 120 
cutting/copying/pasting Clipboard 

text, 116 
document page numbers, 116 
first time document save, 100-107 
folder creation, 93-94 
forcing paragraph breaks with 

Return key, 111-112 
formatting characteristics versus 

typewriters, 110-111 

Index 

Insertion point cursor, 97 
justification types, 114 
lesson-plan template, 122-124 
letterheads, 117-122 
one space after a period, 95 
opening previously saved 

documents, 106-107 
paragraph formatting, 113-114 
Return key usage, 95 
rulers, 87 
saving document as Stationery, 

107-108, 120-122 
scroll bar/box document 

navigation, 115-116 
selecting from C1arisWorks 

menu bar, 94 
supply list, 93-94 
tab settings, 114-115 
text insertion, 97-98 
text selection techniques, 

98-100, 109 
undoing last action, 99, 110 
versus Kid Pix, 165 
versus typewriters, 95-100 
viewing invisible characters, 112 
word wrap, 95-97 

word wrap, versus Return key 
usage,95-97 

words,92, 109-115 
work, saving frequency guidelines, 

32, 100 
workshops, Apple staff-develop-

ment, 255 
World Discovery Deluxe, 284 
The Writing Center, 168-177 
writing software, 277-278 
WWW (World Wide Web), 197, 199, 

203-216 
3-D viewing, 213 
CERN (European Laboratory for 

Particle Physics) develop­
ment, 205 

cite source conventions, 214 
described, 192, 203-204 
history, 205 
HTML (hypertext markup 

language), 204 
hypertext development 

history, 205 
Netscape Navigator connections, 

207-209 
reloading images, 212 
site searches, 211-212 
site types, 203-204 
URL (Uniform Resource Locator) 

address conventions, 205-206 
WYSIWYG (what you see is what 

you get), 338 

•Y• 
Your Personal Trainer for 

the SAT, 296 

•Z• 
Zip drives, 251 
zoom box, expanding window, 18, 

52,338 
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lOG Books Worldwide, Inc., 
End-User License Agreement 

READ THIS. You should carefully read these terms and conditions before opening the software 
packet(s) included with this book ("Book"). This is a license agreement ("Agreement") between you and 
IDG Books Worldwide, Inc. ("lOGB"). By opening the accompanying software packet(s), you acknowl­
edge that you have read and accept the following terms and conditions. If you do not agree and do not 
want to be bound by such terms and conditions, promptly return the Book and the unopened software 
packet(s) to the place you obtained them for a full refund. 

1. Ucense Grant. lOGB grants to you (either an individual or entity) a nonexclusive license to use 
one copy of the enclosed software program(s) (collectively, the "Software") solely for your own 
personal or business purposes on a single computer (whether a standard computer or a 
workstation component of a multiuser network). The Software is in use on a computer when it 
is loaded into temporary memory (RAM) or installed into permanent memory (hard disk, 
CD-ROM, or other storage device). lOGB reserves all rights not expressly granted herein. 

2. Ownership. lOGB is the owner of all right, title, and interest, including copyright, in and to the 
compilation of the Software recorded on the disk(s) or CD-ROM ("Software Media"). Copyright 
to the individual programs recorded on the Software Media is owned by the author or other 
authorized copyright owner of each program. Ownership of the Software and all proprietary 
rights relating thereto remain with lOGB and its licensers. 

3. Restrictions on Use and Transfer. 

(a) You may only (i) make one copy of the Software for backup or archival purposes, or (ii) 
transfer the Software to a single hard disk, provided that you keep the original for backup 
or archival purposes. You may not (i) rent or lease the Software, (ii) copy or reproduce the 
Software through a LAN or other network system or through any computer subscriber 
system or bulletin-board system, or (iii) modify, adapt, or create derivative works based on 
the Software. 

(b) You may not reverse engineer, decompile, or disassemble the Software. You may transfer 
the Software and user documentation on a permanent basis, provided that the transferee 
agrees to accept the terms and conditions of this Agreement and you retain no copies. If 
the Software is an update or has been updated, any transfer must include the most recent 
update and all prior versions. 

4. Restrictions on Use of Individual Programs. You must follow the individual requirements and 
restrictions detailed for each individual program in "About the CD" Appendix E of this Book. 
These limitations are also contained in the individual license agreements recorded on the 
Software Media. These limitations may include a requirement that after using the program for a 
specified period of time, the user must pay a registration fee or discontinue use. By opening 
the Software packet(s), you will be agreeing to abide by the licenses and restrictions for these 
individual programs that are detailed in "About the CD" Appendix E and on the Software Media. 
None of the material on this Software Media or listed in this Book may ever be redistributed, in 
original or modified form, for commercial purposes. 



License Agreement 3 5 ~ 
5. Umited Warranty. 

(a) IDGB warrants that the Software and Software Media are free from defects in materials and 
workmanship under normal use for a period of sixty (60) days from the date of purchase of 
this Book. If IDGB receives notification within the warranty period of defects in materials 
or workmanship, IDGB will replace the defective Software Media. 

(b) lOGB AND THE AUTHOR OF THE BOOK DISCLAIM ALL OTHER WARRANTIFS, EXPRFSS 
OR IMPUED, INCLUDING WITHOUT UMITATION IMPUED WARRANTIFS OF MER­
CHANTABIUTY AND FITNFSS FOR A PARTICULAR PURPOSE, WITH RFSPECT TO THE 
SOFIWARE, THE PROGRAMS, THE SOURCE CODE CONTAINED THEREIN, AND/OR THE 
TECHNIQUES DFSCRIBED IN THIS BOOK. IDGB DOFS NOT WARRANT THAT THE 
FUNCTIONS CONTAINED IN THE sonwARE WILL MEET YOUR REQUIREMENTS OR 
THAT THE OPERATION OF THE sonwARE WILL BE ERROR FREE. 

(c) This limited warranty gives you specific legal rights, and you may have other rights that 
vary from jurisdiction to jurisdiction. 

6. Remedies. 

(a) lOGB's entire liability and your exclusive remedy for defects in materials and workmanship 
shall be limited to replacement of the Software Media, which may be returned to IDGB with 
a copy of your receipt at the following address: Software Media Fulfillment Department, 
Attn.: Macs For Teachers, 3rd Edition, IDG Books Worldwide, Inc., 7260 Shadeland Station, 
Ste. 100, Indianapolis, IN 46256, or ca11800-762-2974. Please allow three to four weeks for 
delivery. This Limited Warranty Is void If failure of the Software Media has resulted from 
accident, abuse, or misapplication. Any replacement Software Media will be warranted for 
the remainder of the original warranty period or thirty (30) days, whichever Is longer. 

(b) In no event shalliDGB or the author be liable for any damages whatsoever (including 
without limitation damages for loss of business profits, business interruption, loss of 
business information, or any other pecuniary loss) arising from the use of or inability to 
use the Book or the Software, even if IDGB has been advised of the possibility of such 
damages. 

(c) Because some jurisdictions do not allow the exclusion or limitation of liability for conse­
quential or incidental damages, the above limitation or exclusion may not apply to you. 

7. u.s. Government Restricted Rights. Use, duplication, or disclosure of the Software by the U.S. 
Government is subject to restrictions stated In paragraph (c)(l)(ii) of the Rights in Technical 
Data and Computer Software clause of DFARS 252.227-7013, and in subparagraphs (a) through 
(d) of the Commercial Computer-Restricted Rights clause at FAR 52.227-19, and In similar 

clauses In the NASA FAR supplement, when applicable. 

General. This Agreement constitutes the entire understanding of the parties and rev~~es and 
S. supersedes all prior agreements, oral or written, between them and ~ay not be modlfa~d or 

amended except in a writing signed by both parties hereto that specafically refers to thts 
Agreement. This Agreement shall take precedence over any other documents that may be in 
conflict herewith. If any one or more provisions contained in this Agreement are held by any 
court or tribunal to be invalid, illegal, or otherwise unenforceable, each and every other 

provision shall remain in full force and effect. 



Installation Instructions 
To install the items from the CD to your hard drive, follow these steps: 

I. Insert the CD into your computer's CD-ROM drive. 

2. Double-click the CD icon when it appears on your desktop. 

3. Double-click the Activity Board icon. 

The Activity Board opens up, showing you the license agreement. 

4. Since you surely want to use the CD, read through the license agree­
ment, nod your head, and then click on the Accept button. 

From here, the CD interface appears. The CD interface enables you to 
run or install the programs on the CD without wading through layer 
after layer of folders. The software on the interface is divided into 
categories whose names you see on the screen. 

5. To view the items within a category, just click the category name. 

6. For more information about a program, click on the program name. 

Be sure to read the information that's displayed. Sometimes a program 
requires you to do a few tricks on your computer first, and this screen 
tells you where to go for that information, if necessary. 

7. To install a program or run a demo, click the Continue button. If you 
don't want to install the program, click on the Cancel button to 
return to the previous category screen. · 

After you click on a Continue button, the CD interface drops to the 
background while the CD begins installing the program or running the 
demo. When installation is done, the interface usually reappears in 
front of other open windows. Sometimes the installation confuses the 
Mac and leaves the interface in the background. To bring the interface 
forward, just click once anywhere in the interface's window. 

8. To move back to the category screen from a program list, click the 
Go Back button. 

9. When you're done installing programs, click on the Quit button to 
close the interface. 

To run some of the programs, you may need to keep the CD inside your 
C~ROM drive. See Appendix E (About the CD) for more details on using 
th1s CD. 




